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Preface 

Thank you for purchasing Application Storage Manager™ (ASM) Data 
Manager, the most flexible storage management system for Microsoft® 
Windows®. Data Manager allows you to extend the capacity of NTFS volumes 
by automating migration of files to storage media. Data Manager uses 
separate media services to manage media in storage devices, so that all drive, 
library, and media specific issues are handled and optimized by the media 
service (like ASM MediaStor). This enables Data Manager to focus specifically 
on the management of files, and allows clients to simply save and retrieve files 
on any extended NTFS volume. 

With Data Manager, many terabytes of data storage can be made available on 
an NTFS volume without adding to the physical capacity of the hard disk 
where the volume is located. Data Manager can be used to represent the 
contents of multiple pieces of media as folders on a single volume, keeping 
track of the exact location of all files on media. CD-ROM, DVD-R, DVD-RAM, 
DVD-ROM, magneto-optical, Network Attached Storage (NAS), tape, Tivoli® 
Storage Manager (TSM), EMC Centera™ (EMC), WORM, and WORM-tape 
media can all be managed easily and effectively using a variety of file 
systems. 

Data Manager adds value to the NTFS file system, enhancing Windows native 
capabilities by providing file migration services. Because of the design of Data 
Manager, file migration can be added without losing any Windows features. 
Windows still manages all issues like security, long file name support, and 
network connectivity.

Data Manager provides a rule-based system for file storage management. 
Rather than simply migrating all files to media without distinction between 
files, Data Manager allows you to set criteria that govern which files will be 
stored where. Using the rules you create, Data Manager manages file storage 
locations in the background, moving files to media and purging their data to 
make space on the extended drive. To the end user, however, all files appear 
to be located on the NTFS drive extended by Data Manager. 

Data Manager provides comprehensive file management capabilities, a single 
point of administration, and scheduling features to optimize system 
performance. Time-consuming processes that compete for system resources 
– such as media restore, media compaction, and file movement to media – 
can be set to occur at convenient times. Data Manager also monitors system 
warnings and errors, and can be configured to send alerts to specific users or 
computers.

This System Guide explains how to configure and utilize Data Manager to 
most effectively manage your file migration system. It contains all the 
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necessary information to achieve the best results for implementing and 
customizing your automated data storage solution.

■ Chapter Summary
The following table summarizes each chapter of this document:

Table 1.  Chapter Summary

Chapter Description
Chapter 1: Introduction 
on page 1 

This chapter provides a brief overview of the 
system, including its concepts and components.

Chapter 2: Managing 
Storage Media on page 
13 

This chapter discusses the types of storage 
media that you can use with Data Manager, as 
well as how to manage and back up media.

Chapter 3: Managing File 
Migration on page 117 

This chapter discusses how to manage media 
folders, move groups, and move rules, as well as 
how to manage client requests for files on media 
(“fetches”).

   Chapter 4: Managing 
the Extended Drive on 
page 163 

This chapter discusses how to manage space on 
the extended drive by purging and deleting files. 
It also discusses modifying extended drive 
properties, deleting the extended drive, and 
running drive scans.

 Chapter 5: Managing the 
Data Manager Computer 
on page 207 

This chapter discusses how to manage the Data 
Manager service and Data Manager computer 
properties, as well as how to troubleshoot using 
logs and event viewing.

Chapter 6: Running Data 
Manager Reports on 
page 245 

This chapter discusses how to run Data 
Manager reports, what information is contained 
in them, and how to set up and save custom 
layouts for your Data Manager reports.

Chapter 7: Data Manager 
Backup and Recovery on 
page 267 

This chapter discusses the functions available in 
Data Manager to allow you to effectively back up 
your Data Manager system, as well as 
procedures for restoring your Data Manager 
system in the event of disaster or failure.

Chapter 8: Remotely 
Administering Data 
Manager on page 289 

This chapter describes how to install the Remote 
Administrator component that allows you to 
administer Data Manager from a computer that 
does not contain a Data Manager extended 
drive. 



Related Documentation

ASM Data Manager System Guide xi
StorageTek Proprietary

■ Related Documentation
Refer to the following additional documentation:

• ASM Data Manager Getting Started Guide

• ASM MediaStor System Guide if using ASM MediaStor as a media service

• StorageTek ACSLS™ documentation if using ACSLS as a media service

• Tivoli Storage Management documentation if using TSM as a media 
service

• EMC Centera documentation if using EMC as a media service 

• Microsoft Cluster Server documentation if using ASM in a clustered 
environment

• Windows documentation if you plan to install ASM on a Windows server 
while using the Windows Server Active Directory® service on your network

• StorageTek Co-StandbyServer User’s Guide if using ASM in a Co-
StandbyServer™ environment

■ Online Help
Help is available online from any Data Manager dialog box. For a description 
of the dialog box, press the <F1> key. A Help window appears, outlining the 
dialog box parameters and fields.

A knowledge base help file with error descriptions, tech notes, software notes, 
fixed/known bugs is also available on the StorageTek® website at http://
www.StorageTek.com/.

All ASM guides, including this one, are available in PDF format on the 
installation CD.

Using RtfPad on page 
303

This chapter discusses how to save, print, and e-
mail the Data Manager logs and reports using 
RtfPad. It also contains information on looking 
up errors that appear in logs in RtfPad.

Using Explorer Add-ons 
on page 309

This chapter discusses the functions available 
through the Explorer Add-ons.

Removing Data Manager 
and Its Components on 
page 311

This chapter provides detailed instructions for 
uninstalling Data Manager, the Remote 
Administrator, and the Explorer Add-ons.

Table 1.  Chapter Summary (Continued)

Chapter Description
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■ Documentation Conventions
Consistent formatting is used throughout all ASM guides to represent certain 
information.

Table 2.  Documentation Conventions

This Cue Represents
monospaced text Characters that must be typed on your screen 

exactly as they appear in this document.

<ALL CAPITALS> Keys on your keyboard used in combination or 
sequence. For example <ALT>+B means to hold 
down the <ALT> key while pressing b, and <ALT>, F, 
X means to press and release each of the keys in 
order: first <ALT>, then F, then X.

ALL CAPITALS Directory names, filenames, and acronyms.

italics References to manual titles, chapter titles, and 
section headings; placeholders; and emphasis.

Note 
Explanatory note 
between two lines. 

Additional information needed as you follow the 
step-by-step operations in this manual.
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1Introduction

Application Storage Manager™ (ASM) Data Manager is a storage 
management system that provides support for multiple media types, flexible 
data organization, and rules-based file migration. Data Manager accomplishes 
this through an easy-to-navigate interface, and transparent communication 
with storage locations and device management software. 

Data Manager allows you to extend the storage capabilities of NTFS volumes 
by using Data Manager file migration services to move files from the NTFS 
volume to other, less-expensive storage media. Users on your network may 
typically save data to a drive on your Windows file server. As long as the drive 
is an NTFS volume, you can significantly expand file storage capabilities 
without changing anything from the user point of view by extending that drive 
with Data Manager. File data on a drive extended by Data Manager can be 
moved to media through a media service (for example, to tape in a library 
managed by ASM’s MediaStor) without affecting the file listing seen by the end 
user.

You are the architect of the Data Manager system. Data Manager allows you 
to leverage your existing hardware configuration or create a new one. The 
powerful features of Data Manager, combined with an easy-to-use graphical 
user interface, allow you to fine-tune a file storage strategy for any type of 
application requirement. Before you update the storage strategy you created, 
however, you should be comfortable with Data Manager terminology and 
concepts. Take the time to read all sections, as this will help you attain the best 
performance, functionality, and organization for your storage solution.

This chapter identifies key terminology and concepts that are vital for you to 
understand. For more information, see the following sections:

• "A Data Manager Glossary, " which follows

• “Data Manager Concepts” on page 7

■ A Data Manager Glossary
To make it easier for you to follow the discussion of Data Manager concepts in 
this chapter, here are brief descriptions of key terms used in the concepts 
section and throughout this guide. You can either read this glossary first, or 
refer to it as needed while you read about Data Manager.
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Table 1.  Data Manager Glossary

Term Definition
ACSLS A device management software product that runs on a 

UNIX platform. Data Manager can use an ACSLS 
installation as a media service. ACSLS has the ability to 
manage retrieval of media in some StorageTek tape 
libraries.

Active Server A cluster server that is always running and processing 
user requests.

Cluster A processing environment consisting of two or more 
server computers and other resources that act as a 
single system and enable high availability.

Compaction The process of reclaiming used storage media by 
eliminating wasted space taken up by outdated copies 
of files or files marked for deletion. Compacting media 
copies all active (non-deleted and current versions of) 
files from media back to the extended drive, and then 
removes the media from the media folder so that it can 
be reformatted and used again. The files that are 
copied to the extended drive are ultimately moved back 
to media based on the move rules for the media folder.

Data Management Control of the location of file data for Data Manager 
files. Data Manager can manage the contents of a file 
separately from the file tag for that file. The file tag for a 
Data Manager file is always displayed on the extended 
drive. In the background, transparent to the user, Data 
Manager controls the location of the file data for each 
file it manages. 

De-migration The process of leaving migrated files on the extended 
drive and marking them as not migrated when you 
remove a piece of media from its media folder. This 
allows the files to be written to another piece of media. 

Direct Read A way of marking files that have been migrated to 
media so that they are opened directly from the media 
when requested rather than being copied back to the 
extended drive.

Drive A hardware device through which media can be read or 
written to. 
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EMC Centera A line of disk-based storage devices deployed on a 
Redundant Array of Independent Nodes (RAIN). EMC 
Centera devices use unique, permanent content 
addresses to store and retrieve data. Data Manager 
can use an EMC Centera installation as a media 
service. 

Extended Drives An NTFS volume (such as a hard drive) or partitioned 
part of a hard drive for which Data Manager provides 
file migration services by moving files to media and 
fetching files from media according to the parameters 
you set.

Fail-over The act of transferring functions from one server in a 
cluster to another server in the cluster when the first 
server fails.

Fetch The process of retrieving file data from storage media 
when a user requests the file. Specifically, a fetch is 
moving the file data from the media back to the 
extended drive.

File Data The contents of a file.

File Migration The movement of files and file data from one type of 
media (a hard drive) to other types of media 
(removable media, such as optical or tape media, or 
logical media, such as a network share or NAS device). 

File Share 
Resource

An entity defined in Cluster Administrator that 
represents a standard shared directory offered to users 
by the cluster.

File System Software that provides an interface for saving and 
retrieving files on storage media. File systems control 
all aspects of media management, including directory/
file structures, data layout, and data transfer. 

File Tag The identifying information for a file. The file tag 
includes such information as file location, file attributes, 
file size, and file age.

Finalization The process of “closing” a piece of DVD-R media when 
you are finished writing to it. Finalizing DVD-R media 
makes the media read-only, effectively closing the 
media from receiving any more data. Finalization also 
stabilizes the media, better protecting the data written 
to it. Finalized DVD-R media can be removed from the 
ASM system and read on a computer with the Windows 
XP operating system. 

Table 1.  Data Manager Glossary (Continued)

Term Definition
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Hard Drive A computer hardware drive with non-removable media. 
Often, large hard drives are partitioned into multiple 
drives or “volumes.” These multiple volumes are also 
sometimes referred to as “hard drives” or just “drives.” 

Hardware Device A device that contains drives where media can be 
accessed.

Jukebox/ Library A hardware device containing one or more removable 
media drives, shelves for pieces of media, and a 
mechanism for moving pieces of media between the 
shelves and the drives. The terms “jukebox” and 
“library” are interchangeable. In most instances in this 
manual, the term “library” is used to refer to libraries or 
jukeboxes.

Logical Cluster 
Name

The network identifier of a clustered environment. 
Because a cluster functions as a single element, users 
access the logical cluster name via the network, rather 
than any of the individual servers in the cluster itself.

Logical Media A piece of media that is defined by its location on a 
piece (or pieces) of media rather than by the physical 
constraints of the media itself. For example, a network 
share that shares a single folder to the network could 
be treated as a piece of media in Data Manager. In 
contrast, a RAID device, which has multiple drives, 
could also be treated as a single piece of media if the 
entire device was shared as a single network share. 

Managed Files Files for which Data Manager has moved the file’s data 
to media. Even if a file is saved to a media folder on an 
extended drive, Data Manager does not assume 
responsibility for management of the file data until it 
has moved the file’s data to external storage media. 

Media A physical medium on which data is written and from 
which data can be retrieved. Depending on the type of 
media, the medium may be different and the 
information may be recorded in different ways. In most 
instances in this guide, the term “media” refers to the 
storage media to which Data Manager files are 
migrated.

Media Pool A reserve of pieces of media available for use with a 
particular extended drive.

Table 1.  Data Manager Glossary (Continued)

Term Definition
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Media Service An access provider to media to which Data Manager 
migrates files. In some cases, the media service is a 
connection to a network share. In other cases, a media 
service is a device management service that retrieves a 
specific piece of media and mounts the media in a 
device such as a library when requested.

Media Type The type of a piece of media, which is determined by 
the composition of the media and the method used to 
record information on that media. Some examples of 
media types are magneto-optical, CD-ROM, DVD-
RAM, and tape. 

MediaStor A device management package that can be used as a 
media service by Data Manager. ASM MediaStor has 
the ability to manage retrieval of media in a wide variety 
of hardware devices.

Network Attached 
Storage (NAS)

Logical media that has been shared to the network to 
allow network users to access the media. Data 
Manager can point to any network share through a 
configured Network Attached Storage media service. 

Network Name 
Resource

An entity defined in Cluster Administrator that 
represents an alphanumeric string associated with a 
specific network (IP) address.

Node A server computer that is part of a cluster. Also called a 
system.

NTFS Volume A piece of stationary media or a partition on a piece of 
stationary media that has been formatted with the 
NTFS file system. 

Overwritable Describes media that allows files to be written to any 
available location on the media. For Data Manager, this 
pertains specifically to how the UDF file system will 
write files to some types of media. 

Passive Server A cluster server that is idle and does not process user 
requests until an active node fails.

Physical Disk 
Resource

An entity defined in Cluster Administrator that 
represents a fiber- or SCSI-attached disk used for 
storage.

Removable Media 
Drive

A drive where different pieces can be inserted and 
removed as needed, such as a CD-ROM drive.

Table 1.  Data Manager Glossary (Continued)

Term Definition
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Removable Media Media that must be mounted in a drive before it can be 
accessed. Removable media can be inserted and 
removed as needed to allow for access to multiple 
pieces of media.

Resource A physical or logical entity defined in Cluster 
Administrator and managed by a cluster node.

Resource Group A logical collection of resources, defined in Cluster 
Administrator, that fails over from one node to another 
in a cluster. Note that resource groups fail over, not 
individual resources.

Retention The act of restricting modification to and/or deletion of 
files. Retention is available for the EMC media service 
and for the NAS media service. Data Manager only 
enforces retention after files have been moved to 
media.

Retention Period The period of time (number of days) for which retention 
is enforced. The retention period is calculated from the 
time the file is migrated to media. Retention period 
configuration is only available for the EMC media 
service. 

Sequential Describes media that requires files to be written in 
sequential order (one right after another) on the media. 
For Data Manager, this pertains specifically to how the 
UDF file system will write files to some types of media. 

Stationary Drive A drive where the same piece of media is always 
mounted, such as the hard drive on your computer. 

Stationary Media Media that is always mounted in a drive and cannot be 
removed without removing the entire drive. 

System A server computer that is part of a cluster. Also called a 
node.

Tivoli Storage 
Manager (TSM)

A storage product that Data Manager can use as a 
media service. Similar to NAS, TSM uses “virtual” 
media.

Virtual Server A group defined in Microsoft’s Cluster Administrator in 
an active/active cluster environment that contains the 
elements that are to transfer over to an active node 
when the other active node fails.

Table 1.  Data Manager Glossary (Continued)

Term Definition
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■ Data Manager Concepts
The following concepts are integral to understanding Data Manager:

• "Storage Media and Media Services, " which follows

• “Extended Drives” on page 8

• “Data Manager System Management” on page 9

Storage Media and Media Services
Data Manager supports many types of high-capacity storage media for the 
migration of files. The functionality accessible through a media service 
depends on the type of media used in the device for that media service. The 
following table defines all media types Data Manager currently supports: 

Data Manager manages all functions relating to the transfer of information to 
and from media. Data Manager performs all movement and fetching of files 
and all media tasks through direct communication with the media service. The 
media service communicates with the device and drives to write files to the 
media and retrieve files from media when Data Manager makes those 
requests. For more information on media services, refer to the Setting Up 
Media Services chapter of the ASM/DMS Getting Started Guide. 

Once you configure media services and add media to your ASM system, there 
are several steps you can take to efficiently manage the media in your system. 
Media tasks and media managers such as the Media Prepare Manager and 
Copy Media Manager allow you to prepare media for use in Data Manager, 

Table 2.  Currently Supported Media Types

Media Types Support Types
CD-ROM Read Only

DVD-R Read/Write

DVD-RAM Read/Write

DVD-ROM Read Only

EMC Centera (EMC) Read/Write

Magneto-optical Read/Write

NAS (Network attached storage available through 
network shares)

Read/Write

Tape (DLT, AIT, 9840, Magstar, 8mm DAT) Read/Write

Tivoli Storage Manager (TSM) Read/Write

WORM Read/Write

WORM-Tape Read/Write
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add it to media folders and move groups, remove it if necessary, and back it up 
so that you can restore it in the event of system failure. 

You can also schedule various media activities to occur at off-peak hours to 
ease the wear-and-tear effect that occurs from the frequent mounting and 
dismounting of media in library devices, or to avoid problems that can arise 
when there are requests pending to mount more pieces of media than there 
are drives available. 

For more information, see “Managing Storage Media” on page 13.

Extended Drives
An extended drive is an NTFS volume (such as a hard drive) for which Data 
Manager provides file migration services by moving files to media and fetching 
files from media according to the parameters you set. Frequently used files 
can be kept on the NTFS volume, while less active files can be moved to 
storage media. It is the addition and configuration of the storage media 
through Data Manager that “extends” the space on the NTFS volume by 
moving files to storage media and then purging the file data, while making the 
file appear to still reside on the extended drive.

To a client retrieving files from a drive extended by Data Manager, all files, 
whether on the extended NTFS volume or on the storage media, appear to be 
present on the NTFS volume. According to move and purge rules that you 
configure, Data Manager moves files to media and then purges the file data 
from the extended drive. When the file data is purged, Data Manager leaves a 
file “tag” on the extended drive containing file information, such as the size and 
time and date of creation or modification. When viewing the extended drive 
through Windows Explorer, the entire file appears to still be stored on the 
drive, even if the file data has actually been purged. 

For more information, see the following sections:

• "File Migration, " which follows

• “Space Management” on page 9

File Migration
All files that are written to Data Manager are initially saved to the NTFS 
volume. New/modified files are then moved to storage media and purged from 
the NTFS volume as specified in the move and purge rules that apply to the 
files. Files can also be retrieved from media and stored on the NTFS volume 
automatically by Data Manager. The movement of a file to media is referred to 
as file migration, and the retrieval of a file from media is referred to as a fetch. 

One of Data Manager’s main performance advantages is that you can 
configure it so that frequently used files are maintained on the faster access, 
fixed media (hard drive) whenever possible. 
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Once you configure file migration when setting up your Data Manager system, 
you can manage the media folders, move groups, and move rules to control 
which files are moved to which groups of media, and which files should not be 
moved to media, to address your changing storage needs.

You can also manage client requests for files that have been purged from the 
extended drive (“fetches”) so that you can avoid a critical strain on system 
resources and media mounting conflicts resulting from multiple client requests 
for purged files. Enabling direct read and retrieving frequently used files from 
storage media in advance of their being requested by a client (“prefetching”) 
are two ways to manage fetch requests. 

For more information, see “Managing File Migration” on page 117. 

Space Management
Part of managing an extended drive involves managing space on the 
extended drive. Ideally, files that are retrieved frequently should remain in their 
original format on the drive, whereas files that are not retrieved as often can 
be purged to file tags once they are moved to media, leaving more space for 
frequently accessed files. In order to manage more files than would actually be 
able to fit on the extended drive, you need to configure space management 
rules. 

Space management rules allow you to control what files are kept immediately 
available on the extended drive and what files are purged. Using Data 
Manager as your data management system allows you to automate not only 
the movement of files to storage media but also the purging and deletion of 
migrated files from the extended drive. 

Purge rules and delete rules enable automation of file data truncation and file 
data deletion based on specific aspects of files, which you determine and 
configure.

• Purge rules control when files are truncated on (or purged from) the 
extended drive, and which files should not be purged from the extended 
drive.

• Delete rules control when files are deleted from the extended drive and 
from any storage media to which they have been moved, and when they 
should not be deleted by Data Manager.

A regular drive scan is required to write files that qualify against purge rules to 
the purge list, and to process delete rules.

For more information, see “Managing the Extended Drive” on page 163.

Data Manager System Management
Data Manager contains several features that allow you to administer, 
diagnose, and troubleshoot the system, as well as utilities to back up the 
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system and restore it in the event of a system failure. In addition, because the 
Data Manager program functions as a Windows service, part of administering 
the Data Manager computer includes administering the Data Manager service.

Data Manager as a Service
Data Manager functions as a Windows service rather than as a user-mode 
application. As a Windows service, Data Manager can continue to be active 
even after you log off Windows, as long as the computer is still running.

You can start, pause, and stop Data Manager, as well as configure it for 
various startup settings, including automatic startup, which starts Data 
Manager upon Windows system startup, and manual startup, which allows 
you to start the service manually. You can manage the service either through 
the Data Manager Administrator or through Windows. 

For more information, see “Managing the Data Manager Computer” on 
page 207. 

Logs and Reports
Data Manager has built-in utilities for monitoring events, errors, and warnings 
on the extended drive. The Event Viewer contains a listing of all Data Manager 
events, errors, and warnings. This information is also logged to event logs. 
The Event Viewer and event logs can help identify and solve potential 
problems during runtime that might otherwise become critical problems if 
ignored. For more information on the Event Viewer and event logs, see 
“Tracking Data Manager Events, Errors, and Warnings” on page 237.

The Data Manager reporting feature is a useful tool for tracking system 
statistics. Using the Report Generator Wizard, you can create various reports 
of system activities, including extended drive information, media information, 
media services, and Data Manager registry settings. In addition, the reporting 
function allows you to create and save custom layouts for your reports, and to 
choose the layout you want when the report is run. For more information on 
reports, see “Running Data Manager Reports” on page 245.

Backup and Recovery
Because constant and reliable access to your data is one of the most critical 
parts of your system, we recommend that you have a comprehensive disaster 
recovery plan in place in the event of system problems or an entire system 
shutdown. Data Manager contains several functions that can make creation 
and/or maintenance of your recovery plan easier.

• Meta-data exports should be performed periodically in order to export Data 
Manager-managed files and file tags for backup.

• Copy media are media that are being used as copies, or backups, of 
original media on the Data Manager extended drive.
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• You can create a backup of your Data Manager system configuration, 
which is stored in registry settings, when needed using the repair disk 
utility.

In the event of system failure, you can restore the meta-data export and the 
Data Manager system configuration. You can also promote copies of media to 
original pieces of media if an original piece of media becomes unreadable. For 
more information, see “Data Manager Backup and Recovery” on page 267.

In addition, if you use a clustered environment to manage fault-tolerance for 
your system, Data Manager can be installed and run on a clustered 
environment, allowing for automatic fail-safe of your Data Manager system. 
For more information, refer to Appendix A: Clustering of the ASM Data 
Manager Getting Started Guide. 
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2Managing Storage Media

By adding media services for the ASM Data Manager computer, you create a 
supply of storage media that you can use to “extend” NTFS volumes on Data 
Manager computers. Media are listed in the Data Manager system as soon as 
they are inserted in the device used by the media service, inventoried if 
necessary, and added to the media pool for an extended drive. For more 
information on configuring a media service and adding media to the extended 
drive, refer to the Setting Up Media Services chapter in the ASM Data 
Manager Getting Started Guide.

Media that have been allocated to the extended drive but are not yet in use by 
a media folder appear under the Available Media tree for each extended drive. 
Media that have been added to a media folder can be found under the Media 
node for the media folder. 

When a piece of media is initially added to a media device, the system 
evaluates the media, then places the media in one of the eight nodes in the 
media tree, depending on whether the media is formatted, labeled, or contains 
a recognized file system. Once media attributes are determined, the media 
can then be formatted, labeled, added to a media folder, or used to copy a 
piece of already existing media.

Although Application Pool media (media assigned to the extended drive) are 
listed in a separate place from media folder media, the media management 
interface is common to all Data Manager media. For example, while different 
media tasks are available depending on the current use and status of the 
media, the interface for adding, editing, and deleting the tasks is the same. 

A discussion of media and available media activities is provided here, as well 
as steps for accessing media commands and information. For more 
information, see the following sections:

• "Types of Storage Media, " which follows

• “Types of Media File Systems” on page 18

• “The Available Media Tree” on page 24

• “Viewing Media Properties” on page 26

• “Media Tasks” on page 34

• “Media Activities” on page 46

• “Managing Media Use” on page 55

• “Maintaining and Backing Up Media” on page 103
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■ Types of Storage Media
ASM Data Manager supports many high-capacity storage media types. Once 
added to the Data Manager system, these media are the storage to which 
your Data Manager files are migrated. The functionality accessible through a 
media service depends on the type of media used in the device for that media 
service. The following table defines all media types currently supported: 

Note: ASM does not currently support CD-R, CD-RW, or DVD-RW media. 

CD-ROM Media
CD-ROM stands for Compact Disc – Read Only Memory. As its name 
indicates, CD-ROM media is read only and cannot be written to. The data is 
stamped onto the CD by the vendor and cannot be erased. CD-ROM can use 
the ISO-9660, High Sierra or Joliet file systems. Each of these are most 
effectively recognized and readable through ASM using the NTFS file system, 
although CSS, the ASM CD file system, can also read CD-ROM media. 

Table 3.  Currently Supported Media Types

Media Type Support 
Type

For More Information, See...

CD-ROM Read Only "CD-ROM Media, " which 
follows

DVD-R Read/Write “DVD-R Media” on page 15

DVD-RAM Read/Write “DVD-RAM Media” on page 15

DVD-ROM Read Only “DVD-ROM Media” on page 15

EMC Centera (EMC) Read/Write “EMC Centera Media” on 
page 15

Magneto-optical Read/Write “Magneto-Optical Media” on 
page 16

NAS (network attached 
storage available through 
network shares)

Read/Write “NAS Media” on page 16

Tape (DLT, AIT, 9840, 
Magstar, 8mm DAT)

Read/Write “Tape Media” on page 17

Tivoli Storage Manager 
(TSM)

Read/Write “Tivoli Storage Manager 
Media” on page 17

WORM Read/Write “WORM Media” on page 18

WORM-Tape Read/Write “WORM-Tape Media” on 
page 18
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DVD-R Media
DVD-R (DVD - Recordable) media is both readable and writable; however, 
you can write data to it only once (although in multiple sessions). Once DVD-R 
media is full, you can finalize the media, at which point it becomes read-only. 
Because of the potential instability of DVD-R media before it is finalized, DVD-
R media is treated differently in Data Manager than other media; files written 
to DVD-R cannot be purged from the extended drive until the media is 
finalized. For more information on finalizing media, see “Finalizing Media” on 
page 82. 

Note: Depending on the type of DVD-R media you are using, as well as the 
type of drive you are using to read from and write to the media, a piece 
of media may appear full before all of the space on the media has been 
used. This is because there is a limit on the number of write 
calibrations that can be performed on a piece of media. If the 
maximum number of write calibrations is reached, Data Manager can 
no longer write files to the piece of media - even if free space remains 
on the media.

DVD-RAM Media
DVD-RAM is a rewritable, high-density optical disc media. DVD originally 
stood for Digital Versatile Disc or Digital Video Disc, but is now simply referred 
to as DVD. RAM, or Random Access Memory, refers to the way data is written 
to and read from the disk. RAM media can be written to and read from 
randomly, as opposed to sequentially, accessing files and space wherever 
necessary.

DVD-ROM Media
DVD-ROM stands for DVD – Read Only Memory. As its name indicates, DVD-
ROM media is read only and cannot be written to. Like CD-ROM, DVD-ROM 
media is pre-manufactured, meaning the data is stamped onto the media and 
cannot be erased. Most manufactured DVD-ROMs use the ISO-9660 file 
system format, which, like CD-ROM is recognized by ASM using the NTFS file 
system. Be advised however, that the ASM interface will identify DVD-ROM 
media as CD-ROM, because the file system drivers cannot distinguish 
between the two types of media and only recognize the ISO-9660 file system 
format. 

EMC Centera Media
EMC Centera (EMC) media is media that is created through the EMC Centera 
media service in Data Manager. The EMC media service provides access to 
an EMC Centera Content Network Repository, which is a line of disk-based 
storage devices deployed on a Redundant Array of Independent Nodes 
(RAIN).
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In Data Manager, media is “virtual”, meaning that a piece of media defined in 
Data Manager does not specifically correspond to a physical piece of media 
(like a tape cartridge). Instead, the virtual media is designed to simulate 
divisions of the larger repository, allowing you to take advantage of the flexible 
file migration features available in Data Manager (media folders, move groups, 
and move, purge, and delete rules). Each piece of virtual media contains more 
than 256 GB of space, and can hold approximately 65,000 files. 

For more information on configuring a media service in Data Manager, refer to 
the Setting up File Migration chapter of the ASM Data Manager Getting 
Started Guide.

Magneto-Optical Media
Optical media refers to removable media that is written to by lasers. Magneto-
optical media (also often called erasable-optical) are optical disks that can be 
written to, erased, and loaded with new data.

NAS Media
Network Attached Storage (NAS) is a type of media that is directly accessible 
through the network as opposed to being accessed through a removable 
media device. NAS media is considered “virtual” media, and represents a 
connection to a share on the network. That share can be located on a NAS 
device or a RAID, or it could even be a shared media folder on another Data 
Manager extended drive.

You can create NAS media in Data Manager to correspond to any network 
share, including a network share resident on the local Data Manager 
computer, as long as the share is not on the local extended drive. 

For more information, see the following sections:

• "RAID Devices, " which follows

• “NAS Devices” on page 17

RAID Devices
A RAID (Redundant Array of Independent Disks) is a device that contains a 
group of disks. In some cases, part of the physical storage capacity is used to 
store redundant information about data stored on the remainder of the storage 
capacity. The redundant information allows for regeneration of data in the 
event that one of the member disks or the access path to it fails. In other 
cases, the disks are set to all run independently, allowing for much faster read/
write speeds. 
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NAS Devices
NAS (Network Attached Storage) devices are storage devices that contain 
several high-capacity magnetic drives and manage storage of data to those 
drives in a way that is seamless to the user. NAS devices have a built-in 
controller that tracks the location of files within the NAS device. 

Some NAS devices allow you to configure one or more volumes as WORM 
volumes, meaning that once data is written to the volume, it cannot be 
modified or deleted (like any other kind of WORM media). 

Tape Media
Tape media are electromagnetic data storage devices that are typically both 
readable and writable; however, you can write data to each sector on a piece 
of tape only once unless you reformat the media in order to reuse it. Tape 
media are read by tape drives that mount, write to, and read from the tape. 
Tape media is often encased in a tape cartridge that protects the magnetic 
tape itself and makes it easily portable.

Data Manager supports the following types of tape media: 8mm DAT, AIT, 
9840, Magstar, and DLT. Tape media is accessible to Data Manager through 
either the ASM MediaStor or StorageTek ACSLS media services. (See the 
ReadMe file for configuring an ACSLS 6.1.1 environment.) For more 
information, refer to the Setting up Media Services chapter of the ASM Data 
Manager Getting Started Guide.

Tivoli Storage Manager Media
Tivoli Storage Manager (TSM) media is media that is created through the TSM 
media service in Data Manager. The TSM media service provides a repository 
for Data Manager files, which TSM can subsequently move to other storage 
devices managed by the TSM server.

In Data Manager, TSM media is “virtual”, meaning that a piece of media in 
Data Manager does not necessarily correspond to a physical piece of media in 
the TSM system (like a tape cartridge). Instead, the virtual media is designed 
to simulate divisions of the larger repository, allowing you to take advantage of 
the flexible file migration features available in Data Manager (media folders, 
move groups, and move, purge, and delete rules). 

Data Manager manages TSM media similarly to NAS media, particularly with 
respect to the functional restrictions for formatting, labeling, and copying. The 
TSM server manages the actual physical removable media, so that tasks like 
formatting, labeling, and copying media are performed by TSM rather than by 
Data Manager. 

For more information on configuring a TSM media service in Data Manager, 
refer to the Setting up File Migration chapter of the ASM Data Manager 
Getting Started Guide. 
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WORM Media
Write Once Read Many (WORM) media is an optical disk technology that 
allows you to write data to each sector on a disk only once, although in 
multiple sessions, but read that data back as often as needed. Once written to, 
WORM media acts just like CD-ROM media in that the data on the media is 
permanent.

WORM-Tape Media
WORM-tape media are identical to tape media, in that they are 
electromagnetic data storage devices that are typically both readable and 
writable. However, you can write to a piece of WORM-tape only once, and 
unlike standard tape, the media cannot be reformatted for reuse. Once written 
to, WORM-tape media acts just like CD-ROM media in that the data on the 
media is permanent and cannot be altered. WORM-tape media are supported 
by drives that have firmware loaded that support WORM media. Please 
contact the specific vendor to verify that they support WORM media in their 
drives, and to acquire the firmware version that supports the WORM media.

■ Types of Media File Systems
When a piece of media is formatted, a file system must be selected for that 
piece of media: either a Windows Native file system, an ASM file system, or a 
Universal Disk Format (UDF) file system. A file system is software that 
provides an interface for saving and retrieving files on storage media. File 
systems control all aspects of media management, including directory/file 
structures, data layout, and data transfer. Media can be formatted for file 
systems that are supported by both the media itself and the device (used by 
the media service) in which the media resides.

Windows NT/2000 installs the Windows Native file system drivers, and ASM 
MediaStor installs the ASM and UDF file system drivers. There are three 
Windows Native file systems (NTFS, CDFS, and FAT), three ASM file systems 
(OSS, TSS, and CSS), and two types of UDF file systems (overwritable and 
sequential). 

Note: The Tivoli Storage Manager (TSM) and EMC Centera (EMC) media 
services use proprietary file systems. Since TSM and EMC media 
cannot be formatted through Data Manager, those file systems are not 
discussed here.
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The following table lists ASM Data Manager file system support by media 
type: 

Note: The Data Manager interface only refers to “ASM File System”, “UDF”, 
and “NTFS” where media file systems are noted. The media type 
determines which specific subsystem of the file system is applied. 

Each file system has benefits and limitations relating to the features and 
performance of the media to which it is applied. In most cases, you do not 
have a choice as to which file system to use: NAS and DVD-ROM can only 
use a Windows Native file system; WORM, WORM-tape, and tape can only 
use an ASM file system; and DVD-R can only use the UDF file system. For 
magneto-optical and DVD-RAM media, however, you must choose a file 
system that best suits your needs. There are two factors to consider: media 
portability and media performance.

Media portability refers to the ability to read and write to media on Windows 
devices outside of Data Manager. If, for example, media used to archive files 
through Data Manager will be distributed to locations that do not have a Data 
Manager installation, media portability is a concern and should be considered 
when determining what file system and type of storage media you will use. 

Media performance refers to the speed with which Data Manager can write to 
and read from storage media. 

Table 4.  Data Manager File System Support by Media Type

Media Type Supported File Systems
CD-ROM CDFS (Windows Native file system)

CSS (ASM file system)

DVD-R UDF file system (sequential)

DVD-RAM OSS (ASM file system)

UDF file system (overwritable)

DVD-ROM CDFS (Windows Native file system)

Magneto-Optical OSS (ASM file system)

UDF file system (overwritable)

NTFS (Windows Native file system)

FAT (Windows Native file system, read-only)

NAS NTFS (Windows Native file system)

Tape TSS (ASM file system)

WORM OSS (ASM file system)

WORM-Tape TSS (ASM file system)



Managing Storage Media

20 Second Edition
StorageTek Proprietary

As a general rule, if portability of optical media is a concern, choose Windows 
Native file systems. Windows Native file systems are overwritable, meaning 
that files are written to any available location on the media. While these file 
systems have a performance disadvantage for optical media in comparison to 
ASM file systems, they are 100% portable (media written in these formats can 
be read on any Windows system, with or without Data Manager). 

ASM file systems are optimized for Data Manager media performance. Unlike 
Windows Native file systems, which are more generic and feature-rich, ASM 
“storage subsystems” implement the minimum set of features required to store 
and retrieve data. For example, ASM file systems are sequential, meaning 
that files are written in sequential order on the media. As a result, runtime 
overhead is very low and data is contiguously organized, enhancing overall 
performance. If portability of storage media is not a concern, choose ASM file 
systems to provide the best overall system performance.

Data Manager supports UDF file systems in order to support the use of DVD-R 
media. Although you can format magneto-optical media using UDF, it does not 
provide a performance advantage over OSS or a portability advantage over 
NTFS. (Use FAT for magneto-optical media only if you want to provide access 
to files on media that has already been formatted using FAT.) Similarly, for 
DVD-RAM media, UDF does not provide a significant performance advantage 
over OSS, and media using UDF is only portable to the few systems that 
support UDF, such as Windows XP.

Note: For optical media, NTFS is not recommended unless media portability 
is essential. Windows Native file systems are not designed for use with 
optical media. 

For more information on file systems, see the following sections:

• "Windows Native File Systems, " which follows

• “ASM File Systems” on page 22

• “UDF File Systems” on page 23

Windows Native File Systems
Windows Native file systems are provided with Windows NT/2000 and are 
loaded onto the system at the time of the operating system installation. These 
are feature-rich file systems meant for hard drives, but may be desirable for 
storage media if you have portability concerns.

ASM supports three Windows Native file systems:

• "NTFS - New Technology File System, " which follows

• “FAT - File Allocation Table” on page 21

• “CDFS - CD-ROM File System” on page 21
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NTFS - New Technology File System
This Windows Native file system is supported only by Windows and provides 
an optimized file system for large volume media. It is specially designed to 
provide fast access and management of very large volumes of information 
(gigabytes or even terabytes) and is used primarily for magnetic disks (like 
hard drives).

NAS media must use NTFS, and you can choose NTFS for magneto-optical 
media. 

Note: Be advised that there are differences between the Windows NT NTFS 
file system and the Windows 2000 NTFS file system. Though the 
differences are not significant, this does mean that some functions (for 
example, check disk) may not run properly when executed from a Data 
Manager installation on one platform and performed on NTFS media 
formatted on the other platform. The differences do not, however, 
affect Data Manager’s read and write capabilities for NTFS media 
between operating systems. 

FAT - File Allocation Table
This Windows Native file system is supported by many different operating 
systems, including DOS, Windows 95/98, and Windows NT/2000. It is an older 
file system that was designed for small-volume (less than 4 GB) management, 
and is not widely used in Windows NT/2000 server environments. 

FAT is not recommended for optical storage management. It is based on older 
file system technology and does not handle the large volume sizes that 
today’s media capacities require. In addition, the data storage strategy is 
prone to fragmentation and, over time, deteriorates Data Manager 
performance.

The FAT file system is supported by ASM as a read-only file system. This 
means that Data Manager cannot write (migrate files) to media formatted 
using FAT.

You can use the FAT file system with magneto-optical media; however, you 
should only use FAT if you want to provide access to files on media that has 
already been formatted using FAT.

CDFS - CD-ROM File System
This Windows Native file system reads three types of CD-ROM and DVD-
ROM formats: ISO-9660, High Sierra, and Joliet. These formats are supported 
by many different operating systems, and are supported natively by Windows. 
Most manufactured DVD-ROM media use the ISO-9660 format, and are 
readable by Data Manager using this Windows native file system. 
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ASM File Systems
ASM file systems are installed with ASM MediaStor and are optimized for ASM 
media performance. Unlike Windows Native file systems, which are more 
generic and feature-rich, ASM “storage subsystems” implement the minimum 
set of features required to store and retrieve data. For example, ASM file 
systems are sequential, meaning that files are written in sequential order on 
the media. As a result, runtime overhead is very low and data is contiguously 
organized, enhancing overall performance. 

There are three ASM file systems:

• "OSS - Optical Storage Subsystem, " which follows

• “TSS - Tape Storage Subsystem” on page 22

• “CSS - CD-ROM Storage Subsystem” on page 23

OSS - Optical Storage Subsystem
This ASM file system supports WORM, DVD-RAM, and magneto-optical 
media. Files are stored contiguously from the beginning to the end of each 
piece of media, with single-seek read and write access. This file system 
provides the best overall read/write performance of all optical file systems 
supported by ASM.

OSS-formatted media requires ASM for reading and writing. This type of 
media may be moved from one ASM service to another, but cannot be read 
without ASM.

When a Delete command is issued, files residing on OSS-formatted media are 
not deleted; only the file tags on the extended drive are actually deleted. 
Deleted file space cannot be reclaimed until the media is compacted (all files 
with file tags on the extended drive are moved back to the extended drive) and 
the media is reformatted. In addition, files that reside on media but whose file 
tags are deleted from the extended drive are restored to the extended drive 
when media is restored to a media folder, or a file restore media task is run on 
the media. 

If WORM media support is required, the OSS file system must be used, as it is 
the only file system supported by ASM for that type of media.

TSS - Tape Storage Subsystem
TSS is the only file system provided for tape and WORM-tape media 
management. Specifically, ASM supports Digital Audio Tape (DAT) and Digital 
Linear Tape (DLT). Files are stored contiguously from the beginning to the end 
of each tape, as with all tape file systems.

TSS-formatted media requires ASM for reading and writing. This type of 
media may be moved from one ASM service to another, but cannot be read 
without ASM. 
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CSS - CD-ROM Storage Subsystem
This file system supports CD-ROM media and is provided to allow use of 
certain devices that cannot use the CDFS file system, which is a Windows 
Native file system. It is recommended that you try to use the CDFS file system 
for a device and then use CSS if CDFS will not work with the device. 

UDF File Systems
ASM meets the specifications (version 2.01) laid out for the UDF (Universal 
Disk Format) file system by the Optical Storage Technology Association 
(OSTA), a nonprofit international trade association. For more information on 
OSTA, refer to the OSTA website, http://www.osta.org.

Support for the UDF file system was added to ASM in order to support the use 
of DVD-R media, but you can also use UDF with magneto-optical and DVD-
RAM media. 

UDF is intended to allow file interchange between different operating systems; 
however, only a few operating systems, such as Windows XP, currently 
support the 2.01 specification and can read media using UDF.

There are two types of UDF file systems: overwritable and sequential. For 
more information, see the following sections:

• "Overwritable UDF File System, " which follows

• “Sequential UDF File System” on page 23

Overwritable UDF File System
The overwritable UDF file system supports DVD-RAM and magneto-optical 
media and allows you to read files from and write files to DVD-RAM and 
magneto-optical media. Files are written to any available location on the 
media.

Sequential UDF File System
The sequential UDF file system supports DVD-R media. Files are written in 
sequential order on the media, and you can write files to media only once, 
although you can write files in multiple sessions. Once the media is full, you 
can finalize the media, which makes the media unavailable for any more file 
writes. In addition, finalizing DVD-R media allows it to be read in a Windows 
XP environment.

Once media is finalized, it functions as read-only media, and you can no 
longer write files to it. 

http://www.osta.org
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■ The Available Media Tree
The Available Media tree contains all media allocated for an extended drive 
but not yet assigned to a media folder. There are eight nodes in the Media 
tree. For more information, see the following sections:

• "Original Media, " which follows

• “Copy Media” on page 24

• “Duplicate Media” on page 25

• “Blank Media” on page 25

• “Foreign Media” on page 25

• “Unknown Media” on page 25

• “Unformatted Media” on page 25

• “Corrupt Media” on page 26

Original Media
All media that have been prepared for use with ASM Data Manager but are not 
currently assigned to a media folder appear in the Original media node. In 
order for a piece of media to appear in this list, the media must be:

• Assigned to the extended drive through the media service. For more 
information on allocating media to an extended drive, refer to the Setting 
Up Media Services chapter of the ASM Data Manager Getting Started 
Guide.

• Formatted for the file system for which the hardware device is configured. 
For more information on formatting media, see “Formatting Media” on 
page 56.

• Labeled. For more information on labeling media, see “Labeling Media” on 
page 64.

• Not currently assigned to a media folder.

Media appearing in this list is ready to be assigned to a media folder when 
necessary. For instructions, see “Adding Media to a Media Folder” on page 67.

Copy Media
Copy media are media that are being used as copies of Original media on the 
Data Manager extended drive. The only difference between an Original piece 
of media and its copy is the serial number for each piece of media. If an 
Original piece of media becomes unreadable, the copy can be promoted to 
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Original status once the damaged original is removed from the system. For 
information on creating Copy media, see “Creating and Managing Copies of 
Media” on page 103.

Duplicate Media
Duplicate media is any media with the same serial number as another piece of 
media on the extended drive. Duplicate media is unusable with Data Manager 
and must be reformatted (if the media allows it) in order to have another serial 
number assigned to it.

Blank Media
Blank media are media that have been formatted for use with Data Manager 
but not yet labeled. Blank media can be labeled, reformatted, or labeled for 
use as a copy (if the media allows it). 

Foreign Media
Any media that has been formatted for a file system other than that of its 
current device or with a file system not supported for that media type is 
considered by Data Manager to be “foreign” media and is placed in the 
Foreign media list. Media in this list can be formatted (if the media is of a type 
that Data Manager supports). Foreign media must be reformatted with the 
appropriate file system in order to be used for file migration. For information on 
formatting media, see “Formatting Media” on page 56.

Note: Unformatted DVD media may appear as Foreign rather than 
Unformatted if the device in which it resides is configured to use the 
UDF file system.

Unknown Media
Unknown media encompasses any media in the hardware device that Data 
Manager does not recognize. The problem could be an unsupported media 
type or an unsupported file system. For detailed information on what media 
types are supported by Data Manager, see “Types of Storage Media” on 
page 14. 

Unformatted Media
All unformatted media are listed under the Unformatted media node. This 
usually encompasses media that was unpackaged and placed in the device 
and has not yet been formatted for the first time. Media in this list must be 
formatted before it can be used. For information on formatting media, see 
“Formatting Media” on page 56.
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Note: Unformatted DVD media may appear as Foreign rather than 
Unformatted if the device in which it resides is configured to use the 
UDF file system.

Corrupt Media
The Corrupt media classification identifies specifically DVD-R media using the 
UDF file system. Corrupt media is media that the system recognizes but 
cannot use due to problems with the media itself. Media corruption most often 
occurs as a result of a power failure while the media was being written to. 
Performing a check disk media task on the media may allow you to find and 
repair the media errors. For more information on running a check disk media 
task, see “Running Check Disk on a Piece of Media” on page 113.

    

■ Viewing Media Properties
The Media Properties dialog box allows you to view detailed information about 
a piece of media, including the type, file system, location, number of files, 
amount of free and used space, number of file reads, writes, and errors, and 
the status of a media task if one is in progress. The properties command is 
always available for every piece of media on an extended drive, regardless of 
the current use, assignment, or status of the media. 

To view media properties:

1. Double-click the media whose properties you want to view. The Media 
Properties dialog box appears.

Figure 1.  Media Properties Dialog Box 

2. View and modify the settings on each of the tabs as necessary. The tabs 
that appear depend on the type of media and its status. For example, the 
Statistics tab only appears for Original and Copy media, and the Progress 



Viewing Media Properties

ASM Data Manager System Guide 27
StorageTek Proprietary

tab only appears for media with tasks that are currently processing. For 
more information, see the following sections:

• "The General Tab, " which follows

• “The Location Tab” on page 29

• “The Space Tab” on page 30

• “The Statistics Tab” on page 31

• “The Progress Tab” on page 33

3. As with most Properties functions in ASM, after making changes you have 
three options:

• To save changes and close the Properties dialog box, click OK.

• To save changes and keep the Properties dialog box open, click Apply.

• To discard all changes made since the Properties dialog box was 
opened (or since the Apply button was used) and close the Properties 
dialog box, click Cancel.  

The General Tab
The General tab of the Media Properties dialog box provides identifying 
information for the selected media. For Original, Copy, and Duplicate media, 
you can use this tab to enter a brief description of the media. This description 
is then used for media reports.

To view the General tab:

• Click the General tab.

Figure 2.  Media Properties – General Tab 
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The information on the tab is separated into three sections: Volume, 
Attributes, and Description. The following table describes each of the 
items appearing on the General tab: 

Note: For blank, foreign, unknown, unformatted, and corrupt media, the 
General tab displays “N/A” in the Name, Serial Number, and Label 
Time fields, and the Description field is not available for editing. For 
Tivoli Storage Manager (TSM) and EMC Centera (EMC) media, the 
Type and File System fields display “TSM” and “EMC” respectively.

Media Serial Numbers
Because media can be taken from one ASM system and imported or placed in 
another, media name is not sufficient for tracking media. While not 
recommended, ASM does allow more than one piece of media with the same 
name. Therefore, ASM must use the serial number of media to track the 
media and the files migrated to the media. 

ASM can support more than one piece of media with the same name on an 
extended drive, provided they have different serial numbers. If ASM identifies 
two pieces of media with the same serial number, it classifies one as Duplicate 
and requires that it be reformatted (which gives the media a new serial 
number) before it can be used. 

Media serial numbers provide a way to track all ASM media uniquely, 
irrespective of the ASM system in which they were formatted. The serial 
number is an eight-byte integer, represented as a hexadecimal string in the 

Table 5.  Media Properties – General Tab Items

Item Description
Name Name assigned to the media when labeled

Serial Number Serial number of the media. For more information, see 
"Media Serial Numbers, " which follows.

Label Time Date and time the media was labeled

Status Current status of media (typically online or offline)

Class Current class of media, corresponding to the media’s listing 
in the Available Media tree. For more information, see “The 
Available Media Tree” on page 24.

Type The type of storage media

File System The media’s file system

Description An editable field where you can enter a media description 
to be used for media reports. The maximum number of 
characters that can be entered into the Description text box 
is 128.
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following format: XXXXXXXXYYYYYYYY. The serial number is broken down as 
follows: 

The Location Tab
The Location tab of the Media Properties dialog box provides information 
about the physical and logical location of the selected media. You can also 
enter an offline location for the media, which is used for mount requests and 
media reports. This location is also shown when a MEDIA NOT FOUND error 
appears.

To view the Location tab:

• Click on the Location tab.

Figure 3.  Media Properties – Location Tab 

The information on the tab is separated into three sections: Physical, 
Extended Drive, and Offline Location. The following table describes each of 
the items appearing on the Location tab:

Table 6.  Serial Number Interpretation

Position Description
(XXXXXXXX) The serial number from the Windows system boot drive 

(usually drive C:). Windows assigns this number when 
the hard drive is formatted. This number is unique for all 
hard disks.

(YYYYYYYY) The encoded date/time that the media was labeled, 
expressed in seconds elapsed since midnight on January 
1, 1970.
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Note: If the selected media has not been added to a media folder, the 
Location tab displays “N/A” for the Folder field. In addition, you can 
only edit the Offline Location text box for Original and Copy media.

The Space Tab
The Space tab of the Media Properties dialog box provides statistical 
information on the physical and logical capacity of the selected media.

To view the Space tab:

• Click on the Space tab.

Figure 4.  Media Properties – Space Tab 

Table 7.  Media Properties – Location Tab Items

Item Description
Drive The drive in which the media is mounted

Library The library in which the media is located, and the media’s 
location in the library (drive and/or shelf number)

Name Name of the computer and the extended drive to which 
the media is assigned

Folder Name of the media folder to which the media is assigned

File Count Number of files on the media

Byte Count Number of bytes used on the media

Offline Location Physical location where offline media are stored. Enter 
up to 128 characters in the text box (for example, Second 
Floor Storage Room, Shelf 25D).
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The information on the tab is separated into two sections: Physical Capacity 
and Logical Capacity. The following table describes each of the items 
appearing on the Space tab:

Note: For blank, foreign, unknown, unformatted, and corrupt media, the 
Space tab displays “N/A” for all fields in the Logical Capacity region of 
the tab. For unformatted media, the Space tab displays “N/A” for all 
fields in the Physical Capacity region. For blank, unknown, 
unformatted, and corrupt media, the Total Space is set to zero.

The Statistics Tab
The Statistics tab of the Media Properties dialog box provides statistics 
relating to mounts, file input and output, and errors for the selected media.

To view the Statistics tab:

• Click on the Statistics tab.

Table 8.  Media Properties – Space Tab Items

Item Description
Bytes per Sector Number of bytes written to the media per sector 

(determined by media)

Number of Sectors Total number of sectors on media

Total Space Total media space, in bytes

Sectors per Cluster Number of sectors per cluster

Free Clusters Number of free clusters on the piece of media

Used Clusters Number of used clusters on the piece of media

Total Clusters Total number of clusters on the piece of media

Free Space Free space in bytes on the piece of media

Used Space Written space in bytes on the piece of media

Total Space Total space in bytes on the piece of media
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Figure 5.  Media Properties – Statistics Tab 

The information on the Statistics tab is separated into three sections: Mount 
Information, I/O Information, and Error Information. It also provides 
information on the date from which the statistics are calculated. 

In addition, the Statistics tab contains a Clear Statistics button which will clear 
the statistics displayed on the tab and reset the date from which the statistics 
are calculated. This function may be particularly useful to perform on Copy 
media, so that Data Manager has an accurate view of the differences between 
written bytes on the Original as compared to the Copy. This helps ensure that 
the Copy media is updated as appropriate.

Note: The Statistics tab does not appear for foreign, blank, unknown, 
unformatted, or corrupt media. 

The following table describes each of the items appearing on the Statistics tab:

Table 9.  Media Properties – Statistics Tab Items

Item Description
Mount Count Number of mounts per current session

Last Mount Time Time the media was last mounted

Read File Count Number of read requests during current session

Read Byte Count Number of bytes of files read during current session

Last Read Time Time the media was last read

Write File Count Number of write requests during current session

Write Byte Count Number of bytes of files written during current 
session

Last Write Time Time the media was last written
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The Progress Tab
During certain system activities, the Media Properties dialog box contains an 
extra Progress tab, which displays the progress of a current activity. Once the 
activity has been completed, the Progress tab no longer appears.

Figure 6.  Media Properties – Progress Tab 

The following table describes each of the items appearing on the Progress tab 
in addition to the descriptive information that appears about the specific 
activity in progress:

Media Errors Number of errors encountered per current session

Valid Since The date from which the statistics on this tab are 
calculated

Clear Statistics 
button

To clear the statistics and reset the date from which 
the statistics on this tab are calculated, click Clear 
Statistics. 

Table 9.  Media Properties – Statistics Tab Items

Item Description

Table 10.  Media Properties – Progress Tab Items

Item Description
Media status Current status of media

Start time Time the activity in progress began

Elapsed time Total amount of time that has passed since the activity 
began
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■ Media Tasks
Media tasks are media activities that you can actively assign to specific pieces 
of media. Media tasks include:

• Add to media folder

• Add to move group

• Check disk

• Compact

• File report

• File restore

• Finalize

• Format

• Label

• Label copy

• Prefetch (all files on a specified piece of media)

• Remove from media folder

• Remove from move group

ASM Data Manager only allows you to set up certain combinations of tasks. 
Which tasks are available is dependent on the status of that piece of media. 
For example, if you set a format task for a piece of media, Data Manager 
allows you to set up a label task to follow it, but does not offer you the option of 
adding the media to a media folder until it is labeled (or until you assign a label 
task). Or, if a piece of media already belongs to a move group, the remove 
from move group task is available, but not the add to move group task. For 
tasks that cannot be queued in combination, you can set up one set of tasks, 
allow the tasks to process, and then set up another set of tasks.

When you assign media tasks to a piece of media, you can choose to process 
the tasks immediately or schedule them to process later. Be advised, however, 
that since media tasks are assigned specifically to media, all tasks assigned to 
a piece of media must be run together – either ASAP or scheduled. Media that 
have tasks assigned as “scheduled” are processed during the time when the 
Process scheduled media tasks schedule is active. 

When you choose to assign a task, the media to which the task is assigned is 
added to the media task queue. Media are processed in the order in which 
they appear in the media task queue. All tasks for each media are processed 
before Data Manager moves to the next media in the queue. You can control 
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the order of media in the queue, thereby controlling when media with assigned 
tasks are processed. 

Note: If you have multiple drives available for media to be mounted, multiple 
pieces of media may have their assigned tasks processed 
simultaneously. 

The Media Task Queue Manager allows you to view and manage media with 
pending, suspended, and in progress media tasks. Media can be removed, 
added, promoted, or demoted using the Media Task Queue Manager. All tasks 
assigned to media in the Data Manager system can also be managed from the 
queue.

For more information, see the following sections:

• "Opening the Media Task Queue Manager, " which follows

• “Adding a Media Task” on page 36

• “Monitoring Media Tasks” on page 39

• “Editing Media Tasks” on page 42

• “Reordering Media Tasks in the Queue” on page 44

• “Aborting a Media Task in Progress” on page 45

• “Deleting Media Tasks” on page 46

Opening the Media Task Queue Manager
Once you open the Media Task Queue Manager, you can add, edit, remove, 
abort, and reorder tasks for media listed in the media task queue.

To open the Media Task Queue Manager:

1. In the tree view of the Administrator, select the extended drive for which 
you want to configure media tasks.

2. Press <CTRL>+T, or, from the Tools menu, select Media Task Manager. 
The Media Task Queue Manager dialog box appears. 
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Figure 7.  Media Task Queue Manager Dialog Box 

Adding a Media Task
Media is added to the media task queue whenever you assign a task to a 
piece of media that did not have a task assigned to it before. You can add 
tasks to media either through the Media Task Queue Manager or using the 
Edit Tasks option on the shortcut menu for media.

Note: If you want to add a media task to a piece of media that currently has 
other tasks assigned to it, follow the steps in “Editing Media Tasks” on 
page 42.

To add a media task:

1. You have the following choices:

• In the tree view of the Administrator, right-click the piece of media to 
which you want to add a task and then select Edit Tasks from the 
shortcut menu that appears. The Media Tasks page appears.

• Open the Media Task Queue Manager and then click Add New Media. 
The Select Media for New Tasks page appears listing all media that do 
not currently have tasks assigned to them. Select the piece of media to 
which you want to assign a media task and then click Next. The Media 
Tasks page appears. 
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Figure 8.  Media Tasks Page 

2. From the Next Task drop-down list, select the media task you want to add 
and then click Add Next Task. 

Note: Remember, the tasks that appear in the Next Task drop-down list 
are dependent on the status of the selected piece of media. For 
example, if a piece of media already belongs to a move group, the 
remove from move group task is available, but not the add to move 
group task.

The task appears in the Task List, and the Options and When To Process 
regions of the Media Tasks page become available.

Figure 9.  Media Tasks Page with Task Added 

3. Enable or disable the options as necessary in the Options region of the 
Media Tasks page. The options that appear depend on the media task you 
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selected. The following table contains a list of media tasks and the section 
in this guide where you can find more information about the task:

4. Select whether to process the media task as soon as possible or on a 
scheduled basis. If you choose to process the media task on a scheduled 
basis, the task is not processed until the Process scheduled media tasks 
schedule is active. For information on configuring media activity 
schedules, see “Scheduling Media Activities” on page 52. 

Note: If you assign multiple tasks for media, be advised that all tasks for 
that media will have the same When to Process option, since all 
tasks for a piece of media are processed simultaneously. If one 
task has the ASAP – as soon as possible option selected, all tasks 
for that piece of media will process ASAP by default. 

5. Repeat steps 2 through 4 for all remaining tasks you want to add to the 
selected piece of media.

6. After tasks have been added and configured as needed in the Media 
Tasks page, you have the following choices: 

Table 11.  Media Tasks

Media Task For More Information, See...
Add to media folder “Using the Add to Media Folder Media Task” on 

page 71

Add to move group “Using the Add to Move Group Media Task” on 
page 74

Check disk “Running Check Disk on a Piece of Media” on 
page 113

Compact “Using the Compact Media Task” on page 80

File report “Assigning a File Report Media Task” on 
page 340

File restore “Restoring Files from Media” on page 77

Finalize “Finalizing Media” on page 82

Format “Using the Format Media Task” on page 57

Label “Using the Label Media Task” on page 65

Label copy “Using the Label Copy Media Task” on page 109

Prefetch “Requesting All Files from a Piece of Media 
Using a Prefetch Media Task” on page 215

Remove from media 
folder

“Using the Remove from Media Folder Media 
Task” on page 92

Remove from move 
group

“Using the Remove from Move Group Media 
Task” on page 85
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• If you added the task(s) through the Media Task Queue Manager, click 
Finish. The Media Task Queue Manager dialog box appears with the 
new media listed and the task(s) pending.

• If you added the task(s) using the Edit Tasks option on either the 
shortcut menu for the media or the Edit menu, click Next. The Order 
Media in Task Queue page appears with the recently added media at 
the bottom of the media task queue list.

Figure 10.  Order Media In Task Queue Page 

7. To promote the selected piece of media so that the media tasks for the 
media are processed before other media in the queue, click the up arrow 
button to the right of the list box. You can also demote a piece of media in 
the list by selecting the media and then clicking the down arrow to the right 
of the list box. When you finish, click Finish.

All media with tasks assigned appear in the Media Task Queue Manager until 
they are processed. For media with tasks selected to process ASAP – as soon 
as possible, those media may only appear briefly in the queue before the 
processing completes and the media is removed from the queue.

Monitoring Media Tasks
After you have assigned media tasks to a piece of media, you can monitor the 
media tasks to be sure they complete successfully. You can configure Data 
Manager to change the color of media items in the tree view of the 
Administrator depending on task status. You can also view media logs. If an 
error occurs, you can clear the task error status so that other activities can 
take place on the media or so that you can attempt to run the media task 
again.

For more information, see the following sections:
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• "Configuring Data Manager to Indicate Media Status by Color, " which 
follows

• “Viewing Media Logs” on page 40

q “Clearing Media Logs” on page 41

q “Clearing Task Error Status” on page 41

Configuring Data Manager to Indicate Media Status by Color
You can configure the media items in the tree view of the Administrator to 
change color depending on their status. This option is enabled by default. The 
following table lists each color and describes the status indicated by each 
color:

To configure the tree view to indicate media status by color:

• From the View menu, select Enable Color. A check mark next to the 
Enable Color option signifies that the option has been enabled. If this 
option is disabled, all media items are black, regardless of status.

Viewing Media Logs
Data Manager maintains a log of activity for each piece of media in the Data 
Manager system. These logs are useful for viewing task processing 
information and error codes/status for failed tasks. 

In addition, if a media task is suspended, an entry in the media log will note 
when the task will be retried.

To open a media log: 

• In the tree view of the Administrator, right-click the media whose log you 
want to view and select View Log from the shortcut menu that appears.

The media log for the piece of media appears in RtfPad. As with any 
information appearing in RtfPad, you can save, print, or email the log. For 
more information, see “Using RtfPad” on page 303.

Table 12.  Media Status Indicated by Color

Media Color Media Status
Black Online

Green Online but with a task pending, in progress, or 
suspended

Red Error

Yellow Offline
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Clearing Media Logs
Media logs have a specific size limitation, after which the log is truncated from 
the beginning of the file. While the log size is regulated through automatic 
truncation, large logs are often cumbersome and difficult to navigate. Clearing 
media logs regularly makes it easier to find new information.

Note: You may want to save your log before clearing it. To save a log, open it 
and then select Save from the File menu in RtfPad.

To clear a media log:

1. In the tree view of the Administrator, right-click the media whose log you 
want to clear, and then select Clear Log from the shortcut menu that 
appears.

2. Click Yes on the confirmation message that appears.

Clearing Task Error Status
If a task for a piece of media fails or an aborted task remains in the task queue 
as a failed task, you may need to clear the error status for the piece of media 
before any other activities for that media can take place. 

To clear the error status for a piece of media:

1. In the tree view of the Administrator, right-click the media encountering the 
error and then select Clear Error Status from the shortcut menu that 
appears. The Clear Media Error Status dialog box appears. 

Figure 11.  Clear Media Error Status Dialog Box 

2. You have the following choices:

• To cancel all pending tasks and clear the error status, select Delete all 
pending media tasks and clear media error status.

• To clear the error status and continue processing assigned tasks, 
select Clear media error status and continue [retry pending tasks]. 

3. Click OK.
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Editing Media Tasks
You can edit tasks assigned to media already in the media task queue. When 
editing tasks for a piece of media, you can change what tasks are assigned 
(add or remove tasks) or change the options configured for existing tasks. 

Note: If you attempt to edit the assigned tasks for a piece of media whose 
tasks are in progress or about to be processed (media has been 
mounted), you may receive an error message and may be unable to 
edit the tasks for that media. 

To edit media tasks for a piece of media:

1. You have the following choices:

• In the tree view of the Administrator, right-click the piece of media for 
which you want to edit tasks and then select Edit Tasks from the 
shortcut menu that appears.

• Open the Media Task Queue Manager and select the piece of media 
for which you want to edit tasks. Click Edit Tasks.

The Media Tasks page appears.

Figure 12.  Media Tasks Page 

2. You have the following choices:

• Add a new task for the piece of media. For instructions, see “Adding a 
Media Task” on page 36.

• To delete a task, select the task from the list and click Delete Selected 
Task.

• To edit a media task, select the task from the list. The Options and 
When To Process regions of the Media Tasks page become available 
with the settings you selected when you added the task.
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3. If you are editing a task, you have the following choices:

• Enable or disable the options as necessary in the Options region of the 
Media Task page. The options that appear depend on the media task 
you selected. The following table contains a list of media tasks and the 
section in this guide where you can find more information about the 
task:

• Select whether to process the media task as soon as possible or on a 
scheduled basis. If you choose to process the media task on a 
scheduled basis, the task is not processed until the Process scheduled 
media tasks schedule is active. For information on configuring media 
activity schedules, see “Scheduling Media Activities” on page 52.

Note: If you assign multiple tasks for media, be advised that all tasks for 
that media will have the same When to Process option, since all 
tasks for a piece of media are processed simultaneously. If one 
task has the ASAP – as soon as possible option selected, all tasks 
for that piece of media will process ASAP by default. 

Table 13.  Media Tasks

Media Task For More Information, See...
Add to media folder “Using the Add to Media Folder Media Task” on 

page 71

Add to move group “Using the Add to Move Group Media Task” on 
page 74

Check disk “Running Check Disk on a Piece of Media” on 
page 113

Compact “Using the Compact Media Task” on page 80

File report “Assigning a File Report Media Task” on 
page 340

File restore “Restoring Files from Media” on page 77

Finalize “Finalizing Media” on page 82

Format “Using the Format Media Task” on page 57

Label “Using the Label Media Task” on page 65

Label copy “Using the Label Copy Media Task” on page 109

Prefetch “Requesting All Files from a Piece of Media Using 
a Prefetch Media Task” on page 215

Remove from media 
folder

“Using the Remove from Media Folder Media 
Task” on page 92

Remove from move 
group

“Using the Remove from Move Group Media 
Task” on page 85
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4. Repeat steps 2 and 3 for all remaining tasks you want to edit for the 
selected piece of media.

5. Once tasks have been edited as needed in the Media Tasks page, you 
have the following choices: 

• If you edited the task(s) through the Media Task Queue Manager, click 
Finish. The Media Task Queue Manager dialog box appears with the 
new media listed and the task(s) pending.

• If you edited the task(s) using the Edit Tasks option on either the 
shortcut menu for the media or the Edit menu, click Next. The Order 
Media in Task Queue page appears with the edited media at the 
bottom of the media task queue list.

Figure 13.  Order Media In Task Queue Page 

6. To promote the selected piece of media so that the media tasks for the 
media are processed before other media in the queue, click the up arrow 
button to the right of the list box. You can also demote a piece of media in 
the list by selecting the media and then clicking the down arrow to the right 
of the list box. When you finish, click Finish or Close as appropriate.

Reordering Media Tasks in the Queue
You can change the processing order of the media in the Media Task Queue 
Manager using the arrow buttons on the right side of the dialog box. 
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Figure 14.  Promote/Demote Arrow Buttons 

Since all assigned tasks for a piece of media are processed simultaneously, 
moving a piece of media in the queue also moves all tasks assigned to that 
media. 

To promote a piece of media in the queue:

• Select the piece of media and click the up button. 

To demote a piece of media in the queue:

• Select the piece of media and click the down button. 

Aborting a Media Task in Progress
The Media Task Queue Manager lists the status of media with pending, in 
progress and suspended tasks. You can choose to stop a task currently in 
progress. All media tasks with the exception of the format, finalize, label, and 
label copy tasks can be stopped in progress. 

Once you stop a media task in progress, you may have to clear the error 
status for the media before the next scheduled task begins. For instructions, 
see “Clearing Task Error Status” on page 41. If there is no error status to be 
cleared, the next pending media task starts processing automatically. 

Note: To abort pending or suspended media tasks, use the Edit Tasks option 
and delete the appropriate tasks from the media. 

To stop a task in progress:

1. You have the following choices:

• In the tree view of the Administrator, right-click the piece media for 
which you want to abort the media task currently in progress, and then 
select Abort Task in Progress from the shortcut menu that appears. 
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• Open the Media Task Queue Manager and select the piece of media 
for which you want to abort the media task currently in progress. Click 
Abort Task in Progress.

2. Click Yes on the confirmation message that appears.

3. If the aborted task remains in the task queue as a “failed” task, clear the 
error status in order to process the remaining tasks (if any) for that piece of 
media. For instructions, see “Clearing Task Error Status” on page 41.

Deleting Media Tasks
You can remove pending tasks for a piece of media from the media task 
queue. When all tasks are deleted from a piece of media, the media is 
removed from the media task queue.

Note: Since you cannot delete a task if it is already in progress, you must first 
stop any tasks that are currently processing before deleting them. For 
more information, see “Aborting a Media Task in Progress” on page 45. 
For instructions on deleting only a portion of assigned tasks for a piece 
of media, see “Editing Media Tasks” on page 42.

To delete all tasks for a piece of media in the queue:

1. Open the Media Task Queue Manager.

2. Select the media for which you want to delete all assigned tasks. 

3. Click Delete Tasks. A confirmation message appears. 

4. Click Yes. The Media Task Queue Manager dialog box reappears, without 
the media in the queue. 

■ Media Activities
A media activity is an activity that requires a piece of media to be online and 
accessible to ASM Data Manager in order for the activity to take place. There 
are six types of media activities:

• "Fetching Files from Media, " which follows

• “Moving Files to Media” on page 48

• “Prefetching Files from Media” on page 48

• “Processing Scheduled Media Tasks” on page 49

• “Updating Copy Media” on page 50

• “Flushing Transactions to Media” on page 50
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Frequent mounting and dismounting of media can have a wear-and-tear effect 
on the library devices that move media to and from the drives where the media 
is mounted. Problems can also arise when there are requests pending to 
mount more pieces of media than there are drives available. 

Data Manager gives you control over media activities by allowing you to 
schedule four of the six storage media activities: Move files to media, Process 
scheduled media tasks, Update media copies, and Allow fetches from media. 
In addition, you can schedule prefetch requests through the Prefetch Request 
Manager. Scheduling of these media activities lets you ensure efficient 
management of media mounts and dismounts within a device, and allows you 
to reduce competition for available drives during peak usage times. For more 
information, see “Scheduling Media Activities” on page 52.

In addition to the scheduling mechanism, Data Manager has a built-in 
precedence system that causes particular activities to always take precedence 
over others. Understanding the priority system allows you to schedule 
activities in the most efficient way possible in order to avoid conflicts with 
system resources. For more information, see “Priority of Media Activities” on 
page 51.

Fetching Files from Media
When a client attempts to open a file on the extended drive, the file data may 
or may not be present on the extended drive. If the file is present, Data 
Manager allows Windows to handle the file request. If only the file tag is 
present on the extended drive (file data has been moved to storage media and 
purged from the volume), Data Manager retrieves the file from media, copies 
the file back to the extended drive, and completes the client request. When a 
file is retrieved, this process is referred to as a “fetch.” 

A fetch is a media activity because it requires that media to be mounted, and 
may use network resources for the transfer of fetched files. 

Fetch requests are carried out as soon as the request is issued unless the 
Allow fetches from media schedule is inactive. Because the retrieval of files is 
one of the most important Data Manager activities, the Allow fetches from 
media schedule is always active by default. Some organizations, however, 
require that fetch access to files on media be restricted at certain times of the 
day. For instructions on setting the Allow fetches from media schedule, see 
“Scheduling Media Activities” on page 52.

Note: The Allow fetches from media schedule only pertains to individual 
client requests for purged Data Manager files from media. It does not 
apply to or affect prefetch requests.

If you restrict client fetch requests, the Defer fetch requests if fetch is disabled 
option on the Options tab of the Extended Drive Properties dialog box allows 
you to queue file requests when the Allow fetches from media schedule is 
inactive. If this option is enabled, Data Manager queues all file requests made 
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during an inactive fetch schedule as deferred fetches. Data Manager then 
processes all deferred fetches when the Allow fetches from media schedule 
becomes active. For more information on the Defer fetch requests if fetch is 
disabled option, see “Defer fetch requests if fetch is disabled” on page 273.

You can also configure Data Manager to cancel fetch requests after a certain 
number of minutes. The Fetch request timeout minutes option on the Options 
tab of the Extended Drive Properties dialog box allows you to reduce network 
traffic by stopping requests in cases where the user no longer expects the file 
to open because of the amount of elapsed time since the request. For more 
information, see “Fetch request timeout minutes” on page 268.

Moving Files to Media
When a file becomes eligible for move, the name of the file is added to the 
move list. Depending on the move rule settings, the file name is added either 
immediately or during the next drive scan. When a drive scan is run, every 
potentially eligible file on the drive is checked and a move list created from the 
results.

When the Move files to media schedule is active, Data Manager copies the 
files on the move list out to storage media, and purges any moved files that 
have the Purge files immediately after move option (on the Settings tab of the 
Move Rule Properties dialog box) configured. The Move files to media 
schedule applies to all files currently on the move list.

For instructions on setting the Move files to media schedule, see “Scheduling 
Media Activities” on page 52.

Prefetching Files from Media
Data Manager contains a prefetch capability, which allows you to retrieve 
frequently used files from storage media in advance of their being requested 
by a client. This allows you to reduce read requests during high traffic times by 
anticipating file retrieval needs. A prefetch request is a media activity because 
it requires media to be mounted. During a prefetch, Data Manager retrieves 
the specified files (except for files marked for direct read) from storage media 
and writes the file data to the extended drive.

Data Manager has two different prefetch functions: Prefetch requests, and the 
Prefetch media task.

Prefetch requests are configured using the Prefetch Request Manager. 
Prefetch requests allow you to select specific files for prefetching. In addition, 
the Prefetch Request Manager contains a separate scheduling function, to 
allow you to prefetch the selected files at a particular time or on a set 
schedule. For more information on creating and scheduling prefetch requests, 
see “Requesting Specific Files Using Prefetch Requests” on page 196.
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The prefetch media task writes all files from a selected piece of media to the 
corresponding media folder on the extended drive (ignoring duplicates and 
files marked for direct read). The prefetch media task (like all media tasks) is 
governed by the Process scheduled media tasks schedule. For more 
information on assigning a prefetch media task, see “Requesting All Files from 
a Piece of Media Using a Prefetch Media Task” on page 215. For more 
information on scheduling the Process scheduled media tasks activity 
schedule, see “Scheduling Media Activities” on page 52.

Note: Data Manager does not support direct read of files with streams. For 
this reason, if you prefetch a streamed file that is marked for direct 
read, the file data is fetched and the direct read attribute is removed 
from the file. 

Processing Scheduled Media Tasks
Media tasks are activities that you can actively assign to specific pieces of 
media. Media tasks include:

• Add to media folder

• Add to move group

• Check disk

• Compact

• File report

• File restore

• Finalize

• Format

• Label

• Label copy

• Prefetch (all files on a specified piece of media)

• Remove from media folder

• Remove from move group

When you assign media tasks to a piece of media, you can choose to process 
the tasks immediately or to schedule them to process later. When you select 
the immediate processing option, Data Manager starts processing the task 
right away. When you choose to schedule a task, the activity does not occur 
until the Process scheduled media tasks schedule is active. 

When the Process scheduled media tasks schedule is active, Data Manager 
processes all scheduled tasks for media listed in the media task queue, in the 
order in which the media are listed. Once all scheduled tasks for a piece of 
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media are complete, Data Manager removes the media from the queue and 
proceeds to the next piece of media.

Note: If you have multiple drives available for media to be mounted, multiple 
pieces of media may have their assigned tasks processed 
simultaneously. 

For more information on media tasks, see “Media Tasks” on page 34. For 
instructions on setting the Process scheduled media tasks schedule, see 
“Scheduling Media Activities” on page 52.

Updating Copy Media
Data Manager automatically updates any piece of copy media that is less than 
100% updated during active copy schedule times. When a copy created, it is 
managed and tracked automatically by Data Manager. 

When the Update copy media schedule is active, Data Manager checks each 
copy against its original to determine whether any updates should be made to 
the copy. Data Manager searches for the number of sectors written, and 
knows how much of the media it has left to copy. If updates are required, Data 
Manager updates the copy. 

Note: If the copy media is offline at the time the Update copy media schedule 
is active, the copy is not updated. 

Update status for individual pieces of copy media can be viewed through the 
Copy Media Manager, which is accessible from the Tools menu in the Data 
Manager Administrator. For more information on creating and managing 
copies, see “Creating and Managing Copies of Media” on page 103.

Note: We recommend that you update any DVD-R media copies immediately 
after finalizing the original, to ensure the copy is complete. Then, 
finalize the copies to ensure the security of the data on the DVD-R 
copy. 

Note: In some cases, the update status for a copy may appear as 100%, but 
the written bytes between the Copy and the Original are different. If 
this happens, open the media properties for the Copy, and clear the 
statistics. This allows Data Manager to reset the tally for written bytes 
and update the copy appropriately. See “The Statistics Tab” on 
page 31 for more information.

Flushing Transactions to Media
When changes are made to file attributes on the extended drive, the piece of 
media where that file is stored is not always immediately mounted so that the 
version of the file on the media can be changed. Instead, Data Manager logs 
the change to the file in a transaction log for the piece of media, and saves 
that information until the next time the media is mounted. The transaction log 
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is an area reserved on the Data Manager computer’s hard drive to 
automatically record all changes that are made. When the media is mounted, 
Data Manager “flushes” the transaction out to media. The file changes are 
then reflected on the media. 

Note: Certain types of transactions are possible on the extended drive but 
not possible on certain types of media. For more details on transaction 
logging, refer to the Planning Your Data Manager System chapter of 
the ASM Data Manager Getting Started Guide.

For currently mounted media in a library drive, Data Manager always flushes 
transaction logs to media before responding to fetch requests, moving files, or 
processing media tasks. Transaction logs for media mounted in a standalone 
drive or tower are flushed automatically every minute (or immediately when a 
media rename occurs).

In libraries, ASM can use the library robotics to mount and dismount media 
without requiring manual insertion and removal of media by the administrator. 
For this reason, ASM mounts media in a library specifically to flush transaction 
logs to the media and keep the media updated. ASM uses the following rules 
for dismounting media currently in a library drive and mounting media on 
shelves in a library to transfer logged information to the media:

• For media currently mounted in the drive for fetch, transactions are flushed 
when the drive becomes available after the timeslice setting expires. The 
timeslice setting is configured on the Options tab of the Service Properties 
dialog box. For more information, see “The Options Tab” on page 299.

• For media currently mounted in the drive for move, transactions are 
flushed when there is nothing left to move (or when the Move files to 
media schedule is inactive). The Move files to media schedule is 
configured from the Settings tab of the Extended Drive Properties dialog 
box. For more information, see “Scheduling Media Activities” on page 52.

• For media mounted for media tasks, transactions are flushed before the 
tasks are processed. The Process scheduled media tasks schedule is also 
configured from the Settings tab of the Extended Drive Properties dialog 
box. For more information, see “Scheduling Media Activities” on page 52.

• For media mounted for copy, transactions are flushed when there are no 
copies left to update (or when the Update copy media schedule is 
inactive). The Update copy media schedule is also configured from the 
Settings tab of the Extended Drive Properties dialog box. For more 
information, see “Scheduling Media Activities” on page 52. 

Priority of Media Activities
Data Manager has a built-in precedence system that causes particular 
activities to always take precedence over others. For example, retrieval of 
requested files from media always takes precedence over all other media 
activities. If a client requests a file that has to be retrieved from media, the 
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media activity precedence rules observed by Data Manager ensure that the 
client does not have to wait for other pending media activities to take place 
before the piece of media containing the needed file is mounted. 

For this reason, we generally recommend that you schedule file migration, 
media tasks, and media copy updates at a time when client retrieval requests 
are at a minimum. 

The following list outlines the order of precedence for Data Manager activities:

• Fetching files from media (including deferred fetches)

• Moving files to media

• Prefetching files from media

• Processing scheduled media tasks

• Updating copy media

• Flushing transactions to media (library drives only)

When schedules overlap, Data Manager performs activities according to these 
priorities. For example, file fetches are performed before files are moved to 
media, if they conflict. 

Note: The priority listing above only applies when activity processing 
happens to occur simultaneously, due to either overlapping schedules 
or other system requests. In addition, if a piece of library media is 
mounted and there are transactions waiting to be flushed to that piece 
of media, the transactions are flushed before the media is dismounted, 
regardless of the priority of media activities listed above.

Move files to media and Flush media transactions are interruptible events; the 
others are not. This means that if, for example, a file move is in progress and 
media restore is scheduled to begin, the file being moved at that time is 
finished, but no other files are moved, allowing the media restore to begin. 
Conversely, if files are being fetched and the Move files to media schedule 
becomes active, the fetches finish before the movement of files begins.

Scheduling Media Activities
There are four storage media activities that can be scheduled for each 
extended drive:

• Move files to media

• Process scheduled media tasks

• Update copy media

• Allow fetches from media
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Note: Prefetch requests are scheduled separately from other media 
activities, during prefetch request configuration in the Prefetch 
Request Manager. For more information on creating and scheduling 
prefetch requests, see “Requesting Specific Files Using Prefetch 
Requests” on page 196.

All of the media activities listed above are specific to the extended drive for 
which they are configured and must be scheduled and maintained separately 
for each extended drive in your Data Manager system.

Media activities are scheduled for a time range (for example, 2 a.m. to 4 a.m.). 
This range provides a “window of opportunity” for the activity(s) to occur. Any 
time within this range that an activity can begin, it will. If for any reason the 
activity does not begin during this time, it is not performed until the next time 
the schedule is active. When these activity schedules overlap, they occur 
based on the priority system noted in “Priority of Media Activities” on page 51.

You should set media activity schedules based on the needs of the individual 
system. Issues to consider when setting up your schedule include the 
importance of specific media activities, the length of time required, and the 
available resources necessary to complete each activity. 

To set up a media activity schedule:

1. Right-click on the extended drive for which you want to configure media 
activity schedules and then select Properties from the shortcut menu that 
appears. The Extended Drive Properties dialog box appears.

2. Click the Settings tab.

Figure 15.  Extended Drive Properties – Settings Tab 

3. Click the Schedule button. The Schedule dialog box appears.
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Figure 16.  Schedule Dialog Box 

Within the scheduler, colored lines represent each activity, allowing you to 
quickly see which activities are scheduled for what blocks of time. By 
default, three of the four available activities are scheduled to occur from 8 
p.m. to 9 a.m. every day of the week. The Allow fetches from media 
activity is scheduled to occur 24 hours a day, 7 days a week (always 
active). 

The schedule grid contains columns for each hour of the day and rows for 
each day of the week, creating cells which each represent one hour. For 
example, the blacked out cell in the figure above represents 5 p.m. to 6 
p.m. on Sunday.

4. To change schedule settings, select the area of the grid that corresponds 
to the time period during which you would like to schedule or clear an 
activity. 

• To set an activity for the selected blocks, check the appropriate 
option(s) in the Activities section of the Schedule dialog box.

• To clear an activity for all selected blocks, uncheck the appropriate 
option(s) in the Activities section of the Schedule dialog box.

5. You have the following choices:

• Click Set to set the activities that are checked and clear the activities 
that are not checked in the highlighted area of the schedule grid.

• Click Clear to clear all scheduled activities in the highlighted area of 
the schedule grid, regardless of which options are checked in the 
Activities section.

Note: Any time the Allow fetches from media schedule is not active, client 
fetch requests for purged files (including files marked for direct 
read) are not honored. Changing the schedule for this activity may 
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prevent clients from having access to necessary files. We 
recommend that you retain the default setting for fetches (always 
active), unless your organization requires a time-based restriction 
of access to purged files. If you have a time-based restriction 
configured, you may want to enable the Defer fetch requests if 
fetch is disabled option. For more information, see “Defer fetch 
requests if fetch is disabled” on page 273.

6. When you finish making changes to the schedule, click OK to save your 
changes and close the Schedule dialog box. The Extended Drive 
Properties dialog box appears.

Note: You must save changes to the schedule using the Set and Clear 
buttons before clicking OK. Making changes and clicking OK 
without using the Set or Clear buttons will close the dialog box 
without saving your changes.

7. Click OK to close the Extended Drive Properties dialog box.

■ Managing Media Use
Media must be prepared and added to the system before ASM can begin 
migrating files to it. The type of media determines the steps that must be taken 
to begin migrating files to the media. For example, new magneto-optical media 
must be formatted, labeled, added to a media folder, and then added to a 
move group; however, Network Attached Storage (NAS) media need only be 
added to the media folder and move group.

If you are adding media that already contains files, you can restore those files 
from the media to the Data Manager extended drive so that users can access 
the files.

Some types of media also allow you to compact and reformat the media so 
that you can efficiently reuse pieces of media. 

When you are finished with a piece of media, you can remove it from ASM.

For more information, see the following sections:

• "Formatting Media, " which follows

• “Labeling Media” on page 64

• “Adding Media to a Media Folder” on page 67

• “Adding Media to a Move Group” on page 73

• “Renaming Media” on page 76

• “Reformatting Media” on page 76
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• “Restoring Files from Media” on page 77

• “Compacting Media” on page 79

• “Finalizing Media” on page 82

• “Removing Media from a Move Group” on page 85

• “Removing Media from a Media Folder” on page 87

• “Deallocating Media from the Extended Drive” on page 95

• “Removing Media from a Media Service” on page 97

• “Removing Media Services” on page 102

Formatting Media
Most media must be formatted for use with Data Manager. Formatting verifies 
the integrity of the media, and makes it available for use with system 
hardware. It prepares the media for file writes by creating the specified file 
system on the media. ASM allows you to format media in a standalone drive, 
one piece of media at a time, or in a library using multiple drives at one time. 

Note: ASM does not support formatting of CD-ROM, DVD-ROM, WORM, 
NAS, EMC Centera (EMC), or Tivoli Storage Manager (TSM) media. 

You can perform a format on unformatted media, or reformat media that has 
previously been formatted for the same or another file system (except for 
DVD-R and WORM-tape media which can be formatted only once). For more 
information on reformatting media, see “Reformatting Media” on page 76. 
Media that has never been formatted appears in the Unformatted media node. 
Media formatted in a file system other than the one configured for the drive or 
device it is in appears in the Foreign media node. 

Note: Unformatted DVD media may appear as Foreign rather than 
Unformatted if the device in which it resides is configured to use the 
UDF file system. Regardless, the media must still be formatted before 
it can be used.

Media is formatted for a particular file system. Media formatting options differ 
depending on the file system configured for the hardware device being used 
as a media service. For example, if a device has been configured for ASM file 
systems, the format command automatically formats media for this file system; 
likewise with Windows Native and UDF file systems. Media formatted for one 
file system cannot be mixed in a hardware device with media formatted for 
another file system.

It is important to examine system needs before deciding on a file system. For 
more information, see “Types of Media File Systems” on page 18.
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The format media task also allows you to select whether to low-level SCSI 
format the media. However, some types of media (like DVD-R) do not support 
low-level SCSI formatting, and for those media, this option is unavailable. 

Note: Formatting double-sided optical media in a standalone drive formats 
only one side of the media. You must dismount, flip, and format the 
reverse side as well. To avoid confusion, always format both sides of 
double-sided media at the same time.

There are two ways to format media:

• If you only need to format a single piece of media, assign the format media 
task. For instructions, see "Using the Format Media Task, " which follows.

• If you want to format and/or label multiple pieces of media, use the Media 
Prepare Manager to assign the format and label media tasks to several 
pieces of library media at once. For instructions, see “Formatting and 
Labeling Using Media Prepare Manager” on page 59.

Using the Format Media Task
You can assign the format media task to format a single piece of media, or to 
format only one side of a piece of double-sided media.

Note: If you are formatting a piece of Original or Unformatted DVD-RAM 
media and you want to assign the label copy task after the format task, 
you must wait for the format task to complete before you can assign 
the label copy task; you cannot assign the two tasks consecutively. 

To assign a format task:

1. Open the Media Tasks page. You have the following choices:

• In the tree view of the Administrator, right-click the piece of media to 
which you want to add the format media task and then select Edit 
Tasks from the shortcut menu that appears.

• Press <CTRL>+T, or open the Tools menu and then select Media Task 
Manager to open the Media Task Queue Manager. If the media already 
has tasks assigned to it, select the media and then click Edit Tasks. If 
the media does not have tasks already assigned to it, click Add New 
Media. The Select Media for New Tasks page appears listing all media 
that do not currently have tasks assigned to them. Select the piece of 
media to which you want to assign the format media task and then 
click Next.

2. From the Next Task drop-down list, select the format media task and then 
click Add Next Task. The format task appears in the Task List, and the 
Options and When To Process regions of the Media Tasks page become 
available.



Managing Storage Media

58 Second Edition
StorageTek Proprietary

Figure 17.  Format Media Task 

3. In the Format Options section, select a file system from the File System 
drop-down list. For more information on file systems, see “Types of Media 
File Systems” on page 18.

4. Enable or disable the Force low-level SCSI format check box. You have 
the following choices:

• To perform a quick format, disable the Force low-level SCSI format 
check box. Quick format clears the file table of all pointers to files on 
the media, but not the actual information on the media. A quick format 
is sufficient if the media is pre-formatted or has been previously low-
level formatted in the drive type being used.

• To perform a low-level SCSI format, enable the Force low-level SCSI 
format check box. A low-level SCSI format is necessary when media 
has repeatedly failed due to media errors. Select this option to perform 
a low-level SCSI format and prepare the media for the current file 
system and drive type. 

Note: If your unformatted DVD-RAM media is not pre-certified, we 
recommend performing a low-level SCSI format on it to reduce the 
possibility of media write errors. 

Note: If a format fails, it is usually an indication that a low-level SCSI 
format is necessary to prepare the media for the current drive type.

5. Enable or disable the Enable compression (on this media) check box. You 
have the following choices:

• Enable the Enable compression check box to enable compression for 
the selected piece of media. If compression is enabled, files are 
compressed when they are written to the media, allowing you to, in 
some cases, conserve storage media space. Whether you can enable 
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compression depends on which file system is being used and whether 
the device in which the media resides supports file compression.

• Disable the Enable compression check box to disable compression for 
the selected piece of media.

6. Select whether to process the media task as soon as possible or on a 
scheduled basis. If you choose to process the media task on a scheduled 
basis, the task is not processed until the Process scheduled media tasks 
schedule is active. For information on configuring media activity 
schedules, see “Scheduling Media Activities” on page 52. 

Note: If you assign multiple tasks for media, be advised that all tasks for 
that media will have the same When to Process option, since all 
tasks for a piece of media are processed at once. If one task has 
the ASAP – as soon as possible option selected, all tasks for that 
piece of media will process ASAP by default. 

7. Once tasks have been added and configured as needed in the Media 
Tasks page, you have the following choices: 

• If you added the task through the Media Task Queue Manager, click 
Finish. The Media Task Queue Manager dialog box appears with the 
media listed and the task pending.

• If you added the task using the Edit Tasks option on either the shortcut 
menu for the media or the Edit menu, click Next. The Order Media in 
Task Queue page appears with the recently added media at the bottom 
of the media task queue list.

8. To promote the selected piece of media so that the media tasks for the 
media are processed before other media in the queue, click the up arrow 
button to the right of the list box. You can also demote a piece of media in 
the list by selecting the media and then clicking the down arrow to the right 
of the list box. When you finish, click Finish or Close as appropriate.

All media with tasks assigned appear in the Media Task Queue Manager until 
they are processed. For media with tasks selected to process ASAP – as soon 
as possible, those media may only appear briefly in the queue before the 
processing completes and the media is removed from the queue.

Once media has been formatted (and before it is labeled), it appears in the 
Blank media node of the Available Media list. 

Formatting and Labeling Using Media Prepare Manager
Data Manager’ Media Prepare Manager allows you to assign the format and 
label media tasks to several pieces of library media at once. This is particularly 
useful if you have a library with a large number of media that need to be 
formatted and/or labeled for use in Data Manager. 
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Once you have assigned the format and/or label tasks to media through the 
Media Prepare Manager, you can view the media and the tasks through the 
Media Task Queue Manager. For more information, see “Monitoring Media 
Tasks” on page 39.

Note: The Media Prepare Manager can only be used for media in libraries 
configured for use with Data Manager.

To use the Media Prepare Manager:

1. From the Tools menu, select Media Prepare Manager; or press 
<CTRL>+M. The Media Prepare Manager – Select Library page appears.

Figure 18.  Media Prepare Manager – Select Library Page 

2. Select the library for which you want to format and/or label media and then 
click Next. The Media Prepare Manager – Select Media page appears.

Figure 19.  Media Prepare Manager – Select Media Page 
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Note: Double-sided media do not appear in the list if either side of the 
media is not available for format and/or label (for example, one 
side is assigned to a media folder, while the other side is not). 

3. Select the media you want to format and/or label and then click Next. The 
Media Prepare Manager – Format page appears.

Figure 20.  Media Prepare Manager – Format Page 

4. You have the following choices:

• If you do not want to format the media, choose Do not format selected 
media. Then skip ahead to step 8. 

• If you want to format the media, choose Format selected media with 
the following options. The file system assigned to the library through 
MediaStor appears in the File System field. 

5. If available, enable or disable the Force low-level SCSI format check box. 
You have the following choices:

• To perform a quick format, disable the Force low-level SCSI format 
check box. Quick format clears the file table of all pointers to files on 
the media, but not the actual information on the media. A quick format 
is sufficient if the media is pre-formatted or has been previously low-
level formatted in the drive type being used.

• To perform a low-level SCSI format, enable the Force low-level SCSI 
format check box. A low-level SCSI format is necessary when media 
has repeatedly failed due to media errors. Select this option to perform 
a low-level SCSI format and prepare the media for the current file 
system and drive type.

Note: If your unformatted DVD-RAM media is not pre-certified, we 
recommend performing a low-level SCSI format on it to reduce the 
possibility of media write errors. 
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Note: If a format fails, it is usually an indication that a low-level SCSI 
format is necessary to prepare the media for the current drive type.

6. If available, enable or disable the Enable compression (on this media) 
check box. You have the following choices:

• Enable the Enable compression check box to enable compression for 
the selected piece of media. If compression is enabled, files are 
compressed when they are written to the media, allowing you to, in 
some cases, conserve storage media space. Whether you can enable 
compression depends on which file system is being used and whether 
the device in which the media resides supports file compression.

• Disable the Enable compression check box to disable compression for 
the selected piece of media.

7. Click Next. The Media Prepare Manager – Label page appears.

Figure 21.  Media Prepare Manager – Label Page 

8. You have the following choices:

• If you do not want to label the selected media, choose Do not label 
selected media. Skip ahead to step 14. 

• If you do want to label the selected media, select Label selected 
media. 

9. If you choose to label the media, you have the following choices: 

• If barcodes are not available on your system, select Use standard 
method to label media based on a label prefix and number width. 

• If barcodes are available on your system, and if you want ASM to 
generate labels for media based on these barcodes, select Use 
barcode. To determine if the media device supports barcode labeling, 
refer to your device manual.
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10. If you use a standard labeling convention, specify a prefix to be used for 
naming each added piece of media in the Label Prefix text box.

11. In the Start Number text box, enter the number at which the label should 
start. For more information on naming media, see “Media Naming 
Conventions” on page 64.

12. From the Number Width drop-down list, select the number of digits to be 
used to create the incremental numbering for the media label. ASM adds 
the number (starting with the value in the Start Number text box) to the 
prefix to create the name for each added piece of media.

13. The Sample Name text box provides an example of what the media name 
will look like based on the prefix and number width criteria you set.

14. Once you have selected labeling options, click Next. The Media Prepare 
Manager – Schedule page appears.

Figure 22.  Media Prepare Manager – Schedule Page 

15. You have the following choices:

• If you want to process the format and/or label task immediately, choose 
ASAP.

• If you want to process the media task on a scheduled basis, choose 
Scheduled. If you choose to process the media task on a scheduled 
basis, the task is not processed until the Process scheduled media 
tasks schedule is active. For information on configuring media activity 
schedules, see “Scheduling Media Activities” on page 52.

16. Click Next. The Summary page appears. 

17. Review the information in the summary.

18. If the information in the summary is correct, click Finish.
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Labeling Media
When media is inserted in a device, the ASM system evaluates the media to 
determine if it recognizes the file system format, and reads the media label as 
well. If the media is formatted but has not been labeled, ASM identifies the 
media as blank media and adds it to the Available Media list under the Blank 
media node. Once media has been labeled, the media appears with the new 
label in the Original media list. Media in the Original media list can be 
assigned to a media folder.

Labeling assigns a name and serial number to a piece of media so that it can 
be tracked by ASM. No two pieces of original media should have the same 
label, because the media label is what allows you to identify the media in the 
ASM Data Manager (and ASM MediaStor) Administrator(s). For ease of use, 
the media label should uniquely identify the media. 

There are three ways to label media:

• If you want to set up automatic media labeling and compaction for your 
move group, use the Automation tab of the Move Group Properties dialog 
box. For more information, see “The Automation Tab” on page 174. This 
option allows you to simply load and format media, and then let other 
media maintenance activity be triggered by internal ASM events.

• If you want to label a single piece of media, assign a label media task. For 
instructions, see “Using the Label Media Task” on page 65.

• If you want to format and label multiple pieces of media, use the Media 
Prepare Manager to assign the format and label media tasks to several 
pieces of library media at once. For instructions, see “Formatting and 
Labeling Using Media Prepare Manager” on page 59.

Media Naming Conventions
Media label names may be alphanumeric (a-z or 0-9) characters. Media 
names may also include the following special characters: $ ! - _ % and #. 

Certain standards should be applied when naming media. It is best to use a 
descriptive and consistent naming convention (as opposed to the date and 
time, or 1,2,3…). This assures easy tracking of all media by name, and 
reduces confusion if different media are accidentally mixed together.

The recommended approach to naming media is to use a prefix and a 
sequence number. The prefix should represent the extended drive name, 
application name, etc. that is writing to the media (for example, CAD, 
IMAGES, DOCS). The sequence number represents the order of the media in 
the group and optionally should reflect the side of media (for example, 1,2,3 or 
1A, 1B, 2A, 2B, 3A, 3B). Combined, they give an orderly system for naming 
media (for example, CAD1A, CAD1B, CAD2A, CAD2B, etc.).
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Depending upon data organization, all media could be given the same prefix, 
with the only difference being the number following the prefix. Alternatively, 
different prefixes could be given to media depending upon file type or location, 
for example. When labeling media in a standalone drive, one side should be 
labeled LABEL1A, while the other side should be labeled LABEL1B, where 
LABEL is the media name.

Using the Label Media Task
The label task can be assigned to follow a format task for a piece of media, or 
blank media can be labeled as needed. For example, you can format all the 
media in a library, making it ready for use, but wait until a piece of media is 
needed to label it. This creates a reserve of blank media, available to be used 
when needed and then labeled accordingly.

To assign a label task:

1. Open the Media Tasks page. You have the following choices:

• In the tree view of the Administrator, right-click the piece of media to 
which you want to add the label media task and then select Edit Tasks 
from the shortcut menu that appears.

• Press <CTRL>+T, or open the Tools menu and then select Media Task 
Manager to open the Media Task Queue Manager. If the media already 
has tasks assigned to it, select the media and then click Edit Tasks. If 
the media does not have tasks already assigned to it, click Add New 
Media. The Select Media for New Tasks page appears listing all media 
that do not currently have tasks assigned to them. Select the piece of 
media to which you want to assign the label media task and then click 
Next.

2. From the Next Task drop-down list, select the label media task and then 
click Add Next Task. The label task appears in the Task List, and the 
Options and When To Process regions of the Media Tasks page become 
available.
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Figure 23.  Label Media Task 

3. In the Label Options section, enter a label in the Media Name text box. For 
recommendations on labeling media, see “Media Naming Conventions” on 
page 64.

4. Select whether to process the media task as soon as possible or on a 
scheduled basis. If you choose to process the media task on a scheduled 
basis, the task is not processed until the Process scheduled media tasks 
schedule is active. For information on configuring media activity 
schedules, see “Scheduling Media Activities” on page 52.

Note: If you assign multiple tasks for media, be advised that all tasks for 
that media will have the same When to Process option, since all 
tasks for a piece of media are processed at once. If one task has 
the ASAP – as soon as possible option selected, all tasks for that 
piece of media will process ASAP by default. 

5. Once tasks have been added and configured as needed in the Media 
Tasks page, you have the following choices: 

• If you added the task through the Media Task Queue Manager, click 
Finish. The Media Task Queue Manager dialog box appears with the 
media listed and the task pending.

• If you added the task using the Edit Tasks option on either the shortcut 
menu for the media or the Edit menu, click Next. The Order Media in 
Task Queue page appears with the recently added media at the bottom 
of the media task queue list.

6. To promote the selected piece of media so that the media tasks for the 
media are processed before other media in the queue, click the up arrow 
button to the right of the list box. You can also demote a piece of media in 
the list by selecting the media and then clicking the down arrow to the right 
of the list box. When you finish, click Finish or Close as appropriate.
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All media with tasks assigned appear in the Media Task Queue Manager until 
they are processed. For media with tasks selected to process ASAP – as soon 
as possible, those media may only appear briefly in the queue before the 
processing completes and the media is removed from the queue.

Once media has been labeled, it appears in the Original media node of the 
Available Media list.

Adding Media to a Media Folder
Adding media to a media folder makes that media available for addition to 
move groups in that folder and ultimately for storage of files saved to that 
folder on the extended drive. Only media listed in the Original node can be 
added to a media folder. You can add both previously unused media and 
media with existing files to a media folder. 

When media with existing files is added to a media folder, those files must be 
restored in order to make them accessible to clients. File restore makes files 
on media available for access through Data Manager by placing tags on the 
extended drive that point to the files on the media. When files and directories 
are restored to the extended drive, file tags and directory structures are 
created in the media folder on the extended drive.

Note: When adding non-finalized DVD-R media that contains files to the 
media folder, the file data (not just the file tags) are copied back to the 
extended drive. This means that you will have to allow for additional 
extended drive space to hold those files until they can be purged. 

There are five ways you can add media to a media folder:

• Use the Add Media to Media Folders command for an extended drive to 
launch the Add Media to Media Folders Wizard. This option is best used if 
you want to add multiple pieces of media to several different media 
folders.

• Drag the media from the Original node under the extended drive’s 
Available Media node to a media folder (or to the Media node under the 
media folder). This option is best used if you want to add a single piece of 
media to a media folder.

• Right-click the Media node under a media folder and select Add Media 
from the shortcut menu. This option is best used if you want to add 
multiple pieces of media to a single media folder.

• Set up automatic media labeling and compaction for your move group. 
This option allows you to simply load and format media, and then let other 
media maintenance activity be triggered by internal ASM events.

• Assign an add to media folder media task. This option is best used if you 
want to add a single piece of media to a media folder in conjunction with 
other media tasks, such as format, label, and add to move group.
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The first three options all bring you into the Add Media to Media Folders 
Wizard. For instructions, see "Using the Add Media to Media Folders Wizard, " 
which follows. 

Automatic media labeling and compaction is configured on the Automation tab 
of the Move Group Properties dialog box. For more information, see “The 
Automation Tab” on page 174.

For more information on the add to media folder media task, see “Using the 
Add to Media Folder Media Task” on page 71.

Using the Add Media to Media Folders Wizard
The Add Media to Media Folders Wizard leads you through the steps to add 
available media to media folders.

To add media to media folders using the wizard:

1. You have the following choices:

• Drag the media from the Original node under the extended drive’s 
Available Media node to a media folder (or to the Media node under 
the media folder). A message appears, prompting you to confirm the 
addition of the media to the media folder. Click Yes. Since you have 
already selected the media to add, the Add Media to Media Folders 
Wizard appears, starting with the Media Restore page. Skip to step 4 
to continue. 

• Right-click the extended drive that contains the media folder to which 
you want to add media and then select Add Media to Media Folders 
from the shortcut menu that appears. The Add Media to Media Folders 
Wizard appears, starting with the Select Media to Add page. 

• Right-click the Media node under the media folder to which you want to 
add media and select Add Media from the shortcut menu. The Add 
Media to Media Folders Wizard appears, starting with the Select Media 
to Add page.
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Figure 24.  Add Media to Media Folders Wizard -- Select Media To Add 
Page 

The Select Media to Add page lists all available media that can be 
assigned. 

2. If you selected the media folder to which you want to add media in the first 
step, notice that the Media Folder text box at the bottom is grayed out but 
contains the media folder you selected in the Administrator for adding 
media. Double-click the piece of media you want to assign to the media 
folder. To assign multiple pieces of media to the media folder, select the 
media and then click Add. The media folder appears to the right of the 
selected media in the Media list. Proceed to step 4.

3. If you did not select a media folder in the first step, you can either create a 
new media folder for the media or assign the media to an existing media 
folder. You have the following choices:

• To create a media folder (or folders) with the same name as the media, 
select the media and click Add. The media folder name appears to the 
right of the media.

Note: If you select two pieces of media that have the same name 
(regardless of capitalization), only one media folder, with that 
name, is created and both pieces of media are assigned to that 
folder.

• To create a media folder with a different name than the media, type the 
name of the folder in the Media Folder text box, select the media you 
want added to that folder, and click Add. The media folder name 
appears to the right of the media.

• To add the media to an existing folder, type the name of the folder in 
the Media Folder text box, select the media you want added to that 
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folder, and click Add. The media folder name appears to the right of the 
media. 

The media folder appears to the right of the selected media in the Media 
list.

4. When you finish assigning media to media folders, click Next. The Media 
Restore page appears.

Figure 25.  Add Media to Media Folders Wizard -- Media Restore Page 

Media restore options are only active if the media you are adding to the 
media folder contains files.

5. Set the appropriate restore options for any media that currently contains 
files. You have the following choices:

• Enable the Log duplicates check box to keep a count of files on the 
media that were already resident on the extended drive when 
restoring. 

• Enable the Direct read check box to apply the direct read attribute to all 
restored files. Direct read means that when accessed by a client, the 
file will be read directly from media rather than fetched to the extended 
drive and read from there.

• Enable the Process as soon as possible check box to restore the 
media immediately, rather than as a scheduled file restore media task 
(which is processed when the Process scheduled media tasks 
schedule is active).

6. After you have finished configuring restore options, click Next. The 
Summary page appears. The Summary page displays the media that will 
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be added to the media folder and the media restore options selected, if 
applicable.

7. Review the information in the Summary page. 

8. If the Summary page information is correct click Finish. The media is 
added to the media folder.

Using the Add to Media Folder Media Task
The add to media folder media task can only be assigned to media that has 
been formatted and labeled. The task is available for Original media, or for 
other media that have the format and/or label tasks scheduled. This allows 
you to add media after other tasks are completed without any need for manual 
intervention, This task can also be used in conjunction with the add to move 
group task to automatically add media to a media folder, then to a move group, 
all within a single process. For more information about adding media to a 
media group, see “Adding Media to a Move Group” on page 165.

To assign an add to media folder task:

1. Open the Media Tasks page. You have the following choices:

• In the tree view of the Administrator, right-click the piece of media to 
which you want to add the add to media folder media task and then 
select Edit Tasks from the shortcut menu that appears.

• Press <CTRL>+T, or open the Tools menu and then select Media Task 
Manager to open the Media Task Queue Manager. If the media already 
has tasks assigned to it, select the media and then click Edit Tasks. If 
the media does not have tasks already assigned to it, click Add New 
Media. The Select Media for New Tasks page appears listing all media 
that do not currently have tasks assigned to them. Select the piece of 
media to which you want to assign the add to media folder media task 
and then click Next.

2. From the Next Task drop-down list, select the add to media folder media 
task and then click Add Next Task. The add to media folder task appears in 
the Task List, and the Options and When To Process regions of the Media 
Tasks page become available.
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Figure 26.  Add to Media Folder Task 

3. In the Add To Media Folder Options section, you have two choices:

• To add the media to an existing media folder, select the media folder to 
which you want to add the media from the Media Folder drop-down list.

• To create a new media folder, click New. The Select New Media Folder 
dialog box appears. Select the folder on the extended drive that you 
want to designate as a media folder and then click OK. The media 
folder appears in the Media Folder drop-down list.

4. Select whether to process the media task as soon as possible or on a 
scheduled basis. If you choose to process the media task on a scheduled 
basis, the task is not processed until the Process scheduled media tasks 
schedule is active. For information on configuring media activity 
schedules, see “Scheduling Media Activities” on page 52.

Note: If you assign multiple tasks for media, be advised that all tasks for 
that media will have the same When to Process option, since all 
tasks for a piece of media are processed at once. If one task has 
the ASAP – as soon as possible option selected, all tasks for that 
piece of media will process ASAP by default. 

5. Once tasks have been added and configured as needed in the Media 
Tasks page, you have the following choices: 

• If you added the task through the Media Task Queue Manager, click 
Finish. The Media Task Queue Manager dialog box appears with the 
media listed and the task pending.

• If you added the task using the Edit Tasks option on either the shortcut 
menu for the media or the Edit menu, click Next. The Order Media in 
Task Queue page appears with the recently added media at the bottom 
of the media task queue list.
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6. To promote the selected piece of media so that the media tasks for the 
media are processed before other media in the queue, click the up arrow 
button to the right of the list box. You can also demote a piece of media in 
the list by selecting the media and then clicking the down arrow to the right 
of the list box. When you finish, click Finish.

All media with tasks assigned appear in the Media Task Queue Manager until 
they are processed. For media with tasks selected to process ASAP – as soon 
as possible, those media may only appear briefly in the queue before the 
processing completes and the media is removed from the queue.

Adding Media to a Move Group
To use media assigned to a media folder for file migration, that media must be 
assigned to a move group within the media folder. You can subdivide media 
within a media folder for separate uses by assigning media to different move 
groups in a media folder. 

By assigning media to move groups, you can control which set of media files 
will be written to and where. This can be useful if segregation of data is 
necessary. For example, if you wish to separate files from different months 
onto different pieces of media within a media folder, you can create a move 
group for each month. Separate media can be assigned to each move group 
so files for different months are not stored on the same media. 

In order to add media to a move group, the media must already be assigned to 
the media folder. Each piece of media can only be assigned to one move 
group at a time. For more information on assigning media to the media folder, 
see “Adding Media to a Media Folder” on page 67.

There are five ways to assign media to a move group:

• Drag the piece of media from the Media node within the media folder and 
drop it in the node for the move group to which you want to assign the 
media. A confirmation message appears. Click Yes. This option is best 
used if you want to add a single piece of media to a move group.

• Add the media to the move group through the Move Group Wizard when 
you create the move group. For instructions, refer to the Setting Up File 
Migration chapter of the ASM Data Manager Getting Started Guide. This 
option is best used while you are setting up your ASM system.

• Open the Move Group Properties dialog box and add the media on the 
Media tab. For instructions, see “Modifying a Move Group” on page 161. 
This option is best used if you have already added multiple pieces of 
media to a media folder and you want to add them to a single move group.

• Set up automatic media labeling and compaction for your move group. 
This option allows you to simply load and format media, and then let other 
media maintenance activity be triggered by internal ASM events. For more 
information, see “The Automation Tab” on page 174.
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• Assign an add to move group media task. For more information, see 
"Using the Add to Move Group Media Task, " which follows. This option is 
best used if you want to add a single piece of media to a move group in 
conjunction with other media tasks, such as format, label, and add to 
media folder.

Using the Add to Move Group Media Task
The add to move group media task adds a piece of media to a move group, 
making it available for ASM to write files to it based on the move rules 
configured for that move group. The task is available for media already 
assigned to a media folder, or for other media that have the format and/or 
label and/or add to media folder tasks scheduled. This allows you to add 
media after other tasks are completed without any need for manual 
intervention. Used in conjunction with the add to media folder task, you can 
automatically add media to a media folder, then to a move group, all within a 
single process.

You can also add one or more pieces of media to a move group when you 
create the move group, or through the Move Group Properties dialog box. In 
addition, you can use the automatic labeling feature for your move groups to 
label a blank piece of media, add it to the media folder and then to the move 
group whenever new media is needed for the move group. 

To assign an add to move group task:

1. Open the Media Tasks page. You have the following choices:

• In the tree view of the Administrator, right-click the piece of media to 
which you want to add the add to move group media task and then 
select Edit Tasks from the shortcut menu that appears.

• Press <CTRL>+T, or open the Tools menu and then select Media Task 
Manager to open the Media Task Queue Manager. If the media already 
has tasks assigned to it, select the media and then click Edit Tasks. If 
the media does not have tasks already assigned to it, click Add New 
Media. The Select Media for New Tasks page appears listing all media 
that do not currently have tasks assigned to them. Select the piece of 
media to which you want to assign the add to move group media task 
and then click Next.

2. From the Next Task drop-down list, select the add to move group media 
task and then click Add Next Task. The add to move group task appears in 
the Task List, and the Options and When To Process regions of the Media 
Tasks page become available.
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Figure 27.  Add To Move Group Media Task 

3. From the Move Group drop-down list, select the move group to which you 
want to add the media.

4. Select whether to process the media task as soon as possible or on a 
scheduled basis. If you choose to process the media task on a scheduled 
basis, the task is not processed until the Process scheduled media tasks 
schedule is active. For information on configuring media activity 
schedules, see “Scheduling Media Activities” on page 52.

Note: If you assign multiple tasks for media, be advised that all tasks for 
that media will have the same When to Process option, since all 
tasks for a piece of media are processed at once. If one task has 
the ASAP – as soon as possible option selected, all tasks for that 
piece of media will process ASAP by default. 

5. Once tasks have been added and configured as needed in the Media 
Tasks page, you have the following choices: 

• If you added the task through the Media Task Queue Manager, click 
Finish. The Media Task Queue Manager dialog box appears with the 
media listed and the task pending.

• If you added the task using the Edit Tasks option on either the shortcut 
menu for the media or the Edit menu, click Next. The Order Media in 
Task Queue page appears with the recently added media at the bottom 
of the media task queue list.

6. To promote the selected piece of media so that the media tasks for the 
media are processed before other media in the queue, click the up arrow 
button to the right of the list box. You can also demote a piece of media in 
the list by selecting the media and then clicking the down arrow to the right 
of the list box. When you finish, click Finish or Close as appropriate.
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All media with tasks assigned appear in the Media Task Queue Manager until 
they are processed. For media with tasks selected to process ASAP – as soon 
as possible, those media may only appear briefly in the queue before the 
processing completes and the media is removed from the queue.

Renaming Media
You can rename media through the Administrator without going through the 
format and label media tasks. Renaming a piece of (writable) media changes 
the label identifier on that media. Renaming a piece of media does not affect 
the files or directories on the media. 

You can only rename media that has already been formatted and labeled.

Note: While the Rename command is available for non-rewritable media, the 
renaming is not permanent. The media reverts to its original label the 
next time the media is inventoried (for non-rewritable media).  

Note: Renaming original media will not rename any copy media associated 
with the original. The copies will be updated, but the media names will 
no longer match. The rename command is not available for copy 
media.

To rename a piece of media:

1. Right-click the media and select Rename from the shortcut menu. 

2. The media name appears highlighted in the tree view with a cursor. 
Retype the name as desired.

3. Press <ENTER> or click outside of the media name. The media is listed 
with its new name.

Reformatting Media
If magneto-optical, DVD-RAM, or tape media has already been formatted and 
is not currently assigned to a media folder, it can be reformatted. To reformat a 
piece of media, assign the format media task for that piece of media. (For 
instructions, see “Formatting Media” on page 56.) The formatting process 
erases existing data and re-creates the file system on the media.

If you want to reformat a piece of media currently assigned to a media folder, 
you should first assign the compact media task. (For instructions, see 
“Compacting Media” on page 79.) Compaction places all of the files currently 
on the media onto the extended drive and removes the media from the media 
folder. After assigning the compact task, you can assign the format task to 
reformat the media.
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Restoring Files from Media
File restore makes files on media available for client access by placing file 
tags in the media folder on the extended drive that point to the files on the 
media. Whenever media is added to a media folder, the files on that media 
must be restored (so that the media’s files are made available to clients), and 
therefore the file restore media task is automatically assigned. However, the 
file restore task can be performed at any time.

The File Restore task is useful for regaining access to files that were 
inadvertently deleted from the extended drive (as long as the file was not also 
deleted from the media). Files written to write-once media and/or media 
formatted with the ASM File System can be restored as long as the media has 
not been reformatted. 

During a file restore, file tags for all files on the media are placed in the media 
folder on the extended drive. If there are duplicate files, the newest file (tag) is 
restored and older versions are always replaced. Files from CD-ROM, DVD-
ROM, WORM, WORM-tape and finalized DVD-R media are restored with tags 
that have a read-only attribute. 

Note: If you have upgraded your Data Manager installation from version 
5.40.050 to the 5.40 Service Release 1, and you are using EMC 
media, you will need to run a File Restore task on all of your EMC 
media in order to have file retention enforced on the extended drive for 
any files written to media before the upgrade. 

Note: When restoring files from non-finalized DVD-R media, the file data (not 
just the file tags) are copied back to the extended drive. This means 
that you will have to allow for additional extended drive space to hold 
those files until they can be purged (after the media is finalized).

When assigning a file restore task, you can enable or disable the Log 
Duplicates option, which allows you to keep a count of duplicate files when 
restoring. If there are duplicate files, the newest file is restored and older 
versions are always replaced. You can also set the direct read attribute for a 
piece of media when you restore it. Setting direct read causes files to be read 
directly from media rather than fetched to the extended drive. 

To assign a file restore task:

1. Open the Media Tasks page. You have the following choices:

• In the tree view of the Administrator, right-click the piece of media to 
which you want to add the file restore media task and then select Edit 
Tasks from the shortcut menu that appears.

• Press <CTRL>+T, or open the Tools menu and then select Media Task 
Manager to open the Media Task Queue Manager. If the media already 
has tasks assigned to it, select the media and then click Edit Tasks. If 
the media does not have tasks already assigned to it, click Add New 
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Media. The Select Media for New Tasks page appears listing all media 
that do not currently have tasks assigned to them. Select the piece of 
media to which you want to assign the file restore media task and then 
click Next.

2. From the Next Task drop-down list, select the file restore media task and 
then click Add Next Task. The file restore task appears in the Task List, 
and the Options and When To Process regions of the Media Tasks page 
become available.

Figure 28.  File Restore Media Task 

3. Enable or disable the Log duplicates check box. You have the following 
choices:

• Enable the check box to keep a count of files on the media that 
duplicate files already on the extended drive when restoring.

• Disable the check box if you don’t want to keep a count of duplicate 
files.

4. Enable or disable the Direct Read check box. Direct read means that when 
accessed by a client, the file is read directly from media rather than 
fetched to the extended drive and read from there. You have the following 
choices:

• Enable the check box to apply the direct read attribute to all restored 
files. 

• Disable the check box to force restored files to be fetched to the 
extended drive when requested by a client.

5. Select whether to process the media task as soon as possible or on a 
scheduled basis. If you choose to process the media task on a scheduled 
basis, the task is not processed until the Process scheduled media tasks 
schedule is active. For information on configuring media activity 
schedules, see “Scheduling Media Activities” on page 52.
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Note: The restore process can be time-consuming for media with a large 
number of files; therefore, you may want to configure the file 
restore task as a scheduled event rather than processing it 
immediately.

Note: If you assign multiple tasks for media, be advised that all tasks for 
that media will have the same When to Process option, since all 
tasks for a piece of media are processed at once. If one task has 
the ASAP – as soon as possible option selected, all tasks for that 
piece of media will process ASAP by default. 

6. Once tasks have been added and configured as needed in the Media 
Tasks page, you have the following choices: 

• If you added the task through the Media Task Queue Manager, click 
Finish. The Media Task Queue Manager dialog box appears with the 
media listed and the task pending.

• If you added the task using the Edit Tasks option on either the shortcut 
menu for the media or the Edit menu, click Next. The Order Media in 
Task Queue page appears with the recently added media at the bottom 
of the media task queue list.

7. To promote the selected piece of media so that the media tasks for the 
media are processed before other media in the queue, click the up arrow 
button to the right of the list box. You can also demote a piece of media in 
the list by selecting the media and then clicking the down arrow to the right 
of the list box. When you finish, click Finish or Close as appropriate.

All media with tasks assigned appear in the Media Task Queue Manager until 
they are processed. For media with tasks selected to process ASAP – as soon 
as possible, those media may only appear briefly in the queue before the 
processing completes and the media is removed from the queue.

Compacting Media
Media compaction allows you to reclaim deleted file space on media by 
relocating active (or non-deleted) files from one or more pieces of media to 
other storage media. Compaction also allows you to migrate files from one 
type of media to another (for example, CD-ROM to optical or optical to tape).

The compaction process copies all files from a piece of media that have 
associated file tags on the extended drive, into the media folder on the 
extended drive to which the media is assigned. Then the media is 
automatically removed from the media folder. The compacted files (those 
placed on the extended drive) remain on the extended drive until transferred 
back to storage media based on the move rules established for the media 
folder in which they reside. 

Because the files being fetched back to the extended drive during the 
compaction have already been written to media once, they will probably 



Managing Storage Media

80 Second Edition
StorageTek Proprietary

qualify for movement back to media as soon as they are written to the drive. 
This means that those files will be re-written out to media as soon as the Move 
files to media schedule is active. 

Once a piece of media has been compacted, it can be reformatted for reuse or 
removed from the system (depending upon the type of media). 

Note: For the best compaction results, you should have at least the 
equivalent of one side of the media available as free space on the 
extended drive. 

Note: If you are planning to use the compaction function to transfer all of your 
files from one type of media to another, please refer to the Moving 
Files from One Media Type to Another chapter of the ASM Upgrade 
Guide for additional information and other Data Manager settings 
recommendations. 

There are two ways to set up compaction of media:

• Set up automatic media labeling and compaction for your move group. 
Automatic compaction allows you to automatically compact media in a 
move group whenever the amount of wasted space on a piece of media 
exceeds a specified watermark. Automatic media labeling and compaction 
is configured on the Automation tab of the Move Group Properties dialog 
box. For more information, see “The Automation Tab” on page 174. This 
option allows you to simply load and format media, and then let other 
media maintenance activity be triggered by internal ASM events.

• Assign the compact media task. For instructions, see "Using the Compact 
Media Task, " which follows. This option is best used if you want to 
compact a single piece of media.

Note: If media compaction fails, some, all, or none of the files from the media 
may have been moved back to the extended drive. If the cause of the 
compaction failure can be determined, make the appropriate 
adjustments and reschedule the compaction. The compaction process 
will start over, but any files already copied back to the extended drive 
will not be duplicated. In addition, all files that have been compacted 
will be re-migrated to media as they qualify for movement.

Using the Compact Media Task
You can assign the compact media task to a single piece of media to manually 
compact the media when necessary. 

If, during the processing of the compaction task for a piece of media, the 
extended drive becomes so full as to not be able to receive any more files, the 
compact task for the media goes into a Suspended state for one hour. In 
addition, if you assigned the compact task to other media, those media are not 
processed until the original hour (for which the attempted compact task was 
suspended) has expired. After an hour has passed, Data Manager retries the 
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original compaction, and if the task is successful, processes any remaining 
compaction tasks.

This suspension of all compact tasks accomplishes two things: it allows Data 
Manager to move and purge files in order to clear needed extended drive 
space, and it ensures that drives, which may be needed to complete other 
media functions, are not being used to attempt compact tasks that can not 
succeed until there is sufficient space on the extended drive. 

To assign a compact task:

1. Open the Media Tasks page. You have the following choices:

• In the tree view of the Administrator, right-click the piece of media to 
which you want to add the compact media task and then select Edit 
Tasks from the shortcut menu that appears.

• Press <CTRL>+T, or open the Tools menu and then select Media Task 
Manager to open the Media Task Queue Manager. If the media already 
has tasks assigned to it, select the media and then click Edit Tasks. If 
the media does not have tasks already assigned to it, click Add New 
Media. The Select Media for New Tasks page appears listing all media 
that do not currently have tasks assigned to them. Select the piece of 
media to which you want to assign the compact media task and then 
click Next.

2. From the Next Task drop-down list, select the compact media task and 
then click Add Next Task. The compact task appears in the Task List, and 
the Options and When To Process regions of the Media Tasks page 
become available.

Figure 29.  Compact Media Task 

3. Select whether to process the media task as soon as possible or on a 
scheduled basis. If you choose to process the media task on a scheduled 
basis, the task is not processed until the Process scheduled media tasks 
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schedule is active. For information on configuring media activity 
schedules, see “Scheduling Media Activities” on page 52.

Note: If you assign multiple tasks for media, be advised that all tasks for 
that media will have the same When to Process option, since all 
tasks for a piece of media are processed at once. If one task has 
the ASAP – as soon as possible option selected, all tasks for that 
piece of media will process ASAP by default. 

4. Once tasks have been added and configured as needed in the Media 
Tasks page, you have the following choices: 

• If you added the task through the Media Task Queue Manager, click 
Finish. The Media Task Queue Manager dialog box appears with the 
media listed and the task pending.

• If you added the task using the Edit Tasks option on either the shortcut 
menu for the media or the Edit menu, click Next. The Order Media in 
Task Queue page appears with the recently added media at the bottom 
of the media task queue list.

5. To promote the selected piece of media so that the media tasks for the 
media are processed before other media in the queue, click the up arrow 
button to the right of the list box. You can also demote a piece of media in 
the list by selecting the media and then clicking the down arrow to the right 
of the list box. When you finish, click Finish or Close as appropriate.

All media with tasks assigned appear in the Media Task Queue Manager until 
they are processed. For media with tasks selected to process ASAP – as soon 
as possible, those media may only appear briefly in the queue before the 
processing completes and the media is removed from the queue.

Note: If the extended drive fills up before a compact task can complete, the 
task is stopped, and the media is listed in the queue with a status of 
“Suspended.” The compact task is retried in one hour. In addition, no 
other compact tasks are allowed to start until the hour has expired. 

Finalizing Media
If you are finished writing files to a piece of DVD-R media, you can finalize the 
media using the finalize media task. Finalization is a process of “closing” the 
media, making it read-only and preventing ASM from writing any more files to 
it. Finalizing media makes the media more stable, better protecting the data on 
the media. It also allows the media to be taken out of the ASM system and 
read on a computer with the Windows XP operating system. 

Original DVD-R media must be removed from the move group (but must 
remain in the media folder) before it can be finalized. You can assign the 
finalize task to copy DVD-R media at any time. 
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Note: If you are maintaining copies of your DVD-R media, it is highly 
recommended that you update your copies immediately following 
finalization of the originals, to ensure the copies are complete. Then, 
finalize the copies to ensure the security of the data on the DVD-R 
copy. 

For DVD-R media, the finalize media task contains two options: Purge Files 
and Direct Read. (These options are grayed out if you are finalizing Copy 
media.) 

If you enable the Purge Files option, the file data for the files written to the 
media is immediately purged from the extended drive. If you do not enable this 
option, those files remain on the extended drive until they qualify for 
configured purge rules.

If you enable the Direct Read (read files directly from media) option, the files 
written to the media are marked for direct read after the files are purged from 
the extended drive (either as part of the finalize media task or as they qualify 
for configured purge rules). 

Note: If for some reason the finalization task fails, do not attempt to re-try the 
task. Failing finalization may indicate a problem with the media, and 
because of this you may want to remove the media from your system. 
Removing media that has failed finalization from a media folder “de-
migrates” files, making them eligible for re-migration to other media. 
When removing this media from its media folder, click Yes to run a 
drive scan when prompted.

To finalize a piece of media:

1. Open the Media Tasks page. You have the following choices:

• In the tree view of the Administrator, right-click the piece of media to 
which you want to add the finalize media task and then select Edit 
Tasks from the shortcut menu that appears.

• Press <CTRL>+T, or open the Tools menu and then select Media Task 
Manager to open the Media Task Queue Manager. If the media already 
has tasks assigned to it, select the media and then click Edit Tasks. If 
the media does not have tasks already assigned to it, click Add New 
Media. The Select Media for New Tasks page appears listing all media 
that do not currently have tasks assigned to them. Select the piece of 
media to which you want to assign the finalize media task and then 
click Next.

2. From the Next Task drop-down list, select the finalize media task and then 
click Add Next Task. The finalize task appears in the Task List, and the 
Options and When To Process regions of the Media Tasks page become 
available. 
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Figure 30.  Finalize Media Task 

3. Enable or disable the Purge Files check box. You have the following 
choices:

• Enable the check box to purge all files written to the media from the 
extended drive as soon as the media is finalized.

• Disable the check box to leave all files written to the media on the 
extended drive. These files are purged as they qualify for configured 
purge rules.

4. Enable or disable the Direct Read check box. You have the following 
choices:

• Enable the check box to apply the direct read attribute to all purged 
files. Direct read means that when accessed by a client, the file is read 
directly from media rather than fetched to the extended drive and read 
from there.

• Disable the check box to force purged files to be fetched to the 
extended drive when requested by a client. 

Note: The Purge Files and Direct Read options are grayed out if you are 
finalizing Copy media. 

5. Select whether to process the media task as soon as possible or on a 
scheduled basis. If you choose to process the media task on a scheduled 
basis, the task is not processed until the Process scheduled media tasks 
schedule is active. For information on configuring media activity 
schedules, see “Scheduling Media Activities” on page 52.

Note: If you assign multiple tasks for media, be advised that all tasks for 
that media will have the same When to Process option, since all 
tasks for a piece of media are processed at once. If one task has 
the ASAP – as soon as possible option selected, all tasks for that 
piece of media will process ASAP by default. 
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6. Once tasks have been added and configured as needed in the Media 
Tasks page, you have the following choices: 

• If you added the task through the Media Task Queue Manager, click 
Finish. The Media Task Queue Manager dialog box appears with the 
media listed and the task pending.

• If you added the task using the Edit Tasks option on either the shortcut 
menu for the media or the Edit menu, click Next. The Order Media in 
Task Queue page appears with the recently added media at the bottom 
of the media task queue list.

7. To promote the selected piece of media so that the media tasks for the 
media are processed before other media in the queue, click the up arrow 
button to the right of the list box. You can also demote a piece of media in 
the list by selecting the media and then clicking the down arrow to the right 
of the list box. When you finish, click Finish or Close as appropriate.

All media with tasks assigned appear in the Media Task Queue Manager until 
they are processed. For media with tasks selected to process ASAP – as soon 
as possible, those media may only appear briefly in the queue before the 
processing completes and the media is removed from the queue.

Removing Media from a Move Group
When you remove a piece of media from a move group, the media becomes 
unavailable for ASM to write files to it based on the move rules configured for 
that move group. However, the piece of media remains in the media folder, 
and clients can access files that reside on that media. In addition, DVD-R 
media must be removed from the move group before you can finalize it.

There are two ways to remove a piece of media from a move group:

• Open the Move Group Properties dialog box and remove the media on the 
Media tab. For instructions, see “Removing Media from a Move Group” on 
page 167. This option is best used if you want to remove multiple pieces of 
media from a move group.

• Assign a remove from move group media task. For more information, see 
"Using the Remove from Move Group Media Task, " which follows. This 
option is best used if you want to remove a single piece of media from a 
move group in conjunction with other media tasks, such as prefetch and 
remove from media folder.

Using the Remove from Move Group Media Task
The remove from move group media task removes a piece of media from a 
move group making it unavailable for ASM to write files to it based on the 
move rules configured for that move group.
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To assign a remove from move group task:

1. Open the Media Tasks page. You have the following choices:

• In the tree view of the Administrator, right-click the piece of media to 
which you want to add the remove from move group media task and 
then select Edit Tasks from the shortcut menu that appears.

• Press <CTRL>+T, or open the Tools menu and then select Media Task 
Manager to open the Media Task Queue Manager. If the media already 
has tasks assigned to it, select the media and then click Edit Tasks. If 
the media does not have tasks already assigned to it, click Add New 
Media. The Select Media for New Tasks page appears listing all media 
that do not currently have tasks assigned to them. Select the piece of 
media to which you want to assign the remove from move group media 
task and then click Next.

2. From the Next Task drop-down list, select the remove from move group 
media task and then click Add Next Task. The remove from move group 
task appears in the Task List, and the Options and When To Process 
regions of the Media Tasks page become available.

Figure 31.  Remove From Move Group Media Task 

3. Select whether to process the media task as soon as possible or on a 
scheduled basis. If you choose to process the media task on a scheduled 
basis, the task is not processed until the Process scheduled media tasks 
schedule is active. For information on configuring media activity 
schedules, see “Scheduling Media Activities” on page 52.

Note: If you assign multiple tasks for media, be advised that all tasks for 
that media will have the same When to Process option, since all 
tasks for a piece of media are processed at once. If one task has 
the ASAP – as soon as possible option selected, all tasks for that 
piece of media will process ASAP by default. 
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4. Once tasks have been added and configured as needed in the Media 
Tasks page, you have the following choices: 

• If you added the task through the Media Task Queue Manager, click 
Finish. The Media Task Queue Manager dialog box appears with the 
media listed and the task pending.

• If you added the task using the Edit Tasks option on either the shortcut 
menu for the media or the Edit menu, click Next. The Order Media in 
Task Queue page appears with the recently added media at the bottom 
of the media task queue list.

5. To promote the selected piece of media so that the media tasks for the 
media are processed before other media in the queue, click the up arrow 
button to the right of the list box. You can also demote a piece of media in 
the list by selecting the media and then clicking the down arrow to the right 
of the list box. When you finish, click Finish or Close as appropriate.

All media with tasks assigned appear in the Media Task Queue Manager until 
they are processed. For media with tasks selected to process ASAP – as soon 
as possible, those media may only appear briefly in the queue before the 
processing completes and the media is removed from the queue.

Removing Media from a Media Folder
Removing media from a media folder generally removes all files (and file tags) 
on that media from the extended drive. Once the media is removed, the files 
on the media only exist on the media and no longer on the extended drive. 
Removing media from a media folder does not delete the files from media.

When you remove non-finalized DVD-R media, however, you can choose 
whether you want to remove the files from the extended drive or de-migrate 
the files, leaving them on the extended drive and marking them as not 
migrated. Once the media is removed, the files on the media exist on both the 
media and the extended drive. De-migrating files allows you to re-migrate the 
files to another piece of media. This option is available only for DVD-R media.

When you remove media from a media folder, the media is also automatically 
removed from the media folder’s move group (if the media is still assigned to 
the move group).

Removing media from a media folder requires an extended drive scan to 
remove the files from the extended drive or to de-migrate them. You can run a 
drive scan after each piece of media is removed (when prompted) or run a 
single drive scan after all of the media is removed. 

After the drive scan(s) finish, the media is then placed in the Original Media list 
until it is moved back into a media folder, deallocated from the extended drive, 
or reformatted.
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Note: To maintain immediate availability of files on media that has been 
removed from a media folder, compact the media before removing it 
from the media folder. For instructions, see “Compacting Media” on 
page 79.

There are four ways you can remove media from a media folder:

• Right-click the piece of media and select Remove from the shortcut menu. 
For more information, see "Using the Shortcut Menu, " which follows. This 
option is best used if you want to remove a single piece of media from a 
media folder.

• Use the Remove Media from Media Folders command for an extended 
drive to launch the Remove Media from Media Folders Wizard. For more 
information, see “Using the Remove Media from Media Folders Wizard” on 
page 90. This option is best used if you want to remove multiple pieces of 
media from several media folders.

• Right-click the Media node under a media folder and select Remove Media 
from the shortcut menu. This also launches the Remove Media from Media 
Folders Wizard. This option is best used if you want to remove multiple 
pieces of media from a single media folder.

• Assign a remove from media folder media task. For more information, see 
“Using the Remove from Media Folder Media Task” on page 92. This 
option is best used if you want to remove a single piece of media from a 
media folder in conjunction with other media tasks, such as remove from 
move group.

Note: Before you remove media from media folders, be sure that all pending 
tasks for the media have been processed or deleted. You cannot 
remove media from media folders if there are pending tasks for the 
media. In addition, you may not be able to remove media if it is in an 
error state. For more information on deleting tasks, see “Deleting 
Media Tasks” on page 46. For more information on clearing media 
error states, see “Clearing Task Error Status” on page 41. 

Using the Shortcut Menu
You can remove a single piece of media from its assigned media folder using 
the shortcut menu for the selected piece of media.

To remove media from a media folder using the shortcut menu:

1. Right-click the piece of media you want to remove from the media folder 
and select Remove from the shortcut menu that appears. One of the 
following occurs:

• If you are removing non-finalized DVD-R media, a warning message 
appears.
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Figure 32.  Migrated File Options Warning 

If you do not want to remove the media from the media folder, click No. For 
more information on finalizing media, see “Finalizing Media” on page 82.

If you want to proceed and remove the media from the media folder, click 
Yes. The Remove Media from Media Folders Wizard appears, starting with 
the Migrated File Options page.

Note: We strongly recommend that you finalize DVD-R media before 
removing it from a media folder. Finalizing media before removing 
it decreases the likelihood of media corruption and increases the 
likelihood that you will be able to access the files on the media in 
the event that you choose to add it back to a media folder later.

• If you are removing other media types (besides non-finalized DVD-R 
media), the Remove Media from Media Folders Wizard appears, 
starting with the Migrated File Options page. 

Figure 33.  Remove Media from Media Folders Wizard - Migrated File 
Options Page 

2. If you are removing DVD-R media that has not been finalized, choose 
whether to delete the files from the extended drive or to de-migrate the 
files by enabling the corresponding option.

Note: If you are removing finalized DVD-R media or any other media 
type, the delete option is selected by default and cannot be 
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changed. If you are removing DVD-R media that has failed 
finalization, the de-migration option is selected by default and 
cannot be changed.

3. Click Next. The summary page appears.

4. Review the information in the summary.

5. If the information in the summary is correct, click Finish. A message 
appears stating that a drive scan must be run to complete removal of the 
media.

6. Click Yes to run the drive scan immediately, or click No to run the drive 
scan later. For more information on drive scans, see “Running Drive 
Scans” on page 276. Once a drive scan is run, the media is removed from 
the media folder and appears in the Original node of the Available Media 
tree for the extended drive.

Using the Remove Media from Media Folders Wizard
The Remove Media from Media Folders Wizard allows you to remove multiple 
pieces of media from a media folder at the same time.

To remove media from a media folder using the wizard:

1. You have the following choices:

• Right-click the extended drive that contains the media folder from 
which you want to remove media and then select Remove Media from 
Media Folders from the shortcut menu that appears.

• Right-click the Media node under the media folder from which you 
want to remove media and select Remove Media from the shortcut 
menu. 

The Remove Media from Media Folders Wizard appears.
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Figure 34.  Remove Media from Media Folders Wizard - Select Media 
Page 

2. Select the media you want to remove from the media folder(s) and then 
click Next. One of the following occurs:

• If you are removing non-finalized DVD-R media, a warning message 
appears.

Figure 35.  Migrated File Options Warning 

If you do not want to remove the media from the media folder, click No. For 
more information on finalizing media, see “Finalizing Media” on page 82.

If you want to proceed and remove the media from the media folder, click 
Yes. The Remove Media from Media Folders Wizard appears, starting with 
the Migration File Options page.

Note: We strongly recommend that you finalize DVD-R media before 
removing it from a media folder. Finalizing media before removing 
it decreases the likelihood of media corruption and increases the 
likelihood that you will be able to access the files on the media in 
the event that you choose to add it back to a media folder later.

• If you are removing other media types (besides non-finalized DVD-R 
media), the Remove Media from Media Folders Wizard appears, 
starting with the Migrated File Options page. 
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Figure 36.  Remove Media from Media Folders Wizard - Migrated File 
Options Page 

3. If you are removing DVD-R media that has not been finalized, choose 
whether to delete the files from the extended drive or to de-migrate the 
files by enabling the corresponding options.

Note: If you are removing finalized DVD-R media or any other media 
type, the delete option is selected by default and cannot be 
changed. If you are removing DVD-R media that has failed 
finalization, the de-migration option is selected by default and 
cannot be changed.

4. Click Next. The summary page appears.

5. Review the information in the summary.

6. If the information in the summary is correct, click Finish. A message 
appears stating that a drive scan must be run to complete removal of the 
media.

7. Click Yes to run the drive scan immediately, or click No to run the drive 
scan later. For more information on drive scans, see “Running Drive 
Scans” on page 276. Once a drive scan is run, the media is removed from 
the media folder and appears in the Original node of the Available Media 
tree for the extended drive.

Using the Remove from Media Folder Media Task
You can assign the remove from media folder task to automatically remove 
media from a media folder. Any piece of media in a media folder can be 
scheduled for removal, but all other pending tasks must have been carried out 
for the media before the media is removed.
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To assign a remove from media folder task:

1. Open the Media Tasks page. You have the following choices:

• In the tree view of the Administrator, right-click the piece of media to 
which you want to add the remove from media folder media task and 
then select Edit Tasks from the shortcut menu that appears.

• Press <CTRL>+T, or open the Tools menu and then select Media Task 
Manager to open the Media Task Queue Manager. If the media already 
has tasks assigned to it, select the media and then click Edit Tasks. If 
the media does not have tasks already assigned to it, click Add New 
Media. The Select Media for New Tasks page appears listing all media 
that do not currently have tasks assigned to them. Select the piece of 
media to which you want to assign the remove from media folder 
media task and then click Next.

From the Next Task drop-down list, select the remove from media folder 
media task and then click Add Next Task. One of the following occurs:

• If you are assigning the task to non-finalized DVD-R media, a warning 
message appears.

Figure 37.  Migrated File Options Warning 

If you do not want to remove the media from the media folder, click No. For 
more information on finalizing media, see “Finalizing Media” on page 82.

If you want to proceed and remove the media from the media folder, click 
Yes. The remove from media folder task appears in the Task List, and the 
Options and When To Process regions of the Media Tasks page become 
available.

Note: We strongly recommend that you finalize DVD-R media before 
removing it from a media folder. Finalizing media before removing 
it decreases the likelihood of media corruption and increases the 
likelihood that you will be able to access the files on the media in 
the event that you choose to add it back to a media folder later.

• If you are assigning the task to other media types (besides non-
finalized DVD-R media), the remove from media folder task appears in 
the Task List, and the Options and When To Process regions of the 
Media Tasks page become available.
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Figure 38.  Remove from Media Folder Media Task 

2. If you are removing DVD-R media that has not been finalized, choose 
whether to delete the files from the extended drive or to de-migrate the 
files by selecting the corresponding option.

Note: If you are removing finalized DVD-R media or any other media 
type, the delete option is selected by default and cannot be 
changed. If you are removing DVD-R media that has failed 
finalization, the de-migration option is selected by default and 
cannot be changed.

3. Select whether to process the media task as soon as possible or on a 
scheduled basis. If you choose to process the media task on a scheduled 
basis, the task is not processed until the Process scheduled media tasks 
schedule is active. For information on configuring media activity 
schedules, see “Scheduling Media Activities” on page 52.

Note: If you assign multiple tasks for media, be advised that all tasks for 
that media will have the same When to Process option, since all 
tasks for a piece of media are processed at once. If one task has 
the ASAP – as soon as possible option selected, all tasks for that 
piece of media will process ASAP by default. 

4. Once tasks have been added and configured as needed in the Media 
Tasks page, you have the following choices: 

• If you added the task through the Media Task Queue Manager, click 
Finish. The Media Task Queue Manager dialog box appears with the 
media listed and the task pending.

• If you added the task using the Edit Tasks option on either the shortcut 
menu for the media or the Edit menu, click Next. The Order Media in 
Task Queue page appears with the recently added media at the bottom 
of the media task queue list.
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5. To promote the selected piece of media so that the media tasks for the 
media are processed before other media in the queue, click the up arrow 
button to the right of the list box. You can also demote a piece of media in 
the list by selecting the media and then clicking the down arrow to the right 
of the list box. When you finish, click Finish or Close as appropriate.

All media with tasks assigned appear in the Media Task Queue Manager until 
they are processed. For media with tasks selected to process ASAP – as soon 
as possible, those media may only appear briefly in the queue before the 
processing completes and the media is removed from the queue.

Deallocating Media from the Extended Drive
When you deallocate media from an extended drive, ASM can no longer use 
the media for file storage. It is completely removed from the system.

You can deallocate ASM MediaStor, Network Attached Storage (NAS), EMC 
Centera (EMC), and Tivoli Storage Manager (TSM) media using either the 
shortcut menu or the Media Service Properties dialog box. 

To deallocate MediaStor, NAS, EMC, and TSM media, the media service 
should be online. If you attempt to deallocate media while the media service is 
offline, the changes might not take effect.

Note: You can also deallocate MediaStor media through the MediaStor 
Administrator. Once you have deallocated media for the extended 
drive Application Pool, the corresponding change appears in the Data 
Manager Administrator. For more information, refer to your ASM 
MediaStor System Guide.

To deallocate StorageTek’s Automated Cartridge System Library Software 
(ACSLS) media, you must remove the media association with the Data 
Manager extended drive through the UNIX interface.

Note: You cannot deallocate media from an extended drive unless it has 
been removed from its media folder. For instructions, see “Removing 
Media from a Media Folder” on page 87. The media then appears in 
the Original node of the Available Media tree.

For more information, see the following sections:

• "Using the Shortcut Menu, " which follows

• “Using the Media Service Properties Dialog Box” on page 96

• “Deallocating ACSLS Media” on page 96

Using the Shortcut Menu
You can deallocate specific pieces of MediaStor, NAS, EMC, or TSM media 
using the shortcut menu that appears when you right-click on the media in the 
Original node of the Available Media tree for the extended drive.



Managing Storage Media

96 Second Edition
StorageTek Proprietary

Note: To deallocate MediaStor, NAS, EMC, and TSM media, the media 
service should be online. If you attempt to deallocate media while the 
media service is offline, the changes may not take effect.

To deallocate media using the shortcut menu:

1. Right-click the media you want to deallocate from the extended drive, and 
then select Deallocate from the shortcut menu that appears. A 
confirmation message appears. 

2. Click Yes to deallocate the selected media, or click No to cancel the 
deallocation.

Using the Media Service Properties Dialog Box
You can deallocate multiple pieces of MediaStor, NAS, EMC, or TSM media 
through the Media Service Properties dialog box.

Note: To deallocate MediaStor, NAS, EMC, and TSM media, the media 
service should be online. If you attempt to deallocate media while the 
media service is offline, the changes may not take effect.

To deallocate media using the Media Service Properties dialog box:

1. From the Service menu, select Configure Media Services. The Configure 
Media Services dialog box appears. 

2. Select the media service and click Properties, or double-click the media 
service. The Media Service Properties dialog box appears.

3. Click the Media List tab.

4. Double-click the media you want to deallocate from the extended drive, or 
select the media you want to deallocate and then click Deallocate. The 
Media Service Properties dialog box reappears, and the selected media is 
listed with no assigned extended drive. 

5. Click OK to return to the Configure Media Services dialog box.

6. Click Close to close the Configure Media Services dialog box.

Deallocating ACSLS Media
Deallocating ACSLS media from an extended drive is done by reassigning 
that media back to the system (making the “system” the owner of the media). 
This section describes how to assign media back to the system, effectively 
removing it from the Data Manager extended drive (and the ASM system 
altogether). All commands described in this procedure are entered on the Sun 
computer where ACSLS is installed.
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To assign media back to the system:

1. In the ACSSS Console, change to the appropriate directory. Type the 
following command and press <Return>:

cd /export/home/ACSSS/data/external/volrpt 

2. In the ACSSS Console, request owner information to find the media that 
you want to deallocate. Type the following command and press <Return>:

volrpt –f owner_id.volrpt –a x 

The placeholder x represents the ACS ID. A list will be displayed showing 
the owner of each media. Refer to the following example:

VOLUME REPORT UTILITY

2000-10-05 11:06:52

TOTAL VOLUMES: 2SEQUENCE: sort by volume identifier

Volume      Volume          Owner

Label:      Status:         ID:

000182      VOLUME_HOME     SYSTEM

004022      VOLUME_HOME     DX_BENCH_E

In this example, the media with volume label 000182 is currently 
unassigned. The media with volume label 004022 is currently assigned to 
DX_BENCH_E (the extended drive E on the computer BENCH).

3. In the ACSSA Command Processor Window, assign the media to system. 
Type the following command and press <Return>:

set owner “System” VOL MediaRange 

In this command, the placeholder MediaRange represents the range of 
numbers for the media that you want to deallocate. The following example 
assigns the media numbered from 060945 to 060948 to the system, which 
deallocates it from the extended drive to which it had been allocated:

set owner “System” VOL 060945-060948

When the new assignment is completed, the following message appears 
in the ACSSA Command Processor Window: “Set: set completed, 
Success.”

Removing Media from a Media Service
If you want to remove media from Data Manager entirely, you can delete the 
media from the media service. For more information, see the following 
sections: 
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"Removing Media from the NAS Media Service, " which follows

• “Removing Media from the TSM Media Service” on page 99

• “Removing Media from the EMC Media Service” on page 100

• “Removing a Drive from the ACSLS Media Service” on page 102

Note: If you want to remove media from the MediaStor media service, you 
must do so through the MediaStor Administrator. For more information, 
refer to the Managing MediaStor Media chapter of the ASM MediaStor 
System Guide.

If you are planning to delete EMC or TSM media, we strongly recommend that you 
compact the media so that any migrated files are written back to the extended drive. 
This is because EMC and TSM media is “virtual” media, and deleting it removes the 
relationships created between the pointers used by Data Manager and the file data on 
the media. After deletion, Data Manager will never again be able to access files on the 
media. For more information on compacting media, see “Using the Compact Media 
Task” on page 80. For more information on transferring files from one type of media to 
another, refer to the Moving Files from One Media Type to Another chapter of the 
ASM Upgrade Guide.

Removing Media from the NAS Media Service
The Media Service Properties dialog box allows you to delete a piece of NAS 
media. You must be a member of the DXAdministrators group to delete media, 
and the NAS media service should be online when removing media. If you 
attempt to delete media while the media service is offline, the changes may 
not take effect. For more information on the DXAdministrators group, refer to 
the Planning Your Data Manager System chapter of the ASM Data Manager 
Getting Started Guide.

To remove a piece of NAS media from the NAS media service:

1. From the Service menu, select Configure Media Services. The Configure 
Media Services dialog box appears.

2. Make sure that the NAS media service is online. If the media service is not 
online, select the media service and click Set Online.

3. Select the NAS media service and click Properties, or double-click the 
media service. The Media Service Properties dialog box appears.
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Figure 39.  NAS Media Service Properties Dialog Box with Media 

4. Make sure that the media you want to remove has been deallocated from 
the extended drive. For instructions, see “Deallocating Media from the 
Extended Drive” on page 95.

5. Select the media you want to remove and then click Delete. A confirmation 
message appears.

6. Click Yes. The Media Service Properties dialog box appears, without the 
NAS media.

7. Click OK to save your changes and close the Media Service Properties 
dialog box. The Configure Media Services dialog box appears.

8. Click Close to return to the Administrator window.

Removing Media from the TSM Media Service
The Media Service Properties dialog box allows you to remove a piece of TSM 
media from the TSM media service. The appropriate delete privileges must be 
set for the client node in the Tivoli Storage Manager before you can remove 
TSM media from Data Manager. If the media has the backup attribute, for 
example, you need to make sure the backup delete option is enabled.

In addition, you must be a member of the DXAdministrators group to remove 
media, and the TSM media service should be online. If you attempt to remove 
media while the media service is offline, the changes may not take effect. For 
more information on the DXAdministrators group, refer to the Planning Your 
Data Manager System chapter of the ASM Data Manager Getting Started 
Guide.

Note: If you are planning to delete TSM media, we strongly recommend that 
you compact the media so that any migrated files are written back to 
the extended drive. This is because TSM media is “virtual” media, and 
deleting it removes the relationships created between the pointers 
used by Data Manager and the file data on the media. After deletion, 
Data Manager will never again be able to access files on the media. 
For more information on compacting media, see “Using the Compact 
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Media Task” on page 80. For more information on transferring files 
from one type of media to another, refer to the Moving Files from One 
Media Type to Another chapter of the ASM Upgrade Guide.

To remove a piece of virtual TSM media from the TSM media service:

1. From the Service menu, select Configure Media Services. The Configure 
Media Services dialog box appears.

2. Make sure that the TSM media service is online. If the media service is not 
online, select the media service and click Set Online.

3. Select the TSM media service and click Properties, or double-click the 
media service. The Media Service Properties dialog box appears.

Figure 40.  TSM Media Service Properties Dialog Box – Media List Tab 
with Media 

4. Make sure that the media you want to remove has been deallocated from 
the extended drive. For instructions, see “Deallocating Media from the 
Extended Drive” on page 95.

5. Select the media you want to remove and then click Delete. A confirmation 
message appears.

6. Click Yes. The Media Service Properties dialog box appears, without the 
media.

7. Click OK to save your changes and close the Media Service Properties 
dialog box. The Configure Media Services dialog box appears.

8. Click Close to return to the Administrator window.

Removing Media from the EMC Media Service
The Media Service Properties dialog box allows you to delete a piece of EMC 
media. You must be a member of the DXAdministrators group to delete media, 
and the EMC media service should be online when removing media. If you 
attempt to delete media while the media service is offline, the changes may 
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not take effect. For more information on the DXAdministrators group, refer to 
the Planning Your Data Manager System chapter of the ASM Data Manager 
Getting Started Guide. 

Note: If you are planning to delete EMC media, we strongly recommend that 
you compact the media so that any migrated files are written back to 
the extended drive. This is because EMC media is “virtual” media, and 
deleting it removes the relationships created between the file pointers 
used by Data Manager and the file data on the media. After deletion, 
Data Manager will never again be able to access files on the media. 
For more information on compacting media, see “Using the Compact 
Media Task” on page 80. For more information on transferring files 
from one type of media to another, refer to the Moving Files from One 
Media Type to Another chapter of the ASM Upgrade Guide. 

To remove a piece of virtual EMC media from the EMC Centera media 
service:

1. From the Administrator’s Service menu, select Configure Media Services. 
The Configure Media Services dialog box appears.

2. Make sure that the EMC Centera media service is online. If the media 
service is not online, select the media service and click Set Online.

3. Select the EMC Centera media service and click Properties, or double-
click the media service. The Media Service Properties dialog box appears. 

Figure 41.  EMC Centera Media Service Properties Dialog Box – Media 
List Tab with Media 

4. Select the media you want to remove and then click Delete. A confirmation 
message appears.

5. Click Yes. The Media Service Properties dialog box appears, without the 
media.

6. Click OK to save your changes and close the Media Service Properties 
dialog box. The Configure Media Services dialog box appears.
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7. Click Close to return to the Administrator window.

Removing a Drive from the ACSLS Media Service
The Media Service Properties dialog box allows you to remove a drive from 
the ACSLS media service.

Note: To remove a drive, the media service must be offline.

To remove a drive from the ACSLS media service:

1. From the Data Manager Administrator’s Service menu, select Configure 
Media Services. The Configure Media Services dialog box appears.

2. Set the ACSLS media service offline by selecting the media service and 
clicking Set Offline.

3. Select the ACSLS media service and click Properties or double-click the 
media service. The Media Service Properties dialog box appears.

Figure 42.  ACSLS Media Service Properties Dialog Box 

4. Select the drive(s) you want to remove and click Delete. A confirmation 
message appears.

5. Click Yes. The Media Service Properties dialog box appears without the 
deleted drive. 

6. Click OK to close the Media Service Properties dialog box. The Configure 
Media Services dialog box appears.

7. Click Close to return to the Administrator window.

Removing Media Services
If you are no longer using a media service, you can delete the media service.
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To delete a media service:

1. Make sure that all media have been deallocated from extended drives. For 
instructions, see “Deallocating Media from the Extended Drive” on 
page 95.

2. From the Service menu of the Administrator, select Configure Media 
Services, or click the Configure Media Services toolbar button.

Figure 43.  Configure Media Services Toolbar Button 

The Configure Media Services dialog box appears.

3. Before you delete a media service, it must be offline. Select the media 
service you want to delete and then click Set Offline. A confirmation 
message appears. Click Yes.

4. Select the media service you want to delete and then click Delete. A 
confirmation message appears.

5. Click Yes. The media service is deleted and the Configure Media Services 
window appears without the deleted media service.

6. Click Close to close the Configure Media Services dialog box.

■ Maintaining and Backing Up Media
Copy media are media that are being used as copies, or backups, of Original 
media on the ASM Data Manager extended drive. If an Original piece of media 
becomes unreadable, the copy of the media can be promoted to an Original 
piece of media (after the original is removed from the system). You can create 
copy media of all media types except for NAS, TSM, EMC, CD-ROM, and 
DVD-ROM media. For NAS media, we recommend that you use a third-party 
backup system. CD-ROM and DVD-ROM media are read-only.

If a piece of media becomes corrupt, you can run a check disk media task to 
scan the files on the media and attempt to repair the media.

For more information, see the following sections:

• "Creating and Managing Copies of Media, " which follows

• “Running Check Disk on a Piece of Media” on page 113

Creating and Managing Copies of Media
Copy media is useful as a backup for original media. In the event the original 
piece of media is lost or damaged, it may become necessary to replace the 
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original using the copy. Copy media has the same label as the original it 
corresponds to, but has a unique serial number. However, as soon as the copy 
is promoted to original, the serial number on the copy is changed to match the 
serial number that was on the original. For this reason, once promoted, you 
should leave the promoted copy as the original. If you try to replace the 
original back into the system, Data Manager will see the media as a duplicate, 
and will not be able to use it. 

Note: Since Data Manager cannot change the serial number on write-once 
media (DVD-R, WORM, WORM-tape), Data Manager tracks the serial 
number internally, and equates the copy serial number with the original 
when copies of these media types are promoted. For this reason, if you 
promote a piece of write-once copy media, remove it from the ASM 
system, and then re-add it later, the media will again be seen as a 
copy, and must be re-promoted. 

Copy media can be created for any piece of media that is allocated to an 
extended drive and is formatted and labeled for use. This media can reside in 
the Original node of the Available media tree, or be assigned to a media folder. 
You can create copies of all media types except for NAS, TSM, EMC, DVD-
ROM, and CD-ROM media.

There are two ways to create copy media:

• If you want to create copies of multiple pieces of media, use the Copy 
Media Manager.

• If you want to create a copy of a single piece of media, assign the label 
copy media task. 

ASM updates all copy media according to the Update copy media schedule. 
For more information, see “Updating Copy Media” on page 50.

Once a copy is created, whether through the Copy Media Manager or 
assigned as a separate media task, the Copy Media Manager allows you to 
view the update status of all copy media and when necessary, promote the 
copy to original, in the event a piece of original media becomes corrupted.

For more information, see the following sections:

• "Choosing Media to Use as a Copy, " which follows

• “Copies from DX 4.x” on page 105

• “Remote Media Copies” on page 105

• “Creating a Copy” on page 106

• “Viewing the Status of Copy Media” on page 111

• “Promoting Copy Media to Original Media” on page 112
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Choosing Media to Use as a Copy
The blank media selected for copy must match the original. The following must 
be identical for the original and the copy media:

• Media type (for example, tape must be used to copy tape, WORM must be 
used to copy WORM, etc.)

• File system (for example, NTFS media must be copied to NTFS media)

• Block size/sector size (for information on setting block size for tape or 
WORM-tape media, see “Tape Block Size Default Value” on page 304) 

• Total media capacity 

• Compression settings (in other words, both must be compressed or both 
must be uncompressed)

You can create copies of all media types except for NAS, TSM, EMC, DVD-
ROM, and CD-ROM media.

Note: For double-sided media in standalone drives, ASM allows you to 
create a copy of an original piece of media on the flip side of that same 
piece of media. However, if you use the other side of an original for its 
copy, ASM is unable to update the copy.

Copies from DX 4.x
ASM 4.x copy media is formatted using unique serial numbers. This is 
compatible with the ASM copy media format. Once ASM is installed and the 
media from the DX 4.2 system is added to the ASM system, these media are 
added to the Copy list under the Available Media tree. 

Remote Media Copies
ASM supports remote media copying, meaning that original media and their 
associated copies can reside in different hardware devices, and even in 
different geographical locations. This capability allows you to create and 
maintain off-site copies of original media for disaster recovery.

Data Manager allows you to create remote copies in two ways:

• Assign the label copy media task to a blank piece of media

• Use the Copy Media Manager

Creating remote copies using the label copy task is the same as creating 
copies on the local device using the label copy task. (For more information on 
using the label copy task, see “Using the Label Copy Media Task” on 
page 109.) Just be sure that when you select the media to which you want to 
assign the task, you select media that is resident in the remote device. To 
determine which media service the media belongs to, select the media in the 
tree view of the Administrator. The physical location of the media, as well as 
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other information about the media, appears in the description view (bottom 
right pane). 

In addition, if you are planning to use the label copy task to create remote 
copies, you may want to more specifically identify the location of the remote 
media using the editable Offline Location text box available through the 
Location tab of the Media Properties dialog box. For more information, see 
“The Location Tab” on page 29.

Creating remote copies using the Copy Media Manager is a bit more 
complicated, in that doing so involves bypassing built-in ASM functionality that 
is designed to enhance performance. The Copy Media Manager does not 
allow you to specifically select which blank media are used to make copies of 
the selected originals. By default, Data Manager selects local blank 
media.This means that to make remote copies of media using the Copy Media 
Manager (which is more efficient if you plan to make copies of multiple 
originals), you must not have any blank media in the local media service. This 
forces Data Manager to select blank media from a remote media service. 

In addition, if you want all of your remote copies to reside in the same location, 
you must make sure that the remote media service that is to contain the 
copies is the only one that contains blank media. For more information on 
making copies with the Copy Media Manager, see “Using the Copy Media 
Manager” on page 107.

As with all media, you can determine the location of the media by looking at 
the Physical Location field in the description view of the Administrator when 
the media is selected. In addition, as stated above, it may be helpful to use the 
editable Offline Location text box located on the Location tab of the Media 
Properties dialog box to more specifically identify the location of all remote 
media, regardless of the media’s classification or use. For more information, 
see “The Location Tab” on page 29.

Creating a Copy
You can create a copy of media using either the Copy Media Manager or the 
label copy media task. 

The Copy Media Manager is intended for the following circumstances:

• You need to label multiple pieces of media for use as copies.

• Both sides of the original media are original, and both sides of the blank 
media are blank and will be used as copies.

The label copy media task is intended primarily to assign the task to individual 
pieces or sides of media and for circumstances such as:

• You need to label a copy for a single side of an original piece of media. 

• You need to copy from a standalone drive to a library drive or vice versa, 
or between two standalone drives.
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• You need to schedule a label copy in conjunction with another task, such 
as format. 

For more information, see the following sections:

• "Using the Copy Media Manager, " which follows

• “Using the Label Copy Media Task” on page 109

Using the Copy Media Manager
The Copy Media Manager allows you to create copies of multiple pieces of 
blank media (formatted but not labeled) at once. Essentially, you are assigning 
the label copy media task to multiple pieces of media. For more information, 
see “Using the Label Copy Media Task” on page 109. You can also view and 
edit the task through the Media Task Queue Manager. For more information, 
see “Media Tasks” on page 34. 

Note: When using the Copy Media Manager to create copy media, the task is 
set to automatically process ASAP – as soon as possible. To change 
the processing to Scheduled – Next active task schedule, you must 
change the status using the Edit Tasks function. For instructions, see 
“Editing Media Tasks” on page 42.

To create a copy using the Copy Media Manager:

1. Press <CTRL>+C, or, from the Tools menu, select Copy Media Manager. 
The Copy Media Manager dialog box appears.

Figure 44.  Copy Media Manager Dialog Box 

2. Click Label New Copy Media. The Label Copy Media page appears. 



Managing Storage Media

108 Second Edition
StorageTek Proprietary

Figure 45.  Label Copy Media Page 

3. You have the following choices:

• If you are creating a copy of an original piece of media that does not 
already have a copy, select Label first copy media. 

• If you are making additional copies of original media that already has a 
copy or copies, select Label additional copy media. 

4. Click Next. The Select Original Media page appears. 

Figure 46.  Select Original Media Page 

5. Select the piece(s) of media for which you would like to make copies and 
then click Next. The Summary page appears.

Note: You must always select the front and back of two-sided media to 
copy the media in this wizard. To copy a single side of a piece of 
media, use the label copy media task. For more information, see 
“Using the Label Copy Media Task” on page 109. 

6. Review the information in the summary.
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7. If it is correct, click Finish. 

Since you essentially assigned the label copy media task to multiple 
pieces of media, the task is scheduled to process when the Process 
scheduled media tasks schedule is active. For more information, see 
“Scheduling Media Activities” on page 52. You can also view and edit the 
task through the Media Task Queue Manager. For more information, see 
“Media Tasks” on page 34.

After the task completes, the media appears with the new label in the Copy 
media node of the Available Media list.

Using the Label Copy Media Task
The label copy media task allows you to assign a piece of blank media to be 
used as a copy of a piece of existing media.

Note: If you want to assign the format task to a piece of Original or 
Unformatted DVD-RAM media before you assign the label copy task, 
you must wait for the format task to complete before you can assign 
the label copy task; you cannot assign the two tasks consecutively. 

To assign a label copy task:

1. Open the Media Tasks page. You have the following choices:

• In the tree view of the Administrator, right-click the piece of media to 
which you want to add the label copy media task and then select Edit 
Tasks from the shortcut menu that appears.

• Press <CTRL>+T, or open the Tools menu and then select Media Task 
Manager to open the Media Task Queue Manager. If the media already 
has tasks assigned to it, select the media and then click Edit Tasks. If 
the media does not have tasks already assigned to it, click Add New 
Media. The Select Media for New Tasks page appears listing all media 
that do not currently have tasks assigned to them. Select the piece of 
media to which you want to assign the label copy media task and then 
click Next.

2. From the Next Task drop-down list, select the label copy media task and 
then click Add Next Task. The label copy task appears in the Task List, and 
the Options and When To Process regions of the Media Tasks page 
become available.
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Figure 47.  Label Copy Media Task 

3. From the Original Media drop-down list, select the piece of original media 
from which you want to want to make a copy.

4. Select whether to process the media task as soon as possible or on a 
scheduled basis. If you choose to process the media task on a scheduled 
basis, the task is not processed until the Process scheduled media tasks 
schedule is active. For information on configuring media activity 
schedules, see “Scheduling Media Activities” on page 52.

Note: If you assign multiple tasks for media, be advised that all tasks for 
that media will have the same When to Process option, since all 
tasks for a piece of media are processed at once. If one task has 
the ASAP – as soon as possible option selected, all tasks for that 
piece of media will process ASAP by default. 

5. Once tasks have been added and configured as needed in the Media 
Tasks page, you have the following choices: 

• If you added the task through the Media Task Queue Manager, click 
Finish. The Media Task Queue Manager dialog box appears with the 
media listed and the task pending.

• If you added the task using the Edit Tasks option on either the shortcut 
menu for the media or the Edit menu, click Next. The Order Media in 
Task Queue page appears with the recently added media at the bottom 
of the media task queue list.

6. To promote the selected piece of media so that the media tasks for the 
media are processed before other media in the queue, click the up arrow 
button to the right of the list box. You can also demote a piece of media in 
the list by selecting the media and then clicking the down arrow to the right 
of the list box. When you finish, click Finish or Close as appropriate.
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All media with tasks assigned appear in the Media Task Queue Manager until 
they are processed. For media with tasks selected to process ASAP – as soon 
as possible, those media may only appear briefly in the queue before the 
processing completes and the media is removed from the queue.

Once the task has been processed, the media appears with the new label in 
the Copy media node of the Available Media list.

Viewing the Status of Copy Media
Once you have created copy media, you can view the status of the copy in the 
Copy Media Manager. 

To view the status of copy media:

• Press <CTRL>+C, or, from the Tools menu, select Copy Media Manager. 
The Copy Media Manager dialog box appears.

Figure 48.  Copy Media Manager Dialog Box 
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The following information appears in the Copy Media Manager dialog box:

Promoting Copy Media to Original Media
If an original piece of media is lost or damaged, it may become necessary to 
replace the original using the copy. In order to use copy media as original 
media, the original piece of media must be completely removed from the 
system (removed from the media folder, deallocated from the extended drive 
and then removed from the library or drive). The copy may then be promoted 
to an original. 

If you promote a copy that is not 100% updated to an original, any changes 
not updated on the copy are lost. For this reason we recommend making sure 
that your copies are updated regularly by setting the Update copy media 
schedule to be active at regular intervals. For information on configuring 
media activity schedules, see “Scheduling Media Activities” on page 52. 

Note: Promoting copy media is intended only for disaster recovery, in the 
event an original is lost or damaged beyond repair. Once a copy has 
been promoted to original, it must remain as an original. Attempting to 
“demote” the copy and return the original back to the system is not 
supported and may result in data loss. 

Note: If you promote a copy that is “write-once” media (DVD-R, WORM or 
WORM-tape), be advised that Data Manager cannot rewrite the serial 
number on write-once media, and only tracks that information 
internally. This means that if you remove a promoted write-once copy 
from the system, and then return it to the system, Data Manager will 
again see the media as a copy. If this occurs, you can re-promote the 
copy to an original. 

For more information, see the following sections:

• "Deleting the Original from Data Manager, " which follows

Table 14.  Copy Media Manager Information

Column Description
Media Name The media label for the piece of copy media (same as 

the media label for the original)

Serial Number The unique serial number for the piece of copy media

Copy Number The number of the copy (For example, if this was the first 
copy of an original created, it would be Copy # 1; if 
another copy already existed when it was created, it 
would be Copy # 2.)

Online Whether the piece of copy media is currently online

% Complete The percentage at which the copy is currently 
synchronized to the original
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• “Promoting the Copy to an Original” on page 113

Deleting the Original from Data Manager
The first step in promoting a copy of a piece of media to an original is to delete 
the original from Data Manager. 

To delete the original media from Data Manager:

1. If the piece of media is currently assigned to a media folder, remove it from 
the media folder. For instructions, see “Removing Media from a Media 
Folder” on page 87.

2. Once the media has been removed from the media folder, deallocate the 
media from the extended drive. For instructions, see “Deallocating Media 
from the Extended Drive” on page 95. 

3. If the media is being managed by the MediaStor media service, delete the 
media from MediaStor. For instructions, refer to the Managing Storage 
Media chapter of the ASM MediaStor System Guide.

Promoting the Copy to an Original
Once the original has been deleted from the ASM system, you can promote 
the copy to replace the original. 

Note: Promoting copy media is intended only for disaster recovery, in the 
event an original is lost or damaged beyond repair. Once a copy has 
been promoted to original, it must remain as an original. Attempting to 
“demote” the copy and return the original back to the system is not 
supported and may result in data loss.

To promote the copy media to original media:

1. Press <CTRL>+C, or, from the Tools menu, select Copy Media Manager. 
The Copy Media Manager dialog box appears.

2. Select the piece of copy media you want to promote to an original.

3. Click Promote Copy to Original. A confirmation message appears.

4. Click Yes. Another confirmation message appears to let you know that the 
copy has been promoted and is no longer considered a copy. The media 
can now be added to a media folder, and files can be read from and written 
to it. 

Running Check Disk on a Piece of Media
You can assign the check disk media task to run NT’s CHKDSK.EXE on ASM 
media formatted with the NTFS file system. For rewritable media formatted 
with the ASM file system, ASM performs a scan of ASM file tags. For media 
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formatted with the UDF file system, the check disk task runs a check and 
repair utility that attempts to repair corrupt media.

The check disk media task is available for original magneto-optical and DVD-
RAM media, as well as original DVD-R media that has not been finalized.

Note: Because of some slight differences between the Windows NT NTFS 
file system and the Windows 2000 NTFS file system, the check disk 
task may not run properly when executed from a Data Manager 
installation on one platform, and performed on NTFS media formatted 
through a Data Manager installation on the other platform. 

To assign a check disk media task:

1. Open the Media Tasks page. You have the following choices:

• In the tree view of the Administrator, right-click the piece of media to 
which you want to add the check disk media task and then select Edit 
Tasks from the shortcut menu that appears.

• Press <CTRL>+T, or open the Tools menu and then select Media Task 
Manager to open the Media Task Queue Manager. If the media already 
has tasks assigned to it, select the media and then click Edit Tasks. If 
the media does not have tasks already assigned to it, click Add New 
Media. The Select Media for New Tasks page appears listing all media 
that do not currently have tasks assigned to them. Select the piece of 
media to which you want to assign the check disk media task and then 
click Next.

2. From the Next Task drop-down list, select the check disk media task and 
then click Add Next Task. The check disk task appears in the Task List, 
and the Options and When To Process regions of the Media Tasks page 
become available.

Figure 49.  Check Disk Media Task 
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3. In the Check Disk Options section, choose whether to report errors only or 
to report and fix errors when found. Errors are reported to the media log. 
For more information, see “Viewing Media Logs” on page 40.

4. Select whether to process the media task as soon as possible or on a 
scheduled basis. If you choose to process the media task on a scheduled 
basis, the task is not processed until the Process scheduled media tasks 
schedule is active. For information on configuring media activity 
schedules, see “Scheduling Media Activities” on page 52.

Note: If you assign multiple tasks for media, be advised that all tasks for 
that media will have the same When to Process option, since all 
tasks for a piece of media are processed at once. If one task has 
the ASAP – as soon as possible option selected, all tasks for that 
piece of media will process ASAP by default. 

5. Once tasks have been added and configured as needed in the Media 
Tasks page, you have the following choices: 

• If you added the task through the Media Task Queue Manager, click 
Finish. The Media Task Queue Manager dialog box appears with the 
media listed and the task pending.

• If you added the task using the Edit Tasks option on either the shortcut 
menu for the media or the Edit menu, click Next. The Order Media in 
Task Queue page appears with the recently added media at the bottom 
of the media task queue list.

6. To promote the selected piece of media so that the media tasks for the 
media are processed before other media in the queue, click the up arrow 
button to the right of the list box. You can also demote a piece of media in 
the list by selecting the media and then clicking the down arrow to the right 
of the list box. When you finish, click Finish or Close as appropriate.

All media with tasks assigned appear in the Media Task Queue Manager until 
they are processed. For media with tasks selected to process ASAP – as soon 
as possible, those media may only appear briefly in the queue before the 
processing completes and the media is removed from the queue.



Managing Storage Media

116 Second Edition
StorageTek Proprietary



Doc Name 117
StorageTek Proprietary

3Managing File Migration

The extended drive, media folders, move groups and move rules, their 
creation, and their management are what enable and automate your file 
migration and data management system. 

This chapter focuses on the management of your file migration components: 
media folders, move groups, and move rules. While you may have done some 
configuration of these components when you created them, you may have to 
make changes or updates at some point. 

For more information on managing the file migration components of ASM Data 
Manager, see the following sections:

• "Managing Media Folders, " which follows

• “Managing Move Groups” on page 119

• “Managing Move Rules” on page 134

• “Fetching Files from Media” on page 143

■ Managing Media Folders
When you create a media folder for an extended drive, you provide a specific 
folder location on the extended drive for files to be stored. When you create 
move groups and move, purge, and delete rules for a media folder, you are 
creating a data management setup for the files saved in that folder. Creating 
multiple media folders for an extended drive allows you to subdivide and 
categorize your files in a way that makes it easier to apply separate migration 
strategies to different types of files. It also allows you be very specific about 
what files are to be migrated to what pieces or types of media.

Media folders do not contain specific properties as many other components of 
ASM Data Manager do. Instead, managing media folders involves creating, 
modifying and deleting move groups and move, purge, and delete rules, and 
applying them to the appropriate files in each of the media folders on the 
extended drive. 

Media folders are listed under the extended drives for which they are 
configured. Each media folder has the move group(s) created for it and the 
media assigned to each move group, along with the move, purge, and delete 
rules listed in a tree structure below the media folder.

Each section of this chapter provides information about managing the 
components of media folders, including move groups and move rules. For 
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information and instructions on creating purge rules and delete rules, see 
“Creating a Purge Rule” on page 229 and “Creating a Delete Rule” on 
page 246. 

For information on deleting media folders, see "Deleting Media Folders, " 
which follows.

Deleting Media Folders
When you delete a media folder, you delete all of the move groups and move, 
purge, and delete rules you have created for that folder. 

You can delete each media folder individually or you can delete all the media 
folders at once. For instructions, see the following sections:

• "Deleting a Single Media Folder, " which follows

• “Deleting Multiple Media Folders” on page 118

Deleting a Single Media Folder
To delete a single media folder, you can use the shortcut menu available for 
each media folder. Before you delete the folder, be sure that you have 
removed all media from it. 

To delete individual media folders:

1. Remove all media from the media folder you plan to delete. For 
instructions, see “Removing Media from a Media Folder” on page 118.

2. In the tree view of the Administrator, right-click the media folder you want 
to remove. Select Delete (the only option) from the shortcut menu that 
appears. A confirmation message appears.

3. Click Yes. Data Manager verifies that the media folder does not contain 
media, and the media folder is removed from the extended drive. 

Deleting Multiple Media Folders
You can delete multiple media folders from an extended drive at once. 
Remember that all media must be removed from the media folders before they 
can be deleted from the extended drive. 

To delete multiple media folders:

1. Remove all media from the media folders you plan to delete. For 
instructions, see “Removing Media from a Media Folder” on page 118.

2. In the tree view of the Administrator, right-click the extended drive from 
which you want to delete media folders. Select Delete Media Folder from 
the shortcut menu that appears. The Delete Media Folder dialog box 
appears.
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Figure 50.  Delete Media Folder Dialog Box 

3. Select the folder(s) you want to delete and then click OK. The media 
folders are removed from the extended drive. 

■ Managing Move Groups
Move groups are specific groupings or pools of media within a media folder. 
When you set up a move rule for a set of files, you point to the move group of 
media to which you want those files moved. 

To use media assigned to a media folder for file migration, that media must be 
assigned to a move group within the media folder. Assigning media to different 
move groups in a media folder allows you to subdivide media within a media 
folder for separate uses. 

By assigning media to move groups, you can control which set of media files 
will be written to and where. This can be useful if segregation of data is 
necessary. For example, if you wish to separate files from different months 
onto different pieces of media within a media folder, you can create a move 
group for each month. Separate media can be assigned to each move group 
so that files for different months are not stored on the same media. 

Note: Move groups can contain only writable media. CD-ROM, DVD-ROM, 
and finalized DVD-R media, for example, cannot be assigned to a 
move group because they are read-only. 

Once you have created a move group, you can modify the media assigned to 
the move group, configure options that allow you to automate management of 
the media in the move group, and configure automatic labeling and 
compaction of the move group. You can also view a move group’s statistics 
and delete the move group. For more information, see the following sections:

• "Modifying a Move Group, " which follows

• “Deleting a Move Group” on page 133
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Modifying a Move Group
After you create a move group, you can change the group name, add and 
remove media from the group, and set different media fill options. If the media 
fill method selected is sequential, promoting and demoting media establishes 
the order in which media is filled for the move group. 

You can also configure Data Manager to automatically manage media for a 
move group based on media usage. Two of the main administrative activities 
related to move group maintenance, automatic media labeling and automatic 
media compaction, can be set to occur.

To modify a move group:

1. Right-click the move group you want to modify and then select Properties 
from the shortcut menu, or double-click the move group you want to 
modify. The Move Group Properties dialog box appears with the General 
tab active by default.

Figure 51.  Move Group Properties -- General Tab 

2. Modify the settings on each of the tabs as necessary. For more 
information, see the following sections:

• "The General Tab, " which follows

• “The Media Tab” on page 121

• “The Options Tab” on page 124

• “The Automation Tab” on page 129

• “The Statistics Tab” on page 132

3. As with most Properties functions in ASM, after making changes you have 
three options:
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• To save changes and close the Properties dialog box, click OK.

• To save changes and keep the Properties dialog box open, click Apply.

• To discard all changes made since the Properties dialog box was 
opened (or since the Apply button was used) and close the Properties 
dialog box, click Cancel. 

The General Tab
The General tab appears when you open the Move Group Properties dialog 
box, and allows you to change the move group’s name and the type of media 
that is assigned to the move group.

Note: You cannot add any media to a move group that is of a different type 
than what is specified for the group. This attribute must be changed 
before media of a different type can be added.

Note: If you have media already assigned to the move group, and you 
attempt to change the media type, a warning box appears informing 
you that all media in that move group will be removed.

To modify the General tab:

1. To change the name of the move group, type the new name into the Name 
text box.

2. To change the type of media that can be assigned to the move group, 
select a different media type from the Media Type drop-down list.

Note: If you change the media type for the move group, you may also 
want to change the move group name to reflect the new media 
type, if applicable.

The Media Tab
The Media tab of the Move Group Properties dialog box lists all media 
currently assigned to the move group and statistics on the total space and free 
space on that media. If you did not assign media to the group when you 
created the move group, you may use this tab to add media after the group is 
created. You must add media to a move group in order to use that media for 
file migration.

In order to add media to the move group, the media must already be assigned 
to the media folder. Each piece of media can only be assigned to one move 
group at a time. For more information on assigning media to the media folder, 
see “Adding Media to a Media Folder” on page 90.

The Media tab allows you to remove a piece of media from a move group, 
which is necessary in order to finalize DVD-R media. Removal from a move 
group renders media unavailable for Data Manager to write files to it based on 
the move rules configured for that move group. However, as long as the media 
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remains in the media folder, clients can access the files that reside on that 
media. 

You can also promote and demote media on the Media tab. When there is 
more than one piece of media assigned to the move group, promoting and 
demoting media changes the order the media appears in the list. If the media 
fill method is set to sequential, files are written to media in the order in which 
the pieces of media appear on the Media tab. For more information, see 
“Media fill method” on page 126. If the media fill method is set to random, the 
next available piece of media in the move group is used, regardless of the 
order set in the list. 

Note: You can also add media to the move group by dragging media to the 
move group in the tree view of the Administrator or by assigning the 
add to move group media task. Similarly, you can remove media from 
the move group using the remove from move group media task. For 
more information, see “Adding Media to a Move Group” on page 98 
and “Removing Media from a Move Group” on page 115.

To modify the Media tab:

1. Click the Media tab in the Move Group Properties dialog box.

Figure 52.  Move Group Properties -- Media Tab 

2. You have the following choices:

• Add media to the move group. For more information, see "Adding 
Media to a Move Group, " which follows. 

• Reorder (promote or demote) media in the move group. For more 
information, see “Reordering Media in a Move Group” on page 123.

• Remove media from the move group. For more information, see 
“Removing Media from a Move Group” on page 124.



Managing Move Groups

ASM Data Manager System Guide 123
StorageTek Proprietary

Adding Media to a Move Group
You must add media to a move group in order to use media assigned to a 
media folder for file migration. In order to add media to the move group, the 
media must already be assigned to the media folder, and the media cannot be 
read-only (like CD-ROM, DVD-ROM, or finalized DVD-R). Each piece of 
media can only be assigned to one move group at a time. 

Note: You can also use a media task to add media to a move group. See 
“Using the Add to Move Group Media Task” on page 100 for more 
information.

To add media to a move group:

1. On the Media tab, click Add. The Select Move Group Media dialog box 
appears, listing all media of the specified media type available in the 
media folder.

Figure 53.  Select Move Group Media Dialog Box 

2. From the Media list, select the media you want to add and click OK. The 
selected media appears in the Media tab.

Reordering Media in a Move Group
You can promote and demote media to set the media fill sequence. If the 
media fill method (configured on the move group Options tab) is set to 
sequential, media is filled in the order in which it is listed on the Media tab. The 
piece of media listed first is the first piece of media to which files will be 
written; when this piece of media is full, files are written to the second piece of 
media, and so on. A piece of media can be “promoted” to a higher position in 
the list, or “demoted” to a lower position. (If media fill method is set to random, 
the next available piece of media in the move group is used, regardless of the 
order set in this list.) 
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To promote or demote media in the move group:

1. In the Media tab, select the piece of media whose order in the list you want 
to change. 

2. You have the following choices:

• To move the media up in the list, click Promote. The media is moved 
up one position in the list.

• To move the media down in the list, click Demote. The media is moved 
down one position in the list.

The media appears in the new order.

Removing Media from a Move Group
When you remove a piece of media from a move group, Data Manager no 
longer writes files to it based on the move rules configured for that move 
group. However, the piece of media remains in the media folder, and clients 
can access the files that reside on that media. And because move groups 
cannot contain read-only media, DVD-R media must be removed from the 
move group before it can be finalized, though you will want the media to 
remain in the media folder so clients can access the files contained on the 
media. 

Note: You can also use a media task to remove media from a move group. 
See “Using the Remove from Move Group Media Task” on page 115 
for more information.

To remove media from the move group:

• On the Media tab, select the media you want to remove and click Remove. 
The selected media is removed from the move group, but remains 
assigned to the media folder.

The Options Tab
The Options tab of the Move Group Properties dialog box lists all configurable 
options available for the move group. The configuration options that appear in 
the lower part of the Options tab correspond to the option selected in the list in 
the upper part of the Options tab.
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To modify the Options tab:

1. Click the Options tab in the Move Group Properties dialog box. 

Figure 54.  Move Group Properties -- Options Tab 

2. Configure the following options as necessary:

• "Library mount - minimum free space on media (KB), " which follows

• “Library mount - minimum number of files” on page 126

• “Maximum media simultaneously receiving files” on page 126

• “Maximum write errors before media write disabled” on page 126

• “Media fill method” on page 126

• “Remove media when free space falls below (MB)” on page 127

• “Warn when group free space falls below (MB)” on page 128

• “Cached moves file watermark” on page 128

• “Cached moves data watermark (MB)” on page 129

Library mount - minimum free space on media (KB)
Use this move group option to specify the minimum number of kilobytes (KB) 
of free space that must be available on a piece of media for Data Manager to 
request that the media service mount that media in order to write files to it. The 
default value is 32 KB. This setting only controls whether Data Manager 
requests the media be mounted specifically for media writes. If the media is 
already mounted when the file moves are activated, Data Manager attempts to 
write to the media regardless of the amount of free space on the media.
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Library mount - minimum number of files
Use this move group option to specify the minimum number of files that must 
be on the move list before the media in this move group is mounted for file 
writes. The default value is one file. This setting only controls whether Data 
Manager requests the media be mounted specifically for media writes. If the 
media is already mounted when the file moves are activated, Data Manager 
attempts to write to the media, regardless of the number of files on the move 
list.

Maximum media simultaneously receiving files
Use this move group option to specify the maximum number of media from 
this move group that can be mounted in device drives for file writes at one 
time. 

This option is only available for configuration if the media fill method for this 
move group is set to Random. For more information, see “Media fill method” 
on page 126.

Note: If your move group contains virtual media (EMC, TSM or NAS), you 
may be able to improve file write performance by setting your media fill 
method to Random, and setting this option to the number of pieces of 
media in your move group. 

Maximum write errors before media write disabled
Use this move group option to configure whether Data Manager stops writing 
to a piece of media if a specified number of write errors occur when migrating 
files to that piece of media.

To configure the Maximum write errors before media write is disabled 
option:

• You have the following choices:

• If you want Data Manager to stop writing to media if the specified 
number of write errors have occurred when attempting to write files to 
the media, select Disable writing to media after write errors occur. 
Then enter the maximum number of errors in the text box. The default 
for all media except Tape, is to stop writing to media after 10 errors 
occur. For Tape, the default is 1. 

• If you want Data Manager to continue to attempt to migrate files to 
media, regardless of the number of write errors that have occurred on 
the media, select Do not disable writing to media after write errors 
occur. 

Media fill method
Use this move group option to configure whether to fill media sequentially in 
the order in which they appear in the media list in the Media tab, or to fill media 
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randomly, selecting media based on its availability. For information on setting 
the order media appears in the Media tab, see “The Media Tab” on page 121.

Setting the fill method to Random optimizes file write times, by allowing Data 
Manager to write to any available move group media. In addition, if the 
Maximum media simultaneously receiving files option is set to greater than 
one, Data Manager can request the mounting of multiple pieces of media for 
file writes. 

Setting the fill method to Sequential optimizes file retrieval times. Filling the 
move group media in order (sequentially) makes it more likely that only one 
piece of media has to be mounted in order to retrieve file data, instead of 
several pieces, which slows fulfillment of client requests. 

Note: If your move group contains NAS, TSM or EMC media, you may be 
able to improve file write performance by setting your media fill method 
to Random, and setting the Maximum media simultaneously receiving 
files option to the number of pieces of media in your move group. 
Because NAS, TSM and EMC are “virtual” media and do not need to 
be mounted, file retrieval times should not be affected. 

To configure the Media fill method option:

• You have the following choices:

• To fill the media in the move group in the order in which they appear in 
the Media tab, select Sequential – Write to one media at a time 
(optimize retrieval). This is the default.

• To fill media based on its availability at the time files are migrated, 
select Random – Write to any available media (optimized writing).

Remove media when free space falls below (MB)
Use this move group option to specify whether to automatically remove media 
from the move group when the free space on the piece of media falls below a 
specified number of megabytes (MB). When you remove a piece of media 
from the move group, files are no longer migrated to that piece of media. 
Media removed from a move group remains in the media folder, however, 
allowing client access to the files contained on that media.

Note: You should leave this option enabled if the move group contains media 
that cannot be compacted. If the media in the move group can be 
compacted and you use automated media compaction for the media, 
you may want to disable this option. Compacting media removes the 
media from the move group and the media folder automatically. For 
more information on automated media compaction, see “The 
Automation Tab” on page 129.

Note: Free space on media may fall below the level specified through the 
Remove media when free space falls below option. This may occur 
because ASM checks media free space on a timed interval of every 15 
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minutes, and ASM may continue to write files to the media in between 
the timed checks. Once the timed verification occurs, the media is 
removed from the move group; however, the media free space may be 
less than the amount specified through this option.

To configure the Remove media when free space falls below option:

• You have the following choices:

• To automatically remove pieces of media when free space on that 
media falls below a certain number of megabytes, select Remove 
media when free space falls below __ MB. Then enter the number of 
megabytes in the text box. This is the default, with a value of 1 MB.

• To leave media in the move group regardless of its fill level, select Do 
not automatically remove full media from this group.

Warn when group free space falls below (MB)
Use this move group option to configure whether you want Data Manager to 
warn you when the free space available on all media in the move group falls 
below a specified number of megabytes (MB). 

To configure the Warn when group free space falls below option:

• You have the following choices:

• To configure Data Manager to send you a warning when the amount of 
free space in the move group media falls below the entered number of 
megabytes, select Warn when group free space fall below __ MB. 

Note: If you leave this option enabled, you can configure these warnings 
to appear as alerts on a selected computer, domain, email 
address, or user account. For more information on setting up 
alerts, see “The Alerts Tab” on page 314.

• To disable any free space watermark warnings, select Do not warn 
when group is low on free space. This is the default.

Cached moves file watermark
Caching files allows Data Manager to write files to media in larger groups 
(rather than writing files to media one at a time), which is more efficient for 
some types of media. Data Manager queues the list of files to be moved to a 
move group until either the cached moves file watermark, the cached moves 
data watermark, (see "Cached moves data watermark (MB), " which follows) 
or the media drive cache size limit is reached, whichever occurs first. At that 
point, Data Manager stops queueing files and flushes all of the file data for the 
queued files out to media in the move group. Once the file data is flushed, 
Data Manager clears the file list queue and then continues processing the 
move list, repeating this process until all files have been moved to the media.
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Use this move group option to specify the number of files that Data Manager 
queues before it flushes the file data to the move group media. The default 
value is 100 files. This setting must be between 1 and 1000 files.

Note: If you do not want Data Manager to cache files before moving them, 
set this watermark value to 1.

Cached moves data watermark (MB)
Caching files allows Data Manager to write files to media in larger groups 
(rather than writing files to media one at a time), which is more efficient for 
some types of media. Data Manager queues the list of files to be moved to a 
move group until the cached moves data watermark, cached moves file 
watermark, (see Cached moves file watermark, above) or the media drive 
cache size limit is reached, whichever occurs first. At that point, Data Manager 
stops queueing files and flushes all of the file data for the queued files out to 
media in the move group. Once the file data is flushed, Data Manager clears 
the file list queue and then continues processing the move list, repeating this 
process until all files have been moved to the media.

Use this move group option to specify the total cumulative size limit (in 
megabytes) of files that Data Manager queues before it flushes the file data to 
the move group media. The default value is 10 MB. This setting must be 
between 1 and 1048576 MB (equal to 1 terabyte). 

The Automation Tab
The Automation tab of the Move Group Properties dialog box allows you to set 
up automatic media labeling and automatic media compaction. These features 
can be used together to create intelligent move groups that allocate new 
media and perform compaction as space is needed. This allows the system 
administrator to simply load and format media, and then let other media 
maintenance activity be triggered by internal Data Manager events. Automatic 
labeling and automatic compaction eliminate a time-consuming requirement of 
system administration: the need to manage move groups and the available 
space within them by allocating/compacting media where necessary.

Note: If your move group contains a media type that does not support media 
labeling or media compaction and reformat (for example, NAS, EMC, 
or TSM media), the Automation tab options are not available. For more 
information on selecting a media type for a move group, see “The 
General Tab” on page 121. 
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To modify the Automation tab:

1. Click the Automation tab in the Move Group Properties dialog box.

Figure 55.  Move Group Properties -- Automation Tab 

2. You have the following choices:

• Set up automatic media labeling. For more information, see "Automatic 
Media Labeling, " which follows.

• Set up automatic media compaction. For more information, see 
“Automatic Media Compaction” on page 131.

Automatic Media Labeling
The automatic labeling option allows you to configure automatic addition of 
available blank media to a move group. When enabled, a media prefix and 
watermark must be defined for use by automatic labeling. For example, the 
move group named PAYROLL MEDIA might be configured with a media prefix 
of “PAYROLL” and a watermark of 200MB. This means that when the free 
space available in the move group falls below 200MB, blank media is 
automatically labeled with a PAYROLL prefix and added to the move group.

Data Manager also contains a batch formatting and labeling utility. This utility 
is called the Media Prepare Manager and formats media, and prepares blank 
media for automatic labeling. For more information, see “Formatting and 
Labeling Using Media Prepare Manager” on page 81. 

Note: Only media in library devices can be used for automatic labeling.
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To configure automatic media labeling:

1. On the Automation tab of the Move Group Properties dialog box, you have 
the following choices:

• To prevent Data Manager from automatically selecting blank media, 
labeling it, and adding it to a move group, select the Do not 
automatically label and add blank media to move group option.

Note: If you do not enable the automatic labeling function, you may want 
to activate the Warn when group free space falls below ____ MB 
option on the Options tab to alert you when move group free space 
falls below a particular level. For more information, see “Warn 
when group free space falls below (MB)” on page 128. 

• To configure Data Manager to automatically select blank media, label 
it, and add it to the move group when the total number of free 
megabytes on media in the move group falls below a specified 
number, select the Auto-label blank media when free space falls below 
option.

2. If you select the automatic labeling option, you have the following choices:

• If barcodes are not available on your system, select Use standard 
method to label media based on a label prefix and number width. 

• If barcodes are available on your system, and if you want to generate 
labels for media based on these barcodes, select Use barcode. To 
determine if the media device supports barcode labeling, refer to your 
device manual.

3. If you use a standard labeling convention, specify a prefix to be used for 
naming each added piece of media in the Label Prefix text box.

4. From the Number Width drop-down list, select the number of digits to be 
used to create the incremental numbering for the media label. Data 
Manager adds the number to the prefix to create the name for each added 
piece of media.

The Sample Name text box provides an example of what the media name 
will look like based on the prefix and number width criteria you set.

Automatic Media Compaction
The automatic compaction option for move groups can be used to configure 
automatic compaction of media in the move group when the amount of wasted 
space on each piece of media (due to deleted files) exceeds a specified 
percentage. 

Compacting media reclaims lost space by writing all active files from the 
media (current versions of written files, and files not marked for deletion) back 
to the media folder on the extended drive, and removing the media from the 
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move group and the media folder. After media has been auto-compacted, it is 
reformatted, allowing that media to be used again. 

After compaction, the files from the media (that were written back to the 
extended drive) are re-migrated to move group media based on the move 
rules for the media folder. Automatic compaction automatically assigns the 
format task to the media it has compacted. Once formatted, the media is 
added to the Blank media node and is available for labeling and re-addition to 
the move group (which can be taken care of by configuring the Automatic 
Media Labeling option for the move group).

To configure automatic media compaction:

• On the Automation tab of the Move Group Properties dialog box, you have 
the following choices:

• To prevent Data Manager from automatically compacting media, select 
Do not automatically compact, remove and format move group media.

• To configure Data Manager to automatically compact media when 
wasted space on the media exceeds a certain percentage, select Auto-
compact media when wasted space exceeds ___ %. Then enter the 
desired percentage in the text box. 

The Statistics Tab
The Statistics tab of the Move Group Properties dialog box contains statistical 
information about the media in the move group, including the total number of 
media, the total number of move rules, total space usage, and pending move 
details. There are no configurable options on this tab.

To view the Statistics tab:

• Click the Statistics tab in the Move Group Properties dialog box. The 
Statistics tab appears. 
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Figure 56.  Move Group Properties -- Statistics Tab 

The following information appears on the Statistics tab: 

Deleting a Move Group
When a move group is deleted, all configurations for that move group, 
including any move rules currently configured to write to the move group, are 
also deleted. In addition, the media must be removed from the move group 
before the group can be deleted (though the media can remain in the media 
folder). The media removed from the move group is then available to be 

Table 15.  Move Group Properties -- Statistics Tab Information

Group Item Description
Information Total Media The number of media currently in the 

move group

Total Move 
Rules

The number of move rules currently 
configured to write to the move group

Space Usage Free Space The number of free bytes (total) on 
move group media

Used Space The number of used bytes (total) on 
move group media

Total Space The number of total bytes on move 
group media

Pending Move Total Files The number of files pending move

Total Bytes The sum of all bytes in files pending 
move
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added to another move group in the media folder. See “Removing Media from 
a Move Group” on page 124 for more information. 

If you want to delete a move group without deleting the associated move 
rule(s), create a new move group, then modify your move rule(s) to point to the 
new move group before you delete the original move group. 

To delete a move group:

1. Right-click the move group you want to delete and select Delete from the 
shortcut menu, or select the move group you want to delete and then 
press <DELETE>. A confirmation message appears.

2. Click Yes. If there are any move rules configured to write to the move 
group, a warning message appears informing you that the move rules will 
be deleted as well.

3. Click OK to continue. The move group and all associated configurations 
and move rules are deleted.

■ Managing Move Rules
Move rules are designed to allow you to configure, very specifically, what files 
in a media folder are moved to what media. A move rule contains the 
instructions that ASM Data Manager follows when choosing which files to 
move (or exclude from movement) to a particular piece or group of media, and 
each move rule points to a target move group of media for migration. For more 
information on managing move groups, see “Managing Move Groups” on 
page 119. 

Once you have created a move rule, you can modify how the rule selects files 
to be migrated or excluded from migration based on the file’s location, 
extension, attributes, and size. You can also change the move group the move 
rule applies to, as well as configure a time delay for files, excluding them from 
movement until after a certain specified time period has elapsed since file 
creation, last file access, or last file write.

If you no longer need a move rule, you can delete it. 

For more information, see the following sections:

• "Modifying a Move Rule, " which follows

• “Deleting a Move Rule” on page 143

Modifying a Move Rule
Accessing the Move Rule Properties dialog box and selecting each of the tabs 
allows you to view and change the settings established when you created the 
move rule. You can change what files are affected by the move rule by 
changing or disabling the file size specifications, changing or disabling the 
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qualification of files based on file attributes, and changing or disabling the age 
(time delay) specifications for moving files. You can also change which move 
group’s media is to receive the files, and enable or disable the direct read and 
purge after move options. In addition, you can change whether the rule is an 
inclusion or exclusion type of move rule.

Note: When files qualify for both an inclusion move rule and an exclusion 
move rule, the exclusion move rule takes precedence, and the files are 
excluded from migration.

To modify a move rule:

1. Right-click the move rule you want to modify and then select Properties 
from the shortcut menu, or double-click the move rule you want to modify. 
The Move Rule Properties dialog box appears with the Rule Type tab 
active by default.

Figure 57.  Move Rule Properties Dialog Box 

2. Modify the settings on each of the tabs as necessary. For more 
information, see the following sections:

• "The Rule Type Tab, " which follows

• “The File Name Tab” on page 136 

• “The Size Tab” on page 138

• “The Attributes Tab” on page 139

• “The Age Tab” on page 139

• “The Settings Tab” on page 141

• “The Statistics Tab” on page 142

3. As with most Properties functions in Data Manager, after making changes 
you have three options:

• To save changes and close the Properties dialog box, click OK.

• To save changes and keep the Properties dialog box open, click Apply.
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• To discard all changes made since the Properties dialog box was 
opened (or since the Apply button was used) and close the Properties 
dialog box, click Cancel. 

The Rule Type Tab
The Rule Type tab of the Move Rule Properties dialog box allows you to 
change whether the criteria configured in the rule will qualify files for or 
exclude files from movement to media.

Note: When files qualify for both an inclusion move rule and an exclusion 
move rule, the exclusion move rule takes precedence, and the files are 
excluded from migration.

To modify the Rule Type tab:

1. If necessary, click the Rule Type tab in the Move Rule Properties dialog 
box to activate it.

2. Select the appropriate Rule Type for this move rule. You have the following 
choices: 

• Select the Include option if you want to create a move rule that 
specifies which files should be moved to media. 

• Select the Exclude option if you want to create a move rule that 
specifies which files should not be moved to media.

For example, if you want to move all the files in a media folder except for 
text files, configure an inclusion move rule to include all files, and then 
configure a second exclusion move rule to exclude all “*.txt” files. 

If your media folder has multiple sub-directories that contain files you do 
not want moved to media, you can set an inclusion move rule to move all 
files and subdirectories in a media folder, and then set an exclusion move 
rule to exclude all files (or specific files) in a subdirectory. 

The File Name Tab
The File Name tab of the Move Rule Properties dialog box allows you to view 
and change the folder and file name specifications for the move rule.

To modify the File Name tab:

1. Click the File Name tab in the Move Rule Properties dialog box. 
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Figure 58.  Move Rule Properties -- File Name Tab 

2. Select the folder to which you want the move rule to apply. The active 
media folder is listed by default. If you want to apply the rule to only the 
files in a specific subfolder of the media folder, click Browse. The Select 
Folder dialog box appears. Select the folder and then click OK. 

3. Enable or disable the Apply rule to subfolders option. If enabled, all files in 
the specified folder, and all subfolders and their files are subject to the 
move rule. If disabled, only the files in the specified directory are subject to 
the move rule.

Note: You cannot include more than one select subfolder of the media 
folder in a single move rule. You can apply the rule to either one or 
all subfolders only. To apply a move rule to files in a different 
subfolder, create a second move rule. For information on creating 
move rules, refer to the Setting Up File Migration chapter of the 
ASM Data Manager Getting Started Guide.

4. Specify the file naming patterns or file extension to which the move rule 
applies. You can use the standard Windows asterisk (*) wildcard, which 
represents one or more characters in the name or extension part of the file 
name. For example:

• To apply the move rule to all files in the directory, type *.* in the File 
Name text box. 

• To apply the move rule to only files of a particular type, type in an 
asterisk before the period and the appropriate file extension after the 
period. For example, to move or exclude only bitmaps type *.BMP in 
the File Name text box.

• To apply the move rule to files with a certain naming convention use 
the asterisk as part of the file name. For example, to move or exclude 
only files indicated as reports, type *REPORT.* or *REPORT*.* in the 
File Name text box. 

• To use the wildcard to specify only files of a certain type with a specific 
naming convention, use the asterisk in the name part of the file name 
while specifying the file extension. For example, to move or exclude 
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only text files indicated as reports, type *REPORT*.TXT in the File 
Name text box.

Note: Only one file name specification can be configured per move rule. To 
move or exclude files of a different specification in the same folder, 
create a second move rule.

The Size Tab
The Size tab of the Move Rule Properties dialog box allows you to view and 
change the file size qualifications for the move rule.

To modify the Size tab:

1. Click the Size tab in the Move Rule Properties dialog box.

Figure 59.  Move Rule Properties – Size Tab 

2. You have the following choices:

• To qualify files of all sizes, select Apply rule to files of any size. This is 
the default.

• To qualify only files of a specified size range, select Apply rule to files 
with the following sizes. 

3. If you choose to qualify files based on their size, you have the following 
options:

• Enable the Files larger than __ KB option. In the text box, type in the 
number of kilobytes (KB) that a file must equal or exceed in order to 
qualify for this rule. 

• Enable the Files smaller than __ KB option. In the text box, type in the 
number of kilobytes (KB) that a file must be equal to or smaller than in 
order to qualify for this rule. 

Note: When both options are enabled, only files whose size falls in 
between the kilobyte specifications are subject to the move rule.  
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The Attributes Tab
The Attributes tab of the Move Rule Properties dialog box allows you to view 
and change the specific file attribute qualifications for the move rule.

To modify the Attributes tab:

1. Click the Attributes tab in the Move Rule Properties dialog box.

Figure 60.  Move Rule Properties – Attributes Tab 

2. You have the following choices:

• To qualify files regardless of attributes, select Apply rule to files with 
any attribute. This is the default.

• To qualify only files with certain attributes for this move rule, select 
Apply rule to files with the following attributes. Then enable the options 
for the attributes a file should have if you want the file to qualify for this 
rule.

Note: When selecting attributes, be advised that files possessing any of 
the checked attributes will qualify for the rule (as opposed to files 
needing to possess all of the checked attributes to qualify, or files 
needing to possess only the checked attributes to qualify).

Note: If you have extended a system drive, or if you have application files 
on an extended drive, be sure to configure an exclude rule that 
excludes all files with the System attribute, to prevent operating 
system or application file purge. Extending a system drive with 
Data Manager is not recommended and may cause severe 
operating system damage. Attributes for existing files can be 
viewed through Windows Explorer.

The Age Tab
The Age tab of the Move Rule Properties dialog box allows you to qualify files 
of any age against this move rule or to qualify only files of a particular age.

If there is no age specification configured for the move rule, and if it is an 
inclusion type move rule, all files that otherwise qualify for movement to media 
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under this move rule are written to the move list immediately upon being 
saved to the media folder on the extended drive.

If an age specification is configured for the move rule, and it is an inclusion 
type move rule, all files that otherwise qualify for movement to media under 
this move rule are written to the move list when the entered days have elapsed 
since the selected file action and the next drive scan is run. For information on 
drive scans, see “Running Drive Scans” on page 276.

Note: If you are have configured retention for your EMC media, or set 
Aggregation or WORM options for your NAS media, keep in mind that 
restrictions for those files are not enforced until the files are moved to 
media. Configuring an age-delay in your move rules creates an 
extended period of time during which files can be deleted from or 
modified on the extended drive with no copies retained (because the 
files have not yet been moved to media). 

To modify the Age tab:

1. Click the Age tab in the Move Rule Properties dialog box.

Figure 61.  Move Rule Properties – Age Tab 

2. You have the following choices:

• To qualify files regardless of age, select Apply rule to files of any age. 

• To qualify only files older than a particular age, enable the Apply rule to 
files of age greater than option. 

3. If you selected the option to qualify files based on their age, in the Days 
text box, type in the number of days you want to elapse from the file action 
trigger before the file qualifies for this rule.

4. Select the appropriate file action trigger from the Since drop-down box. 
You have the following choices: 

• Create time

• Last access time

• Last write time
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The Settings Tab
The Settings tab of the Move Rule Properties dialog box allows you choose a 
different move group to receive the files being selected for move by the move 
rule. You can also enable or disable the direct read and purge files after move 
options.

For exclusion type move rules, the Settings tab appears, but the information 
and options on the page are grayed out.

Note: If you disabled certain time periods on the Allow fetches from media 
schedule to create a time-based restriction of access to purged files, 
you may want to take that into consideration when determining 
whether to purge files immediately after move or to mark files for direct 
read. For more information on setting the Allow fetches from media 
schedule, see “Scheduling Media Activities” on page 71.

To view the Settings tab:

1. Click the Settings tab in the Move Rule Properties dialog box.

Figure 62.  Move Rule Properties – Settings Tab 

2. You have the following options:

• To choose a different existing move group to receive the files being 
selected for migration by the move rule, select the new move group 
from the Move Group To Receive Files drop-down box.

• To create a new move group to receive migrating files, click New. This 
opens the Move Group Wizard and leads you through the creation of a 
new move group. Once the wizard completes, you are returned to the 
Settings tab and the new move group appears in the Move Group To 
Receive Files text box. For more information on running the Move 
Group Wizard, refer to the Setting Up File Migration chapter of the 
ASM Data Manager Getting Started Guide.

3. To determine whether all files moved to media under the move rule should 
be set for direct read, enable or disable the Mark file for direct read after 
move option. 
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Direct Read means that the file data is read directly from media when 
requested by a client, rather than being fetched to the extended drive first 
and then read from there. 

Note: When files are marked for direct read as a result of checking this 
box on your move rule, the files are automatically purged from the 
extended drive when they are moved. For this reason the Purge 
files immediately after move option is automatically checked and 
grayed out when the direct read option is selected. 

4. To determine whether file data for all files moved to media under this rule 
is immediately purged after the file is moved, enable or disable the Purge 
files immediately after move option.

Note: Be advised that if you enable either the Purge files immediately 
after move or the Mark files for direct read setting, files qualifying 
for this move rule are purged, and are not subject to any exclusion 
type purge rules you may have configured. 

Note: If the move group targeted by the move rule contains DVD-R 
media, the Purge files immediately after move and Mark file for 
direct read options are unavailable. This is because files moved to 
DVD-R cannot be purged until the media is finalized. In addition, if 
you enable either option and later change the move group to one 
that contains DVD-R media, the option is disabled. 

Note: Purge rules for files can be configured separately if purging after 
move is not appropriate for all files that qualify for this move rule. 
For details on creating separate purge rules, see “Creating a Purge 
Rule” on page 229. 

The Statistics Tab
The Statistics tab of the Move Rule Properties dialog box provides pending file 
migration statistics from the most recent drive scan. The statistics shown 
pertain only to the files selected for migration by qualifying for this move rule 
and are valid only until the next extended drive scan.

For exclusion type move rules, the Statistics tab appears, but the information 
does not apply.

To view the Statistics tab:

• Click the Statistics tab in the Move Rule Properties dialog box. The 
Statistics tab appears.



Fetching Files from Media

ASM Data Manager System Guide 143
StorageTek Proprietary

Figure 63.  Move Rule Properties – Statistics Tab 

The following information appears on the Statistics tab:

Deleting a Move Rule
Deleting a move rule deletes all configured options for that move rule. 
Remember, however, that you must have at least one inclusion type move rule 
configured in order to migrate files to media.

To delete a move rule:

1. You have the following choices:

1. Right-click the move rule you want to delete and select Delete from the 
shortcut menu, or select the move rule you want to delete and then press 
<DELETE>. A confirmation message appears.

2. Click Yes. The move rule is deleted.

■ Fetching Files from Media
When a client requests a purged file and the file does not have the direct read 
attribute set, the file data is “fetched”, or copied, back to the extended drive 
and then opened for the client’s use. (When files are marked for direct read, 
they are opened directly from the media when requested rather than being 
copied back to the extended drive.)

Note: Files with streams, and non-read-only files accessed through “write 
access” applications (e.g., Microsoft Word) are automatically fetched 

Table 16.  Statistics Tab Pending Move Information

Item Description
Total Files The number of files that qualified for migration to media 

using this move rule at the time of the last drive scan.

Total Bytes The total size, in bytes, of all files that qualified for migration 
to media using this move rule at the time of the last drive 
scan.
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to the extended drive when requested, even if those files are marked 
for direct read. 

Depending on the type of media the file has been migrated to, it may take 
some time to retrieve purged file data. In addition, multiple client requests for 
purged files may put a critical strain on your system resources and cause 
media mounting conflicts in your media device.

ASM Data Manager contains a prefetch capability, which allows you to retrieve 
frequently used files from storage media in advance of their being requested 
by a client. This allows you to reduce read requests during high traffic times by 
anticipating file retrieval needs. During a prefetch, Data Manager retrieves the 
specified files from storage media (excluding files marked for direct read) and 
writes the file data to the extended drive.

Data Manager also allows you to set the Allow fetches from media schedule to 
specify when clients can fetch files from media. Note that if you disable certain 
time periods of the Allow fetches from media schedule to create a time-based 
restriction of access to purged files, you will want to be sure to have all 
necessary files prefetched to the extended drive in order to maintain access to 
those files during the times when fetches are prohibited.

Note: The Allow fetches from media schedule only pertains to individual 
client requests for purged files from media. It does not apply to or affect 
prefetch requests.

For more information, see the following sections:

• "Managing Client Fetch Requests, " which follows

• “Enabling Direct Read” on page 145

• “Requesting Specific Files Using Prefetch Requests” on page 146

• “Requesting All Files from a Piece of Media Using a Prefetch Media Task” 
on page 160

Managing Client Fetch Requests
The Allow fetches from media schedule lets you restrict client fetch requests to 
certain times of the day. If you restrict client fetch requests, the Defer fetch 
requests if fetch is disabled option on the Options tab of the Extended Drive 
Properties dialog box allows you to queue file requests when the Allow fetches 
from media schedule is inactive. If this option is enabled, Data Manager 
queues all file requests made during an inactive fetch schedule as deferred 
fetches. Data Manager then processes all deferred fetches when the Allow 
fetches from media schedule becomes active. For more information, on the 
Allow fetches from media schedule, see “Fetching Files from Media” on 
page 64. For more information on the Defer fetch requests if fetch is disabled 
option, see “Defer fetch requests if fetch is disabled” on page 273.
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You can also configure Data Manager to cancel fetch requests after a certain 
number of minutes. The Fetch request timeout minutes option on the Options 
tab of the Extended Drive Properties dialog box allows you to reduce network 
traffic by stopping requests in cases where the user no longer expects the file 
to open because of the amount of elapsed time since the request. For more 
information, see “Fetch request timeout minutes” on page 268.

Enabling Direct Read
When files are marked for direct read, they are opened directly from the media 
when requested rather than being copied back to the extended drive. This 
eases the strain on system resources caused by fetching the files back to the 
extended drive to be read.

Note: When a file marked for direct read (that is not read-only) is opened with 
a “write access” application (e.g., Microsoft Word), the file is fetched to 
the extended drive, instead of being read directly from the media. 

There are six ways you can mark a file for direct read:

• To mark files that qualify for a particular move rule for direct read as soon 
as Data Manager moves them to media (and purges them), enable the 
Mark file for direct read after move option on the Settings tab of the Move 
Rule Properties dialog box. For more information, see “The Settings Tab” 
on page 141.

• To mark files moved to DVD-R media for direct read, enable the Mark files 
for direct read option when assigning the finalize media task to the media. 
For more information, see “Finalizing Media” on page 111. 

• To mark all files purged from the extended drive for direct read, enable the 
Force direct read for all files option on the Options tab of the Extended 
Drive Properties dialog box. For more information, see “Force direct read 
for all files” on page 268.

• To mark all files on a piece of media for direct read when you are restoring 
them to the extended drive, enable the Direct Read check box on the 
Media Tasks page when you are adding a file restore media task. For more 
information, see “Restoring Files from Media” on page 103.

• To mark all files on selected piece(s) of media for direct read when you are 
restoring them to the extended drive while adding the media to a media 
folder, enable the Direct read check box on the Media Restore page of the 
Add Media to Media Folders Wizard. For more information, see “Using the 
Add Media to Media Folders Wizard” on page 92.

• To mark only a specific file or directory for direct read, use the Explorer 
Add-ons. 

• If you enable direct read, use the Direct read memory cache option on the 
Options tab of the Extended Drive Properties dialog box to configure the 
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amount of memory in megabytes (MB) to be allocated for direct reads from 
media. For more information, see “Direct read memory cache (MB)” on 
page 267. 

Note: Data Manager cannot read a file with streams directly from the media. 
For this reason, when a streamed file marked for direct read is 
requested, the file is fetched, and the direct read attribute is removed 
from the file.

Requesting Specific Files Using Prefetch Requests
Any files that you know will be needed can be “prefetched” so that they will 
already be present on the extended drive when they are requested. The 
Prefetch Request Manager allows you to select files for a prefetch and specify 
when the prefetch should occur, as well as manage prefetch requests.

You can schedule a prefetch request to occur once at a set time, to reoccur at 
set times, or to be processed immediately. Prefetching files at low traffic times 
frees system resources and speeds read request response during high traffic 
times.

There are two types of prefetch requests: indirect and direct. 

• An indirect prefetch request allows you to load an existing file list. This 
option is intended for re-occurring batch prefetches where the list of files 
being prefetched may change. You designate the name of the file 
containing the file list, and then rebuild that list if needed. With an indirect 
request, Data Manager registers only the name of the file that contains the 
list of files to be prefetched. As long as that list is saved under the 
specified filename, the contents of the list can change as often as required.

• A direct prefetch allows you to build a prefetch file list by browsing to and 
selecting certain files and folders. However, you can also add files to the 
list by selecting a text file that lists specific files. The direct prefetch 
function also allows you to save the file list you build, in order to use it 
later.  

Note: If the contents of a file list loaded for a direct request changes, 
Data Manager does not register those changes for resubmission. 
For this reason, direct requests should not be used for recurring 
prefetches where file lists are being regenerated each time. 
Instead, save the recurring file list for use later in an indirect 
prefetch request. For more information on saving file lists, see 
“Saving a Prefetch File List to a File” on page 154.

For more information on prefetch requests, see the following sections:

• "Creating a Prefetch Request, " which follows

• “Modifying a Prefetch Request” on page 155

• “Viewing a Prefetch Request Log” on page 158
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• “Resubmitting a Prefetch Request” on page 159

• “Aborting a Prefetch Request” on page 160

• “Deleting a Prefetch Request” on page 160

Creating a Prefetch Request
The Prefetch Wizard leads you step-by-step through configuring either direct 
or indirect prefetch requests. Once the requests have been configured, they 
are added to the list in the Prefetch Request Manager and are processed 
based on the schedule you set for each prefetch request.

Note: Prefetch is a memory-intensive procedure. When planning to prefetch 
a large number of files, for optimal performance, we recommend you 
create several smaller prefetch request lists instead of one large list. 
You also may want to create separate lists (if possible) for files fetched 
from separate pieces of media. This reduces the potential for drive and 
media competition within a library.

For more information, see the following sections:

• "Prefetch File Format, " which follows

• “Starting the Prefetch Wizard” on page 148

• “Configuring Prefetch Information” on page 149

• “Scheduling the Prefetch Request” on page 150

• “Managing a Prefetch File List” on page 152

Prefetch File Format
If you are performing an indirect prefetch request, you should create the 
prefetch file before you run the Prefetch Wizard to create the request. In the 
wizard, you can browse for the file or type it in the file text box. Prefetch 
request files should be saved with an extension of .DXP. You can also use the 
direct prefetch wizard to create the listing of files, and then save the created 
list for use later. See “Saving a Prefetch File List to a File” on page 154.

If you have an existing list of files, you can load that list into the file list once 
you have formatted it correctly. For the list import to be successful, the file 
must contain a complete, correct directory path for each file to be added, such 
as:

\ACCOUNTS\OCTOBER\EXPENSES.XLS

The file should have a single file listing per line (in other words, file listings are 
separated by hard returns). Comments can be inserted in the file, but each 
comment line should be proceeded by a semi-colon (;).
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Figure 64.  Example of File for List Creation 

Starting the Prefetch Wizard
To create a prefetch request, start the Prefetch Wizard through the Prefetch 
Manager.

To start the Prefetch Wizard:

1. From the Tools menu in the Administrator, select Prefetch Request 
Manager. The Prefetch Manager dialog box appears. 

Figure 65.  Prefetch Manager Dialog Box 

2. Click New. The Prefetch Wizard opens with the Prefetch Information page.
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Figure 66.  Prefetch Wizard – Prefetch Information Page 

The Prefetch Information page allows you to configure settings for the prefetch 
request. For more information, see "Configuring Prefetch Information, " which 
follows. 

Configuring Prefetch Information
You can configure tracking details and the type of prefetch you want to 
perform on the Prefetch Information page of the Prefetch Wizard.

 To configure prefetch information:

1. In the Tracking Details section of the Prefetch Information page, enter the 
identifying information for the request. This information appears in the 
Prefetch Properties page once the request is complete.

2. Select the type of prefetch you want to perform. You have the following 
choices:

• Choose Direct if you want to build a prefetch file list by browsing to 
specific files.

• Choose Indirect if you have created a file that lists the files that you 
want to prefetch. Then enter the path and name for the file, or click 
Browse to browse to and select the file.

Table 17.  Prefetch Information Page – Request Details

Item Description
Owner The name of the person initiating the prefetch request

Title The name of the prefetch job

Description A description of the request (up to 128 characters in 
length)
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3. Click Next. The Prefetch Schedule page appears.

Figure 67.  Prefetch Wizard – Prefetch Schedule Page 

For more information on the Prefetch Schedule page, see "Scheduling the 
Prefetch Request, " which follows. 

Scheduling the Prefetch Request
The Prefetch Schedule page defines when the prefetch will occur. Prefetches 
can be scheduled to occur as soon as possible, once, hourly, daily, weekly, or 
monthly.

Note: The prefetch scheduler functions independently of the Allow fetches 
from media schedule, and runs when scheduled through the wizard, 
regardless of whether the Allow fetches from media schedule is active 
at that time. For more information on setting the Allow fetches from 
media schedule, see “Scheduling Media Activities” on page 71.
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To continue with the Prefetch Wizard:

1. Select a scheduling option. The following table contains detailed 
information on each of the scheduling options:

2. When you finish selecting a scheduling option, you have the following 
choices: 

• If you are configuring an indirect prefetch, click Finish to complete 
configuration of your prefetch. The request appears in the Request List 
in the Prefetch Manager dialog box.

• If you are configuring a direct prefetch, click Next. The Prefetch File 
List page appears. 

Table 18.  Prefetch Scheduling Options

Scheduling 
Option

Prefetch Frequency Settings to 
Configure

ASAP Once, immediately after you finish 
configuring the prefetch in the 
wizard. This is the default.

None

Once Once on the specified date and 
time. 

Note that the default values when 
this option is enabled are the 
current date and time.

Date

Time 

Hourly On an hourly basis (once every x 
hours where x is a number 
between 1 and 24) at the interval 
and time you specify.

Hourly rate

Time

Daily Every x days at the specified time, 
where x is a number between 1 
and 365.

Daily frequency

Time

Weekly Every x weeks on the specified 
days (Monday through Sunday) 
and time, where x is a number 
between 1 and 52. 

Weekly frequency

Time

Days of the week

Monthly Every x months on the specified 
date (1st through 31st) and time, 
where x is a number between 1 
and 12.

Monthly frequency

Time

Day of the month
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Figure 68.  Prefetch Wizard – Prefetch File List Page 

For more information, see "Managing a Prefetch File List, " which follows. 

Managing a Prefetch File List
For a new request, the Prefetch File List page is initially blank because no files 
have been selected for prefetch. You can add files to the list by browsing for 
them or by loading a file with a list of files in it. Once files have been added, 
you can delete files from the list. You can also save the list to a file if you would 
like to use the list again later. You can sort the list of added files by media ID 
and file location by checking Show list in optimized order.

For more information, see the following sections:

• "Browsing to Files to Add to the Prefetch File List, " which follows

• “Saving a Prefetch File List to a File” on page 154

• “Loading Files to the Prefetch File List From a File” on page 154

Browsing to Files to Add to the Prefetch File List
If you do not have a file containing a list of files that you want to prefetch, you 
can browse to and select the files you want to prefetch.
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To add files to the Prefetch file list:

1. On the Prefetch File List page, click Add. The Select Files dialog box 
appears.

Figure 69.  Select Files Dialog Box 

The Select Files dialog box lists files available on the extended drive on 
the Data Manager computer. You can select a new directory from the Look 
in drop-down list, or use the Up button to move up one directory level at a 
time on the current drive. 

2. Select the files that you would like to add to the prefetch request and click 
OK. One of the following may occur:

• If you choose to add an entire folder, a message appears, verifying 
addition of subfolders. Click Yes to include files in subfolders.

Figure 70.  Include Subfolder Verification Message 

• If a file you are adding is already present on the extended drive, a 
message appears, verifying addition to the list. Click Yes or Yes To All 
to verify adding the specified file(s), or click No or No To All to not add 
the specified file(s) to the list. Files listed on the Prefetch list that are 
already resident on the extended drive at the time the prefetch is run 
will be ignored.
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Figure 71.  Verify Existing File Dialog Box 

• If neither of the above occurs, the files are added successfully to the 
prefetch file list and appear in the Prefetch File List page.

3. You have the following choices:

• Repeat steps 1 and 2 if you want to add more files to the prefetch file 
list.

• To delete files from the list, select the files you want to delete and click 
Delete. A confirmation message appears. Click Yes. 

• If you want to prefetch the same files again at a later date, you can 
save the list you created to a file. For more information, see the next 
section on "Saving a Prefetch File List to a File, " which follows.

4. When you finish creating the prefetch file list, click Finish. The request 
appears in the Request List in the Prefetch Manager dialog box.

Saving a Prefetch File List to a File
You can save the currently displayed file list to a file. The saved file can be 
used or edited later for an indirect prefetch request.

To save a prefetch file list to a file:

1. On the Prefetch File List page, click Save As. The Save As dialog box 
appears. 

2. Prefetch files are saved by default to the root of the extended drive. The 
file list is saved as a prefetch file (.DXP) by default. You can change the 
directory by selecting a different location in the Save As dialog box.  

3. Enter the file name for the list you are saving and click Save to return to 
the File List page.

Loading Files to the Prefetch File List From a File
If you have an existing list of files, you can load those files into the file list by 
selecting the list file once you have formatted it correctly. For more information 
on the correct prefetch file list format, see “Prefetch File Format” on page 147.

If the contents of a file list loaded for a direct request changes, Data Manager 
does not register those changes for resubmission. If you are using recurring 
prefetches where file lists are being regenerated each time, save the recurring 
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file list for later use in an indirect prefetch request. For more information on 
saving file lists, see “Saving a Prefetch File List to a File” on page 154.

To load files to the Prefetch File List from a file:

1. On the Prefetch File List page, click Load From File. The Open dialog box 
appears. By default, only prefetch (.DXP) files are listed. 

2. Navigate to the file that you want to add and click Open. If you successfully 
open a file list, the files from the list appear in the File List page.

Figure 72.  Prefetch Wizard – File List Page 

 

Note: To delete files from the list, select the files you want to delete and 
click Delete. A confirmation message appears. Click Yes. 

3. Click Finish. The request appears in the Request List in the Prefetch 
Manager dialog box.

Modifying a Prefetch Request
After you create a prefetch request, you can modify it if necessary. 
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To edit a prefetch request:

1. From the Tools menu in the Administrator, select Prefetch Request 
Manager. The Prefetch Manager dialog box appears. 

Figure 73.  Prefetch Manager Dialog Box 

2. Select the prefetch request you want to change and then click Edit. The 
Prefetch Information page appears.

Figure 74.  Prefetch Wizard – Prefetch Information Page 

3. Edit the fields on the Prefetch Information page as necessary. For more 
information, see “Configuring Prefetch Information” on page 149. When 
you finish, click Next. The Prefetch Schedule page appears.
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Figure 75.  Prefetch Wizard -- Prefetch Schedule Page 

4. Adjust the schedule for the prefetch request as necessary. For more 
information, see “Scheduling the Prefetch Request” on page 150. When 
you finish, click Next. One of the following occurs:

• If you are configuring an indirect prefetch, click Finish to complete 
configuration of your prefetch. The edited request appears in the 
Request List in the Prefetch Manager dialog box.

• If you are configuring a direct prefetch, click Next. The Prefetch File 
List page appears.

Figure 76.  Prefetch Wizard -- Prefetch File List Page with Files 

5. If the Prefetch File List page appears, edit the list as necessary. For more 
information, see “Managing a Prefetch File List” on page 152. Then click 
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Finish to complete configuration of your prefetch. The edited request 
appears in the Request List in the Prefetch Manager dialog box.

Viewing a Prefetch Request Log
When a prefetch request is in progress or complete, you can view a log 
containing information about the request. The log allows you to determine 
whether the prefetch request is successful, and if not, to diagnose the 
problems.

To view a prefetch request log:

1. From the Tools menu in the Administrator, select Prefetch Request 
Manager. The Prefetch Manager dialog box appears. 

2. Select the prefetch request for which you want to view the log and then 
click Log. The request must be in process or complete.

The prefetch request log appears in RtfPad. (For more information on 
using RtfPad, see “Using RtfPad” on page 303.) The following table 
explains the information that appears in the prefetch request log.

Table 19.  Prefetch Request Log Information

Field Description
Log start time The date and time the log was started

Owner The owner of the prefetch request as entered 
on the Prefetch Request Information page

Title The title of the prefetch request as entered on 
the Prefetch Request Information page

Description A description of the prefetch request as entered 
on the Prefetch Request Information page

Indirect Whether the request was a direct or indirect 
prefetch request

Target extended drive The extended drive to which the files are 
prefetched from media

Submit time The time the prefetch request was submitted

Prefetch started at The time Data Manager began to process the 
prefetch request

Prefetch ended at The time Data Manager finished processing the 
prefetch request

Files processed The number of files that were processed as part 
of the prefetch request

Files fetched The number of files that were fetched from 
media and copied to the extended drive
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Resubmitting a Prefetch Request
Prefetch requests remain in the Prefetch Manager with a status of 
COMPLETE after Data Manager finishes processing them. You can resubmit 
a prefetch request to reuse the request after it is completed. Resubmitting a 
prefetch request reduces your prefetch configuration time.

Note: If you want to resubmit a prefetch request that was run using the Once 
scheduling option, you will have to modify the request and change the 
date/time values on the Schedule page, as the scheduled time for the 
request will have occurred in the past. See “Modifying a Prefetch 
Request” on page 155 for more information.

To resubmit a prefetch request:

1. From the Tools menu in the Administrator, select Prefetch Request 
Manager. The Prefetch Manager dialog box appears. 

2. Select the prefetch request you want to resubmit and then click Resubmit. 
The request must be complete before you can resubmit it.

Files not needing fetch The number of files that were listed in the 
prefetch request but already resided on the 
extended drive, or were marked for direct read, 
and therefore did not need to be fetched from 
media 

Files on offline media The number of files that were listed in the 
prefetch request but resided on media that was 
offline when Data Manager attempted to fetch 
them

Files not on media The number of files that were listed in the 
prefetch request but did not reside on media in 
the Data Manager system

Files not found The number of files that were listed in the 
prefetch request but that Data Manager could 
not find

File error count The number of files that were listed in the 
prefetch request but that caused an error when 
Data Manager attempted to fetch them

Total time The total time it took for Data Manager to 
process prefetch request

Prefetch … completed Whether the prefetch was successfully 
completed

Table 19.  Prefetch Request Log Information (Continued)

Field Description
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3. Click Yes on the confirmation message that appears. 

Aborting a Prefetch Request
If a prefetch request is in process and you want to stop it before it is 
completed, you can abort the request.

To abort a prefetch request:

1. From the Tools menu in the Administrator, select Prefetch Request 
Manager. The Prefetch Manager dialog box appears. 

2. Select the prefetch request you want to abort and then click Abort. The 
request must be in progress for you to abort it.

3. Click Yes on the confirmation message that appears.

Deleting a Prefetch Request
Prefetch requests that have completed and are not scheduled to run again 
remain in the Prefetch Manager with a status of COMPLETE. This allows you 
to reuse the request by resubmitting it later if necessary. If you no longer need 
the request, however, you can delete it.

To delete a prefetch request:

1. From the Tools menu in the Administrator, select Prefetch Request 
Manager. The Prefetch Manager dialog box appears. 

2. Select the prefetch request you want to delete and then click Delete. The 
request must be complete for you to delete it.

3. Click Yes on the confirmation message that appears.

Requesting All Files from a Piece of Media Using a Prefetch 
Media Task

The prefetch media task writes all files from the selected piece of media to the 
corresponding media folder on the extended drive (ignoring duplicates and 
files marked for direct read). This task is particularly useful if you know a 
specific piece or pieces of media will not be available for file retrieval for an 
extended period of time. It also makes it possible to remove the media from 
the system without the risk that it may be needed to provide file data for client 
requests.

Note: The prefetch media task is governed by the Process scheduled media 
tasks schedule, and is in no way affected by the Allow fetches from 
media schedule. For more information on media activity schedules, 
see “Scheduling Media Activities” on page 71.

Note: Data Manager cannot read a file with streams directly from the media. 
For this reason, when a streamed file marked for direct read is 
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prefetched, the file is fetched, and the direct read attribute is removed 
from the file.

To assign a prefetch task:

1. Open the Media Tasks page. You have the following choices:

• In the tree view of the Administrator, right-click the piece of media to 
which you want to add the prefetch media task and then select Edit 
Tasks from the shortcut menu that appears.

• Press <CTRL>+T, or open the Tools menu and then select Media Task 
Manager to open the Media Task Queue Manager. If the media already 
has tasks assigned to it, select the media and then click Edit Tasks. If 
the media does not have tasks already assigned to it, click Add New 
Media. The Select Media for New Tasks page appears listing all media 
that do not currently have tasks assigned to them. Select the piece of 
media to which you want to assign the prefetch media task and then 
click Next.

2. From the Next Task drop-down list, select the prefetch media task and 
then click Add Next Task. The prefetch task appears in the Task List, and 
the Options and When To Process regions of the Media Tasks page 
become available.

Figure 77.  Prefetch Media Task 

3. Select whether to process the media task as soon as possible or on a 
scheduled basis. If you choose to process the media task on a scheduled 
basis, the task is not processed until the Process scheduled media tasks 
schedule is active. For information on configuring media activity 
schedules, see “Scheduling Media Activities” on page 71.

Note: If you assign multiple tasks for media, be advised that all tasks for 
that media will have the same When to Process option, since all 
tasks for a piece of media are processed at once. If one task has 
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the ASAP – as soon as possible option selected, all tasks for that 
piece of media will process ASAP by default. 

4. Once tasks have been added and configured as needed in the Media 
Tasks page, you have the following choices: 

• If you added the task through the Media Task Queue Manager, click 
Finish. The Media Task Queue Manager dialog box appears with the 
media listed and the task pending.

• If you added the task using the Edit Tasks option on either the shortcut 
menu for the media or the Edit menu, click Next. The Order Media in 
Task Queue page appears with the recently added media at the bottom 
of the media task queue list.

5. To promote the selected piece of media so that the media tasks for the 
media are processed before other media in the queue, click the up arrow 
button to the right of the list box. You can also demote a piece of media in 
the list by selecting the media and then clicking the down arrow to the right 
of the list box. When you finish, click Finish or Close as appropriate.

All media with tasks assigned appear in the Media Task Queue Manager 
until they are processed. For media with tasks selected to process ASAP – 
as soon as possible, those media may only appear briefly in the queue 
before the processing completes and the media is removed from the 
queue.
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4Managing the Extended Drive

Administering your extended drive involves management of the files saved on 
the extended drive, and of the extended drive itself. Much of the administration 
of the extended drive can be done through configuration of the extended drive 
properties and proper setup of certain schedulable events. 

As the ASM Data Manager administrator, you will want to become very familiar 
with the properties and options for the extended drives. Understanding how 
these functions work, and more importantly, how they work together, allows 
you to configure Data Manager in a way that makes management of the 
system simple and more efficient.

In addition, using a file migration system to manage your data and files also 
allows you to manage data storage space. After file data is moved to storage 
media, that data can be removed from the local storage space, freeing up that 
space for additional files. The key is to maintain as much local storage space 
as possible while still making files easily available. Ultimately, your data 
management system is also a space management system. You can manage 
space on the extended drive by purging and deleting files. As with file 
migration, Data Manager provides a rule-based system so that you can select 
which files you want to purge and/or delete, and when.

Since the extended drive is one of the most critical components of the Data 
Manager system, this guide has devoted this entire chapter to explaining 
space management and the extended drive functions and options available to 
you. You will also find instructions for deleting an extended drive if you no 
longer need it, and for running drive scans so that Data Manager can write 
files to the move and purge lists, and consequently to move the files to storage 
media and to purge the data from the extended drive. For more information, 
see the following sections:

• "Managing Space on the Extended Drive, " which follows

• “Modifying the Extended Drive” on page 190

• “Deleting the Extended Drive” on page 204

• “Running Drive Scans” on page 204

■ Managing Space on the Extended Drive
Space management refers to management of the available space on your 
extended drive. An extended drive is called such because its storage capacity 
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is “extended” for use by ASM Data Manager’s file migration services. Data 
Manager allows you to “extend” an NTFS-formatted hard drive on a Data 
Manager computer by moving files to media for storage while making the files 
appear to remain on the hard drive.

Those files appear to remain on the hard drive because Data Manager uses a 
“file tag” to identify the file after the file data is removed. Removing file data 
while leaving the file tag behind is called a purge. The file is still accessible, 
and to a client workstation, appears to be saved on the extended drive 
volume. When the client requests the file, Data Manager goes to the media 
where the file is stored and retrieves the file data, displaying it for the client.

In some instances, you may also want to delete files completely when they are 
no longer of use. Data Manager allows you to set up delete rules that set 
specific criteria for what files are to be deleted from both the extended drive 
and the storage media. 

The extended drive, media folders, move groups, and move rules, and their 
creation and management are what enable and automate file migration in your 
data management system. The purge rules (and the purge after move setting 
in move rules) and delete rules are what enable and automate space 
management within your data management system.

For more information, see the following sections:

• "Purging Files, " which follows

• “Deleting Files” on page 180

For details on the creation of extended drives and media folders, and creation 
and management of move groups and move rules, refer to the Setting Up File 
Migration chapter of the ASM Data Manager Getting Started Guide.

Purging Files
Once files have been moved to media, they can be purged from the extended 
drive, creating more space for new files. When a file is purged, the data in the 
file is removed from the extended drive and a “file tag” is left behind. The file 
tag contains information about the file, including name, size, age, and other 
attributes. It is this tag that makes purged files appear to be resident on the 
extended drive volume, allowing clients to access them.

Because space and file retrieval requirements vary, Data Manager provides 
several different ways to purge files from the extended drive. In addition, Data 
Manager allows you to be very specific as to when files are purged from the 
extended drive. 

There are four different events that can trigger files to be purged from the 
extended drive:
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• Moving a file to media. Files can be purged from the extended drive 
immediately after they are moved if you enable the Purge files immediately 
after move option on the Settings tab of the move rule.

• Finalizing media. Files written to DVD-R media cannot be purged until the 
media is finalized (to avoid the possibility of data loss, in the event there is 
a problem with the media before it is finalized). Because of this, the finalize 
media task contains a Purge files option that allows you to purge the file 
data for all files written to the media at the time the media is finalized. 

• During an extended drive scan. Files that qualify for purge rules that are 
configured with the Force files to purge during extended drive scans option 
selected (in the Settings tab of the purge rule) are purged from the 
extended drive during the first drive scan that occurs after the file qualifies 
for the rule.

• When the used extended drive space reaches a pre-set limit or watermark. 
Files that qualify for purge rules that do not have the Force files to purge 
during extended drive scans option enabled (in the Settings tab of the 
purge rule) are written to the purge list. The purge list is a listing of files 
that are due to be purged from the extended drive based on purge rules 
configured. The purge list is not processed until space is needed on the 
extended drive, at which time the purge list is processed and those files 
are purged.

For more detailed information on these processes, see the following sections:

• "When to Purge Files, " which follows

• “Purge Rules” on page 169

When to Purge Files
Files cannot be purged from the extended drive until they are moved to media. 
However, once a file is moved to media, you can choose whether to purge that 
file from the extended drive immediately after it has been moved, wait until a 
specified period of time has passed, purge the file when extended drive space 
is low, purge during the next drive scan (after the file qualifies for the purge 
rule) or choose not to purge the file at all, leaving the file data on the extended 
drive.

Note: You can also select specific files and purge them manually using the 
Explorer Add-ons. For more information, see “Using Explorer Add-ons” 
on page 309.

Which option you choose is likely determined by a number of factors, including 
the type of storage media you are using, how much space you have on your 
extended drive, and how often files are normally accessed. For example, if 
you are using EMC or NAS as your storage media, you may want to purge all 
files as soon as they have been moved, because file retrieval from these 
media is much faster than with other types of media. Or, if you only want to 
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remove infrequently used files, you may decide to purge files only after a 
certain number of days have passed since they were last accessed.

In addition, if you disable certain time periods on the Allow fetches from media 
schedule to create a time-based restriction of access to purged files, you may 
want to take that into consideration when determining when to purge files. (For 
more information on the Allow fetches from media schedule, see “Fetching 
Files from Media” on page 47.) 

Purge rules can be used to purge files based on the age of the file. That 
capability, in combination with one or more of the purge options listed below, 
allows you to maintain necessary extended drive space while still allowing 
client access to needed files, regardless of media access restrictions:

• "Purging Files Immediately After They Have Been Moved, " which follows

• “Purging Files During Drive Scans” on page 167

• “Purging Files As Disk Space Is Needed” on page 167

• “Never Purging Files” on page 168

Purging Files Immediately After They Have Been Moved
The option to purge files immediately after they have been moved to media is 
configured in move rules as opposed to purge rules. This is because the 
attribute that qualifies the file to be purged is that it was moved to media; no 
other qualifier is necessary.

When the Purge files immediately after move option is enabled in a move rule 
(using the Settings tab), the files that qualify for the move rule are moved to 
media and their data is immediately purged. They are never written to the 
purge list. Purging files in this way allows you to maintain a high volume of free 
space on your extended drive and is particularly useful if your storage media 
allows for fast retrieval of files upon client request.

Purging files immediately after they are moved to media and then setting up 
prefetch requests for frequently used files allows you to manage, very 
specifically, what file data is resident on the extended drive. Using these two 
options in conjunction with one another gives you a great deal of control over 
your extended drive space. For information on configuring the Purge files 
immediately after move option for your move rules, see The Settings Tab for 
move rules on page 141. For information on prefetch requests, see 
“Requesting Specific Files Using Prefetch Requests” on page 146. 

Purging Files During Finalization (DVD-R media only)
If you are using DVD-R as your media, you cannot purge files that were written 
to the media until the media is finalized. The finalize media task allows you to 
select the Purge Files option, which tells Data Manager to purge those files at 
the time the media is finalized. If you do not select to purge files at that time, 
the data for those files remains on the extended drive until the files qualify for 
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configured purge rules. Then it is the selections made in the purge rules that 
determine when the files are purged from the extended drive (see the two 
discussions that follow). For information on the finalize media task, see 
“Finalizing Media” on page 82.

Purging Files During Drive Scans
Setting up purge rules allows you to specify what files are purged from the 
extended drive and when. You can set up your purge rules so that Data 
Manager purges files that qualify for the purge rule during the next drive scan 
rather than when the used extended drive space reaches the purge start 
watermark.

During an extended drive scan (either scheduled or forced), Data Manager 
checks all migrated files to see whether they qualify for a purge rule. If a file 
does qualify, and the rule for which it qualifies is configured with the Force files 
to purge during extended drive scans option enabled on the Settings tab, that 
file is purged from the extended drive at the time of the drive scan.

Note: When purge rules are configured without an age delay, files are written 
to the purge list when they are moved to media. If the purge rules are 
configured to force purges during drive scans, then the files are purged 
during the next drive scan. If, however, the extended drive used space 
reaches the purge start watermark before the next drive scan, then the 
files may be purged as the purge list is processed. For information on 
configuring the purge start watermark, see “Purge start watermark 
(drive percent full)” on page 200.

Using this option in conjunction with regularly scheduled extended drive scans 
helps maintain a high volume of free space on your extended drive. This may 
be particularly useful if the types of files written to the drive are very large 
(multi-media files, for example). For information on configuring the Force files 
to purge during extended drive scans option, see “Configuring the Purge Rule 
Settings Page” on page 176. For information on running drive scans, see 
“Running Drive Scans” on page 204.

Purging Files As Disk Space Is Needed
Because setting up purge rules is designed to make sure there is always 
enough usable space on the extended drive for new files, the default setup for 
purging files is to do so only when the free space on the extended drive 
reaches a critical level.

When files are moved to media or fetched from media, Data Manager checks 
the files to see whether they qualify for a purge rule. If the files qualify, the files 
are written to the purge list.

Unless the files qualify for a purge rule that is configured to purge during drive 
scans, the files on the purge list are not purged from the extended drive until 
the drive’s used space reaches the purge start watermark, as configured on 
the Options tab of the Extended Drive Properties dialog box. The purge start 
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watermark is simply an identification of how much space on the extended 
drive must be filled (in percentage) before files will be purged. The default is 
95 percent.

In addition, the purge list is only processed (and listed files are purged) until 
the purge stop watermark is reached, which is also configured on the Options 
tab of the Extended Drive Properties dialog box. The purge stop watermark is 
simply an identification of how much space on the extended drive must be 
filled (in percentage) before processing of the purge list will stop. The default 
is 90 percent.

The percentage of extended drive space between the purge start and the 
purge stop watermarks is how much space must be reclaimed for use by 
purging files from the extended drive through processing the purge list.

Note: If files on the purge list qualify for a purge rule that is configured to 
purge during drive scans and a drive scan occurs before the purge 
start watermark is reached, then the files are purged as part of the 
drive scan and the purge list is updated.

You can also configure your purge rules using a priority system for purging 
qualified files. This priority ranking allows you to make an additional 
determination with respect to keeping certain file data on the extended drive 
until removing it is absolutely necessary. 

Purging files in this way assures that file data remains on the extended drive 
until purging to recover space on the extended drive is absolutely necessary. 
This method is recommended if you are using a type of storage media that 
does not allow for fast retrieval of files. 

For information on configuring the purge start and stop watermarks, see 
“Purge start watermark (drive percent full)” on page 200 and “Purge stop 
watermark (drive percent full)” on page 201.

Never Purging Files
It is not necessary to purge files from your extended drive. However, files 
moved to media remain resident on the extended drive if they are not purged. 
Files then become redundant, because the files are now saved on both the 
extended drive and the media. Be advised that filling up extended drive space 
to capacity can cause problems if extended drive space is required to run a 
Data Manager function such as compaction.

Setting up file migration without purging files may be useful if you are only 
using your Data Manager system for file backup or extended drive mirroring. 
However, if you are using Data Manager as a tool to manage files and file 
space, we recommend purging files at a point that makes the most sense for 
proper maintenance of your Data Manager system.

To configure Data Manager to never purge files, do not configure any purge 
rules, and be sure that the Purge files immediately after move setting in your 
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move rules is not enabled. If you choose to never purge files from the 
extended drive, however, you will want to have Data Manager send an alert 
when drive space reaches a critical level. For more information on enabling 
the extended drive option to send this warning, see “Warn when free space is 
getting low (MB)” on page 201.

Purge Rules
Data Manager allows you to configure purge rules to reclaim space on the 
extended drive by truncating files after those files have been moved to media. 
Purge rules control when file data from moved files is purged from the hard 
drive. 

The parameters used to select files for a purge rule are similar to those 
configured for a move rule. File age, size, extension, and attributes can be 
used to specify a set of files to be purged. You can also configure the 
processing priority for a purge rule. Priorities can be used to ensure that 
certain files, such as larger files, are purged first, optimizing the purge 
process. 

Purge rules also contain an exclusion type option that allows you to identify 
files in the media folder that should not be purged from the drive. Exclusion 
type purge rules allow for specification of the same kind of criteria as inclusion 
type purge rules. This exclusion option makes it easy to set up Data Manager 
to purge all files in a folder except for a specified file type or a specified sub-
folder. By combining inclusion and exclusion type purge rules, you can be very 
specific about what files are purged from the extended drive. 

Note: When files qualify for both an inclusion purge rule and an exclusion 
purge rule, the exclusion purge rule takes precedence, and the files 
are excluded from purging.

Regular drive scans are required to make sure that files that qualify against 
purge rules are either purged (during the drive scan if the Force files to purge 
during extended drive scans option on the Settings page is enabled) or written 
to the purge list (if the purge rules are configured with an age delay). For more 
information on drive scans, see “Running Drive Scans” on page 204. 

When purge rules are configured without an age delay, files are written to the 
purge list when they are moved to media. If the purge rules are configured 
such that Data Manager does not force purges during drive scans, then the 
purge list is processed (and files are purged) when the purge start watermark 
is reached. Data Manager continues to purge files until the purge stop 
watermark is reached. 

If, however, the purge rules are configured to force purges during drive scans, 
then the files are purged during the next drive scan or when the purge start 
watermark is reached (and the purge list is therefore processed), whichever 
comes first. 
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For information on configuring the purge start and stop watermarks, see 
“Purge start watermark (drive percent full)” on page 200 and “Purge stop 
watermark (drive percent full)” on page 201.

Since Data Manager does not attempt to qualify files for purge until they have 
been moved to media, only files that have been moved to media can be 
purged using purge rules.

In addition, files moved to DVD-R media cannot be purged until the media is 
finalized. When you finalize DVD-R media, you have the option of purging 
those files at the time of finalization. If you select not to purge files at that time, 
the files that were written to the media remain on the extended drive, but will 
be purged like any other files, as they qualify for configured purge rules.

You can create, modify, and delete purge rules. For instructions, see the 
following sections:

• "Creating a Purge Rule, " which follows

• “Modifying a Purge Rule” on page 178

• “Deleting a Purge Rule” on page 180

Creating a Purge Rule
The Purge Rule Wizard leads you step-by-step through the purge rule creation 
process. You can configure the purge rule at the time you create it, or you can 
access and change these configurations later through the Purge Rule 
Properties dialog box. Each tab of the Purge Rule Properties dialog box is 
identical to the corresponding page of the Purge Rule Wizard.

For instructions on running the Purge Rule Wizard, see the following sections:

• "Starting the Purge Rule Wizard, " which follows

• “Configuring the Purge Rule File Name Page” on page 172

• “Configuring the Purge Rule Size Page” on page 173

• “Configuring the Purge Rule Attributes Page” on page 174

• “Configuring the Purge Rule Age Page” on page 175

• “Configuring the Purge Rule Settings Page” on page 176

• “Completing the Purge Rule Wizard” on page 177

Starting the Purge Rule Wizard
This section describes how to start the Purge Rule Wizard and configure the 
Rule Type page. 
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To start the Purge Rule Wizard: 

1. Right-click the Purge Rules node under the media folder for which you 
want to create the purge rule, and then select New from the shortcut 
menu. The Purge Rule Wizard appears, starting with the Rule Type page.

Figure 78.  Purge Rule Wizard -- Rule Type Page 

The Rule Type page allows you to select whether the criteria configured in 
the rule you are creating qualifies files for purge, or excludes files from 
being purged from the extended drive.

2. Select the appropriate Rule Type for this purge rule. You have the 
following choices:

• Select the Include option if you want to create a purge rule that 
specifies which files should be purged from the extended drive.

• Select the Exclude option if you want to create a purge rule that 
specifies which files should not be purged from the extended drive.

For example, if you want to purge all the files in a media folder except for 
text files, configure an inclusion type purge rule to include all files, and 
then configure an exclusion type purge rule to exclude all “*.txt” files.

If your media folder has multiple sub-directories that contain files you do 
not want purged from the drive, you can set an inclusion type purge rule to 
purge all files from the media folder and all sub-directories, and then set an 
exclusion type purge rule to exclude all files (or specific files) in a sub-
directory. 

Note: When files qualify for both an inclusion purge rule and an exclusion 
purge rule, the exclusion purge rule takes precedence, and the 
files are excluded from purging. However, if a configured move rule 
applies to the same files as an exclusion type purge rule you are 
configuring, and the Purge files immediately after move option on 
the move rule Settings page was selected, the files qualifying for 
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the move rule are purged and are not subject to the exclusion type 
purge rule. 

3. Click Next. The File Name page appears. For more information, see 
"Configuring the Purge Rule File Name Page, " which follows.

Configuring the Purge Rule File Name Page
The File Name page allows you to define the location and extension for the 
files to be purged or excluded from purging.

Figure 79.  Purge Rule Wizard -- File Name Page 

To configure the purge rule File Name page:

1. Select the folder to which you want the purge rule to apply. The active 
media folder is listed by default. If you want to apply the rule to only the 
files in a specific subfolder of the media folder, click Browse. The Select 
Folder window appears.

Figure 80.  Select Folder Window 

Select the subfolder to use for the purge rule and click OK.
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Note: You cannot include more than one subfolder of the media folder in 
a single purge rule. You can include either one or all subfolders 
only. To apply a purge rule to files in a different subfolder, create a 
second purge rule.

2. Enable or disable the Apply rule to subfolders option. If enabled, all files in 
the specified folder and all subfolders and their files are subject to the 
purge rule. If disabled, only the files in the specified directory are subject to 
the purge rule.

3. In the File Name text box, enter the file specification to determine which 
files are to qualify for this purge rule. You can use the standard Windows 
asterisk (*) wildcard to select only files with specific extensions or naming 
conventions for qualification. The asterisk represents one or more 
characters in the name or extension part of the file name. For example:

• To apply the purge rule to all files in the directory, type *.* in the File 
Name text box. 

• To apply the purge rule to only files of a particular type, type in an 
asterisk before the period and the appropriate file extension after the 
period. For example, to qualify only bitmaps, type *.BMP in the File 
Name text box.

• To apply the purge rule to files with a certain naming convention use 
the asterisk as part of the file name. For example, to qualify only files 
indicated as reports, type *REPORT.* or *REPORT*.* in the File 
Name text box. 

• To use the wildcard to specify only files of a certain type with a specific 
naming convention, use the asterisk in the name part of the file name 
while specifying the file extension. For example, to qualify only text 
files indicated as reports, type *REPORT*.txt in the file name text 
box.

Note: Only one specified file extension can be configured per purge rule. 
To purge or exclude files of different specified extensions in the 
same folder, create a second purge rule.

4. Click Next. The Size page appears. For more information, see 
"Configuring the Purge Rule Size Page, " which follows. 

Configuring the Purge Rule Size Page
The Size page allows you configure a specific size range for the files to be 
affected by the purge rule, or to qualify files of any size.



Managing the Extended Drive

174 Second Edition
StorageTek Proprietary

Figure 81.  Purge Rule Wizard -- Size Page 

To configure the purge rule Size page:

1. You have the following choices:

• To qualify files of all sizes, select Apply rule to files of any size. 

• To qualify only files of a certain size, select the Apply rule to files with 
the following sizes option.

2. If you select the Apply rule to files with the following sizes option, you have 
the following options:

• Enable the Files larger than __ KB check box. In the text box, type in 
the number of kilobytes that a file must equal or exceed in order to 
qualify for this rule.

• Enable the Files smaller than __ KB check box. In the text box, type in 
the number of kilobytes that a file must be equal to or smaller than in 
order to qualify for this rule.

Note: If both options are enabled, only files whose size falls in between 
the kilobyte specifications are subject to the purge rule.

3. Click Next. The Attributes page appears. For more information, see 
"Configuring the Purge Rule Attributes Page, " which follows. 

Configuring the Purge Rule Attributes Page
The Attributes page allows you to choose whether to qualify only files with 
certain attributes against the purge rule, or to qualify all files regardless of 
attributes.
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Figure 82.  Attributes Page 

To configure the purge rule Attributes page:

1. You have the following choices:

• To qualify files regardless of attribute, select Apply rule to files with any 
attribute. 

• To qualify only files with particular attributes for this rule, select Apply 
rule to files with the following attributes. Then enable the options for 
the attributes a file should have if you want the file to qualify for this 
rule. 

Note: When selecting attributes, be advised that files possessing any of 
the checked attributes will qualify for the rule (as opposed to files 
that need to possess all of the checked attributes to qualify, or files 
that need to possess only the checked attributes to qualify).

Note: If you have extended a system drive, or if you have application files 
on an extended drive, be sure to configure an exclude rule that 
excludes all files with the System attribute in order to prevent 
operating system or application file purge. Extending a system 
drive with Data Manager is not recommended and may cause 
severe operating system damage. Attributes for existing files can 
be viewed through Windows Explorer.

2. Click Next. The Age page appears. For more information, see "Configuring 
the Purge Rule Age Page, " which follows. 

Configuring the Purge Rule Age Page
The Age page allows you to configure a time delay for the purging of files from 
the extended drive. 

If there is no age specification configured for the purge rule, and if it is an 
inclusion type purge rule, all files that have been moved to media and that 
otherwise qualify for purge under this purge rule are written to the purge list.
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If an age specification is configured for the purge rule, and it is an inclusion 
type purge rule, all files that have been moved to media and that otherwise 
qualify for purge under this purge rule are written to the purge list when the 
entered number of days has elapsed since the selected file action and when 
the next drive scan is run.

Figure 83.  Purge Rule Wizard -- Age Page 

To configure the purge rule Age page:

1. You have the following choices:

• To qualify files regardless of age, select Apply rule to files of any age. 

• To qualify only files older than a particular age, enable the Apply rule to 
files of age greater than option. 

2. If you enable the Apply rule to files of age greater than option, enter the 
number of days that must elapse before a file qualifies for this rule. 

3. Set the date from which that file age is calculated by selecting one of the 
following options from the Since drop-down list:

• Create time

• Last write time

• Last access time

4. Click Next. The Settings page appears. For more information, see 
"Configuring the Purge Rule Settings Page, " which follows. 

Configuring the Purge Rule Settings Page
The Settings page allows you to specify whether you want to purge files as 
disk space is needed (as determined by the purge start and stop watermarks) 
or during extended drive scans.

You can also configure the processing priority for a purge rule. Priorities can 
be used to ensure that certain files, such as larger files or files that are 
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accessed less frequently, are purged first (when disk space is needed), 
optimizing the purge process.

For exclusion type purge rules, the Settings page appears, but the information 
and options on the page do not apply, and therefore are grayed out. 

In addition, files written to DVD-R media are not purged until the media is 
finalized.

Figure 84.  Purge Rule Wizard -- Settings Page 

To configure the purge rule Settings page:

1. You have the following choices:

• To purge files only when extended drive space is needed, select Do 
not force purges during extended drive scans. Then choose the priority 
for the purging of files that qualify for this rule in relation to other purge 
rules. 

• To configure the rule to purge eligible files during a drive scan, select 
Force files to purge during extended drive scans.

Note: If you choose to purge files as disk space is needed, remember to 
configure the purge start and stop watermarks in the Options tab of 
the Extended Drive Properties. For more information, see “The 
Options Tab” on page 194. If you choose to purge files during 
extended drive scans, remember to set up a regular drive scan 
schedule. For more information, see “Scheduling Drive Scans” on 
page 205.

2. Click Next. The Summary page appears. For more information, see 
"Completing the Purge Rule Wizard, " which follows.

Completing the Purge Rule Wizard
The Summary page allows you to review the information that you have 
provided in the Purge Rule Wizard and then to finish creating the purge rule.
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To complete the Purge Rule Wizard:

1. Review the information on the Summary page.

2. If the information in the summary is correct, click Finish. The purge rule is 
created and appears under the Purge Rules node of the media folder on 
the extended drives tree.

Modifying a Purge Rule
Accessing the Purge Rule Properties dialog box and selecting each of the tabs 
allows you to view and change the settings established when the purge rule 
was created. You can change the folder and files to which the rule applies, 
change or disable the file size specifications, change or disable the 
qualification of files based on file attributes, change or disable the age (time 
delay) specifications for purging files and select whether to purge files during 
drive scans or only when extended drive disk space is needed. In addition, 
you can change whether the rule is an inclusion or exclusion type of purge 
rule.

To modify a purge rule: 

1. Right-click the purge rule you want to modify and then select Properties 
from the shortcut menu, or double-click the purge rule you want to modify. 
The Purge Rule Properties dialog box appears with the Rule Type tab 
active by default.

Figure 85.  Purge Rule Properties Dialog Box 

2. Modify the settings on each of the tabs as necessary. All of the tabs but the 
Statistics tab are identical to the corresponding page of the Purge Rule 
Wizard. For more information, see the following sections: 

• The Rule Type tab is discussed in “Starting the Purge Rule Wizard” on 
page 170

• The File Name tab is discussed in “Configuring the Purge Rule File 
Name Page” on page 172.

• The Size tab is discussed in “Configuring the Purge Rule Size Page” 
on page 173.
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• The Attributes page is discussed in “Configuring the Purge Rule 
Attributes Page” on page 174.

• The Age tab is discussed in “Configuring the Purge Rule Age Page” on 
page 175.

• The Settings page is discussed in “Configuring the Purge Rule 
Settings Page” on page 176.

• The Statistics tab, which is not part of the Purge Rule Wizard, is 
discussed in "The Statistics Tab, " which follows.

3. As with most Properties functions in ASM, after making changes you have 
three options:

• To save changes and close the Properties dialog box, click OK.

• To save changes and keep the Properties dialog box open, click Apply.

• To discard all changes made since the Properties dialog box was 
opened (or since the Apply button was used) and close the Properties 
dialog box, click Cancel. 

The Statistics Tab
The Statistics tab of the Purge Rule Properties dialog box provides pending 
file purge statistics from the most recent drive scan. The statistics shown 
pertain only to the files selected for purge by qualifying for this purge rule, and 
are valid only until the next extended drive scan.

For exclusion type purge rules, the Statistics tab appears, but the information 
does not apply.

To view the Statistics tab:

• Click the Statistics tab in the Purge Rule Properties dialog box.

Figure 86.  Purge Rule Properties – Statistics Tab 
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The items shown on the Statistics tab are as follows:

Deleting a Purge Rule
Deleting a purge rule deletes all configured options for that purge rule. 

To delete a purge rule:

1. Right-click the purge rule you want to delete and select Delete from the 
shortcut menu, or select the purge rule you want to delete and then press 
<DELETE>.

2. Click Yes on the confirmation message that appears.

Deleting Files
In certain situations, you may not want to keep files after a certain period of 
time, even on storage media. You can use delete rules to automatically delete 
files from both the extended drive and from storage media. Users may also 
decide to delete files when they determine those files are no longer needed.

When a file is deleted, either by a user (for example, through Windows 
Explorer), or by becoming eligible for deletion under a delete rule, Data 
Manager deletes the file from the extended drive and marks it for deletion on 
the media. The file may still exist on the media, but it becomes an “orphaned” 
file and is no longer recognized or tracked by Data Manager.

When the storage media that the (now deleted) file was moved to is 
compacted, Data Manager does not copy any deleted files from the original 
piece of media back to the extended drive. Files on compacted media are 
actually deleted when the compacted media is reformatted. For more 
information on compacting media, see “Compacting Media” on page 79. While 
it may be possible to recover deleted files from storage media, we do not 
support this recovery and recommend that you use extreme caution if using 
delete rules to delete files on a regular basis.

On NTFS media, deleted files are removed from the storage media when the 
transactions are flushed. However, for other types of media, files qualifying for 
deletion are not deleted until the media is compacted and reformatted. If the 
media is “write-once” media, like WORM, WORM-tape, or DVD-R, the files on 

Table 20.  Purge Rule Statistics Tab Information

Item Description
Total Files The number of files that, at the time of the last drive scan, 

qualified for purging from the extended drive using this 
purge rule

Total Bytes The total size in bytes of all files that, at the time of the last 
drive scan, qualified for purging from the extended drive 
using this purge rule
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the media are never deleted, but the file tag that Data Manager uses to track 
the file is deleted from the extended drive. Without the file tag, Data Manager 
cannot track the file or retrieve it for clients. 

If you are using EMC media and you have set a retention period, remember 
that files cannot be deleted until the retention period expires. For more 
information on retention periods for EMC media, see the Setting Up Media 
Services chapter of the ASM Data Manager Getting Started Guide. 

Note: It is important to note that Data Manager does not keep copies of 
deleted files anywhere in the Data Manager system. To simply clear 
space on the extended drive but retain file data on storage media, use 
purge rules rather than delete rules. 

Delete Rules
Delete rules allow you to specify what files you want to delete from both the 
extended drive and storage media (if applicable). When a file becomes eligible 
for deletion under a delete rule, Data Manager deletes it from the extended 
drive and marks it for deletion on the media. The file may still exist on a piece 
of media, but it becomes an “orphaned” file and is no longer recognized or 
tracked by Data Manager.

These rules can be used, for example, to help manage archival of particular 
files kept in order to comply with legal requirements. You could create a delete 
rule that deletes all files in a particular directory that you are not legally 
required to keep. As long as the files fit the legal criteria, they are backed up to 
media by Data Manager and remain in the directory. Once the files no longer 
meet the required criteria (for example, the files reach a certain age), however, 
Data Manager can automatically delete them in accordance with a delete rule.

The parameters used to select files for a delete rule are similar to those 
configured for move and purge rules. File age, size, extension, and attributes 
can be used to specify a set of files to be deleted. 

Delete rules also contain an exclusion type option that allows you to identify 
files in the media folder that Data Manager should not delete from the 
extended drive and associated media. Exclusion type delete rules allow for 
specification of the same kind of criteria as inclusion type delete rules. 
Combining inclusion and exclusion type delete rules allows you to be very 
specific about what files are deleted from the ASM system. 

Note: When files qualify for both an inclusion delete rule and an exclusion 
delete rule, the exclusion delete rule takes precedence, and Data 
Manager does not delete the files.

Note: Delete rules do not prevent users from deleting files on the extended 
drive; they only specify which files Data Manager should or should not 
delete.
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Delete rules are processed when a drive scan is run. For more information on 
drive scans, see “Running Drive Scans” on page 204.

You can create, modify, and delete your delete rules. For instructions, see the 
following sections:

• "Creating a Delete Rule, " which follows

• “Modifying a Delete Rule” on page 189

• “Deleting a Delete Rule” on page 190

Creating a Delete Rule
The Delete Rule Wizard leads you step-by-step through the delete rule 
creation process. You can configure the delete rule at the time you create it, or 
you can access and change these configurations later through the Delete Rule 
Properties dialog box. Each tab of the Delete Rule Properties dialog box is 
identical to the corresponding page of the Delete Rule Wizard. 

For instructions on running the Delete Rule Wizard, see the following sections: 

• "Starting the Delete Rule Wizard, " which follows

• “Configuring the Delete Rule File Name Page” on page 184

• “Configuring the Delete Rule Size Page” on page 186

• “Configuring the Delete Rule Attributes Page” on page 186

• “Configuring the Delete Rule Age Page” on page 187

• “Completing the Delete Rule Wizard” on page 188 

Starting the Delete Rule Wizard
This section describes how to start the Delete Rule Wizard and configure the 
Rule Type page. 

To start the Delete Rule Wizard:

1. Right-click the Delete Rules node under the media folder for which you 
want to create the delete rule and then select New from the shortcut menu. 
A verification message appears stating that delete rules are automatic 
policies that will permanently remove files from your system. 

2. Click Yes. The Delete Rule Wizard appears, starting with the Rule Type 
page.
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Figure 87.  Delete Rule Wizard -- Rule Type Page 

The Rule Type page allows you to select whether the criteria configured in 
the rule you are creating will qualify files for or exclude files from being 
deleted from the extended drive and associated media.

3. Select the appropriate Rule Type for this delete rule. You have the 
following choices:

• Select the Include option if you want to create a delete rule that 
specifies which files should be deleted from the system.

• Select the Exclude option if you want to create a delete rule that 
specifies which files should not be deleted from the system.

For example, if you want to delete all the files in a media folder except for 
text files, configure an inclusion type delete rule to include all files, and 
then configure an exclusion type delete rule to exclude all “*.txt” files.

If your media folder has multiple sub-directories that contain files you do 
not want deleted from the system, you can set an inclusion type delete rule 
to remove all files from the media folder and all sub-directories, and then 
set an exclusion type delete rule to exclude all files (or specific files) in a 
sub-directory. 

Note: When files qualify for both an inclusion delete rule and an exclusion 
delete rule, the exclusion delete rule takes precedence, and Data 
Manager does not delete the files.

Note: Delete rules do not prevent users from deleting files on the 
extended drive; they only specify which files Data Manager should 
or should not delete. 

4. Click Next. The File Name page appears. For more information, see 
"Configuring the Delete Rule File Name Page, " which follows.
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Configuring the Delete Rule File Name Page
The File Name page allows you to define the location and extension for the 
files to be deleted or excluded from deletion. You can also select to Apply the 
rule to subfolders and Apply the rule to files that have not been migrated for 
qualification for this rule. 

Figure 88.  Delete Rule Wizard -- File Name Page 

To configure the delete rule File Name page:

1. Select the folder to which you want the delete rule to apply. The active 
media folder is listed by default. If you want to apply the rule to only the 
files in a specific subfolder of the media folder, click Browse. The Select 
Folder window appears.

Figure 89.  Select Folder Window 

Select the folder to use for the delete rule and click OK. The file path 
appears in the Folder box of the File Name page.
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Note: You cannot include more than one subfolder of the media folder in 
a single delete rule. You can include either one or all subfolders 
only. To qualify files in a different subfolder, create a second delete 
rule.

2. Enable or disable the Apply rule to subfolders option. If enabled, all files in 
the specified folder and all subfolders and their files are subject to the 
delete rule. If disabled, only the files in the specified directory are subject 
to the delete rule.

3. Enable or disable the Apply rule to files that have not been migrated 
option. If enabled, all files, including those files that have not been 
migrated, are subject to the delete rule. If disabled, only files that have 
been migrated are subject to the delete rule.

Note: If you check the Apply rule to files that have not been migrated 
option, Data Manager attempts to qualify all files in the media 
folder against the delete rule(s), regardless of whether the files 
have been moved to media.

4. In the File Name text box, enter the file specification to determine which 
files are to be deleted or excluded from deletion using this delete rule. You 
can use the standard Windows asterisk (*) wildcard to select only files with 
specific extensions or naming conventions for delete. The asterisk 
represents one or more characters in the name or extension part of the file 
name. For example:

• To apply the delete rule to all files in the directory, type *.* in the File 
Name text box. 

• To apply the delete rule to only files of a particular type, type in an 
asterisk before the period and the appropriate file extension after the 
period. For example, to qualify only bitmaps, type *.BMP in the File 
Name text box.

• To apply the delete rule to files with a certain naming convention use 
the asterisk as part of the file name. For example, to qualify only files 
indicated as reports, type *REPORT.* or *REPORT*.* in the File 
Name text box.

• To use the wildcard to specify only files of a certain type with a specific 
naming convention, use the asterisk in the name part of the file name 
while specifying the file extension. For example, to qualify only text 
files indicated as reports, type *REPORT*.txt in the file name text 
box.

Note: Only one file name specification can be configured per delete rule. 
To qualify files of a different specification in the same folder, create 
a second delete rule.

5. Click Next. The Size page appears. For more information, see 
"Configuring the Delete Rule Size Page, " which follows.
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Configuring the Delete Rule Size Page
The Size page allows you to choose to qualify all files in the folder, or 
configure a specific size range for the files affected by the delete rule.

Figure 90.  Delete Rule Wizard -- Size Page 

To configure the delete rule Size page:

1. You have the following choices:

• To qualify files of all sizes, select Apply rule to files of any size. 

• To qualify only files of certain sizes for this rule, select the Apply rule to 
files with the following sizes option.

2. If you select the Apply rule to files with the following sizes option, you have 
the following options:

• Enable the Files larger than __ KB check box. In the text box, type in 
the number of kilobytes that a file must equal or exceed in order to 
qualify for this rule.

• Enable the Files smaller than __ KB check box. In the text box, type in 
the number of kilobytes that a file must be equal to or smaller than in 
order to qualify for this rule.

Note: If both options are enabled, only files whose size falls in between 
the kilobyte specifications are subject to the delete rule. 

3. Click Next. The Attributes page appears. For more information, see 
"Configuring the Delete Rule Attributes Page, " which follows.

Configuring the Delete Rule Attributes Page
The Attributes page allows you to choose whether to qualify files with certain 
attributes against this rule, or to qualify all files regardless of attribute.
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Figure 91.  Delete Rule Wizard -- Attributes Page 

To configure the delete rule Attributes page:

1. You have the following choices:

• To qualify files regardless of attributes, select Apply rule to files with 
any attribute. 

• To qualify only files with particular attributes for this rule, select Apply 
rule to files with the following attributes, and then enable the options for 
the attributes of files that should qualify for this rule. 

Note: When selecting attributes, be advised that files possessing any of 
the checked attributes will qualify for the rule (as opposed to files 
needing to possess all of the checked attributes to qualify, or files 
needing to possess only the checked attributes to qualify).

Note: If you have extended a system drive, or if you have application files 
on an extended drive, be sure to configure an exclude rule that 
excludes all files with the System attribute, to prevent operating 
system or application file purge. Extending a system drive with 
Data Manager is not recommended and may cause severe 
operating system damage. Attributes for existing files can be 
viewed through Windows Explorer.

2. Click Next. The Age page appears. For more information, see "Configuring 
the Delete Rule Age Page, " which follows.

Configuring the Delete Rule Age Page
The Age page allows you to configure a time delay for the qualification of files 
for this rule. 

If an age specification is configured for the delete rule and it is an inclusion 
type delete rule, all files that otherwise qualify for deletion under this delete 
rule are deleted when the entered days have elapsed since the selected file 
action and when the next drive scan is run.
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Figure 92.  Delete Rule Wizard -- Age Page 

Note: If there is no age specification configured for the delete rule, and it is 
an inclusion type delete rule, all files that otherwise qualify for deletion 
under this delete rule are deleted immediately after the first drive scan.

To configure the delete rule Age page:

1. You have the following choices:

• To qualify files regardless of age, select Apply rule to files of any age. 

• To qualify files older than a particular age, enable the Apply rule to files 
of an age greater than option.

2. If you enable the Apply rule to files of an age greater than option, enter the 
number of days that must elapse before a file qualifies for the rule. 

3. Set the date from which that file age is calculated by selecting one of the 
following options from the Since drop-down list.

• Create time

• Last write time

• Last access time

4. Click Next. The Summary page appears.

Completing the Delete Rule Wizard
The Summary page allows you to review the information that you have 
provided in the Delete Rule Wizard and then to finish creating the delete rule. 

To complete the Delete Rule Wizard:

1. Review the information in the summary. 

2. If the information in the summary is correct, click Finish. The delete rule is 
created and appears under the Delete Rules node of the media folder in 
the extended drive tree.
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Modifying a Delete Rule
Accessing the Delete Rule Properties dialog box and selecting each of the 
tabs allows you to view and change the settings established when the delete 
rule was created. You can change the folder and files to which the rule applies, 
change or disable the file size specifications, change or disable the 
qualification of files based on file attributes, and change or disable the age 
(time delay) specifications for deleting files. You can also change whether the 
rule is an inclusion or exclusion type delete rule.

To modify a delete rule: 

1. Right-click the delete rule you want to modify and then select Properties 
from the shortcut menu, or double-click the delete rule you want to modify. 
The Delete Rule Properties dialog box appears with the Rule Type tab 
active by default. 

Figure 93.  Delete Rule Properties -- Rule Type Tab 

2. Modify the settings on each of the tabs as necessary. All of the tabs are 
identical to the corresponding page of the Delete Rule Wizard. For more 
information, see the following sections:

• The Rule Type tab is discussed in “Starting the Delete Rule Wizard” on 
page 182

• The File Name tab is discussed in “Configuring the Delete Rule File 
Name Page” on page 184.

• The Size tab is discussed in “Configuring the Delete Rule Size Page” 
on page 186.

• The Attributes page is discussed in “Configuring the Delete Rule 
Attributes Page” on page 186.

• The Age tab is discussed in “Configuring the Delete Rule Age Page” 
on page 187.

3. As with most Properties functions in ASM, after making changes you have 
three options:
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• To save changes and close the Properties dialog box, click OK.

• To save changes and keep the Properties dialog box open, click Apply.

• To discard all changes made since the Properties dialog box was 
opened (or since the Apply button was used) and close the Properties 
dialog box, click Cancel. 

Deleting a Delete Rule
Deleting a delete rule deletes all configured options for that delete rule. 

To delete a delete rule:

1. Right-click the delete rule you want to delete and select Delete from the 
shortcut menu, or select the delete rule you want to delete and then press 
<DELETE>.

2. Click Yes on the confirmation message that appears.

■ Modifying the Extended Drive
Much of your extended drive administration can be taken care of automatically 
with proper setup and configuration of the available extended drive properties. 
The options available within the Extended Drive Properties dialog box allow 
you to do everything from setting up media activity schedules and drive scan 
schedules, to having the system inform you when extended drive space gets 
low and setting up a percentage full watermark for when to purge files.

To modify the extended drive:

1. Right-click on the extended drive you want to modify and then select 
Properties from the shortcut menu that appears, or double-click the 
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extended drive you want to modify. The Extended Drive Properties dialog 
box appears.

Figure 94.  Extended Drive Properties Dialog Box 

2. Modify the settings on each of the tabs as necessary. Note that the 
Settings and Options tabs are identical to the corresponding pages of the 
Extended Drive Wizard used to create the extended drive. For more 
information, see the following sections:

• "The General Tab, " which follows

• “The Settings Tab” on page 193

• “The Options Tab” on page 194

• “The Statistics Tab” on page 202

3. As with most Properties functions in ASM, after making changes you have 
three options:

• To save changes and close the Properties dialog box, click OK.

• To save changes and keep the Properties dialog box open, click Apply.

• To discard all changes made since the Properties dialog box was 
opened (or since the Apply button was used) and close the Properties 
dialog box, click Cancel. 

The General Tab
The General tab of the Extended Drive Properties dialog box displays 
identifying information for the drive, as well as extended drive total space and 
free space information.
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To view the General tab:

• Click the General tab of the Extended Drive Properties dialog box.

Figure 95.  Extended Drive Properties – General Tab 

The information on the tab is separated into two sections: Drive 
Information and Size Information. The following table describes each of 
the items appearing on the General tab: 

Table 21.  Extended Drive Properties – General Tab Items

Group Item Description
Drive 
Information

Computer Name The name of the Data Manager 
computer where the extended drive 
is located

Drive Letter The drive letter of the extended 
NTFS volume (extended drive)

Volume Name The volume name of the extended 
NTFS volume (extended drive)

Serial Number The serial number of the physical 
hard drive on which the extended 
NTFS volume is located

Physical Name The physical name of the hard drive 
on which the extended NTFS volume 
is located
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The Settings Tab
The Settings tab of the Extended Drive Properties dialog box provides access 
to the scheduling functions for drive scans, media activities, and meta-data 
exports.

To configure the Settings tab:

1. Click the Settings tab of the Extended Drive Properties dialog box.

Drive Space The percentage of drive space used 
on the physical hard drive on which 
the extended NTFS volume is 
located

Status The status (online or offline) of the 
extended drive

Size 
Information

Sector Size The size of each sector on the 
extended drive

Total Physical 
Capacity

The total physical space available on 
the extended drive

Total Logical 
Capacity

The total usable space available on 
the extended drive

Drive Free Space The total free space available on the 
extended drive

Table 21.  Extended Drive Properties – General Tab Items (Continued)

Group Item Description
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Figure 96.  Extended Drive Properties – Settings Tab 

2. You have the following choices:

• To configure media activity schedules, click Schedule. There are four 
storage media activities that can be scheduled for each extended 
drive: Move files to media, Process scheduled media tasks, Update 
copy media, and Allow fetches from media. For more information, see 
“Scheduling Media Activities” on page 52.

• To configure a drive scan schedule, click Drive Scan. Drive scans must 
be performed periodically in order to write files to the move and purge 
lists, and consequently to move the files to storage media and to purge 
the data from the extended drive. Drive scans are also required to 
delete files based on configured delete rules. You should have 
configured a drive scan when you initially set up your Data Manager 
system. For more information, refer to the Setting Up File Migration 
chapter of the ASM Data Manager Getting Started Guide.

• To configure a meta-data export schedule, click Meta-Data Export. 
Because configuration and scheduling of meta-data exports should be 
a part of a complete backup and recovery plan, we have placed details 
and specific instructions for this function in the Data Manager Backup 
and Recovery chapter. For more information, see “Exporting File Meta-
Data” on page 268.

The Options Tab
The Options tab of the Extended Drive Properties dialog box allows you to 
view and configure several options affecting extended drive functionality. We 
recommend that you pay special attention to the functions available through 
the Extended Drive Properties Options tab and configure them appropriately. 
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These options are designed to make administering your extended drive easier, 
and to help prevent file read/write and space issues.

To configure the Options tab:

1. Click the Options tab of the Extended Drive Properties dialog box.

Figure 97.  Extended Drive Properties – Options Tab 

The upper section of the Options tab shows a list of extended drive options 
available for configuration. The information in the bottom section of the 
Options tab changes to reflect the configuration aspects available for the 
option selected from the list in the top section of the Options tab.

2. Modify the settings for each option as necessary. For more information, 
see the following sections: 

• "3rd party backup mode for managed files, " which follows

• “3rd party backup saves migration info” on page 196

• “Direct read memory cache (MB)” on page 197

• “Disable folder rename check” on page 197

• “Fetch request timeout minutes” on page 198

• “Force direct read for all files” on page 198

• “Force moves when nothing to purge” on page 198

• “Prevent file delete” on page 199

• “Prevent file modification” on page 200

• “Purge start watermark (drive percent full)” on page 200
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• “Purge stop watermark (drive percent full)” on page 201

• “Warn when free space is getting low (MB)” on page 201

• “Defer fetch requests if fetch is disabled” on page 201

3rd party backup mode for managed files
Use this extended drive option to configure how Data Manager managed files 
are saved during a backup using a third-party backup system. Files become 
“managed” by Data Manager once they are moved to media. Since the file 
data is managed by Data Manager on storage media, you can choose to have 
the third-party backup system only back up the file tag for those files.

Note: This backup setting pertains only to third-party system backups 
external to Data Manager and is not related in any way to the Data 
Manager meta-data export utility. We recommend that you also back 
up your extended drive files using the Data Manager meta-data export 
utility. For more information, see “Exporting File Meta-Data” on 
page 268.

To configure the 3rd party backup mode for managed files option:

• You have the following choices:

• To back up only the file tags of files that are managed by Data 
Manager, select Fast backup – read only ASM tracking data. This is 
the default.

• To back up all file tags and the file data of files that are managed by 
Data Manager, select Full backup – read all file data, including tracking 
data.

Note: Setting the 3rd party backup option to Full will cause purged files to 
be fetched to the extended drive. If you need to use this option, be 
sure you have enough extended drive free space to accommodate 
the file data.

Note: If you are using a third-party backup program that does NOT back 
up extended file attributes, this setting should be left at Full. Setting 
this option for Fast backup may result in file data not being backed 
up properly, as Data Manager will not recognize the files restored 
to the extended drive if the extended attributes are not captured. 

3rd party backup saves migration info
If the 3rd party backup mode for managed files option is set to Full, all file data 
for managed files is included in third-party backups. Use this extended drive 
option to configure whether Data Manager migration information is included in 
the third-party backups for those files, or if just the file data is saved in the 
backup image. 
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If you expect to restore the data to a drive that is not an Data Manager 
extended drive, you do not need to retain the migration information. If, 
however, you restore a backup without migration information to a Data 
Manager extended drive, Data Manager re-migrates the files (as if they had 
never been migrated to media). This causes those files to be saved to media 
again, duplicating the amount of space used for migrated files. 

Note: This feature is only available when the 3rd party backup mode for 
managed files option is set to Full backup. For more information, see 
3rd party backup mode for managed files above.

Note: This backup setting pertains only to third-party system backups 
external to Data Manager and is not related in any way to the Data 
Manager meta-data export utility. We recommend that you also back 
up your Data Manager files using the Data Manager meta-data export 
utility. For more information, see “Exporting File Meta-Data” on 
page 268.

To configure the 3rd party backup saves migration info option:

• You have the following choices:

• To strip Data Manager extended attributes from each file before the file 
is backed up by a third-party tool, select Migration info will not be 
stored in backup image.

• To include Data Manager extended attributes for each file in a third-
party backup, select Migration info will be stored in backup image.

Direct read memory cache (MB)
Use this extended drive option to configure the amount of memory in 
megabytes (MB) to be allocated for direct reads from media. Direct read 
means that when files are requested, they are read directly from the media 
rather than being fetched to the extended drive first. 

The file data for direct read files must be fetched to a temporary cache for 
distribution to the requesting client. This setting determines how much space 
to allow for that temporary cache. Each open file will consume at least 64KB of 
this cache, and you should configure the size based on the expected number 
of concurrently open files on the extended drive. The default value for this 
setting is 1 MB, which will handle 16 concurrently open files 64KB x 16 = 
1MB).  

Disable folder rename check
Use this extended drive option to manage whether users can rename folders 
on the extended drive. The folder rename check allows only folders containing 
Window Native file system media to be renamed. ASM and UDF (for DVD-R) 
file system formatted media do not support folder renaming. Folder renames 
are also not allowed on WORM NAS and Aggregate NAS media. For more 
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information on file systems, refer to the Planning Your Data Manager System 
chapter of the ASM Data Manager Getting Started Guide. 

To configure the Disable folder rename check option:

• You have the following choices:

• To allow users to rename folders regardless of whether the rename is 
supported by media, select Disable rename folder check (allow 
rename of all folders).

• To allow users to rename only folders that contain Windows Native file 
system formatted media, which supports folder renaming, select 
Prevent folder renames when not supported by media. This is the 
default.

Fetch request timeout minutes
Use this extended drive option to configure the number of minutes Data 
Manager waits after a fetch request has been made before canceling the 
request. This option allows you to reduce network traffic by stopping requests 
in cases where the user no longer expects the file to open because of the 
amount of elapsed time since the request. This number should be high 
enough to prevent cancellation of requests for which clients could conceivably 
still be waiting. The default value is 10 minutes.

Force direct read for all files
Use this extended drive option to add the direct read attribute to all files 
purged from the extended drive. Direct read means that when files are 
requested, they are read directly from the media rather than being fetched to 
the extended drive first.

To configure the Force direct read for all files option:

• You have the following choices:

• To apply the direct read attribute to all files purged from this extended 
drive, regardless of whether individual direct read setting on these files 
is enabled, select Force all files to be read using direct read.

• To apply the direct read attribute only to files that have been otherwise 
configured for direct read (either through move rules or Explorer Add-
ons, or if the option was enabled when media is restored), select Use 
direct read only for files marked for direct read. This is the default.

Force moves when nothing to purge
Use this extended drive option when the purge watermark for the extended 
drive has been reached and there are no files on the purge list (in other words, 
eligible for purge). Since files on the extended drive cannot be purged until 
they are moved to media, enabling this option forces processing of the move 
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list so that files can be written to the purge list (if appropriate) and purged from 
the extended drive. Essentially, this option activates the Move files to media 
schedule for the extended drive.

To configure the Force moves when nothing to purge option:

• You have the following choices:

• To force processing of the move list when the purge list is empty and 
space still needs to be cleared on the extended drive to reach the 
purge stop watermark, select Force file moves when there is nothing to 
purge.

• To prevent Data Manager from being forced to move files, even if 
space still needs to be cleared on the extended drive to reach the 
purge stop watermark, select Do not force moves when there is 
nothing to purge. If this option is selected, purging resumes the next 
time a file is added to the purge list. This is the default. 

Note: If you are concerned about running out of space and you have 
configured move rules with age delays and purge rules, make sure 
your drive scan schedule is set to run regular drive scans so that files 
are added to the move list and purged when they become eligible. You 
should have configured a drive scan when you initially set up your Data 
Manager system. For instructions, refer to the Setting Up File Migration 
chapter of the ASM Data Manager Getting Started Guide.

Prevent file delete
Use this extended drive option to limit delete rights for files in media folders 
that contain write-once only media. This type of media includes WORM, 
WORM-tape, WORM NAS, CD-ROM, DVD-ROM, and finalized DVD-R media, 
and any media formatted with the FAT file system. This option does not affect 
files in media folders associated with re-writable media. 

If file deletion is not prevented, deletion of files stored on write-once and read-
only media deletes the files (and/or file tags) from the extended drive, 
preventing Data Manager from tracking the files on the media. However, 
running a file restore media task on the associated media restores those file 
tags, allowing access to those files.

 To configure the Prevent file delete option:

• You have the following choices:

• To prevent clients from deleting files from Data Manager media folders 
that contain only write-once media, select Prevent deletion of files 
stored on write-once and read-only media.

• To allow clients to delete any files, select Do not prevent the delete 
operation for any files. This is the default. 
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Prevent file modification
Use this extended drive option to restrict user rights to modify files in media 
folders that contain only read-only or write-once media. This includes WORM, 
WORM-tape, WORM NAS, CD-ROM, DVD-ROM, and finalized DVD-R media, 
and any media formatted with the FAT file system. This option does not affect 
files in media folders associated with re-writable media. 

If file modification is allowed, modification of files stored on read-only media 
only modifies the files on the extended drive. However, if the updated files 
qualify for move, the files are re-migrated to media.

To configure the Prevent file modification option:

• You have the following choices:

• To prevent clients from modifying files in media folders that contain 
only write-once media, select Prevent modification of files stored on 
write-once and read-only media.

• To allow clients to modify any files in Data Manager media folders that 
contain only write-once or read-only media, select Do not prevent 
modification of any files. This is the default.

Purge start watermark (drive percent full)
Use this extended drive option to configure whether Data Manager starts 
processing the purge list (and therefore purging files) when extended drive 
used space reaches a certain percentage. Processing of the purge list then 
continues until the purge list is empty or until the purge stop watermark is 
reached. 

To configure the Purge start watermark option:

• You have the following choices:

• To configure Data Manager to begin processing the purge list when the 
extended drive is filled to a certain percentage, enable the Start 
purging files when the extended drive becomes more than option. 
Then enter the percentage in the text box. This option is enabled by 
default, with a value of 95 percent full.

• To configure Data Manager so that files are not purged based on 
extended drive used space, enable the Do not purge files based on 
extended drive free space option.

Note: If you choose to prevent Data Manager from purging files based on 
extended drive used space, you should configure Data Manager to 
purge files either when files are moved to media (move rule setting) or 
during drive scans (purge rule setting) in order to avoid filling up your 
extended drive. Otherwise, files may never be purged from the 
extended drive. In addition, you may want to enable the Warn when 
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free space is getting low option to alert you before the free space on 
the extended drive reaches a critical level. For more information, see 
“Purging Files” on page 164 and “Warn when free space is getting low 
(MB)” on page 201.

Purge stop watermark (drive percent full)
Use this extended drive option to configure the percentage of used drive 
space that must be reached to cause Data Manager to stop processing the 
purge list once processing has been triggered (by the purge start watermark 
configuration). This option is only available if the Purge start watermark option 
is enabled. The default value is 90 percent full.

Warn when free space is getting low (MB)
Use this extended drive option to configure whether Data Manager creates a 
warning when the free space on the extended drive reaches a (configured) 
critical point. 

Warnings appear in the Event Viewer and in the Data Manager event logs. 
They can also be sent out as alerts using the Alerts tab in the Service 
Properties dialog box. For more information on using the Event Viewer and the 
event logs, see “Tracking Data Manager Events, Errors, and Warnings” on 
page 237. For more information on alerts, see “The Alerts Tab” on page 232.

To configure the Warn when free space is getting low option:

• You have the following choices:

• To configure Data Manager to create a warning when free space falls 
below a certain number of megabytes, select Warn when free space 
falls below. Then, in the text box, enter the amount of free extended 
drive space (in MB) that will trigger the warning. The default setting is 
to send a warning when the extended drive free space reaches 10 MB 
or less.

• To disable low free space warnings, select Do not warn when extended 
drive is low on free space. 

Defer fetch requests if fetch is disabled
If you have set the Allow fetches from media schedule to be inactive at any 
time, clients are unable to retrieve purged files from media during those times. 
Data Manager allows you to determine whether those requests for files are 
rejected outright or queued as deferred fetch requests until the fetch schedule 
becomes active again. If you enable this extended drive option, all client file 
retrievals are postponed until the Allow fetches from media schedule becomes 
active. At that time, all requested (queued) files are retrieved from media. 

Note: This option only applies when you have set time-based restrictions to 
purged files by disabling the Allow fetches from media schedule in the 
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media activity scheduler. The Allow fetches from media schedule is 
active 24 hours a day by default.

To configure the Defer fetch requests if fetch is disabled option:

• You have the following choices: 

• To configure Data Manager to accept but defer all requests for purged 
files made when the Allow fetches from media schedule has been 
disabled, select Defer fetch requests if fetch is disabled. The queued 
requests are processed when the schedule becomes active again.

• To configure Data Manager to reject all requests for purged files made 
during times when the Allow fetches from media schedule is inactive, 
select Refuse fetch requests if fetch is disabled.

The Statistics Tab
The Statistics tab of the Extended Drive Properties dialog box provides 
statistics on files on the extended drive. These statistics are based on 
information collected during the most recent drive scan. 

To view the Statistics tab:

• With the Extended Drive Properties dialog box open, click the Statistics 
tab.

Figure 98.  Extended Drive Properties – Statistics Tab 
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The following table describes each of the items on the Statistics tab: 

Note: The Moved Files and Pending Files lists are dynamically updated as 
files are fetched and purged and added to the move and purge lists, 
respectively. 

Table 22.  Extended Drive Properties – Statistics Tab Items

Group Item Description
Moved Files Fetched The total number and size of files 

fetched between the most recent drive 
scan and the drive scan immediately 
preceding it

Purged The total number and size of files 
purged between the most recent drive 
scan and the drive scan immediately 
preceding it

Total The sum of the number and size of files 
fetched and files purged between the 
most recent drive scan and the drive 
scan immediately preceding it

Pending Files Move The total number and size of files 
currently on the move list for the 
extended drive

Purge The total number and size of files 
currently on the purge list for the 
extended drive

Last Drive 
Scan

Start Time The time at which the last drive scan 
for the extended drive began

Duration The amount of time that the last drive 
scan took to process

Next Scan Time The date and time of the next 
scheduled drive scan

Last Meta-
Data Export

Start Time The time at which the last meta-data 
export began

Duration The amount of time that the last meta-
data export took to process

Next Export 
Time

The date and time of the next 
scheduled meta-data export
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■ Deleting the Extended Drive
When you delete an extended drive from ASM Data Manager, all associated 
settings are deleted as well, including all schedules and configured options for 
that extended drive. 

All components of the extended drive should be deleted prior to deleting the 
extended drive. In addition, you must deallocate all media from the extended 
drive before you delete the drive. 

To delete an extended drive:

1. In the tree view of the Administrator, right-click the extended drive you 
want to delete. Select Delete Extended Drive from the shortcut menu that 
appears.

2. Click Yes on the confirmation message that appears.

■ Running Drive Scans
Drive scans must be performed periodically in order to write files to the move 
and purge lists, and consequently to move the files to storage media and to 
purge the data from the extended drive. Drive scans are also required to 
delete files from the system based on configured delete rules.

During a drive scan, ASM Data Manager inventories all of the files on an 
extended drive and checks each file against the migration rules for the drive, 
adding eligible files to the move list, purging files or adding them to the purge 
list, and deleting files that qualify for deletion. 

Drive scans are also necessary when removing a piece of media from a media 
folder, in order to completely remove that media’s files from the folder on the 
extended drive. Normally Data Manager prompts you to run a drive scan at 
that time, but if necessary you can wait until a later time to force the drive scan 
needed to remove those files, or wait until the next scheduled drive scan.

Drive scans can be forced or scheduled. Until you set up a drive scan 
schedule for an extended drive, automatic (scheduled) drive scans are 
disabled. However, you can force an extended drive scan whenever needed. 

For more information, see the following sections:

• "Forcing Drive Scans, " which follows

• “Scheduling Drive Scans” on page 205

Forcing Drive Scans
If you are planning any Data Manager system maintenance, forcing an 
extended drive scan in conjunction with activating your Move files to media 
schedule is an excellent way to be sure all appropriate files are written to 
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media before the maintenance is done. For more information on the Move files 
to media schedule, see “Moving Files to Media” on page 48. You can also use 
this command to run a drive scan if you need to remove several pieces of 
media, but do not want to run a drive scan after each one. You can force a 
drive scan when you are finished removing all pieces of media. 

To force a drive scan on the extended drive:

• Right-click on the extended drive and select Force Drive Scan from the 
shortcut menu. A drive scan is run on the extended drive and the 
appropriate files are marked for move or purge or are deleted as 
necessary.

Scheduling Drive Scans
Regular drive scans are required to be sure that all appropriate files are 
written to the move list when they qualify, and as such, are being written out to 
storage media (in coordination with your Move files to media schedule). 

If you configure any move rules to have age-delays, you must perform regular 
extended drive scans to update the move list. If you configure any purge or 
delete rules for your extended drive, you must perform regular drive scans to 
purge files or to write files to the purge list (depending on the purge rule 
setting), and to delete files qualifying for delete rules. 

In addition, file-sharing issues or sharing violations can prevent files from 
being added to the move list when appropriate. Data Manager must have full 
access to a file in order to obtain information required for the move list. If the 
file is open or otherwise being accessed by a program or user, Data Manager 
cannot add it to the move list. 

Drive scans are scheduled through the Settings tab of the Extended Drive 
Properties dialog box. You should have configured a drive scan when you 
initially set up your Data Manager system. For more information, refer to the 
Setting Up File Migration chapter of the ASM Data Manager Getting Started 
Guide.
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5Managing the Data Manager 
Computer

ASM Data Manager contains several functions that allow you to administer, 
diagnose, and troubleshoot Data Manager. In addition, because the Data 
Manager program functions as a Windows NT/2000 service, part of 
administering the Data Manager computer includes administering the Data 
Manager service. This chapter discusses the available tools for administering 
your Data Manager computer through the Administrator interface (and through 
Windows where applicable). 

The Service Properties dialog box lets you view and manage the Data 
Manager computer configuration. You can view general information about the 
Data Manager installation. You can also configure options to control the 
behavior of the hardware devices holding the media to which Data Manager 
moves files.

Troubleshooting can be done using the diagnostic utilities in the Tools menu 
and the Service menu. You can look up error definitions in the Administrator 
using the Error Glossary feature. Information on each of these utilities is 
provided in this chapter. 

For more information, see the following sections:

• "Managing the Data Manager Computer, " which follows

• “Configuring Data Manager Service Properties” on page 218

• “Tracking Data Manager Events, Errors, and Warnings” on page 237

■ Managing the Data Manager Service
ASM Data Manager functions as a Windows NT/2000 service rather than as a 
user-mode application. As a Windows service, Data Manager can be 
configured for various startup settings, including automatic startup, which 
starts Data Manager upon Windows system startup, and manual startup, 
which allows you to start the service manually. You can also disable the 
service, which prevents the service from starting until that status is changed to 
either manual or automatic. 

As a Windows NT/2000 service, Data Manager can continue to be active even 
after you log off Windows, as long as the computer is still running.
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Since the service will continue to run as long as the computer is running, if you 
are planning to shut down the Data Manager computer, we highly 
recommend stopping the Data Manager service before doing so. This allows 
the service to complete whatever function it was performing before the system 
shuts down. In the case where Data Manager is writing a file to media, 
stopping the service before shutting down the computer reduces the possibility 
of file write and/or media errors occurring during shutdown. 

You can manage the service either through the Data Manager Administrator or 
through Windows. 

Note: If Data Manager is installed in a clustered environment, the Data 
Manager service should only be stopped, paused, or started using the 
Cluster Administrator. You should not manage services through either 
the Service Manager or the Windows Services feature. If you stop the 
service in the Administrator or through the Windows Services feature, 
the system detects that the service filed and fails over to the other 
node in the cluster. For more information on clustering see Appendix 
A: Clustering, of the ASM Data Manager Getting Started Guide.

For more information, see the following sections:

• "Managing the Service Using the Administrator, " which follows

• “Managing the Service Using the Windows NT Control Panel” on page 211

• “Managing the Service Using the Windows 2000 Administrative Tools” on 
page 214

Managing the Service Using the Administrator
Management of the Data Manager service can be performed through the Data 
Manager Administrator using the Service Manager. You can start, pause, and 
stop the service, as well as change the startup type and the account Data 
Manager uses to log on as a service 

You can manage the Data Manager service on more than one computer if the 
computers are registered in the Administrator even if the computer is not 
currently connected through the Administrator. Data Manager computers that 
are not connected are listed in the tree view with a status of 
(Disconnected). For more information on registering remote Data 
Manager computers, refer to the Remotely Administering Data Manager 
chapter of the ASM Data Manager Getting Started Guide.

To manage the service through the Administrator:

1. In the Administrator, select the computer for which you want to manage 
the Data Manager service. You can choose the computer from the 
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Computer drop-down list, or, in the tree view, select the extended drive of 
the computer whose service you want to manage.

2. Open the Service Manager. From the Tools menu, select Service 
Manager, or click the Service Manager toolbar button.

Figure 99.  Service Manager Toolbar Button 

The Service Manager dialog box appears.

Figure 100.  Service Manager Dialog Box 

The Service Manager indicates the status of the Data Manager service just 
below the traffic light signal in the center of the Service Manager dialog 
box. A green light indicates the service is started, a yellow light indicates 
the service is paused, and a red light indicates the service is stopped. 

Note: When you plan to pause or shut down the service, it is a good idea 
to broadcast a message telling users the service will be paused or 
stopped. This gives users enough time to finish their tasks. To 
broadcast a message, simply proceed to the command prompt and 
type net send /users “message”, where “message” 
contains the words notifying the users that the service will pause or 
stop. The message is then sent to all users connected to the Data 
Manager computer.

3. Configure the service settings as necessary. You have the following 
choices:

• To stop the service, double-click Stop. A confirmation message 
appears. Click Yes.

• To pause the service, double-click Pause. A confirmation message 
appears. Click Yes.

• To start the service, double-click Start. A confirmation message 
appears. Click Yes.

• To edit service settings, including the startup type and the account 
Data Manager uses to log on as a service, click Edit Service Settings. 



Managing the Data Manager Computer

210 Second Edition
StorageTek Proprietary

For more information, see "Configuring Service Settings in the 
Administrator, " which follows.

4. When you finish configuring service settings, click Close to return to the 
Administrator. 

Configuring Service Settings in the Administrator
The Data Manager service, like any Windows NT/2000 service, can be set to 
start in a number of ways. For example, you may want the service to start 
immediately upon system startup, or you may want the ability to manually start 
or even disable the service. 

You may also need to change the user name or password for the account that 
Data Manager uses to log on as a service.

You can edit these service settings through the Service Manager.

To edit service settings through the Service Manager:

1. In the Service Manager dialog box, click Edit Service Settings. The Edit 
Service Settings dialog box appears.

Figure 101.  Edit Service Settings Dialog Box 

2. Select a startup type. You have the following choices:

• Choose Automatic if you want the service to start every time the 
Windows system starts. This is the default.

• Choose Manual if you want the service to be started by a user or by a 
dependent service.

• Choose Disabled to prevent the service from starting until the startup 
type is changed to Automatic or Manual.

3. In the Log On As section, This Account option is enabled by default and 
should contain the login and password entered on installation of Data 
Manager on the computer. You have the following choices:
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• To change the domain name or user name Data Manager uses to log 
on, enter the new name(s) in the This Account text box.

• To change the password Data Manager uses to log on, enter the new 
password in the Password text box. Then re-enter the password in the 
Confirm Password text box.

• To have the service log in as the system account, enable System 
Account.

Note: The account that Data Manager uses to log on as the service must 
have the Log on as a service privilege. This privilege is 
automatically assigned to the account entered during installation; 
however, if you want to change the service account, you will need 
to add this privilege to the new account if it does not already have 
the privilege.

Note: Unless you have specific reason to do so, you should not enable 
the System Account option for logon. The local system account 
may not have all of the rights necessary to perform all Data 
Manager functions, particularly if your media service resides on a 
different machine. 

4. Click OK to save your changes and return to the Service Manager. 

Managing the Service Using the Windows NT Control Panel
The Control Panel in Windows NT allows you to modify the system while 
working in Windows. The Services option in the Control Panel allows you to 
start and stop Windows NT services as well as configure service parameters 
for services running on the local machine, including the Data Manager service.

To manage the service using Windows NT:

1. On the Data Manager computer, open the Windows Service Manager. 
From the Start menu, select Control Panel and then Services.

Figure 102.  Windows NT Services Dialog Box 
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2. From the services list in the right pane of the Services dialog box, select 
ASM.

3. You have the following choices:

• To stop the service, click Stop. A confirmation message appears. Click 
Yes.

• To start the service, click Start.

• To pause the service, click Pause. A confirmation message appears. 
Click Yes.

• To edit service settings, including the startup type and the account 
Data Manager uses to log on as a service, click Startup. For more 
information, see "Configuring Service Settings in Windows NT, " which 
follows.

4. When you finish configuring service settings, click Close to close the 
Services dialog box.

Configuring Service Settings in Windows NT
The Data Manager service, like any Windows NT service, can be set to start in 
a number of ways. For example, you may want the service to start 
immediately upon system startup, or you may want the ability to manually start 
or even disable the service. 

You may also need to change the user name or password for the account that 
Data Manager uses to log on as a service.

You can edit these service settings through the Services option from the 
Windows NT Control Panel.
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To edit service settings through Windows NT:

1. In the Windows NT Services dialog box, select ASM and then click 
Startup. The Service dialog box appears.

Figure 103.  Service Dialog Box 

2. Select a startup type. You have the following choices:

• Choose Automatic if you want the service to start every time the 
Windows system starts. This is the default.

• Choose Manual if you want the service to be started by a user or by a 
dependent service.

• Choose Disabled to prevent the service from starting until the startup 
type is changed to Automatic or Manual.

3. In the Log On As section, This Account option is enabled by default and 
should contain the login and password entered on installation of Data 
Manager on the computer. You have the following choices:

• To change the domain name or user name Data Manager uses to log 
on, enter the new name(s) in the This Account text box.

• To change the password Data Manager uses to log on, enter the new 
password in the Password text box. Then re-enter the password in the 
Confirm Password text box.

• To have the service log in as the system account, enable System 
Account.

Note: The account that Data Manager uses to log on as the service must 
have the Log on as a service privilege. This privilege is 
automatically assigned to the account entered during installation; 
however, if you want to change the service account, you will need 
to add this privilege to the new account if it does not already have 
the privilege.
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Note: Unless you have specific reason to do so, you should not enable 
the System Account option for logon. The local system account 
may not have all of the rights necessary to perform all Data 
Manager functions, particularly if your media service resides on a 
different machine. 

4. When you finish configuring service settings, click OK to save your 
changes and return to the Services dialog box.

Managing the Service Using the Windows 2000 
Administrative Tools

The Administrative Tools application in Windows 2000 allows you to modify 
the system while working in Windows. The Services and Applications option in 
the Administrative Tools allow you to start and stop Windows 2000 services as 
well as configure service parameters for services running on the local 
machine, including the Data Manager service.

To manage the service using Windows 2000:

1. On the Data Manager computer, open the Windows Service Manager. 
From the Start menu, select Programs, Administrative Tools, and then 
Services. The Services dialog box appears.

Figure 104.  Windows 2000 Services Dialog Box 

2. From the services list in the right pane of the Services dialog box, select 
ASM.

3. You have the following choices:

• To stop the service, click the Stop button or choose Stop from the 
Action menu.

• To start the service, click the Start button or choose Start from the 
Action menu.
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• To pause the service, click the Pause button or choose Pause from the 
Action menu.

• To stop and then restart the service in one step, click the Restart button 
or choose Restart from the Action menu.

• To edit service settings, including the startup type and the account 
Data Manager uses to log on as a service, double-click on the service 
to open the ASM Properties dialog box. For more information, see 
"Configuring Service Settings in Windows 2000, " which follows.

4. When you finish configuring service settings, click the Close button to 
close the Services dialog box.

Configuring Service Settings in Windows 2000 
The Data Manager service, like any Windows 2000 service, can be set to start 
in a number of ways. For example, you may want the service to start 
immediately upon system startup, or you may want the ability to manually start 
or even disable the service. 

You may also need to change the user name or password for the account that 
Data Manager uses to log on as a service.

You can edit these service settings through the Services and Applications 
option from the Windows 2000 Administrative Tools.

To edit service settings through Windows 2000:

1. In the services list of the Windows 2000 Services dialog box, double-click 
ASM. The Properties dialog box appears with the General tab active by 
default. 
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Figure 105.  ASM Properties Dialog Box 

2. From the Startup type drop-down list, select a startup type. You have the 
following choices:

• Choose Automatic if you want the service to start every time the 
Windows system starts. This is the default.

• Choose Manual if you want the service to be started by a user or by a 
dependent service.

• Choose Disabled to prevent the service from starting until the startup 
type is changed to Automatic or Manual.

3. Select the Log On tab. 
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Figure 106.  ASM Properties Dialog Box – Log On Tab 

4. This account option is enabled by default and should contain the login and 
password entered on installation of Data Manager on the computer. You 
have the following choices:

• To change the domain name or user name Data Manager uses to log 
on as a service, enter the new name(s) in the This account text box.

• To change the password Data Manager uses to log on, enter the new 
password in the Password text box. Then re-enter the password in the 
Confirm password text box.

• To have the service log on as the system account, enable Local 
System account.

Note: The account that Data Manager uses to log on as the service must 
have the Log on as a service privilege. This privilege is 
automatically assigned to the account entered during installation; 
however, if you want to change the service account, you will need 
to add this privilege to the new account if it does not already have 
the privilege.

Note: Unless you have specific reason to do so, you should not enable 
the Local System account option for logon. The local system 
account may not have all of the rights necessary to perform all 
Data Manager functions, particularly if your media service resides 
on a different machine. 

5. When you finish configuring service settings, click OK to save your 
changes and retu
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■ Configuring Data Manager Service Properties
ASM Data Manager allows you to view and configure Data Manager service 
properties. Each Data Manager computer has a Service Properties dialog box 
that displays tabs of information pertaining to the Data Manager service. 
These tabs include: General, Settings, Options, Alerts, and Licensing 
Information.

To configure Data Manager service properties:

1. From the Service menu, select Properties. 

Figure 107.  Service Properties Dialog Box 

2. Modify the settings on each of the tabs as necessary. For more 
information, see the following sections:

• "The General Tab, " which follows

• “The Settings Tab” on page 219

• “The Options Tab” on page 222

• “The Alerts Tab” on page 232

• “The Licensing Information Tab” on page 236

3. As with most Properties functions in ASM, after making changes you have 
three options:

• To save changes and close the Properties dialog box, click OK.

• To save changes and keep the Properties dialog box open, click Apply.

• To discard all changes made since the Properties dialog box was 
opened (or since the Apply button was used) and close the Properties 
dialog box, click Cancel. 
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The General Tab
The General tab of the Service Properties dialog box displays identifying 
information for the Data Manager computer.

To view the General tab:

• Click the General tab in the Service Properties dialog box.

Figure 108.  Service Properties – General Tab 

The following table describes each of the items appearing on the General 
tab.

The Settings Tab
The Settings tab of the Service Properties dialog box allows you to map a 
partition to the Data Manager extended drive. Partition mapping allows clients 
(like ApplicationXtender) to connect to the Data Manager service via a 
Remote Procedure Call (RPC). Creating a partition allows other applications 
to connect to the Data Manager extended drive without using an actual folder 
share. 

Table 23.  Service Properties – General Tab

Item Description
Computer Name The Windows computer name for the Data Manager 

computer

Installation Date The date that Data Manager was installed (or 
updated)

Version The installed version of Data Manager
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To configure the Settings tab:

1. Click the Settings tab of the Service Properties dialog box.

Figure 109.  Service Properties – Settings Tab 

2. Click Partition Map. The Partition Map dialog box appears.

Figure 110.  Partition Map Dialog Box 

The Partition List in the Partition Map dialog box lists all mapped partitions 
and the extended drives to which they have been mapped.

3. You have the following choices:

• Create a new partition map. For more information, see "Creating a 
Partition Map, " which follows.

• Edit a partition map. For more information, see “Editing a Partition 
Map” on page 221.

• Delete a partition map. For more information, see “Deleting a Partition 
Map” on page 222.

4. When you finish configuring partition maps, click Close to return to the 
Settings tab of the Service Properties dialog box.

Creating a Partition Map
If you want to allow clients to connect to Data Manager via RPC, you need to 
create a partition map.



Configuring Data Manager Service Properties

ASM Data Manager System Guide 221
StorageTek Proprietary

To create a partition map:

1. In the Partition Map dialog box, click New. The New Partition Map Entry 
dialog box appears.

Figure 111.  New Partition Map Entry Dialog Box 

2. In the Partition Name text box, enter a name for the partition.

3. From the Extended Drive drop-down list, select the extended drive to 
which you want to map the partition.

4. Click OK. The Partition Map dialog box appears with the new partition map 
listed.

Figure 112.  Partition Map Dialog Box 

Editing a Partition Map
If you have already created a partition map, you can edit it. If you edit a 
partition map, remember to change the configuration for the applications that 
point to the partition map as necessary. 
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To edit a mapped partition:

1. In the Partition Map dialog box, select the partition you want to change and 
click Edit. The Edit Partition Map Entry dialog box appears.

Figure 113.  Edit Partition Map Entry Dialog Box 

2. You have the following choices:

• To change the partition name, enter the new name in the Partition 
Name text box.

• To change the extended drive to which the partition is mapped, select 
the extended drive from the Extended Drive drop-down list.

3. Click OK. The Partition Map dialog box appears with the changes to the 
partition map listed.

Deleting a Partition Map
If you no longer need a partition map, you can delete it. Remember that if you 
delete a partition map, you may need to reconfigure the applications that point 
to that partition map.

To delete a mapped partition:

1. In the Partition Map dialog box, select the partition you want to delete and 
click Delete. 

2. Click Yes on the confirmation message that appears.

The Options Tab
The Options tab of the Service Properties dialog box allows you to configure 
options that control the behavior of the hardware devices holding the media to 
which Data Manager moves files. We recommend you pay special attention to 
the functions available through the Options tab and configure them 
appropriately. These options are designed to ease administration of your Data 
Manager service and improve performance. 

To configure the Options tab:

1. Click the Options tab of the Service Properties dialog box.
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Figure 114.  Service Properties – Options Tab 

The upper section of the Options tab shows a list of service options 
available for configuration. The option information in the bottom section of 
the Options tab changes to reflect the configuration aspects available for 
the option selected in the list in the top section of the Options tab.

2. Modify the settings for each option as necessary. For more information, 
see the following sections: 

• "CD-ROM Drive Saver, " which follows

• “CD-ROM Timeslice - Minimum Mount” on page 224

• “CD-ROM Timeslice - Last Fetch” on page 224

• “CD-ROM Timeslice - Maximum Mount” on page 224

• “DVD Drive Saver” on page 224

• “DVD Timeslice - Minimum Mount” on page 225

• “DVD Timeslice - Last Fetch” on page 225

• “DVD Timeslice - Maximum Mount” on page 225

• “Optical Drive Saver” on page 225

• “Optical Timeslice - Minimum Mount” on page 225

• “Optical Timeslice - Last Fetch” on page 225

• “Optical Timeslice - Maximum Mount” on page 226

• “Tape Block Size Default Value” on page 226

• “Tape Timeslice - Minimum Mount” on page 226

• “Tape Timeslice - Last Fetch” on page 226
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• “Tape Timeslice - Maximum Mount” on page 226

• “Use Hardware Compression” on page 226

• “Use Special Application Filtering” on page 228

• “Use Write Verify Command” on page 227

• “EMC Centera Resource Saver” on page 228

CD-ROM Drive Saver
Use this service option to configure how long Data Manager waits after CD-
ROM media becomes inactive before it automatically spins down the media. 
Automatically spinning down media means that the media is still mounted but 
lies idle until the media is requested by Data Manager or dismounted. The 
default value is 5 minutes.

CD-ROM Timeslice - Minimum Mount
Use this service option to configure the minimum amount of time Data 
Manager keeps CD-ROM media in a drive after it has been mounted. This 
means that CD-ROM media remains in the drive for at least the amount of 
time you enter. Data Manager does not automatically dismount CD-ROM 
media, and you cannot dismount the media before the time limit is up. The 
default value is 30 seconds.

CD-ROM Timeslice - Last Fetch
Use this service option to configure the amount of time CD-ROM media must 
remain mounted after Data Manager has fetched data from that media. This 
means that CD-ROM media is not dismounted immediately after a fetch; 
instead, Data Manager waits at least the entered amount of time before 
dismounting the media. The default value is 5 seconds.

CD-ROM Timeslice - Maximum Mount
Use this service option to limit the amount of time CD-ROM media can stay 
mounted if it is inactive and has no pending fetches, and if there is other CD-
ROM media that has pending fetches. This allows Data Manager to dismount 
inactive media in favor of other media that is being requested. The default 
value is 60 seconds.

DVD Drive Saver
Use this service option to configure how long Data Manager waits after DVD 
media becomes inactive before it automatically spins down the media. 
Automatically spinning down media means that the media is still mounted but 
lies idle until the media is requested by Data Manager or dismounted. The 
default value is 5 minutes.
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DVD Timeslice - Minimum Mount
Use this service option to configure the minimum amount of time Data 
Manager keeps DVD media in a drive after it has been mounted. This means 
that DVD media is mounted for at least the amount of time you enter. Data 
Manager does not automatically dismount DVD media, and you cannot 
dismount the media before the time limit is up. The default value is 30 
seconds.

DVD Timeslice - Last Fetch
Use this service option to configure the amount of time DVD media must 
remain mounted after Data Manager has fetched data from that media. This 
means that DVD media is not dismounted immediately after a fetch; instead, 
Data Manager waits at least the entered amount of time before dismounting 
the media. The default value is 5 seconds.

DVD Timeslice - Maximum Mount
Use this service option to limit the amount of time DVD media can stay 
mounted if it is inactive and has no pending fetches, and if there is other DVD 
media that has pending fetches. This allows Data Manager to dismount 
inactive media in favor of other media that is being requested. The default 
value is 60 seconds.

Optical Drive Saver
Use this service option to configure how long Data Manager waits after optical 
media becomes inactive before it automatically spins down the media. 
Automatically spinning down media means that the media is still mounted but 
lies idle until the media is requested by Data Manager or dismounted. The 
default value is 5 minutes.

Optical Timeslice - Minimum Mount
Use this service option to configure the minimum amount of time Data 
Manager keeps optical media in a drive after it has been mounted. This means 
that optical media is mounted for at least the amount of time you enter. Data 
Manager does not automatically dismount optical media, and you cannot 
dismount the media before the time limit is up. The default value is 30 
seconds.

Optical Timeslice - Last Fetch
Use this service option to configure the amount of time optical media must 
remain mounted after Data Manager has fetched data from that media. This 
means that optical media is not dismounted immediately after a fetch; instead, 
Data Manager waits at least the entered amount of time before dismounting 
the media. The default value is 5 seconds.



Managing the Data Manager Computer

226 Second Edition
StorageTek Proprietary

Optical Timeslice - Maximum Mount
Use this service option to limit the amount of time optical media can stay 
mounted if it is inactive and has no pending fetches, and if there is other 
optical media that has pending fetches. This allows Data Manager to dismount 
inactive media in favor of other media that is being requested. The default 
value is 60 seconds.

Tape Block Size Default Value
Use this service option to configure the size settings Data Manager uses for 
formatting tape and WORM-tape media. The value you use dictates the 
default block size of tape and WORM-tape media that Data Manager formats. 
This value is used to set the default block size of the media when the Media 
Prepare Wizard and the format media task are run. The default value is 64 
kilobytes.

Tape Timeslice - Minimum Mount
Use this service option to configure the minimum amount of time Data 
Manager keeps tape media in a drive after it has been mounted. This means 
that tape media is mounted for at least the amount of time you enter. Data 
Manager does not automatically dismount tape media, and you cannot 
dismount the media before the time limit is up. The default value is 300 
seconds.

Tape Timeslice - Last Fetch
Use this service option to configure the amount of time tape media must 
remain mounted after Data Manager has fetched data from that media. This 
means that the tape media is not dismounted immediately after a fetch; 
instead, Data Manager waits at least the entered amount of time before 
dismounting the media. The default value is 60 seconds.

Tape Timeslice - Maximum Mount
Use this service option to limit the amount of time tape media can stay 
mounted if it is inactive and has no pending fetches, and if there is other tape 
media that has pending fetches. This allows Data Manager to dismount 
inactive media in favor of other media that is being requested. The default 
value is 1200 seconds.

Use Hardware Compression
Use this service option if you want Data Manager to compress data. Data 
compression allows Data Manager to store data in a format that requires less 
space than usual. 
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Note: Not all hardware devices support data compression. The Use 
hardware compression option only works with devices that support 
data compression.

To configure the Use hardware compression option:

• You have the following choices:

• To compress migrated data, select Enable hardware compression if 
supported by drive.

• To leave migrated data uncompressed, select Do not use hardware 
compression. This is the default. 

Use Write Verify Command
The Write Verify command sends data to the device buffer, writing the data to 
the media and then reading the data from the media to compare it to the data 
in the buffer. This verifies that the media properly accepted the file data and 
that no error occurred during migration.

It is possible to disable write verification for your Data Manager system by 
disabling this service option. However, note that without write verification, you 
have no assurance that data has been correctly transferred to media. We 
recommend that you leave this option enabled, particularly if you frequently 
purge files immediately after they are moved.

This option only applies for magneto-optical, WORM, and DVD-RAM media 
using the ASM file system. Write verification is always enabled (regardless of 
this option’s setting) for DVD-RAM media using the UDF file system, and is 
not managed by Data Manager for media using the NTFS file system. DX 
cannot write-verify DVD-R media. 

Note: If you have performance concerns, it is recommended that you 
improve performance by upgrading your hardware rather than by 
disabling this option.

To configure the Use write verify command option:

• You have the following choices:

• To enable the Write Verify command, select Verify data after writing to 
media. This is the default.

• To disable write verification, select Do not verify data after writing. 
Remember, selecting this option gives you no assurance that data has 
been correctly transferred to media.

Note: By disabling this option, you have removed the primary safeguard 
against undetected data corruption on media. Note that you will be 
responsible for any damage to your data incurred as a result of 
disabling this option.
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EMC Centera Resource Saver
Use this service option to configure how long Data Manager waits after EMC 
media becomes inactive before it automatically frees session resources. This 
is designed to help conserve system memory by freeing up idle EMC media 
resources. The default value is 600 seconds (10 minutes). 

Use Special Application Filtering
Use this service option to allow Data Manager to force a type of data access 
for purged files when those files are called by specific software applications. 
For example, you may not want your virus scanning software to recall purged 
file data from media during a virus scan, or you may want a program to read 
files directly from the media. 

To configure the Use special application filtering option:

1. You have the following choices:

• To force a type of data access for purged files when those files are 
called by specific software, select Enable special application filtering. 
This is the default. 

Figure 115.  Service Properties – Options Tab 

• If you do not want Data Manager to force a type of data access for 
purged files, select Disable special application filtering. 

2. If choose to enable special application filtering, click Edit List. The Special 
Application List dialog box appears.
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Figure 116.  Special Application List Dialog Box 

The following table describes the applications listed in the Applications list: 

Table 24.  Default Applications Listed for Filtering

Application Name EXE Name EXE Type Default 
Action

AVX Anti-Virus avxmonitornt.exe Service No recall

AVX Anti-Virus avxw.exe GUI No recall

AVX Anti-Virus avxc.exe CmdLine No recall

AVX Anti-Virus avxlite.exe Schedule No recall

Dr. Solomon’s Anti-
Virus

mcshield.exe Service No recall

Dr. Solomon’s Anti-
Virus

scan32.exe GUI No recall

F-Secure Anti-Virus fpavsvc.exe Service No recall

F-Secure Anti-Virus fpwm32.dll GUI No recall

McAfee Anti-Virus netshield.exe Service No recall

McAfee Anti-Virus vsmain.exe GUI No recall

McAfee Anti-Virus scan.exe CmdLine No recall

McAfee Anti-Virus vshwin32.exe schedule No recall

Norton Anti-Virus navwnt.exe Service No recall

Panda Anti-Virus pavsrv.exe Service No recall

Panda Anti-Virus iface.exe GUI No recall

Panda Anti-Virus pavjobs.exe schedule No recall

Tivoli Backup dsm.exe GUI Direct read



Managing the Data Manager Computer

230 Second Edition
StorageTek Proprietary

3. You have the following choices:

• Add an application to the list. For more information, see "Adding an 
Application to the Special Application Filtering List, " which follows.

• Edit the name of the application executable or the type of data access 
Data Manager allows the application. For more information, see 
“Editing an Application in the Special Application Filtering List” on 
page 231.

Note: The four Tivoli Backup executables in the Applications list 
(DSM.EXE, DSMC.EXE, DSMCSVC.EXE, and DAMAGENT.EXE) 
are set to Direct Read by default and should remain that way. If you 
are using Tivoli Storage Manager (TSM) as your media service, 
changing the Action for these four files to No Recall can result in 
data loss. 

• Delete an application from the list. For more information, see “Deleting 
an Application from the Special Application Filtering List” on page 232.

Note: Deleting default applications set by Data Manager may cause 
system problems (including deadlock) due to both the application 
and Data Manager attempting to run conflicting processes at the 
same time.

• Reset the applications list and its settings to their status when Data 
Manager was installed. For more information, see “Resetting the 
Special Application Filtering List Defaults” on page 232.

4. When you finish, click OK to return to the Options tab of the Service 
Properties dialog box.

Adding an Application to the Special Application Filtering List
If you are using an application not listed in the Applications list in conjunction 
with your Data Manager system and you would like to specify the type of data 
access Data Manager allows the application, you can add the application to 
the list.

Tivoli Backup dsmc.exe CmdLine Direct read

Tivoli Backup dsmagent.exe Service Direct read

Tivoli Backup dsmcsvc.exe Service Direct read

Table 24.  Default Applications Listed for Filtering (Continued)

Application Name EXE Name EXE Type Default 
Action
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To add an application to the special application filtering list:

1. In the Special Application List dialog box, click New. The Special 
Application Settings dialog box appears.

Figure 117.  Special Application Settings Dialog Box – Add Mode 

2. In the Application Executable text box, enter the executable file name 
(including the .EXE extension) for the application you want to add.

3. From the Special Action drop-down list, select the type of data access you 
want Data Manager to allow. You have the following choices:

• Choose No Recall if you want the software application to ignore 
purged files (the program sees the purged files as 0 bytes and skips 
over them). This is the default.

• Choose Direct Read if you want the software application to read the 
purged file data directly from the media.

4. Click OK. The Special Application List dialog box appears with the 
application added to the list.

Editing an Application in the Special Application Filtering List
If necessary, you can change the name of the application executable or the 
type of data access Data Manager allows the application.

To edit an application in the special application filtering list:

1. In the Special Application List dialog box, select the application you want 
to edit from the Applications list and then click Edit. The Special 
Application Settings dialog box appears.

Figure 118.  Special Application Settings Dialog Box – Edit Mode 

2. You have the following choices:

• If you want to change the application’s executable name, enter the new 
name (including the .EXE extension) in the Application Executable text 
box.
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• If you want to change the type of data access Data Manager allows the 
application, select the option from the Special Action drop-down list. 
Choose No Recall if you want the software application to ignore 
purged files (the program sees the purged files as 0 bytes and skips 
over them), or choose Direct Read if you want the software application 
to read the purged file data directly from the media.

Note: The four Tivoli Backup executables in the Applications list 
(DSM.EXE, DSMC.EXE, DSMCSVC.EXE, and DAMAGENT.EXE) 
are set to Direct Read by default and should remain that way. If you 
are using Tivoli Storage Manager (TSM) as your media service, 
changing the Action for these four files to No Recall can result in 
data loss. 

3. Click OK. The Special Application List dialog box appears with the edited 
application in the list.

Deleting an Application from the Special Application Filtering List
If you do not want to specify a type of data access for an application, you can 
delete it from the Applications list.

Note: Deleting default applications set by Data Manager may cause system 
problems (including deadlock) due to both the application and Data 
Manager attempting to run conflicting processes at the same time.

To delete an application from the special application filtering list:

1. In the Special Application List dialog box, select the application you want 
to delete from the Applications list and then click Delete. A confirmation 
message appears.

2. Click Yes.

Resetting the Special Application Filtering List Defaults
You can reset the Applications list to all of the settings established when Data 
Manager was installed. When the list is reset, all applications you added are 
removed, all applications you deleted are reinstated with their original settings, 
and all applications you changed are reset to their original values.

To reset the special application filtering list defaults:

1. In the Special Application List dialog box, click Reset Defaults. A 
confirmation message appears.

2. Click Yes.

The Alerts Tab
The Alerts tab of the Service Properties dialog box allows you to configure 
Data Manager to send alerts to specific users, workstations, email addresses, 
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or domains. An alert is a message box that appears notifying the recipient of 
an error or warning on the Data Manager system. 

Figure 119.  Alert Message 

Alerts can be sent to a specific computer or user, to an entire domain, or to an 
email address.

A default alert for both warnings and errors is created for the Data Manager 
computer when Data Manager is installed. 

To configure alerts:

1. Click the Alerts tab on the Service Properties dialog box.

Figure 120.  Service Properties – Alerts Tab 

2. You have the following choices:

• Add an alert. For more information, see "Adding an Alert, " which 
follows.

• Edit an existing alert. For more information, see “Editing an Alert” on 
page 235.

• Delete an alert. For more information, see “Deleting an Alert” on 
page 236.

3. If you configured any email alerts, enter the name of the mail server being 
used to deliver the alerts in the Mail Server text box at the bottom of the 
Alerts tab. The well-known port for SMTP servers is supported, so no 



Managing the Data Manager Computer

234 Second Edition
StorageTek Proprietary

additional configuration should be required for use with mail servers, 
routers, or firewalls.

Note: An email client must be installed on the Data Manager computer on 
which you are configuring the alert in order for email alerts to work. 

Adding an Alert
To send alerts to specific users, workstations, email addresses, or domains, 
you need to add an alert from the Alerts tab of the Service Properties dialog 
box.

To add an alert:

1. On the Alerts tab of the Service Properties dialog box, click Add. The Alert 
Settings dialog box appears. 

Figure 121.  Alert Settings Dialog Box – Adding an Alert 

2. From the Type drop-down list box, select the type of alert that you would 
like to configure. You have the following choices:

• Computer

• Domain

• Email

• User

3. In the Send To text box, enter the email address, domain name, user 
name, or computer name to which you want alerts sent. 

4. Below the Send To box you may configure the following options:

• If you want the alert to be sent for warnings and errors, enable both the 
Notify warnings and Notify errors check boxes.

• If you want an alert to be sent for warnings but not for errors, enable 
the Notify warnings check box.

• If you want an alert to be sent for errors but not warnings, enable the 
Notify errors check box.
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• If you want to temporarily disable the alert, disable both the Notify 
warnings and Notify errors check boxes. You can enable either of 
these options at a later time.

5. When you are finished choosing the alert settings, click Add. The 
information in the Send To box disappears, and the recipient is added to 
the alerts listing. 

6. You have the following choices:

• Repeat steps 2 through 5 to add another alert. 

• If you are finished configuring alerts, click Close on the Alert Settings 
dialog box. The alert appears in the Alert list in the Alerts tab. 

Editing an Alert
Once alerts have been established, you can edit them.

To edit an alert:

1. On the Alerts tab of the Service Properties dialog box, select the alert you 
want to edit and then click Edit. The Alert Settings dialog box appears.

Figure 122.  Alert Settings Dialog Box -- Editing an Alert 

2. You have the following choices:

• To change the type of alert that is sent, select a type from the Type 
drop-down list box.

• To change the email address, domain name, user name, or computer 
name to which you want alerts sent, enter the new value in the Send 
To text box.

• To change whether warnings are sent as alerts, enable or disable the 
Notify warnings check box.

• To change whether errors are sent as alerts, enable or disable the 
Notify errors check box.

3. When you finish editing the alert, click OK. The edited alert appears in the 
Alert list in the Alerts tab.
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Deleting an Alert
If you no longer need an alert, you can delete it.

To delete an alert:

1. On the Alerts tab of the Service Properties dialog box, select the alert you 
want to delete and then click Delete. A confirmation message appears.

2. Click Yes.

The Licensing Information Tab
The Licensing Information tab of the Service Properties dialog box displays 
license information for the Data Manager computer. 

To view the Licensing Information tab:

• Click the Licensing Information tab in the Service Properties dialog box.

Figure 123.  Service Properties – Licensing Information Tab 

The following table describes each of the items appearing on the Licensing 
Information tab. 

Table 25.  Service Properties – Licensing Information Tab

Item Description
Licensee The user information entered during the Data Manager 

installation.

Company The company information entered during the Data 
Manager installation.
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■ Tracking Data Manager Events, Errors, and 
Warnings

ASM Data Manager has built-in utilities for monitoring events, errors, and 
warnings on the extended drive. The Event Viewer contains a listing of all Data 
Manager events, errors, and warnings. This information is also logged to 
event logs. Errors and warnings are logged automatically, while Data Manager 
must be configured to log other events.

The Event Viewer and event logs provide a quick look at the activities of Data 
Manager. They allow you to monitor all aspects of extended drive events. 
Logs can help identify and solve potential problems during runtime that might 
otherwise become critical problems if ignored. If the Event Viewer and event 
logs become large and cumbersome to navigate, you can clear them.

For more information, see the following sections:

• "Using the Event Viewer, " which follows

• “Using Event Logs” on page 238

• “Looking up Errors” on page 239

• “Configuring Event Logging” on page 240

• “Clearing the Event Viewer and Event Logs” on page 244

Using the Event Viewer
The Event Viewer displays all events for the extended drive. If you do not want 
to automatically save a record of the events on the extended drive, you can 
disable event logging in the Service Event Configuration dialog box and simply 
monitor events in the Event Viewer. For more information on disabling event 
logging, see “Configuring Event Logging” on page 240.

License Server The name of the computer containing the installation of 
License Server that is currently administering the Data 
Manager licenses for this Data Manager service.

Licensing Details Detailed description of the Data Manager licenses 
configured in the License Server. This includes the 
number of Data Manager licenses and type and file 
size capacity of the media services available for use 
with Data Manager.

Table 25.  Service Properties – Licensing Information Tab

Item Description
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You can also take a “snapshot” of the contents of the Event Viewer and save it 
for later use. A snapshot is a capture of up to the last 2048 lines of the Event 
Viewer.

To open the Event Viewer:

• From the Service menu, select Event Viewer.

To take a snapshot of the Event Viewer:

• From the File menu in the Event Viewer, select Snapshot. The snapshot 
appears in RtfPad. You can save, print, and email the snapshot from 
RtfPad. For more information, see “Using RtfPad” on page 303.

Using Event Logs
In addition to the viewing capabilities offered by the Event Viewer, Data 
Manager also contains three event logs that save events, errors, and warnings 
for the Data Manager computer to log files.

• The All Events log lists all activities on the Data Manager service. Event 
logging is useful to trace Data Manager service events of interest to you. 
You can configure which events are traced. 

• The Errors Only Log lists only Data Manager system errors and is a useful 
tool for detecting and diagnosing those errors. 

Note: You can use the System Error Lookup feature to obtain additional 
information about each error, including the error’s name and 
description, and to quickly translate error codes that appear in Data 
Manager. For more information, see “Looking up Errors” on 
page 239.

• The Warnings Only Log lists only Data Manager system warnings to warn 
you of possible problems in Data Manager, such as requests for media 
(either to read or write to a file) that could not be satisfied because the 
media was not present on the ASM system (not in any drive or library), 
files that could not be migrated due to media being full or no more media 
being available in a move group, or disk full warnings for the NTFS volume 
on the extended drive. The purpose of this list is to provide a simpler 
means of discovering where problems exist that are hindering Data 
Manager performance.

Errors and warnings also appear in the Event Viewer, but the Errors Only Log 
and Warnings Only Log provide a more precise focus on these important 
events. You can also configure errors and warnings to be sent out as alerts to 
a specific domain, user, computer, or email address so that you are 
automatically notified when they occur. For more information, see “The Alerts 
Tab” on page 232.
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Because they are necessary for system diagnostics, error and warning logging 
cannot be disabled. If technical support is needed, you may be asked to open 
these logs and specify the information reported.

When opened, the logs slow down Data Manager performance. When closed, 
the impact they have on performance is insignificant. The logs should be 
opened and used only for debugging purposes.

Note: Because tracing events impedes system performance, no events are 
traced by default, though errors and warnings are logged automatically 
because of their necessity for troubleshooting. For more information, 
see “Configuring Event Logging” on page 240.

To open a log:

1. From the Service menu, select Event Logs. A shortcut menu appears.

2. Select the log you want to view. You have the following choices:

• All Events

• Warnings Only

• Errors Only

The selected log appears in RtfPad. The log displays both the time and a 
message for each event. The most recent events are last on the list (the 
list automatically scrolls to display the most current events).

3. You can save, print, and email the log from RtfPad. For more information, 
see “Using RtfPad” on page 303.

4. When you finish, open the File menu in RtfPad and then select Exit to 
close the log.

Looking up Errors
Each Data Manager error is displayed as an error number. The Data Manager 
error lookup feature allows you to obtain additional information about the error, 
including the error name and description, and to quickly translate the error 
codes provided in Data Manager messages. 

To look up an error:

1. You have the following choices:

• In the Administrator window, open the Help menu and then select Error 
Glossary. press <CTRL>+E. The System Error Lookup dialog box 
appears. Enter the error number in the Error Number text box and click 
Look Up.

• Highlight the error code number in the event log and then press F2 or 
select Error Lookup from the View menu in RtfPad.
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The error string (if applicable) and its description are displayed in the 
System Error Lookup dialog box.

Figure 124.  System Error Lookup Dialog Box 

2. You have the following choices:

• Click the forward or backward arrow buttons to scroll through the list of 
system errors. 

• When you finish, click Close to exit the dialog box.

Configuring Event Logging
Event logging is necessary only when tracing events of interest to you. You 
can configure which events are traced. Because tracing events impedes 
system performance, no events are traced by default, though errors and 
warnings are logged automatically because of their necessity for 
troubleshooting.

Data Manager allows you to configure which events are logged, and whether 
to trace the local service events or remote procedure calls (remote 
administration events). 

For all logs, you can control the format of the log entries, and adjust the 
maximum sizes for the log files. For the All Events Log, you can disable 
logging and enable the tracing of events upon startup. You can enable logging 
to the Windows Application Log for the Warnings Only Log and the Errors Only 
Log.

Log Properties Configuration
You can control several aspects of logging functionality, including log entry 
format, log file size, event logging, automatic startup of event logging, and 
logging of errors and warnings to the Windows Application Log. 
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To configure log properties:

1. From the Service menu, select Event Settings. The Service Event 
Configuration dialog box appears. The Configuration tab is active by 
default.

Figure 125.  Service Event Configuration Dialog Box – Configuration Tab 

2. In the Line Format section, specify logging of particular event attributes. 
These options are enabled by default. You have the following choices:

• To disable logging the time each event occurs, disable the Time check 
box.

• To disable logging the date each event occurs, disable the Date check 
box.

• To disable logging the thread the event used to communicate with the 
processor, disable the Thread ID check box.

3. In the Event Log section, configure logging to the All Events Log. Event 
logging is enabled by default; however, no events are traced. For 
information on selecting events to trace, see "Event Tracing Configuration, 
" which follows. You have the following choices to configure event logging:

• To change the maximum size in megabytes (MB) for the log file, enter 
a new value in the Maximum Log Size text box. The default size is 5 
MB. After the maximum log size is reached, the log is truncated from 
the beginning of the file (oldest events).

• To disable logging to the All Events Log, enable the Disable log file 
(viewer only) check box. Events are still logged to the Event Viewer.
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• To automatically initiate event logging when Data Manager is started, 
enable the Trace messages on startup check box.

4. In the Warning Log section, configure logging to the Warnings Only Log. 
You have the following choices:

• To change the maximum size in MB for the log file, enter a new value 
in the Maximum Log Size text box. The default size is 5 MB. After the 
maximum log size is reached, the log is truncated from the beginning 
of the file (oldest events).

• To enable logging of Data Manager warnings to the Windows 
Application Log, enable the Write to Windows Application Log check 
box. Since Data Manager warning logs are cleared when the service is 
restarted, this would allow the Windows Application Log to maintain a 
running log for Data Manager warnings outside of the Data Manager 
service. 

Note: To access the Windows Application Log, open the Start menu. 
Then select Programs, Administrative Tools, and Event Viewer.

Note: You cannot disable logging to the Warnings Only Log and Errors 
Only Log.

5. In the Error Log section, configure logging to the Errors Only Log. You 
have the following choices:

• To change the maximum size in MB for the log file, enter a new value 
in the Maximum Log Size text box. The default size is 5 MB. After the 
maximum log size is reached, the log is truncated from the beginning 
of the file (oldest events).

• To enable logging of Data Manager errors to the Windows Application 
Log, enable the Write to Windows Application Log check box. Since 
Data Manager error logs are cleared when the service is restarted, this 
would allow the Windows Application Log to maintain a running log for 
Data Manager errors outside of the Data Manager service.

Note: To access the Windows Application Log, open the Start menu. 
Then select Programs, Administrative Tools, and Event Viewer.

6. You have the following choices:

• If you want to begin tracing events, click Apply to save your changes 
and then select the Trace tab. For more information on tracing events, 
see "Event Tracing Configuration, " which follows.

• If you are finished configuring log properties, click OK to save your 
changes and close the Service Event Configuration dialog box.
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Event Tracing Configuration
You can configure which events are to be traced and reported to the Event 
Viewer and the All Events Log. By default, all event tracing is disabled. Unless 
instructed to enable tracing of events by a technical support representative, 
you can leave the default settings in place. 

Note: Event tracing configuration affects events only; errors and warnings 
relating to events of the types listed are logged regardless of event 
tracing settings. 

Note: Enabling event tracing hinders performance and should be performed 
only when debugging is required. 

To configure events to be logged:

1. From the Service menu, select Event Settings. The Service Event 
Configuration dialog box appears. 

2. Click the Trace tab. The System drop-down list displays Server Processing 
by default. 

Figure 126.  Service Event Configuration – Trace Tab 

3. From the System drop-down list, select whether to trace Server 
Processing (local machine service events) or Remote Procedure Calls 
(remote administration service events). 

4. In the Options list, enable the check box next to an event to begin tracing 
that event.

5. When you are finished, click OK to save the new settings and close the 
Service Event Configuration dialog box. 
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Clearing the Event Viewer and Event Logs
Note: You can manually clear the information in the Event Viewer and the 

event logs. Event logs have a specific size limitation, after which the 
log is truncated from the beginning of the file. While the log size is 
regulated through automatic truncation (see “Configuring Event 
Logging” on page 240 for more information), large logs are often 
cumbersome and difficult to navigate. Clearing event logs regularly 
makes it easier to find new information.You may want to save your log 
before clearing it. To save a log, open it and then select Save from the 
File menu in RtfPad.

To clear the Event Viewer or an event log:

1. From the Service menu, select Event Logs. A shortcut menu appears.

2. You have the following choices:

• To clear the Event Viewer and the All Events Log, select Clear Event 
Log.

• To clear the Warnings Only Log, select Clear Warning Log.

• To clear the Errors Only Log, select Clear Error Log. 

3. Click Yes on the confirmation message that appears.



ASM Data Manager System Guide 245
StorageTek Proprietary

6Running Data Manager Reports

The ASM Data Manager reporting feature is a useful tool for tracking system 
statistics. Using the Report Wizard, you can create various reports of system 
activities, including extended drive information, media information, media 
services, and Data Manager registry settings.

You can run the following reports in Data Manager:

• The Extended Drive Information Report provides detailed information 
about the selected extended drive(s). For more information, see page 247.

• The Media Report provides detailed information on the selected piece(s) 
of media. For more information, see page 249.

• The Media Files Report provides information about the files on the 
selected piece(s) of media. For more information, see page 251.

• The Media Services Report provides detailed information about the media 
service(s) configured for the selected Data Manager computer(s). For 
more information, see page 255.

• The Media Tasks Report lists all pending media tasks for the selected 
piece (s) of media. For more information, see page 256.

• The Product Registry Information Report lists all of the Data Manager 
information contained in the Windows registry for the selected Data 
Manager computer(s). For more information, see page 258.

You can also create custom layouts for your reports. Custom layouts are 
particularly useful because they can be saved and reused every time you run 
a report. For instructions, see “Report Layout Editor” on page 259.

Since Data Manager is designed to allow you to manage multiple registered 
Data Manager computers from a single Administrator interface, you can run 
any one of the available reports on multiple computers and multiple extended 
drives. You can also run more than one report at a time, allowing you to view 
several different aspects or details about several different registered Data 
Manager computers/extended drives in one consolidated report.

For more information, see the following sections:

• "Creating Reports, " which follows

• “Report Layout Editor” on page 259
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■ Creating Reports
The Report Wizard allows you to create various reports of system activities on 
one or more registered ASM Data Manager computers, including information 
about each extended drive and its components, media, and media task 
information. It also allows you to run more than one report at a time so that you 
can view several different aspects or details about several different registered 
Data Manager computers/extended drives in one consolidated report. 

To open the Report Wizard:

1. From the Tools menu, select Report Generator, or press <CTRL>+R. The 
Report Wizard opens, starting with the Select Report(s) To Run page.

Figure 127.  Report Wizard – Select Report(s) To Run Page 

The Select Report(s) To Run page lists all available Data Manager reports. 
A description of the report appears as a pop-up text box when you rest the 
mouse pointer on any report option.

2. Select the appropriate report type(s).

Note: If you choose multiple reports to run, the appropriate Report 
Wizard pages for each report are merged to form one wizard to 
lead you through the report generation process.

3. Click Next. The Select Computer(s) page appears.
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Figure 128.  Report Wizard – Select Computer(s) Page 

The Select Computer(s) page lists all registered and connected Data 
Manager computers.

4. Select the Data Manager computer(s) for which you want to generate a 
report and then click Next. The next page of the Report Wizard for the 
selected report(s) appears. For more information, see the following 
sections:

• "Extended Drive Information Report, " which follows

• “Media Report” on page 249

• “Media Files Report” on page 251

• “Media Services Report” on page 255

• “Media Tasks Report” on page 256

• “Product Registry Information Report” on page 258

Extended Drive Information Report
The Extended Drive Information Report displays information about the 
extended drive(s) you select, including properties and assigned media. Full 
reports also display additional information, including drive scan statistics and 
schedule information, as well as meta-data export statistics, move statistics, 
and fetch statistics.

To create an Extended Drive Information Report:

1. After you select the Data Manager computers for which you want to 
generate a report and then click Next, the Select Extended Drive(s) page 
appears.
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Figure 129.  Report Wizard – Select Extended Drive(s) Page 

The Select Extended Drive(s) page lists all available extended drives for 
the selected Data Manager computers.

2. Select the extended drive(s) for which you want to generate a report and 
then click Next. The Options page appears.

Figure 130.  Report Wizard – Extended Drive Information Report Options 
Page 

3. If there is more than one layout/computer listed, select the one you want to 
use for your report. To edit a selected layout, click Edit Layouts. For 
instructions, see “Report Layout Editor” on page 259.

4. Select the amount of detail you want on the report: Full or Summary.

5. Click Next. The Summary page appears. 

6. Review the information in the Summary page. 

7. If the information in the summary is correct, click Finish. The report 
appears in RtfPad. As with any information appearing in RtfPad, you can 
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save, print, or email the report. For more information, see “Using RtfPad” 
on page 303.

Media Report
The Media Report includes information on the selected media, either as a 
summarized list or a detailed description of properties. Information displayed 
in the detailed report includes location information, total/free space, and read/
write/mount statistics. 

To run a Media Report:

1. After you select the Data Manager computer(s) for which you want to 
generate a report and then click Next, the Select Extended Drive(s) page 
appears.

Figure 131.  Report Wizard – Select Extended Drive(s) Page 

The Select Extended Drive(s) page lists all available extended drives for 
the selected Data Manager computers.

2. Select the extended drive(s) for which you want to generate a report and 
then click Next. The Select Media for Media Report page appears.
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Figure 132.  Report Wizard – Select Media for Media Report Page 

The Select Media for Media Report page lists all available media for which 
you can generate a report. It lists the Data Manager computer where the 
media is located and the name of the media.

3. From the Listed Media drop-down list, select one of the media types to 
narrow the number of media listed in the Media list and make it easier to 
find and choose media for the report.

4. Select the media for which you want to generate the report and then click 
Next. The Options page appears.

Figure 133.  Report Wizard – Media Report Options Page 

5. If there is more than one layout/computer listed, select the one you want to 
use for your report. To edit a selected layout, click Edit Layouts. For 
instructions, see “Report Layout Editor” on page 259.

6. Select the amount of detail you want on the report: Full or Summary.

7. Click Next. The Summary page appears. 

8. Review the information in the Summary page. 
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9. If the information in the summary is correct, click Finish. The report 
appears in RtfPad. As with any information appearing in RtfPad, you can 
save, print, or email the report. For more information, see “Using RtfPad” 
on page 303.

Media Files Report
A Media Files Report provides information about the files on the selected 
piece(s) of media. You cannot run a Media Files Report unless you have 
previously processed a file report media task for the selected piece(s) of 
media on the selected extended drive(s). For instructions, see the following 
sections:

• "Assigning a File Report Media Task, " which follows

• “Running a Media Files Report” on page 253

Note: You can also run a file report using the Explorer Add-ons. For more 
information, see “Running a Media Files Report” on page 253.

Assigning a File Report Media Task
The file report media task obtains file information from the specified piece of 
media so that you can run a Media Files Report using the Report Wizard. You 
must run this task before running a Media Files Report to have current media 
information in the report. You can choose whether to obtain a complete listing 
of files on the piece of media, or a summary of file totals on the media. 

To assign a file report task:

1. Open the Media Tasks page. You have the following choices:

• In the tree view of the Administrator, right-click the piece of media to 
which you want to add the file report media task and then select Edit 
Tasks from the shortcut menu that appears.

• Press <CTRL>+T, or open the Tools menu and then select Media Task 
Manager to open the Media Task Queue Manager. If the media already 
has tasks assigned to it, select the media and then click Edit Tasks. If 
the media does not have tasks already assigned to it, click Add New 
Media. The Select Media for New Tasks page appears listing all media 
that do not currently have tasks assigned to them. Select the piece of 
media to which you want to assign the file report media task and then 
click Next.

2. From the Next Task drop-down list, select the file report media task and 
then click Add Next Task. The file report task appears in the Task List, and 
the Options and When To Process regions of the Media Tasks page 
become available.
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Figure 134.  File Report Media Task 

3. Choose whether you want a full or summary report. You have the following 
choices:

• Select the Complete listing of all files on this media option to run a full 
report.

• Select the Summary only option to run a summary report that contains 
only file totals (no file listing).

4. Select whether to process the media task as soon as possible or on a 
scheduled basis. If you choose to process the media task on a scheduled 
basis, the task is not processed until the Process scheduled media tasks 
schedule is active. For information on configuring media activity 
schedules, see “Scheduling Media Activities” on page 52.

Note: If you assign multiple tasks for media, be advised that all tasks for 
that media will have the same When to Process option, since all 
tasks for a piece of media are processed at once. If one task has 
the ASAP – as soon as possible option selected, all tasks for that 
piece of media will process ASAP by default. 

5. Once tasks have been added and configured as needed in the Media 
Tasks page, you have the following choices: 

• If you added the task through the Media Task Queue Manager, click 
Finish. The Media Task Queue Manager dialog box appears with the 
media listed and the task pending.

• If you added the task using the Edit Tasks option on either the shortcut 
menu for the media or the Edit menu, click Next. The Order Media in 
Task Queue page appears with the recently added media at the bottom 
of the media task queue list.

• To promote the selected piece of media so that the media tasks for the 
media are processed before other media in the queue, click the up 
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arrow button to the right of the list box. You can also demote a piece of 
media in the list by selecting the media and then clicking the down 
arrow to the right of the list box. When you finish, click Finish.

All media with tasks assigned appear in the Media Task Queue Manager 
until they are processed. For media with tasks selected to process ASAP – 
as soon as possible, those media may only appear briefly in the queue 
before the processing completes and the media is removed from the 
queue.

Running a Media Files Report
After the file report media task finishes processing, you can run the Media 
Files Report using the Report Wizard.

To run a Media File Report:

1. After you select the Data Manager computer(s) for which you want to 
generate a report and then click Next, the Select Extended Drive(s) page 
appears.

Figure 135.  Report Wizard – Select Extended Drive(s) Page 

The Select Extended Drive(s) page lists all available extended drives for 
the selected Data Manager computers.

2. Select the extended drive(s) for which you want to generate a report and 
then click Next. The Select Media for Media Files Report page appears.
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Figure 136.  Report Wizard – Select Media for Media Files Report Page 

The Select Media for Media Files Report page lists all media for which the 
File Report media task has previously been run. This window also notes 
whether the Summary or Complete option was selected when the media 
task was configured.

3. Select one of the listed media for which you want to generate the report 
and then click Next. The Select Media File Report Options page appears.

Figure 137.  Report Wizard – Select Media File Report Options Page 

4. You have the following choices:

• Choose List files to list all files on the media. If you want to sort the files 
in a particular order in the report, enable the Sort check box. Then 
choose the first sort criteria from the Key 1 drop-down list, and select 
whether to sort the files in ascending or descending order using that 
sort criteria. To choose a secondary sort criteria, choose the criteria 
from the Key 2 drop-down list, and then choose ascending or 
descending.
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• Choose List directories only to list only the directories on the media. 
Then choose whether to list the directories in ascending or descending 
order.

• Choose Summary only to list only summary information on the media.

Note: If you chose the Summary only option on the Media Tasks page 
when you ran the file report media task, the List files and List 
directories only options are not available. You can only run a 
summary report in this case. For more information on running a file 
report media task, see “Assigning a File Report Media Task” on 
page 251.

5. When you finish choosing report option(s), click Next. The Options page 
appears. 

Figure 138.  Report Wizard – Options Page 

6. If there is more than one layout/computer listed, select the one you want to 
use for your report. To edit a selected layout, click Edit Layouts. For 
instructions, see “Report Layout Editor” on page 259. 

7. Click Next. The Summary page appears. 

8. Review the information in the Summary page. 

9. If the information in the summary is correct, click Finish. The report 
appears in RtfPad. As with any information appearing in RtfPad, you can 
save, print, or email the report. For more information, see “Using RtfPad” 
on page 303.

Media Services Report
The Media Services Report provides information on the media services 
configured on the selected Data Manager computer(s).
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To run a Media Services Report:

1. After you select the Data Manager computer(s) for which you want to 
generate a report and then click Next, the Options page appears.

Figure 139.  Report Wizard – Media Services Report Options Page 

2. If there is more than one layout/computer listed, select the one you want to 
use for your report. To edit a selected layout, click Edit Layouts. For 
instructions, see “Report Layout Editor” on page 259. 

3. Click Next. The Summary page appears. 

4. Review the information in the Summary page. 

5. If the information in the summary is correct, click Finish. The report 
appears in RtfPad. As with any information appearing in RtfPad, you can 
save, print, or email the report. For more information, see “Using RtfPad” 
on page 303.

Media Tasks Report
The Media Tasks Report displays a list of media tasks that are pending, are in 
progress, or that have failed for selected media on the selected extended 
drive(s).

To run a Media Tasks Report:

1. After you select the Data Manager computer(s) for which you want to 
generate a report and then click Next, the Select Extended Drive(s) page 
appears.
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Figure 140.  Report Wizard – Select Extended Drive(s) Page 

The Select Extended Drive(s) page lists all available extended drives for 
the selected Data Manager computers.

2. Select the extended drive(s) for which you want to generate a report and 
then click Next. The Select Media for Media Task Report page appears.

Figure 141.  Report Wizard – Select Media For Media Task Report Page 

The Select Media for Media Task Report page lists all available media for 
which you can generate a report. It lists the Data Manager computer where 
the media is located and the name of the media.

3. From the Listed Media drop-down list, select one of the media types to 
narrow the number of media listed in the Media list and make it easier to 
find and choose media for the report.

4. Select the media for which you want to generate the report and then click 
Next. The Options page appears.
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Note: Be sure to select media that currently has pending media tasks 
assigned to it. If you select media with no pending media tasks, the 
report is still generated but contains no information for that media. 

Figure 142.  Report Wizard – Media Tasks Report Layout Options Page 

5. If there is more than one layout/computer listed, select the one you want to 
use for your report. To edit a selected layout, click Edit Layouts. For 
instructions, see “Report Layout Editor” on page 259.

6. Select the amount of detail you want on the report: Full or Summary.

7. Click Next. The Summary page appears. 

8. Review the information in the Summary page. 

9. If the information in the summary is correct, click Finish. The report 
appears in RtfPad. As with any information appearing in RtfPad, you can 
save, print, or email the report. For more information, see “Using RtfPad” 
on page 303.

Product Registry Information Report
The Product Registry Information Report provides a complete listing of all 
information contained in the Windows registry about the Data Manager service 
on the selected Data Manager computer(s). The report information includes a 
listing of all registry keys (and associated values) used by Data Manager.
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To run a Product Registry Information Report:

1. After you select the Data Manager computer(s) for which you want to 
generate a report and then click Next, the Options page appears.

Figure 143.  Report Wizard – Product Registry Information Report 
Options Page 

2. If there is more than one layout/computer listed, select the one you want to 
use for your report. To edit a layout, select the layout from the list and click 
Edit Layouts. For instructions, see “Report Layout Editor” on page 259. 

3. Click Next. The Summary page appears. 

4. Review the information in the Summary page. 

5. If the information in the summary is correct, click Finish. The report 
appears in RtfPad. As with any information appearing in RtfPad, you can 
save, print, or email the report. For more information, see “Using RtfPad” 
on page 303.

■ Report Layout Editor
The Report Layout Editor allows you to define the font, font sizes, tab stops, 
and header and footer contents for ASM Data Manager reports. The styles 
and layouts can be set and saved as report defaults; however, you can 
override these options whenever necessary.

Data Manager also allows you to create and save new layouts on different 
Data Manager computers. These layouts are available for use any time a 
report is run for that Data Manager computer, regardless of whether the report 
is being run from that Data Manager computer or from a remote Data Manager 
computer.
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To customize report layouts: 

1. You have the following choices:

• If you are in the process of running a report and you want to edit an 
existing layout, select the layout on the Options page of the Report 
Generator Wizard and then click Edit Layouts.

• If you are in the process of running a report and you want to create a 
new layout, on the Options page of the Report Generator Wizard, click 
Edit Layouts.

• If you are not in the process of running a report, open the Tools menu 
and then select Report Layouts. 

The Report Layout Editor dialog box appears.

Figure 144.  Report Layout Editor 

2. You have the following choices:

• Create a new layout. For more information, see "Creating a New 
Layout, " which follows.

• Change the header or footer for a report layout. For more information, 
see “Changing Headers and Footers for Layouts” on page 261.

• Edit layout styles. For more information, see “Editing Layout 
Paragraph Styles” on page 263.

• Rename a layout. For more information, see “Renaming a Layout” on 
page 265.

• Switch from one layout to another. For more information, see 
“Switching from One Layout to Another” on page 265.

• Preview a layout. For more information, see “Previewing a Layout” on 
page 265.

• Delete a layout. For more information, see “Deleting a Layout” on 
page 266.
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Creating a New Layout
Creating a layout is as simple as giving it a name. When creating a layout, 
remember that each layout should be identified by a descriptive name to make 
the layout easy to identify for use with your reports. 

To create a new layout:

1. In the Report Layout Editor dialog box, click New. The Enter New Layout 
Name dialog box appears.

Figure 145.  Enter New Layout Name Dialog Box 

2. In the text box, type a name. Click OK. A new layout is created with that 
name and the default layout settings. To modify the default settings, see 
the following sections: 

• "Changing Headers and Footers for Layouts, " which follows

• “Editing Layout Paragraph Styles” on page 263

Changing Headers and Footers for Layouts
You can configure a customized header and footer for each report layout using 
the Report Layout Editor. 

The header and footer can contain dynamic codes that retrieve specific 
values, such as date, time, user name, and domain, and write them directly 
into the header or footer. Placing these dynamic codes in custom headers or 
footers, and thereby on the reports generated with a custom layout, can help 
you identify, file, and retrieve reports later.

To change a header or footer for a layout:

1. Verify that the correct report appears in the Name drop-down list in the 
Report Layout Editor.

2. Click in either the Header Text box or the Footer Text box and type or edit 
the desired text. 

3. To insert a dynamic code in the text, place the cursor in the Text box where 
you want the code value to appear. If you do not want to insert a dynamic 
code in the text, skip to step 7.

4. Click Insert Code under the appropriate text box. The Select Report Code 
to Insert dialog box appears.
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Figure 146.  Select Report Code To Insert Dialog Box 

5. Select the code that you want to insert. You have six options:

6. Click OK to insert the code and return to the Report Layout Editor dialog 
box.

Note: Spaces are not automatically inserted around the code. If you want 
spaces to appear before or after the value the code inserts, place 
spaces in the text box before and after the code where you want 
spaces to appear.

7. Choose whether to use a dotted line as a divider between the header or 
footer and the report body.

• If you do not want a dotted line to separate the header from the report 
body, disable the Use divider below header check box. This option is 
enabled by default.

• If you do not want a dotted line to separate the footer from the report 
body, disable the Use divider above footer check box. This option is 
also enabled by default.

8. You have the following choices:

Table 26.  Report Code Options

Option Description
User name Inserts the user name of the currently logged in 

Windows user

Network domain Inserts the domain on which Data Manager is 
running

Date Inserts the system date on which the report is 
generated

Time Inserts the system time the report is generated

Report name Inserts the name given to the report when 
generated

Product version Inserts the version of Data Manager being used to 
generate the report
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• To preview the report layout, click Preview.

• To save changes and keep the Report Layout Editor dialog box open, 
click Update.

• To save changes and close the Report Layout Editor dialog box, click 
OK.

Editing Layout Paragraph Styles
The Report Layout Editor allows you to customize the look of your reports by 
giving you font, size, color, and other stylistic options for each type of 
paragraph used in generating report output. This makes it easier to call 
attention to specific information in the reports and may make your reports 
easier to read and interpret.

To edit styles for a layout:

1. Verify that the correct report appears in the Name drop-down list in the 
Report Layout Editor.

2. Click Edit Styles. The Report Layout - Styles dialog box appears. 

Figure 147.  Report Layout - Styles Dialog Box 

Each paragraph type has a drop-down list containing all available style 
profiles. 

3. You have the following choices:

• To use an existing style profile, select the profile from the drop-down 
list next to the paragraph type you want to change.

• To create a new profile, click the Edit button to the right of profile drop-
down list. The Report Style Editor dialog box appears.
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Figure 148.  Report Style Editor Dialog Box 

Select the desired characteristics for Font, Font Size, Text Color, and 
Alignment from the appropriate drop-down lists. 

Enable or disable the Underline and Bold characteristics for the paragraph 
by clicking in the check box next to each option. 

Click OK to save your changes to the paragraph style and return to the 
Report Layout - Styles dialog box. Your new style properties appear in the 
profile drop-down list.

4. Once you have configured all necessary styles, you can preview the report 
layout by selecting the Preview button on the Report Layout - Styles dialog 
box. A Report Layout Preview appears in RtfPad.

Figure 149.  Report Layout Preview – Sample Report 



Report Layout Editor

ASM Data Manager System Guide 265
StorageTek Proprietary

5. When you are satisfied with your layout styles, click OK to save changes 
and return to the Report Layout Editor dialog box.

Renaming a Layout
If necessary, you can rename an existing custom layout.

To rename a layout:

1. In the Report Layout Editor dialog box, make sure that the correct layout 
appears in the Name drop-down list.

2. Click Rename. The Enter New Layout Name dialog box appears.

Figure 150.  Enter New Layout Name Dialog Box 

3. In the text box, type the new name. 

4. Click OK. The new name appears in the Name text box in the Report 
Layout Editor dialog box.

Switching from One Layout to Another
If you have created or made edits to a report layout and you want to create or 
edit another one, you should click Update to save your changes. If you select 
another layout from the Name drop-down list or click New without clicking the 
Update button, Data Manager prompts you to save unsaved changes to the 
current layout. 

Figure 151.  Save Changes? 

To save changes, click Yes. Or, to discard changes that you have made since 
the last time you clicked Update, click No.

Previewing a Layout
You can preview a report layout so that you know what the report will look like 
before you run it.
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To preview a layout:

1. In the Report Layout Editor dialog box, make sure the correct layout 
appears in the Name drop-down list.

2. Click Preview. A Report Layout Preview appears in RtfPad.

Figure 152.  Report Layout Preview – Sample Report 

3. When you finish, close the preview by selecting Exit from the RtfPad File 
menu.

Deleting a Layout
If you no longer need a custom report layout, you can delete it.

To delete a layout:

1. In the Report Layout Editor dialog box, make sure the layout you want to 
delete appears in the Name text box.

2. Click Delete. A confirmation message appears. 

3. Click Yes.
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7Data Manager Backup and 
Recovery

Because constant and reliable access to your data is one of the most critical 
parts of your system, we recommend that you have a comprehensive disaster 
recovery plan in place in the event of system problems or an entire system 
shutdown. ASM Data Manager contains several functions that can make 
creation and/or maintenance of your recovery plan easier. Data Manager also 
contains registry backup and meta-data export utilities that can help you 
restore Data Manager files and registry information, even when the problem is 
a minor one.

For more information, see the following sections:

• "Backing Up Your Data Manager System, " which follows

• “Restoring Your Data Manager System” on page 279

■ Backing Up Your Data Manager System
ASM Data Manager contains several utilities that allow you to effectively back 
up the most important aspects of your Data Manager system. There are three 
basic backups that you should perform in addition to regular third-party 
backups to ensure that you can restore your Data Manager system after a 
disaster or catastrophic system failure.

• Meta-data exports should be performed periodically in order to export Data 
Manager extended drive files and file tags for backup. For more 
information, see "Exporting File Meta-Data, " which follows.

• Copy media are media that are being used as copies, or backups, of 
original media on the Data Manager extended drive. If an original piece of 
media becomes unreadable, the copy of the media can be promoted to an 
original piece of media. For more information, see “Backing Up Media” on 
page 275.

• Data Manager system configuration is stored in registry settings. You can 
create a backup of your Data Manager system configuration using the 
repair disk utility, which saves a backup of the Data Manager registry 
settings. In the event of a Data Manager computer crash, you can then use 
the repair disk backup to restore the Data Manager configuration. 
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For “virtual” media such as Tivoli Storage Manager (TSM) and EMC 
Centera (EMC), the repair disk backup is especially critical because 
“virtual” media is defined through Data Manager configuration. In the event 
of system failure, you must restore that configuration to access (and 
restore, if necessary) files on the media. 

For more information, see “Backing Up the Data Manager Configuration” 
on page 275.

Exporting File Meta-Data
While you may be using a system backup program, these programs can often 
be limited when it comes to backing up all of the data necessary to restore 
your Data Manager files in the event of a system problem or disaster. There 
are two basic limitations when using traditional backup solutions with 
extended drives: performance issues and incomplete backup sets. The Data 
Manager meta-data export feature provides an alternative solution when these 
problems occur.

Backup programs that are not “NTFS aware” suffer from performance 
problems when running with Data Manager. These programs open files in a 
“normal mode” and cause file data to be fetched from remote storage. This 
can make backup impossible (due to time constraints) and can cause backup 
failures due to insufficient disk space resources. 

Even many backup solutions that are “NTFS aware” may not be suitable for 
Data Manager because they do not back up (and restore) all NTFS data. A 
complete backup for an extended drive must include the following information:

• File names and metadata (for files managed by Data Manager)

• File data (for files that are not managed by Data Manager)

• File stream data 

• Security information

• Extended attributes (additional metadata)

Since Data Manager stores its file tracking data in NTFS extended attributes, 
this data is critical to any backup and restore strategy. Many backup programs 
do not back up and restore this data, making them ineffective as disaster A 
Data Manager meta-data export set contains all necessary data for disaster 
recovery of a Data Manager extended drive. This feature provides a compact, 
high-speed export of any extended drive. Export sets contain different data 
depending on the type of file being exported:
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Notice that meta-data export sets do not include file data for Data Manager 
files (files that Data Manager has already moved to media). This data is 
permanently archived on remote storage media and can always be retrieved, 
and therefore is not necessary in a standard export. This optimization 
significantly reduces the size of export data sets and the time it takes to export 
large volumes.

Note: If you intend to use backups to restore files that have been accidentally 
deleted, we recommend you use non-rewritable media with your ASM 
system to ensure that delete transactions are not flushed out to media 
and that manual recovery of file data from media is possible if needed. 

Once Data Manager has created an export set, this data must be archived 
(like any other backup data) for disaster recovery.

During a meta-data export, Data Manager inventories the files on an extended 
drive and sees that the appropriate information (file data, file tags, and all 
necessary additional data) is saved. The Data Manager meta-data export 
utility allows you to set a network path for the export data and choose to export 
either all files on the extended drive or only those files that have not yet been 
migrated to media. You can also set schedules for full and incremental 
exports. Until you set up an export schedule for the extended drive, automatic 
exports are disabled.

Incremental exports are generally used in between full export schedules to 
export files not previously exported by Data Manager. Incremental exports 
take significantly less time than full exports. 

Meta-data exports can be forced or scheduled. You can also stop a meta-data 
export once it has started.

For more information, see the following sections:

• "Scheduling Meta-Data Exports, " which follows

• “Forcing a Meta-Data Export” on page 274

• “Stopping a Meta-Data Export in Progress” on page 274

Table 27.  Types of Data Exported By Data Manager

Data Manager Files Non-Data Manager Files
File names and metadata

File stream data

Security information

Extended attributes

File names and metadata

File stream data

Security information

Extended attributes

File data
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Scheduling Meta-Data Exports
For the most complete export results, you should schedule your meta-data 
exports to occur when the fewest number of users are likely to be accessing 
Data Manager files. Most applications do not allow simultaneous access to 
open files, meaning that any files open at the time the export is run will be 
“locked” to the export process. Files that are locked when the export is run are 
skipped at that time but captured during the next export.

To configure meta-data exports:

1. Right-click on the extended drive that contains the meta-data you want to 
export and then select Properties from the shortcut menu. The Extended 
Drive Properties dialog box appears.

2. Click the Settings Tab.

Figure 153.  Extended Drive Properties – Settings Tab 

3. Click Meta-Data Export. The Extended Drive Meta-Data Export dialog box 
appears.
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Figure 154.  Extended Drive Meta-Data Export Dialog Box 

4. In the UNC Path text box of the Location section of the Extended Drive 
Meta-Data Export dialog box, type in or browse to the folder in which you 
want to have your export sets saved. 

When your export is created, Data Manager creates a folder hierarchy 
within the identified folder that lists the name and serial number of the 
extended drive, and within that, a folder with the date of the most recent 
export.

Figure 155.  Export Folders Created in Explorer 

Each time a new full export is created, a new dated folder is created that 
replaces the old one. This means that only the current full and associated 
incremental exports are resident in the UNC path at any given time.

5. In the Scheduling section of the Extended Drive Meta-Data Export dialog 
box, select the frequency with which you want incremental meta-data 
exports created. This schedule is disabled by default and remains disabled 
until you set a schedule.

The table below lists the scheduling options and descriptions available for 
incremental exports.
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6. To force Data Manager to create a full meta-data export the next time the 
incremental export schedule is activated, enable the Force next export to 
be full (setting cleared upon completion) check box. Once completed, this 
setting is cleared. (Selecting this option does not affect any scheduled full 
exports described in the step below.)

7. To set a regular schedule for Data Manager to create full meta-data 
exports, enable the Perform at scheduled interval check box. (Selecting 
this option does not affect a forced full export described in the step above.)

Note: Data Manager does not allow you to schedule full exports more 
frequently than incremental exports. For this reason the Perform at 
scheduled interval option may be grayed out, depending on your 
incremental export schedule.

8. If you enabled the Perform at scheduled interval option, click Full Export 
Frequency. The Full Meta-Data Export Frequency dialog box appears.

Table 28.  Export Scheduling Options

Scheduling 
Option

Export Frequency Settings to 
Configure

Disable Never. This is the default. None

Once Once on the specified date and 
time. Note that the default date 
and time are today’s date and 
12:00AM, respectively. Because 
this default time likely occurs in 
the past, the export will not run 
unless you change the defaults 
to a date and/or time in the 
future.

Date

Time 

Daily Every day at the specified time. Time

Weekly Every week on the specified 
days (Monday through Sunday) 
at the same time each day 
specified. 

Time

Days of the week

Monthly Every month on the specified 
date (1st through 31st) and time.

Time

Day of the month
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Figure 156.  Full Meta-Data Export Frequency Dialog Box 

Note: Data Manager does not allow you to schedule full exports more 
frequently than incremental exports. For this reason, the full export 
scheduling options in the Full Meta-Data Export Frequency dialog 
box may be grayed out, depending on your incremental export 
schedule.

9. You have three options:

• Select Always to create a full meta-data export every time the 
incremental export schedule is active. If you select this option, Data 
Manager always creates a full export and never creates incremental 
exports.

• Select Once per week on ____ to create a full meta-data export once 
per week on the day you select from the drop-down list. If you select 
this option, Data Manager creates a full export on the selected day, 
and creates incremental exports at the time(s) configured for the 
incremental export schedule.

• Select Once per month on the ___ (1st – 4th) ______ (day) to create a 
full meta-data export once a month on the day of the month you select 
from the drop-down list. If you select this option, Data Manager creates 
a full export on the selected day, and creates incremental exports at 
the time(s) configured for the incremental export schedule.

Full exports can often be time-consuming because a full export may 
include all files on the extended drive. Please keep this in mind when 
scheduling full exports.

1  After setting your full export frequency schedule, click OK to 
save changes and return to the Extended Drive Meta-Data 
Export dialog box.

2  To export only those files that have not yet been migrated to 
media, enable the Only export files that have not been 
migrated check box.

3  When all meta-data export schedule settings are complete, 
click OK to return to the Extended Drive Properties Settings 
tab.

4  Click OK to close the Extended Drive Properties dialog box.
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Forcing a Meta-Data Export
Data Manager allows you to force a meta-data export whenever needed. 
Forcing a meta-data export is similar to running an incremental export using 
the Once option. All files that have not already been exported are exported at 
that time. 

If there is no current export of the Data Manager extended drive, forcing a 
meta-data export forces a full export (essentially an incremental export of all 
files, because they have not been exported before). If an export of the Data 
Manager extended drive has already been created, forcing an export creates 
a true incremental export, capturing all files since the last export (either full or 
incremental) was run.

A forced meta-data export uses the folder specified in the UNC Path text box 
of the Extended Drive Meta-Data Export dialog box to save the export. You 
must have this path information entered in order to force an export.

To force a meta-data export:

1. Right-click the extended drive you want to back up and then select Force 
Meta-data Export from the shortcut menu. A message appears reminding 
you that a meta-data export may take a considerable amount of time for a 
large extended drive.

2. Click Yes to continue with the forced meta-data export. One of the 
following occurs: 

• If you have not configured a UNC Path in the Extended Drive Meta-
Data Export dialog box, an error message appears. 

Figure 157.  Force Meta-data Export Error – No Path Defined 

Click OK to close the message and return to Data Manager. Follow the 
Scheduling Meta-Data Exports instructions beginning on page 270 to set a 
UNC path for your export.

• If you have a location path configured, the export proceeds and the 
forced export is saved in the specified UNC path folder.

Stopping a Meta-Data Export in Progress
Data Manager allows you to stop a meta-data export after one has started. 
This function may be useful if a scheduled export begins at an inconvenient or 
inappropriate time, or if you forced an export and later determined it was going 
to take more time than could be allotted for the function.
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When you stop a meta-data export in progress, the system finishes exporting 
the file it was on when the stop export command was issued, and retains 
whatever files were exported to that point. Any files not exported are captured 
during the next export.

To stop a meta-data export in progress:

1. Right-click on the extended drive with the export in progress and then 
select Abort Meta-data Export from the shortcut menu.

2. Click Yes on the confirmation message that appears. An additional 
message appears to confirm that the meta-data export was aborted.

3. Click OK to close the message and return to Data Manager.

Backing Up Media
You can back up the files on your media by creating a copy of each piece of 
media. In the event the original piece of media is lost or damaged, it may 
become necessary to replace the original using the copy. Copy media has the 
same label as the original it corresponds to, but it has a unique serial number. 
Copy media can be created for each piece of media that is allocated to an 
extended drive and appears in the Original node of the Available Media tree. 
You can create copy media of all media types except for NAS, EMC, TSM, 
CD-ROM, and DVD-ROM. For NAS media, we recommend that you use a 
third-party backup system. CD-ROM and DVD-ROM media are read-only.

There are two ways to create copy media:

• Use the Copy Media Manager.

• Assign the label copy media task. 

For more information, see “Creating and Managing Copies of Media” on 
page 103.

Backing Up the Data Manager Configuration
You can create a backup of your Data Manager system configuration, which is 
stored in registry settings, using the repair disk utility. In the event of an Data 
Manager computer crash, you can then use the repair disk backup to restore 
the Data Manager configuration. 

Note: For “virtual” media such as Tivoli Storage Manager (TSM) and EMC 
Centera (EMC), the repair disk backup is especially critical because 
“virtual” media is defined through Data Manager configuration. In the 
event of system failure, you must restore that configuration to access 
(and restore, if necessary) files on the media. 

Data Manager automatically updates the repair disk backup after the following 
actions:



Data Manager Backup and Recovery

276 Second Edition
StorageTek Proprietary

• Every 15 minutes 

• When the service starts or stops

• When an extended drive is created or deleted

• When a media service is added or deleted

• When changes are made to the Service Properties (and OK or Apply is 
clicked)

• When the repair disk backup location is changed (through the 
Administrator)

You can set the location where the repair disk is automatically saved, set a 
location for a copy of the repair disk for the current Data Manager 
configuration, or restore Data Manager registry settings using the Repair Disk 
Wizard.

This section provides procedures for setting the backup location for your 
repair disk and for creating a copy of the repair disk backup. For information 
and instructions on restoring a repair disk file, see “Restoring Data Manager 
Configuration” on page 280.

For more information, see the following sections:

• "Setting the Repair Disk Backup Location, " which follows

• “Copying the Repair Disk Backup” on page 278

Setting the Repair Disk Backup Location
The Repair Disk Wizard allows you to designate where Data Manager stores 
the repair disk backup it creates. In order to ensure fail-proof disaster 
recovery, the backup should be copied to a location separate from your 
Windows server files. Ideally, you should copy it to a different volume. 

Note: The repair disk backup file should also be saved regularly to an 
additional location. Besides allowing for an additional backup of the 
repair disk file, this also allows for “versioning” of repair disk backup 
copies, in the event the last saved repair disk is corrupt or otherwise 
unusable for system restore.

To set the repair disk location:

1. From the Tools menu, select Repair Disk. The Repair Disk Wizard 
appears.
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Figure 158.  Repair Disk Wizard – Introduction Page 

2. Choose Set the automatic repair disk location and then click Next. The 
Automatic Repair Disk Location page appears.

Figure 159.  Repair Disk Wizard -- Automatic Repair Disk Location Page 

3. In the Location text box, enter the UNC path to which the repair disk 
backup should be saved. To browse to a directory, click Browse. 

4. Once you have entered a path in the Location text box, click Next. The 
Summary page appears.

5. Review the information in the summary.

6. If the information in the summary is correct, click Finish to complete the 
wizard. A warning message appears. 

Figure 160.  Repair Disk Media Task Warning Message 

7. Click OK. A progress message appears, indicating that the auto disk repair 
location is being saved. Once the message disappears, the location 
setting is complete.
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Copying the Repair Disk Backup
In addition to designating where the repair disk backup is stored, the Repair 
Disk Wizard also allows you to store a copy of the current registry settings at 
will. We highly recommend regularly creating a copy of the repair disk, in order 
to be sure you have a usable copy of your system configuration. In addition, 
because the normal repair disk is saved at a minimum of every 15 minutes, if 
some corruption took place before the new repair disk was saved, the primary 
copy of your repair disk file may be unusable for system restoration. 

When you use the Repair Disk Wizard to set a location for a copy of the 
current configuration, Data Manager creates a copy of the Data Manager 
configuration as soon as the wizard is completed. The copy is a one-time 
backup and does not update regularly.

Setting a location for a copy of the current configuration does not affect the 
location for automatic backup. Data Manager continues to back up Data 
Manager registry information to the location set for automatic repair disk 
creation. To copy the current repair disk backup:

1. From the Tools menu, select Repair Disk. The Repair Disk Wizard 
appears.

Figure 161.  Repair Disk Wizard – Introduction Page 

2. Select Copy current repair disk information to another location and then 
click Next. The Copy Repair Disk Information page appears.
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Figure 162.  Repair Disk Wizard -- Copy Repair Disk Information Page 

3. Enter a directory path and file name in the File Name text box. To browse 
to a directory and/or file, click Browse.

4. Once you have entered a path in the File Name text box, click Next. The 
Summary page appears.

5. Review the information in the summary.

6. If the information in the summary is correct, click Finish to complete the 
wizard. A progress message appears, indicating that the copy disk repair 
location is being saved. Once the message disappears, the copy is 
complete.

■ Restoring Your Data Manager System
In the event of catastrophic system failure, the same ASM Data Manager 
utilities that allow you to create exports of your extended drive files and 
backups of your registry settings also allow you to restore those exports and 
backups to your Data Manager system. The restore functions for the repair 
disk utility and the meta-data export utility make recovery and re-configuration 
of your system after a disaster both faster and more accurate. 

This section provides information and procedures for restoring export files and 
registry configurations in the event you ever need to restore your Data 
Manager system after a disaster or catastrophic system failure. 

Note: If you are using the EMC Centera media service with your Data 
Manager system, additional recovery steps related to the EMC 
Centera Content Network Repository are required. Please contact 
StorageTek technical support at 1-800-678-4430 for assistance when 
restoring Data Manager. 

When a system failure or disaster occurs, the following steps should be taken 
in order to most effectively restore your Data Manager system, Data Manager 
files, and Data Manager configurations.
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To restore your Data Manager system:

1. If necessary, reformat the Data Manager computer hard drive. 

2. Reinstall Windows NT/2000.

3. Reinstall and configure the necessary media service software. For more 
information on media services, see the Setting up Media Services chapter 
of the ASM Data Manager Getting Started Guide. 

4. Reinstall Data Manager. For instructions, refer to the Installing Data 
Manager chapter of the ASM Data Manager Getting Started Guide.

5. Restore the repair disk (Data Manager registry) file. For instructions, see 
"Restoring Data Manager Configuration, " which follows.

6. Run the Change Extended Drive Serial Number Wizard (which 
automatically appears if the change is required – otherwise, continue with 
next step). For more information, see “Changing the Extended Drive Serial 
Number” on page 283.

7. Restore any third-party backups you may have made. 

8. Restore the extended drive from the meta-data export. For instructions, 
see “Restoring the Meta-Data Export” on page 284.

9. If your meta-data export contains only files that had not been migrated, 
you also need to restore files that were migrated to media. (If the Only 
export files that have not been migrated check box is enabled on the 
Extended Drive Meta-Data Export dialog box, meta-data exports contain 
only files that have not been migrated and do not contain file tags for files 
that are on media. For more information, see “Scheduling Meta-Data 
Exports” on page 270.) To restore files from media, run the file restore 
media task for each piece of media. For more information, see “Restoring 
Files from Media” on page 77.

Note: In addition, if you are restoring files using a third-party backup, and you 
have any non-finalized DVD-R media in your system, you should plan 
to assign the file restore media task to that media, to ensure that all 
appropriate file data is copied back to the extended drive after the 
system is restored. 

These steps should be sufficient to get your Data Manager system up and 
running after a disaster or system failure. As always, if you run into any 
problems, contact your technical support representative for assistance.

Restoring Data Manager Configuration
When problems occur on your Data Manager computer, you can restore your 
Data Manager registry configuration by using the Repair Disk Wizard to 
restore the backup copy of the registry settings after you have reinstalled all of 
the necessary software components. 
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Note: Attempting to restore a repair disk file from a version of Data Manager 
other than the one currently installed will fail. Be sure that you are 
restoring a repair disk file from the same version and build of Data 
Manager you are currently running.

Note: Depending on what problems occurred to cause you to have to restore 
your Data Manager system, you may be prompted to run the Change 
Extended Drive Serial Number Wizard before restoring the Data 
Manager repair disk. If the wizard appears, we recommend that you 
click Cancel and run the repair disk restore first. 

To restore the repair disk configuration:

1. From the Tools menu, select Repair Disk. The Repair Disk Wizard 
appears.

Figure 163.  Repair Disk Wizard – Introduction Page 

2. Choose Restore service configuration from a repair disk and click Next. 
The Restore Repair Disk page appears.

Figure 164.  Repair Disk Wizard -- Restore Repair Disk Page 

3. Enter the directory path and file name for the repair disk file in the File 
Name text box. To browse for a file, click Browse.

Note: Be sure that you are restoring a repair disk file from the same 
version and build of Data Manager you are currently running. 
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Attempting to restore a repair disk file from a version of Data 
Manager other than the one currently installed will fail.

4. Click Next. The Restore Repair Disk – Warning page appears.

Figure 165.  Repair Disk Wizard -- Restore Warning Page 

 

5. Read the Restore Repair Disk – Warning page carefully.

6. When you finish, click Next. The Restore Repair Disk – Note page 
appears. 

Figure 166.  Repair Disk Wizard -- Restore Note Page 

This page provides a reminder that the current product configurations will 
be overwritten with the saved configuration from the specified repair disk 
location.

7. To continue, click Next. The Summary page appears.

8. Review the information in the summary carefully.

9. If the information in the summary is correct, click Finish to complete the 
wizard. The repair disk information is copied, and the backup Data 
Manager configuration is restored to your machine. Then a message 
appears to prompt you to restart the Data Manager computer. 
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Figure 167.  Restore Repair Disk 

10. Click OK, and then restart the Data Manager computer. After restart, if 
necessary, Data Manager may prompt you to run the Change Extended 
Drive Serial Number Wizard.

Changing the Extended Drive Serial Number
Data Manager tracks extended drives by the volume serial number assigned 
to each NTFS volume. This number is set during the format process and 
uniquely identifies each NTFS volume on a network.

In a disaster recovery scenario, it is likely that the volume serial number for a 
drive will change (due to reformatting the drive). In this case, the extended 
drive in Data Manager (identified by the old serial number) appears as 
OFFLINE in the Administrator, indicating that the extended drive cannot be 
found.

The Change Extended Drive Serial Number Wizard allows you to view all 
OFFLINE extended drives and redefine volume serial numbers for each drive. 
When completed, this wizard resets the Data Manager configuration to 
recognize “old” extended drives under the “new” volume serial number.

This wizard is typically used after restoring an Data Manager repair disk. In 
most cases, the extended drive has been lost and reformatted before restoring 
the Data Manager repair disk. Although the repair disk restores all pre-existing 
configuration information for Data Manager, it has no way of knowing what 
drives have been reformatted or what their new serial numbers are.

Using the Change Extended Drive Serial Number Wizard, you may select new 
volume serial numbers from a drop-down list containing all unused volume 
serial numbers on the Data Manager computer.

Be advised, there is no way to manually start the Change Extended Drive 
Serial Number Wizard. The wizard automatically starts when the Data 
Manager service starts and determines that one or more extended drives are 
offline due to a serial number change. 
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To change an extended drive’s serial number:

1. When the wizard starts, the Welcome page appears. Read the information 
in the Welcome page and click Next. The Select New Serial Number(s) 
page appears.

Figure 168.  Change Extended Drive Serial Number Wizard -- Select New 
Serial Number(s) Page 

The Select New Serial Number(s) page lists all offline extended drives and 
the serial number previously assigned to those drives. At the bottom of the 
page is a drop-down list of all currently unassigned drive letters on the 
Data Manager computer.

2. Select the drive with the serial number you want to change.

3. From the drop-down list of drive letters, select the drive letter (and new 
serial number) to which you want to assign the original serial number.

4. Click Next. The Summary page appears.

5. Review the information in the summary.

6. If the information in the summary is correct, click Finish. A progress 
message appears, letting you know that the extended drive is being 
remapped. When the process is complete, you are returned to the 
Administrator and your extended drive appears in the tree view. 

Restoring the Meta-Data Export
If you have created meta-data exports, Data Manager allows you to restore 
the exported files. If it is necessary, you can restore extended drive files 
exported from a different extended drive in the event that the entire structure 
of your Data Manager system had to change to accommodate recovery.

Be advised that a meta-data import does not overwrite files created on the 
extended drive since the export was created, and as such, does not restore 
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files from an export if a file of the same name already exists on the extended 
drive. Because of the potential for confusion or for maintenance of outdated or 
corrupted files, we strongly recommend that you not use the meta-data import/
export function except as a disaster recovery tool.

To restore the extended drive from a meta-data export:

1. Right-click on the extended drive you want to restore and select Meta-data 
Import from the shortcut menu. The Extended Drive Meta-Data Import 
Wizard welcome page appears.

2. Click Next. The Provide Meta-Data Set Location page appears with the 
meta-data export folder location listed in the UNC Path text box by default.

Figure 169.  Extended Drive Meta-Data Import Wizard -- Provide Meta-
Data Set Location Page 

3. To change the export from which the extended drive is restored, enter the 
path in the UNC Path text box. To browse to the directory, click Browse. 

Note: You must select the same UNC path that you specified for the 
meta-data export. Do not attempt to specify the Data Manager-
created meta-data export folder (identified by date) for the restore. 
The Extended Drive Meta-Data Import Wizard finds the most 
recent export(s) automatically and allows you to select the correct 
one.

4. When you finish selecting the UNC path for the export, click Next. The 
Select Meta-Data Set page appears.
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Figure 170.  Extended Drive Meta-Data Import Wizard -- Select Meta-Data 
Set Page 

Since you can create export sets for more than one extended drive and 
maintain them in the same UNC path, you may have multiple export sets 
from which to choose. However, Data Manager only retains the most 
recent exports for each extended drive, so only one export set appears 
within each meta-data export folder.

5. To view the folder and date information for an export set, highlight the 
appropriate export set and click Details. The Meta-Data Set Details dialog 
box appears.

Figure 171.  Meta-data Set Details Dialog Box 

6. When you finish viewing the details, click Done to return to the Select 
Meta-Data Set page.

7. When you finish selecting a meta-data set, click Next. One of the following 
occurs:

• If you are restoring a meta-data export to a different extended drive 
than the one from which the export was created, or if you had to 
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change the serial number of the extended drive as part of the recovery 
procedure, a verification message appears.

Figure 172.  Meta-Data Restore Verification Message 

Click Yes to continue with the restore. The Summary page appears.

• The Summary page appears. 

8. Review the information in the summary. 

9. If it is correct, click Finish. Your extended drive files are restored to the 
point at which the export was created.

There are two points to keep in mind about migrated files when restoring a 
meta-data export.

First, if the Only export files that have not been migrated check box is enabled 
on the Extended Drive Meta-Data Export dialog box, your meta-data exports 
will contain only files that have not been migrated and will not contain file tags 
for files that are on media. If this is the case with the export you are restoring, 
you will also need to restore files that were migrated to media. To restore files 
from media, run the file restore media task for each piece of media. For more 
information, see “Restoring Files from Media” on page 77.

Second, if your meta-data export contains both migrated and non-migrated 
files, the files in the export that had been migrated to media will not be 
restored unless that media is in the media folder at the time the export is 
restored. 

For more information on scheduling meta-data exports and setting the 
associated options, see “Scheduling Meta-Data Exports” on page 270. 

After restoring your Data Manager system, you may want to run one or more 
of the available Data Manager reports to make sure that your system has been 
returned to the appropriate state and that Data Manager files, system registry, 
and media have been reset to their proper configuration. For more 
information, see “Running Data Manager Reports” on page 245.
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8Remotely Administering Data 
Manager

You can administer the ASM Data Manager system both from the computer on 
which Data Manager is installed and from remote computers. You can use the 
Administrator function that comes with a full installation of Data Manager to 
administer other Data Manager computers, or you can install the Remote 
Administrator, which simply provides you with the Administrator interface and 
the registration capability to attach remotely to one or more networked Data 
Manager computers. The remote administration function is the same whether 
you use an Data Manager Administrator (full installation) or a Remote 
Administrator. 

The Data Manager computer(s) you plan to manage must be the same version 
or higher as the Administrator you are using (either a Remote Administrator, or 
a full Data Manager Administrator). For example, a Data Manager version 5.4 
SR1 installation can be remotely administered using a version 5.4 or a version 
5.40.102 Administrator. However, a version 5.40.102 Administrator will not be 
able to connect to a version 5.4 (lower version) Data Manager service.

This chapter covers installation of the Remote Administrator, and briefly 
outlines procedures for starting the Remote Administrator for the first time. It 
also covers registering a Data Manager computer so that you can remotely 
administer it, and connecting to and disconnecting from Data Manager 
computers. For more information, see the following sections:

• "Before Installing the Remote Administrator, " which follows

• “Installing the Remote Administrator” on page 291

• “Starting the Remote Administrator the First Time” on page 294

• “Registering a Computer for Remote Administration” on page 295

• “Connecting to Data Manager Computers” on page 300

■ Before Installing the Remote Administrator
Before you install the Remote Administrator, you need to consider the 
following requirements:

• "Operating System Requirements, " which follows
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• “Windows Security” on page 290

• “Clustering” on page 290

Operating System Requirements
The ASM Data Manager Remote Administrator requires one of the following 
operating systems: 

• Windows NT 4.0 with Service Pack 6a, or 

• Windows 2000 with Service Pack 2 or 3

• Windows XP

Consult your Windows documentation for information on installing the 
operating system.

Windows Security
Remote administration of Data Manager computers works through a Remote 
Procedure Call (RPC) connection that enables communication between a 
remote Data Manager Administrator and the Data Manager computer. Security 
for that connection is managed by managing the membership of the local 
domain Administrators group and the DXAdministrators group on the Data 
Manager computer. To administer the Data Manager functions through a 
remote installation of the Data Manager Administrator, you must be a member 
of the DXAdministrators group on the Data Manager computer. To administer 
the Data Manager service through a remote installation of the Data Manager 
Administrator, you must be a member of the local Administrators group on the 
Data Manager computer. For more information, refer to the Planning Your 
Data Manager System chapter of the ASM Data Manager Getting Started 
Guide. 

In addition, for your convenience, the Remote Administrator setup wizard 
allows you to install the Remote Administrator on multiple computers at once, 
provided those computers are visible on your network and you are a member 
of the local Administrators group on those computers. To take advantage of 
this feature, you may want to determine which computers are to have the 
Remote Administrator installed on them and make sure you have 
administrative privileges on those machines before you run the setup wizard. 
This will enable you to run the installation only once rather than multiple times.

Clustering
You can install the Remote Administrator in either an active/passive or active/
active clustered environment. In both environments, you must register each 
computer you want to remotely administer on both nodes once the installation 
is complete. 
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If you choose to install the Remote Administrator in an active/passive 
clustered environment, install the program on the Primary server. Once the 
installation is replicated to the Secondary server, register each computer you 
want to remotely administer on both the Primary server and the Secondary 
server. 

If you choose to install the Remote Administrator in an active/active clustered 
environment, select the node names as the target computers for install, not 
the virtual server names. 

For more information, see the Clustering appendix in the ASM Data Manager 
Getting Started Guide.

■ Installing the Remote Administrator
For Remote Administrator workstations connecting to a Data Manager 
computer, a full Data Manager setup is not necessary. Connecting 
workstations need access to the Administrator only. A Remote Administrator 
installation sets up the Administrator interface as well as online help on the 
computer.

To install the Remote Administrator:

1. Exit all applications on the computer(s) on which you want to install the 
Remote Administrator. The Remote Administrator setup wizard may not be 
able to write to all necessary files if other software is running.

2. Insert the ASM CD-ROM into the drive. 

3. From the Start menu, select Run. The Run dialog box appears.

4. You can either browse to the following file or type the path in the Open text 
box:

D:\DX2000.XXX\DISKXTENDER REMOTE 
ADMINISTRATOR\SETUP.EXE

(In this path, D represents the drive holding the setup CD-ROM and XXX 
represents the ASM version number.) 

5. Once the file/path appears in the Open text box, click OK. Data Manager 
Remote Administration setup is initiated (which may take up to two 
minutes), and the Installation page appears. The Installation page briefly 
describes the installation process. 

6. Click Next. The Installation Options page appears. 
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Figure 173.  Remote Administrator Setup Wizard -- Installation Options 
Page 

7. Select Install new product and then click Next. The License Agreement 
page appears.

Figure 174.  Remote Administrator Setup Wizard -- License Agreement 
Page 

8. You must accept the terms of the license agreement before you can 
proceed with the installation. Scrolling to the bottom of the agreement 
allows you to enable the Accept terms of agreement check box. Check the 
box and click Next. The Registration page appears. 

Figure 175.  Remote Administrator Setup Wizard -- Registration Page 
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9. Enter your name and the name of your organization and then click Next. 
The Target Computers page appears. 

Figure 176.  Remote Administrator Setup Wizard -- Target Computers 
Page 

10. You have the following choices:

• To install the Remote Administrator only on the computer listed in the 
Target Computers list, click Next. The Summary page appears.

• To install the Remote Administrator on other computers in addition to 
the one listed in the Target Computers list, click Add. The Browse 
Computers dialog box appears. 

Figure 177.  Browse Computers Dialog Box 

11. In the Browse Computers dialog box, you have two choices:

• Under Available Computers, navigate to and select the computer on 
which you want to install the Remote Administrator and then click Add 
to add the computer to the Selected Computers list. 

• In the Computer Name text box, type in the name or the IP address of 
the computer on which you want to install the Remote Administrator 
and then click Add to add the computer to the Selected Computers list.

Repeat this step for each additional computer on which you want to install 
the Remote Administrator. When you finish selecting target computers, 
click OK. You are returned to the Select Target Computers page. Click 
Next. The Summary page appears. 
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12. Verify the accuracy of the information in the summary. 

13. If all information is correct, click Finish. Remote Administration Setup 
copies all program files onto the system, and adds Remote Administrator 
entries and the program group to the system configuration for each target 
computer selected. A progress bar displays the status of the operation. 

When the installation is complete, one of the following occurs:

• If you installed the Remote Administrator on one or more remote 
computers (in addition to or instead of the local computer), the ASM 
Administrator Setup Result dialog box appears, listing the installation 
results for each computer you specified. 

Figure 178.  Setup Result Dialog Box 

Take note of any computers that need to be restarted (or computers on 
which the installation failed) and then click OK. Be sure to restart each 
computer on which it is required before you start the Remote 
Administrator.

• If you installed the Remote Administrator on the local computer, a 
message appears, indicating that the Remote Administration 
installation has been successfully completed. Click Start to close the 
Remote Administration Setup wizard and open the Administrator, or 
click Exit to close the Remote Administration Setup wizard without 
starting the Administrator.

■ Starting the Remote Administrator the First Time
Because the Remote Administrator functions as an interface for Data Manager 
services installed on other machines, you must register the other computers 
through the Administrator in order to use the remote functionality. 

To start the Remote Administrator:

1. From the Start menu, select Programs, ASM Administrator, and then 
Administrator. The first time you start the Remote Administrator, a 
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message appears prompting you to register a Data Manager computer to 
the Remote Administrator. 

Figure 179.  Register a Computer? Message 

2. You have the following choices:

• To close the message box, but leave the empty Administrator window 
open, click No.

• To begin registering computers, click Yes. For more information and 
detailed instructions on registering Data Manager computers, see 
"Registering a Computer for Remote Administration, " which follows.

■ Registering a Computer for Remote 
Administration

You can administer ASM Data Manager both from the computer on which Data 
Manager is installed and from remote computers. You can use the 
Administrator function that comes with a full installation of Data Manager to 
administer other Data Manager computers, or you can install the Remote 
Administrator, which simply provides you with the Administrator interface and 
the registration capability to attach remotely to any networked Data Manager 
computer. Only computers where the same or higher version of Data Manager 
is currently installed can be registered. 

The remote administration function is the same whether you use an Data 
Manager Administrator (full installation) or a Remote Administrator. 
Regardless of which Administrator function you are working from, you have to 
register the remote Data Manager computer in order to allow the Administrator 
you are running to find and connect to the remote Data Manager computer.

You can register Data Manager computers either using the auto-detect 
function or by adding the Data Manager computer manually by browsing to it. 
For procedures, see "Registering Computers Using Auto-Detect, " which 
follows, or “Registering Computers Manually” on page 298.

Registering Computers Using Auto-Detect
For large systems with several Data Manager computers, the manual 
registration process is unwieldy since you must browse to and select each 
computer on the network. The Auto-Detect Wizard allows you to detect and 
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select all currently running Data Manager services on the network without 
browsing the system to find individual Data Manager computers.

Note: The auto-detect function will only detect Data Manager installations 
whose version matches that of the Administrator you are running. To 
register a Data Manager service running a higher version than the 
Administrator, you must register the computer manually. 

To register Data Manager computers using the Auto-Detect Wizard:

1. From the Service menu in the Administrator in which you want to register 
the computer(s), select Register, or click the Register Computer button on 
the toolbar.

Figure 180.  Register Computer Button 

The Register Computers dialog box appears.

Figure 181.  Register Computers Dialog Box 

All computers already registered with the currently open Administrator 
appear in the Register Computers dialog box. If you are registering 
through a Remote Administrator and you have not yet registered any Data 
Manager computers, the Register Computers dialog box is blank.

2. Click Detect to start the Auto-Detect Wizard. The Introduction Page 
appears.

3. Read the Introduction and click Next. The Computer List page appears.



Registering a Computer for Remote Administration

ASM Data Manager System Guide 297
StorageTek Proprietary

Figure 182.  Auto-Detect Wizard -- Computer List Page 

The Auto-Detect Wizard detects all computers on which Data Manager is 
installed and where the Data Manager service is actively running.

Note: The Auto-Detect Wizard does not detect Data Manager computers 
that have been powered off or where the Data Manager service 
has been stopped, or where the Data Manager version does not 
match that of the Administrator you are running.  

4. Select the computer(s) you want to register and click Next.

Note: If a computer that you want to register does not appear in the 
Computers Detected list, you need to register the computer 
manually. See “Registering Computers Manually” on page 298.

5. Review the summary to make sure the computers you want to register are 
listed.

6. If the information in the summary is correct, click Finish. The selected 
computers are registered and appear in the Register Computers dialog 
box. 

7. If you inadvertently list a computer you do not want to register, or you wish 
to delete a previously registered computer, select that computer and click 
Delete. Then click Yes on the confirmation message that appears.

8. Once the computers you want to remotely administer appear in the 
Register Computers dialog box, click Close. The Administrator attempts to 
connect to all registered Data Manager computers. All registered computer 
name(s) appear in the Computer drop-down list located directly beneath 
the menu bar in the Administrator, and in the tree view of the Administrator 
window.

The Administrator can be used to manage the Data Manager service on all 
registered and connected Data Manager computers. You can switch between 
registered computers by selecting different computer names from the 
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Computer drop-down list or by selecting the computers in the tree view of the 
Administrator.

Registering Computers Manually
If the Auto-Detect Wizard does not detect a Data Manager computer you want 
to remotely administer, or if you want to select the computers yourself, you can 
register them manually. In addition, if you want to register a Data Manager 
computer that is running a higher version of the service than that of the 
Administrator, you will need to register the computer manually. 

To manually register a Data Manager computer:

1. From the Service menu in the Administrator in which you want to register 
the computer(s), select Register, or click the Register Computer button on 
the toolbar.

Figure 183.  Register Computer Button 

The Register Computers dialog box appears.

Figure 184.  Register Computers Dialog Box 

All computers already registered with the currently open Administrator 
appear in the Register Computers dialog box. If you are registering 
through a Remote Administrator and you have not yet registered any Data 
Manager computers, the Register Computers dialog box is blank.

2. Click Add. The Select Computer dialog box appears.
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Figure 185.  Select Computer Dialog Box 

The Select Computer dialog box contains a list of machines on the current 
network. Data Manager must be installed on the remote computer before it 
can be registered for remote administration. 

3. You have the following choices:

• Select the Data Manager computer you want to register and click OK.

• Double-click the computer you want to register.

The Register Computer dialog box appears, listing the selected computer. 

4. Repeat steps 2 and 3 for each computer you want to register.

5. If you inadvertently list a computer you do not want to use as a Data 
Manager service, or you wish to delete a previously registered computer, 
select that computer and click Delete. The computer is removed from the 
list.

6. Once the appropriate computers appear in the Register Computers dialog 
box, click Close. The Administrator attempts to connect to all registered 
Data Manager computers. All registered computer name(s) appear in the 
Computer drop-down list located directly beneath the menu bar in the 
Administrator, and in the tree view.

The Administrator can be used to manage the Data Manager service on all 
registered and connected Data Manager computer(s). You can switch 
between registered computers by selecting different computer names from the 
Computer drop-down list or by selecting the computers in the tree view of the 
Administrator.
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■ Connecting to Data Manager Computers
When the Administrator is opened, it attempts to connect to all registered ASM 
Data Manager computers (including the local computer for full installations of 
Data Manager). Once these connections have been made, the window 
displays information pertaining to each Data Manager service. 

The Administrator allows you to switch easily between registered Data 
Manager computers by selecting the computers in the tree view, or by 
selecting different computers from the Computer drop-down list.

Figure 186.  Computer Drop-Down List 

Remember, to successfully connect to an Data Manager computer in order to 
administer it, you must be a member of the DXAdministrators group on the 
computer you want to administer.

Note: If you are connecting to a higher version of Data Manager than that of 
the Administrator, you will receive a warning message noting the 
difference. 

Disconnecting from a Data Manager Computer
You may wish to disconnect from the currently active Data Manager computer. 
Disconnecting from the active service removes that computer’s Data Manager 
components from the tree view, though the computer still appears, listed with a 
status of (Disconnected).

To disconnect from the active Data Manager computer:

1. In the tree view of the Administrator, select the computer/extended drive 
from which you want to disconnect.

2. From the Service menu, select Disconnect, or click the Disconnect toolbar 
button. 

Figure 187.  Disconnect Toolbar Button 

Data Manager removes the selected computer’s components from the tree 
view, and the computer is listed with a status of (Disconnected).
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Reconnecting to a Data Manager Computer
Disconnected Data Manager computers appear in the tree view of the 
Administrator with a status of (Disconnected). Reconnecting Data 
Manager computers re-displays their configured extended drives and 
extended drive components so that you can administer them.

To reconnect to a Data Manager computer:

1. In the tree view of the Administrator, select the computer to which you 
want to connect.

1. From the Service menu, select Connect. or click the Connect toolbar 
button.

Figure 188.  Connect Toolbar Button 

Data Manager connects to the selected computer, and the computer’s 
Data Manager components appear in the tree view of the Administrator so 
that you can administer them.
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AUsing RtfPad

Reports and event logs all appear in RtfPad. You can use RtfPad to save, 
print, and email logs, reports, and Event Viewer snapshots. You can also 
configure RtfPad to display event logs in a black-and-white interface, or with 
color to contrast errors and warnings from other events. When you encounter 
system errors, RtfPad allows you to easily find and view descriptions of the 
errors. For more information, see the following:

• "Saving in RtfPad, " which follows

• “Printing in RtfPad” on page 303

• “Previewing and Printing in RtfPad” on page 304

• “Setting up Printing in RtfPad” on page 305

• “Sending from RtfPad” on page 306

• “Changing the Error Format” on page 307

• “Using RtfPad Error Lookup” on page 307

■ Saving in RtfPad
You can save a log, report, or Event Viewer snapshot for future reference.

To save in RtfPad:

1. From RtfPad’s File menu, select Save As. The Save As dialog box 
appears. 

2. Navigate to the location where you want to save the file.

3. In the File name text box, specify a file name.

4. From the Save as type drop-down list, select the file format in which you 
want to save the file.

5. Click Save.

■ Printing in RtfPad
You can print a log, report, or Event Viewer snapshot for future reference.
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To print in RtfPad:

1. From the File menu, select Print, or press <CTRL>+P. The standard 
Windows Print dialog box appears.

Figure 189.  Print Dialog Box 

2. From the Name list, select the printer you want to use.

3. In the Number of copies text box, specify the number of copies you want to 
print. 

4. Make any other print setting selections and then click OK. The file is sent 
to the selected printer. 

■ Previewing and Printing in RtfPad
You can print a log, report, or Event Viewer snapshot for future reference, and 
you can preview it before printing.

To preview and print in RtfPad:

1. From the File menu, select Print Preview. The text is displayed as it would 
appear when printed.
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Figure 190.  Print Preview in RtfPad 

2. You have the following choices:

• To navigate to the next or previous page, click Next Page or Prev 
Page.

• To display two pages at a time, click Two Pages.

• To display one page at a time, click One Page.

• To zoom in on or zoom out, click Zoom In or Zoom Out. 

• To close the print preview without printing, click Close.

3. When you are ready to print the text, click Print.

■ Setting up Printing in RtfPad
You can configure how a log, report, or Event Viewer snapshot is printed from 
RtfPad.
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To set up printing in RtfPad:

1. From the File menu, select Print Setup. The Print Setup dialog box 
appears.

Figure 191.  Print Setup Dialog Box 

2. From the Name list, select the printer that you want to use as the default 
printer. 

3. Select the default paper size, source, and orientation. 

4. Make any other print setting selections and then click OK. 

■ Sending from RtfPad
You can send a log, report, or Event Viewer snapshot to someone by email.

To send an RtfPad file as an email attachment:

1. From the File menu, select Send. A mail dialog box corresponding to your 
email system appears. 

Figure 192.  E-Mail Message with an RtfPad File as an Attachment 
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2. Address the message to the desired user. 

3. Complete the message by adding any other comments.

4. Send the message using your email program’s Send command. 

■ Changing the Error Format
RtfPad can be viewed in a black-and-white interface, or with color to contrast 
errors and warnings from other events. If RtfPad is set for Error Format, text 
appears as described in the following table:

To set RtfPad to display information in error format:

• From the RtfPad View menu, select Error Format. This is a toggle 
command. When enabled (selected), a check mark appears to the left of 
the command.

To disable error format:

• From the RtfPad View menu, select Error Format again. This is a toggle 
command. When disabled, no check mark appears to the left of the 
command.

■ Using RtfPad Error Lookup
When an error appears in RtfPad, an error number appears in brackets with 
the error message. This error number identifies the error and allows you to 
use the RtfPad error lookup feature to obtain additional information about the 
error, including the error name and a brief description. 

To obtain additional information about an error:

1. With the error log open, select the error number.

2. From the View menu, select Error Lookup, or press <F2>. The System 
Error Lookup dialog box appears with the error name and description. 

Table 29.  RtfPad Error Format Colors

Text Color
Errors Red

Warnings Yellow

Header Green

All other text Black
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Figure 193.  System Error Lookup Dialog Box 

3. You have the following choices:

• To scroll through the list of system errors, click the forward or backward 
arrows. 

• To access context-sensitive help for the error glossary, click Help.

• To close the System Error Lookup dialog box, click Close.
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BUsing Explorer Add-ons

The Explorer Add-ons allow users to view ASM Data Manager file and media 
folder properties from client machines without a full installation of Data 
Manager. The Explorer Add-ons enable this by connecting to the extended 
drive through Windows Explorer. Explorer Add-ons can be run on a Windows 
NT or Windows 2000 server or workstation, or on a Windows 98, ME, or XP 
workstation.

You can use the Explorer Add-ons to perform the following functions:

• View Data Manager file properties

• Run Data Manager file reports

• Set direct read for specified Data Manager files

• Purge specific Data Manager files

The Explorer Add-ons also provide a client fetch notification feature. When a 
client (with Explorer Add-ons installed) requests a file that must be fetched 
from media (the data is not resident on the extended drive), and the retrieval 
takes more than a few seconds to complete, the client receives a progress 
message, noting that file retrieval is taking place. This situation occurs most 
often when a requested file exists on a piece of media that must be mounted 
in a drive before the data can be fetched. 

The Data Manager Explorer Add-ons can be accessed using a wizard or by 
selecting files in Windows Explorer and then right-clicking the files to access a 
shortcut menu.

The Shell Xtensions Wizard is accessible both from the ASM program group in 
the Start menu and through the shortcut menu in Windows Explorer. The 
advantage of using the wizard over the shortcut menu commands is the ability 
to select multiple files from multiple directories. If you are selecting one or 
more files from only one directory (or all files in a single directory), it may be 
faster to use the shortcut menu commands.
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CRemoving Data Manager and Its 
Components

When ASM Data Manager is removed, all configuration settings and system 
files are deleted. If you reinstall Data Manager, new settings must be 
configured. Caution should be taken when removing the product, as all 
settings are permanently lost. 

The Data Manager setup wizard, accessed through the ASM program group in 
the Windows Start menu, takes you step-by-step through the uninstall 
process. However, Data Manager requires that you remove several key 
components before you attempt to uninstall the program. If you run the setup 
wizard before removing these components, a message appears to inform you 
that you must remove these items from your Data Manager configuration 
before uninstalling the program.

Note: If you plan to reinstall Data Manager later, you should create a copy of 
your Data Manager configuration before you uninstall Data Manager. 
The Repair Disk Wizard allows you to back up your Data Manager 
settings. For instructions, see “Copying the Repair Disk Backup” on 
page 278.

This chapter describes the steps you need to take before uninstalling Data 
Manager. In addition, you will find instructions on running the setup wizard to 
uninstall Data Manager, the Data Manager Remote Administrator, and the 
Explorer Add-ons. For more information, see the following sections:

• "Preparing for Uninstalling Data Manager, " which follows

• “Preparing for Uninstalling Data Manager” on page 311

• “Uninstalling Data Manager Remote Administrator” on page 315

• “Uninstalling Explorer Add-ons” on page 318

■ Preparing for Uninstalling Data Manager
In preparation for removing ASM Data Manager, you must remove all existing 
extended drives (and any media folders and any media in the media folders on 
those extended drives) and force a drive scan to update the affected Data 
Manager components. 
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For your convenience, the setup wizard allows you to uninstall Data Manager 
from multiple computers at once. Be sure to prepare each computer from 
which you are removing Data Manager.

Note: The steps below are only necessary if you are removing Data Manager 
itself. The preparation steps do not apply if you are uninstalling the 
Remote Administrator or the Explorer Add-ons.

To prepare for removing Data Manager:

1. Delete all move rules, to ensure no additional files are moved to media 
while executing the steps to remove Data Manager. For instructions, see 
“Deleting a Move Rule” on page 143.

2. Delete all scheduled media tasks for all extended drives. For instructions, 
see “Deleting Media Tasks” on page 46.

3. Compact all media. Compacting media writes all files on the media back to 
the extended drive, and ensures access to these files once the media is 
removed from the system. For instructions, see “Using the Compact Media 
Task” on page 80.

4. Remove all media from every media folder, and run the drive scans for 
each extended drive as prompted. For instructions, see “Removing Media 
from a Media Folder” on page 87.

5. Deallocate all media from the extended drive. For instructions, see 
“Deallocating Media from the Extended Drive” on page 95.

6. Delete each extended drive. For instructions, see “Deleting the Extended 
Drive” on page 204.

7. Remove all media services. For instructions, see “Removing Media 
Services” on page 102. 

8. Stop the Data Manager service. For instructions, see “Managing the Data 
Manager Computer” on page 207. 

■ Uninstalling Data Manager
Once you have completed the steps listed in “Preparing for Uninstalling Data 
Manager” on page 311, you are ready to uninstall Data Manager. The same 
setup wizard that installed the program can be used to uninstall the program. 
Because the setup wizard allows you uninstall Data Manager from multiple 
computers at once, you may want to determine which computers are to have 
Data Manager removed from them before you run the setup wizard, enabling 
you to run the wizard once rather than multiple times.

Note: If you are removing Data Manager from an active/passive clustered 
environment, you should run the setup wizard to remove the product 
directly on the Primary server (the server node currently in control). If 
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you are removing Data Manager from an active/active clustered 
environment, you can run the setup wizard from any server.

To remove Data Manager:

1. From the Windows Start menu, select Programs, ASM, and then Setup. 
The setup wizard appears, starting with the welcome page.

2. Click Next. The Installation Options page appears.

Figure 194.  Data Manager Removal – Installation Options Page 

3. Select Remove product and related items and then click Next. A warning 
appears informing you that uninstalling cannot be undone.

Figure 195.  Uninstall Warning Message 

4. Click Yes to continue. The Target Computers page appears. 

Figure 196.  Data Manager Removal – Target Computers Page 

Note: If you are removing Data Manager from an active/passive clustered 
environment, select the logical cluster name as the target computer 
for removal. If you are removing Data Manager from an active/
active clustered environment, select the virtual server names as 
the target computers for removal.
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5. You have the following choices:

• To remove Data Manager from only the computer(s) listed in the Target 
Computers list, click Next. The Summary page appears.

• To remove Data Manager from other computers in addition to the 
one(s) listed in the Target Computers list, click Add. The Browse 
Computers dialog box appears. 

Figure 197.  Browse Computers Dialog Box 

6. In the Browse Computers dialog box you have two choices:

• Under Available Computers, navigate to and select the computer from 
which you want to remove Data Manager and then click Add to add the 
computer to the Selected Computers list. 

• In the Computer Name text box, type in the name or the IP address of 
the computer from which you want to remove Data Manager and then 
click Add to add the computer to the Selected Computers list. 

Repeat this step for each additional computer from which you want to 
remove Data Manager. When you finish, click OK. You are returned to the 
Target Computers page. When the Target Computers list is complete, click 
Next. The Summary page appears.

7. Review the information in the summary.

8. If the information in the summary is correct, click Finish. A progress bar 
appears, indicating the completion percentage of the removal process. If 
you are uninstalling from multiple Data Manager computers, separate 
progress bars appear for each computer.

Any settings related to Data Manager in the Windows NT/2000 registry, all 
program files in the installation path, and the ASM program group/folder 
are removed. 

Then, one of the following occurs:
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• If you are uninstalling from one or more remote computers (in addition 
to or instead of the local computer), the ASM Setup Result dialog box 
appears, listing the results for each target computer. 

Figure 198.  ASM Removal Result Dialog Box 

Take note of any computers that need to be rebooted (or computers on 
which the uninstall failed) and then click OK. Restart each computer for 
which the ASM Setup Result dialog box indicates a reboot is required. 

• If you are uninstalling from the local machine, a message appears to 
prompt you to reboot the computer. Click Restart to close the message 
and reboot the computer immediately, or Exit to close the message 
without rebooting.

■ Uninstalling Data Manager Remote Administrator
ASM Data Manager Remote Administrator can be removed from a computer if 
necessary. Removing the Remote Administrator from a remote machine does 
not affect the Data Manager computer to which it points. Only the system files 
for the Remote Administrator and Service Manager are deleted. This means 
that you do not need to perform the preparation steps necessary for 
uninstalling the Data Manager program itself.

The same Remote Administrator setup wizard that installed the program can 
be used to uninstall the program. Because the setup wizard allows you 
uninstall the Remote Administrator from multiple computers at once, you may 
want to determine which computers are to have the Administrator removed 
from them before you run the setup wizard, enabling you to run the wizard 
once rather than multiple times.

Note: If you are removing the Remote Administrator from an active/passive 
clustered environment, you should run the setup wizard to remove the 
product directly on the Primary server (the server node currently in 
control). If you are removing the Remote Administrator from an active/
active clustered environment, you can run the setup wizard from any 
server.
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To remove the Remote Administrator:

1. From the Start menu, select Programs, then ASM Administrator and then 
Setup. The setup wizard opens, starting with the welcome page.

2. Click Next. The Installation Options page appears.

Figure 199.  Remote Administrator Removal – Installation Options Page 

3. Select Remove product and related items and then click Next. A warning 
appears to inform you that the uninstall cannot be undone.

Figure 200.  Uninstall Warning Message 

4. Click Yes to continue. The Target Computers page appears. 

Figure 201.  Remote Administrator Removal – Target Computers Page 

Note: If you are removing the Remote Administrator from an active/
passive clustered environment, select the logical cluster name as 
the target computer for removal. If you are removing the Remote 
Administrator from an active/active clustered environment, select 
the virtual server names as the target computers for removal.

5. You have the following choices:
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• To remove the Remote Administrator from only the computer(s) listed 
in the Target Computers list, click Next. The Summary page appears.

• To remove the Remote Administrator from other computers in addition 
to the one(s) listed in the Target Computers list, click Add. The Browse 
Computers dialog box appears.

Figure 202.  Browse Computers Dialog Box 

6. In the Browse Computers dialog box you have two choices:

• Under Available Computers, navigate to and select the computer from 
which you want to remove the Remote Administrator and then click 
Add to add the computer to the Selected Computers list. 

• In the Computer Name text box, type in the name or the IP address of 
the computer from which you want to remove the Remote 
Administrator and then click Add to add the computer to the Selected 
Computers list. 

Repeat this step for each additional computer from which you want to 
remove the Remote Administrator. When you finish, click OK. You are 
returned to the Target Computers page. When the Target Computers list is 
complete, click Next. The Summary page appears.

7. Review the information in the summary.

8. If the information in the summary is complete, click Finish. A progress bar 
appears indicating the completion percentage of the removal process. If 
you are uninstalling from multiple computers, separate progress bars 
appear for each computer.

Any settings related to the Remote Administrator in the Windows registry, 
all program files in the installation path, and the ASM Remote 
Administrator program group/folder are removed. 

Then, one of the following occurs:
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• If you are uninstalling from one or more remote computers (in addition 
to or instead of the local computer), the ASM Administrator Setup 
Result dialog box appears, listing the results for each target computer. 

Figure 203.  ASM Administrator Setup Result Dialog Box 

Take note of any computers that need to be rebooted (or computers on 
which the uninstall failed) and then click OK. Restart each computer for 
which the ASM Administrator Setup Result dialog box indicates a reboot is 
required. 

• If you are uninstalling from the local machine, a message appears to 
prompt you to reboot the computer. Click Restart to close the message 
and reboot the computer immediately, or Exit to close the message 
without rebooting.

■ Uninstalling Explorer Add-ons
Explorer Add-ons can be removed from a machine if necessary. The same 
setup wizard that installed the program can be used to uninstall the program. 
Because the setup wizard allows you uninstall the Explorer Add-ons from 
multiple computers at once, you may want to determine which computers are 
to have the Explorer Add-ons removed from them before you run the setup 
wizard, enabling you to run the wizard once rather than multiple times.

To remove Explorer Add-ons

1. From the Start menu, select Programs, ASM Explorer Add-ons, and then 
Setup. The setup wizard opens with the welcome page.

2. Click Next. The Installation Options page appears.
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Figure 204.  Explorer Add-ons Removal – Installation Options Page 

3. Select Remove product and related items and then click Next. A warning 
appears to inform you that the uninstall cannot be undone.

Figure 205.  Uninstall Warning Message 

4. Click Yes. The Target Computers page appears. 

Figure 206.  Explorer Add-ons Removal – Target Computers Page 

5. You have the following choices:

• To remove the Explorer Add-ons from only the computer(s) listed in the 
Target Computers list, click Next. The Summary page appears.

• To remove the Explorer Add-ons from other computers in addition to 
the one(s) listed in the Target Computers list, click Add. The Browse 
Computers dialog box appears. 
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Figure 207.  Browse Computers Dialog Box 

6. In the Browse Computers dialog box you have two choices:

• Under Available Computers, navigate to and select the computer from 
which you want to remove the Explorer Add-ons and then click Add to 
add the computer to the Selected Computers list. 

In the Computer Name text box, type in the name or the IP address of the 
computer from which you want to remove the Explorer Add-ons and then 
click Add to add the computer to the Selected Computers list. 

Repeat this step for each additional computer from which you want to 
remove the Explorer Add-ons. When you finish, click OK. You are returned 
to the Target Computers page. When the Target Computers list is 
complete, click Next. The Summary page appears.

7. Review the information in the summary.

8. If the information in the summary is complete, click Finish. A progress bar 
appears indicating the completion percentage of the removal process. If 
you are uninstalling from multiple computers, separate progress bars 
appear for each computer.

Any settings related to the Explorer Add-ons in the Windows registry, all 
program files in the installation path, and the ASM Explorer Add-Ons 
program group/folder are removed. 

Then, one of the following occurs:

• If you are uninstalling from one or more remote computers (in addition 
to or instead of the local computer), the Explorer Add-ons Setup Result 
dialog box appears, listing the results for each target computer. 
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Figure 208.  Explorer Add-ons Setup Result Dialog Box 

Take note of any computers that need to be rebooted (or computers on 
which the uninstall failed) and then click OK. Restart each computer for 
which the Explorer Add-ons Setup Result dialog box indicates a reboot is 
required. 

• If you are uninstalling from the local machine, a message appears to 
prompt you to reboot the computer. Click Restart to close the message 
and reboot the computer immediately, or Exit to close the message 
without rebooting.
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Index

Symbols
.DXP files, 147, 154

Numerics
3rd party backup

limitations, 268
media, 103, 275
mode for managed files, 196
saves migration info, 196

8mm DAT tape, 14
9840 tape, 14

A
aborting

fetch requests, 48
media tasks, 45
meta-data exports, 274
prefetch requests, 160

account, service
configuring in Data Manager, 210
configuring in Windows 2000, 214
configuring in Windows NT, 212

ACSLS, 2
deallocating media, 95, 96
deleting a media service, 102
removing a drive, 102

Administrative Tools, Windows 2000
managing the service, 214

Administrator
remote, 289

AIT tape, 14
alerts

accessing, 232
adding, 234
configuring, 232
deleting, 236
free space warning, 128
modifying, 235

alignment, changing for reports, 263
All Events Log, 238

clearing, 244
configuring, 240
configuring format, 240
configuring maximum size, 240
opening, 239
selecting events to trace, 243

allowing fetches from media, 47
default settings, 54
planning, 54, 166
scheduling, 52

ASM, 1
removing, 311, 312

ASM file systems, 18, 22, 197
ASM MediaStor, definition, 5
ASM MediaStor, deleting a media service,
102
ASM MediaStor, removing media from, 98
ASM Shell Wizard, 309
Auto-Detect Wizard, 295
automation, move group, 129
available media, 13, 24

blank media, 25
copy media, 24
corrupt, 26
duplicate media, 25
foreign media, 25
original media, 24
unformatted media, 25
unknown media, 25

B
backup, 10, 267

3rd party, limitations, 268
3rd party, media, 103, 275
3rd party, mode for managed files, 196
3rd party, saving migration info, 196
copy media, 103
Data Manager configuration, 10, 267,
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275
Data Manager configuration, copying,

278
Data Manager configuration, location,

276
file tags only, 196
including migration information, 196
media, 10, 103, 267, 275
meta-data export, 10, 267, 268
meta-data export, forcing, 274
meta-data export, forcing full, 272
meta-data export, full, 269
meta-data export, incremental, 269
meta-data export, location, 271
meta-data export, scheduling, 193, 270,

271
meta-data export, stopping, 274
only files not migrated, 273
required information, 268
restoring Data Manager from, 279
statistics, 203

barcodes, using to label media, 62, 131
blank media, 25
block size

setting for tape media, 226
block size, setting for WORM-tape media,
226

C
caching

setting limit for direct read, 197
canceling

fetch requests, 48, 198
media tasks, 45
meta-data exports, 274
prefetch requests, 160

capacity
extended drive, 193
media, 30

CDFS media support, 18, 21
CD-ROM, 14

drive saver, 224
preventing file delete, 199
preventing file modification, 200
supported file systems, 19
timeslice last fetch, 224
timeslice maximum mount, 224

timeslice minimum mount, 224
check disk, 103, 113
clearing

event logs, 244
media logs, 41
media statistics, 33
media task error status, 41

client fetch notification, 309
clustering, 2, 10
color, enabling for media status, 40
compaction, 2, 79, 127

automatic, 129, 131
before reformatting, 76
before removing media from media fold-

ers, 88
free space requirements, 80
handling deleted files, 180
using media tasks, 80

compression
disabling/enabling, 58, 62
hardware, 226

computer drop-down list, 300
connecting to remote computers, 300, 301
Control Panel, NT service management, 211
Copy Media Manager, 7, 104, 107

viewing status, 111
copying media, 10, 24, 103, 267, 275

choosing media to use, 105
creating, 106
priority for updates, 52
promoting originals, 112, 113
scheduling creation, 107
scheduling updates, 52
serial number, 112
updating, 50
using copies from DX 4.x, 105
using media tasks, 109
using the Copy Media Manager, 107
viewing status, 111

corrupt media, 26
repairing using check disk, 103, 113

CSS file system, 18, 23

D
data management, 2
Data Manager, 1

configuration backup, 267, 275
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configuration restoration, 280
installation date, 219
licensing information, 236
managing the computer, 207
preparing to uninstall, 311
registry report, 245, 258
service, 207
service account, 210, 212, 215
service, managing, 208
uninstalling, 311, 312
version number, 219

deallocating
ACSLS media, 96
EMC media, 95, 96
media, 95
MediaStor media, 95, 96
NAS media, 95, 96
TSM media, 95, 96

deferring fetch requests, 47, 144, 201
planning, 54

definitions, 1
delete rules, 9, 181

age tab, 187
attributes tab, 186
creating, 182
deleting, 190
file name tab, 184
inclusion vs. exclusion, 181, 182
modifying, 189
processing, 182
rule type tab, 182
setting age qualifications, 187
setting attributes qualifications, 186
setting file name qualifications, 184
setting folder qualifications, 184
setting size qualifications, 186
size tab, 186

deleting
ACSLS media, 102
alerts, 236
applications to filter, 232
delete rules, 190
EMC media, 100
extended drives, 204
files, 180
files, ensuring, 180
files, preventing, 199
media, 97

media folders, 118
media services, 102
media tasks, 46
move groups, 133
move rules, 143
NAS media, 98
original media, 113
partition maps, 222
prefetch requests, 160
purge rules, 180
report layouts, 266
TSM media, 99

de-migration
defined, 2

demoting
media in move groups, 121, 123
media tasks, 44

diagnostic utilities, 207
direct read, 9, 48, 145

defined, 2
during DVD-R finalization, 84
during file restore, 70, 78
forcing for all files, 198
memory cache, 145, 197
setting for moved files, 141

directories, extended drive, 117
disabling

event logging, 237, 240
folder rename check, 197

disaster recovery, 10, 267, 279
disclaimer, v
disconnecting from remote computers, 300
DiskXtender Shell Wizard

uninstalling, 318
DLT tape, 14
drive, 2
drive saver

CD-ROM, 224
DVD, 224
EMC, 228
optical, 225

drive scans, 9, 169, 182, 204
forcing, 204
purging files during, 167, 176
scheduling, 193, 205
statistics, 203
when to run, 204

duplicate
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files, logging during file restore, 70, 78
media, 25

DVD
drive saver, 224
timeslice last fetch, 225
timeslice maximum mount, 225
timeslice minimum mount, 225

DVD-R, 14, 15
finalizing and enabling direct read, 84
finalizing and purging files, 84
supported file systems, 19

DVD-RAM, 14
supported file systems, 19

DVD-ROM, 15
supported file systems, 19

DX2000
MediaStor, deallocating media, 95

DXAdministrators
for remote administration, 290

E
emailing

logs and reports, 306
system errors and warnings, 232

EMC Centera (EMC), 15
deallocating media, 95, 96
media, 15
removing media, 100

EMC media
resource saver, 228

erasable optical, 14, 16
supported file systems, 19

errors
clearing for media tasks, 41
configuring format in RtfPad, 307
displaying as alerts, 232
log, 10, 237, 238
log, clearing, 244
log, configuring, 240
log, configuring format, 240
log, configuring maximum size, 240
log, opening, 239
looking up, 238, 239, 307
maximum before media writes disabled,

126
media, 33
repairing with check disk, 103, 113

event log, 10, 237, 238
clearing, 244
configuring, 240
configuring format, 240
configuring maximum size, 240
configuring start time, 240
disabling, 240
opening, 239
selecting events to trace, 243

event viewer, 10, 237
clearing, 244
configuring, 240
print previewing in RtfPad, 304
print setup in RtfPad, 305
printing in RtfPad, 303
saving in RtfPad, 303
sending by email, 306

exclude rules
delete, 181
move, 136
purge, 169, 171

Explorer Add-ons, 309
client fetch notification, 309
uninstalling, 318

extended drive, 8
3rd party backup mode for managed

files, 196
3rd party backup saves migration info,

196
administration, 163
configuring, 190
deallocating media, 95
defer fetch requests if fetch is disabled,

201
definition, 3
deleting, 204
deleting files, 180
direct read memory cache, 145, 197
disable folder rename check, 197
drive scans, 204
event viewer, 237
fetch request timeout minutes, 198
folders, media, 117
force direct read for all files, 198
force moves when nothing to purge, 198
free space, calculating, 193
free space, maintaining, 166, 167
general tab, 191
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managing space on, 163
media activities, scheduling, 52
meta-data export, 10, 267, 268
meta-data export location, 271, 285
meta-data export, forcing, 274
meta-data export, forcing full, 272
meta-data export, only files not migrated,

273
meta-data export, restoring, 284
meta-data export, scheduling, 270, 271
meta-data export, stopping, 274
options tab, 194
prevent file delete, 199
prevent file modification, 200
purge start watermark, 200
purge stop watermark, 201
purging files from, 164
report, 245, 247
serial number, 192
serial number, changing, 281, 283
settings tab, 193
size information, 193
space management, 9
statistics tab, 202
status, 193
warn when free space is getting low, 201

F
FAT media support, 18, 21

preventing file delete on, 199
preventing file modification on, 200

fetching files, 3, 9, 47, 143
allowing, 47, 143, 144, 166
canceling requests, 48, 198
deferring, 47, 201
prefetch, 48, 143, 146
priority, 52
restricting, 47
scheduling, 52
timeout minutes, 48, 144, 198

file data, 3
file management, 4
file migration, 8, 164

definition, 3
forcing when nothing to purge, 198
from one media type to another, 79
managing, 117

priority, 52
scheduling, 48

file report, 251
file restore, 70, 77

enabling direct read, 70, 78
logging duplicates, 70, 78
processing ASAP, 70

file systems
ASM, 22
benefits and limitations, 19
CDFS, 21
CSS, 23
definition, 3
FAT, 21
formatting media, 56
NTFS, 21
OSS, 22
portability vs. performance, 19
supported, 18
TSS, 22
UDF overwritable, 23
UDF sequential, 23

file tag, 3, 164
backing up, 196

filtering applications, 228
adding applications, 230
deleting applications, 232
modifying applications, 231
resetting list defaults, 232

finalization
defined, 3

finalize DVD-R media
enabling direct read, 84
purging files, 84

finalizing media, 82
flushing transactions to media, 50

priority, 52
fonts, changing for reports, 263
footer, changing for reports, 261
forcing

direct read for all files, 198
drive scans, 204
full meta-data exports, 272
meta-data exports, 274
moves when nothing to purge, 198

foreign media, 25
formatting media, 56

double-sided optical, 57



Index

328 Second Edition PN313473404
StorageTek Proprietary

enabling/disabling compression, 58, 62
low-level SCSI, 58, 61
reformatting, 76
using a media task, 57
using Media Prepare Manager, 59
when to format, 56

free space
extended drive, calculating, 193
extended drive, maintaining, 163, 166,

167
extended drive, warn when getting low,

201
media, 30
media, removing when low, 127
purging files as needed, 167, 176

G
glossary of terms, 1

H
hard drive, 4

extending, 8
hardware, 4

compression, 226
device management, 207, 222

header, changing for reports, 261

I
include rules

delete, 181
move, 136
purge, 169, 171

incremental
media labeling, 63
meta-data export, 269

installation date, Data Manager, 219
installing

Remote Administrator, 291

J
jukebox

definition, 4
flushing transactions, 51

L
labeling media, 64

automatically, 64, 129, 130
naming conventions, 64
renaming, 76
using a media task, 65
using barcodes, 62
using Media Prepare Manager, 59
using the standard method, 62

layout editor, reports, 259
liability, v
library

definition, 4
flushing transactions, 51
maximum number of media to mount,

126
minimum free space before mount, 125
minimum number of files on move list be-

fore mount, 126
license agreement for Remote Administrator,
292
licensing information, 236
location

backup, 271, 285
media, 29

logging duplicates during file restore, 70, 78
logical cluster name, 4
logical media, 4
logs, 10

all events, 237, 238
errors, 237, 238
event viewer, 237
event, clearing, 244
event, configuring, 240
event, configuring format, 240
event, configuring start time, 240
event, impact on performance, 243
event, limiting size, 240
event, selecting to trace, 243
impact on performance, 239, 240
media, clearing, 41
opening, 239
prefetch request, 158
previewing in RtfPad, 304
print setup in RtfPad, 305
printing in RtfPad, 303
saving in RtfPad, 303
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sending by email, 306
warnings, 237, 238

looking up errors, 307
low-level SCSI format, 58, 61

M
magneto-optical, 14, 16

supported file systems, 19
Magstar tape, 14
managed files, 4
manual registration, 298
mapping partitions, 219

creating maps, 220
deleting maps, 222
modifying maps, 221

maximum write errors before media write dis-
abled, 126
media, 7

aborting/stopping tasks, 45
activities, 46
activity scheduling, 52, 193
adding to media folders, 67, 68, 71
adding to move groups, 73, 74, 121,

123
available space, 30
backups, 103, 275
blank, 25
CD-ROM, 14
changing type for move groups, 121
choosing to use as copies, 105
classes, 24
clearing logs, 41
clearing task error status, 41
compacting, 79, 80
compacting automatically, 129
compacting before removing from media

folders, 88
compression, 58, 62
copying, 10, 24, 103, 106, 107, 109,

275
corrupt, 26
deallocating, 95, 96
definition, 4
deleting, 97
deleting tasks, 46
duplicate, 25
DVD-R, 14, 15

DVD-RAM, 14
DVD-ROM, 14, 15
editing tasks, 42
EMC Centera, 14, 15
error statistics, 33
fetching files from, 47, 143
file read statistics, 32
file restore, 70
file write statistics, 32
fill method, random, 126
fill method, sequential, 126
fill sequence, 123
finalizing, 82
flushing transactions, 50
foreign, 25
formatting, 56, 57
general tab, 27
groups, 119
labeling, 62, 64, 65
labeling automatically, 129
location, 29
location tab, 29
magneto-optical, 14
managing, 7, 13, 55
mixing in hardware devices, 56
mount statistics, 32
mount times, 224
moving files between types, 79
moving files to, 48
naming conventions, 64
NAS, 14, 16
NAS devices, 17
optical, 16
original, 24
portability vs. performance, 19
prefetching files from, 48, 49, 146, 160
preparing for use in ASM, 55, 59
processing tasks, 49
progress tab, 33
promoting copies, 112, 113
properties, 26
RAID devices, 16
reformatting, 76
removing from media folders, 87, 88, 90,

92
removing from media services, 97
removing from move groups, 85, 121,

124, 127
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renaming, 76
reordering in move groups, 121, 123
reordering tasks, 44
repairing using check disk, 103, 113
report, 245, 249
report on files, 245, 251
report on tasks, 256
restoring files from, 77
serial numbers, 28
space tab, 30
spinning down, 224, 225
statistics tab, 31
statistics, clearing, 33
status, 40
supported file systems, 18
supported types, 14
tape, 14, 17
tasks, 34
Tivoli Storage Manager, 14, 17
unformatted, 25
unknown, 25
updating copies, 50
verifying file writes, 227
viewing copy media status, 111
WORM, 14, 18
WORM-Tape, 18

media folders
adding media to, 67, 68, 71
creating, 69, 72
deleting, 118
managing, 117
removing media from, 87, 88, 90, 92

media pool, 4
Media Prepare Manager, 7, 59
media services, 7

definition, 5
deleting, 102
overview, 7
removing media from, 97
report, 245, 255

Media Task Queue Manager, 35
media tasks, 13, 34

aborting/stopping, 45
add to media folder, 71
add to move group, 74
adding, 36
check disk, 103, 113
clearing error status, 41

compact, 79
deleting, 46
editing, 42
file report, 251
file restore, 77
finalize, 82
format, 57
format low-level SCSI, 58, 61
label, 65
label copy, 109
monitoring, 39
prefetch, 49, 160
processing, 49
processing priority, 52
progress, 33
queue manager, 35
queue manager, opening, 35
remove from media folder, 92
remove from move group, 85
reordering, 39, 44
report, 245, 256
scheduling, 38, 49, 52

media type, 5
MediaStor

deallocating media, 95, 96
definition, 5
deleting a media service, 102
removing media from, 98

migrating files, 8
forcing when nothing to purge, 198
from one media type to another, 79
managing, 117
priority, 52
scheduling, 48, 52

monitoring Data Manager with event logs,
237
mounting media, 125, 224
move groups

adding media to, 73, 74, 123
automation tab, 129
cached moves data watermark, 129
cached moves file watermark, 128
changing group name, 121
changing media type, 121
deleting, 133
free/used space, 132
general tab, 121
library mount, maximum number of me-
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dia, 126
library mount, minimum free space on

media, 125
library mount, minimum number of files,

126
managing, 119
maximum write errors before media write

disabled, 126
media tab, 121
modifying, 120
options tab, 124
remove media when free space falls be-

low, 127
removing media from, 85, 121, 124
reordering media, 121, 123
selecting in move rules, 141
statistics tab, 132
supported media, 119
use sequential fill method, 126
warn when group free space falls below,

128, 131
move rules

age tab, 139
attributes, 139
changing attribute qualifications, 139
changing file name qualifications, 136
changing folder, 136
changing size qualifications, 138
changing time delay for file migration,

139
choosing move group to receive files,

141
deleting, 143
enabling direct read for moved files, 141
file name tab, 136
inclusion vs. exclusion, 136
managing, 134
modifying, 134
purge files after move, 141
rule type tab, 136
settings tab, 141
size tab, 138
statistics tab, 142

moving files, 8
forcing when nothing to purge, 198
from one media type to another, 79
managing, 117
priority, 52

scheduling, 48, 52

N
name

changing for move groups, 121
changing for report layouts, 265

naming conventions, media, 64, 130
NAS, 14

deallocating media, 95, 96
deciding when to purge files to media,

165
definition, 5
deleting a media service, 102
devices, 17
media, 16
RAID devices, 16
removing media, 98
supported file systems, 19

NTFS
file system support, 21
media support, 18
volume, definition, 5
volume, extending, 8, 163

O
online help, xi
opening Remote Administrator, 294
optical media, 16

drive saver, 225
formatting double-sided, 57
supported file systems, 19
timeslice last fetch, 225
timeslice maximum mount, 226
timeslice minimum mount, 225

original media, 24
deleting, 113

OSS file system, 18, 22
overwritable

definition, 5
UDF file system, 18, 23

P
partition mapping, 219

creating maps, 220
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deleting maps, 222
modifying maps, 221

performance of storage media, 19
planning Remote Administrator installation,
289
portability of storage media, 19
Prefetch Request Manager, 146
prefetching files, 9, 48, 49, 143, 146, 166

.DXP files, 147, 154
aborting requests, 160
browsing for files to add, 152
configuring, 149
creating a request, 147
deleting requests, 160
direct request, 146
file format for indirect requests, 147
indirect request, 146
loading files from a file, 154
managing the file list, 152
modifying requests, 155
planning, 147
priority, 52
resubmitting requests, 159
saving a file list, 154
scheduling, 48, 150
starting the wizard, 148
using media tasks, 160
using Prefetch Request Manager, 146
viewing logs, 158

preventing
file delete, 199
file modification, 200

previewing
logs and reports before printing, 304
navigating, 305
report layouts, 265
zooming in/out, 305

printing
logs and reports, 303
setting up in RtfPad, 305

priority
media fill sequence, 123
media tasks in queue, 44
purge rules, 176

privileges, security, 290
promoting

copy media to original media, 112
media in move groups, 121, 123

media tasks, 44
purge, 164

definition, 164
during DVD-R finalization, 84
files as disk space needed, 167, 176
files during drive scans, 167, 176
files immediately after move, 141, 166
files never, 168
files, filtering data access, 228
forcing moves when no files available,

198
list, 165, 166, 169
list, processing, 167, 200
list, stopping processing, 201
rules, 9
rules, age tab, 175
rules, attributes tab, 174
rules, creating, 170
rules, deleting, 180
rules, file name tab, 172
rules, inclusion vs. exclusion, 169, 171
rules, modifying, 178
rules, priority, 168, 169, 176
rules, rule type tab, 170
rules, setting age qualifications, 175
rules, setting attributes qualifications,

174
rules, setting file name qualifications,

172
rules, setting file size qualifications, 173
rules, setting folder qualifications, 172
rules, settings tab, 176
rules, size tab, 173
rules, statistics tab, 179
start watermark, 167, 199, 200
stop watermark, 167, 199, 201
when to, 165

R
RAID devices, support for, 16
random media fill method, 126
recovery, 10, 267, 279

changing extended drive serial number,
283

confirmation, 287
Data Manager configuration, 280
meta-data export, 284
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promoting copy media to original media,
112

restoring files from media, 287
reformatting media, 76
registering computers, 295

automatically, 295
manually, 298

registration of the Remote Administrator,
292
registry

backup, 10, 267, 275
backup location, 276
backup, copying, 278
report for Data Manager, 245, 258
restoring Data Manager configuration,

280
Remote Administrator, 289

automatically registering, 295
connecting to remote computers, 300,

301
disconnecting computers, 300
installing, 291
installing on multiple computers, 293
manually registering, 298
registering computers, 295
security and access, 290
starting the first time, 294
uninstalling, 315

Remote Procedure Call (RPC), 219
removable media, 6
removable media drive, 5
removing

ACSLS media from extended drives, 95,
96

DX2000 and components, 311
EMC media from extended drives, 95,

96
media from extended drives, 95
media from media services, 97
media from the ACSLS media service,

102
media from the EMC media service, 100
media from the MediaStor media service,

98
media from the NAS media service, 98
media from the TSM media service, 99
media services, 102
media when free space falls below, 127

MediaStor media from extended drives,
95, 96

NAS media from extended drives, 95, 96
TSM media from extended drives, 95, 96

renaming
extended drive folders, disabling, 197
media, 76
report layouts, 265

reordering
media in move groups, 121
media tasks in the queue, 44

repair disk, 10, 267, 275
copying current configuration, 278
restoring Data Manager configuration,

280
setting backup location, 276

repairing media using check disk, 103, 113
Report Generator Wizard, 246
reports, 10, 245, 287

changing header and footer, 261
creating, 246
extended drive information, 245, 247
layout editor, 259
layouts, 245
layouts, changing header and footer, 261
layouts, creating, 261
layouts, deleting, 266
layouts, editing styles, 263
layouts, previewing, 264, 265
layouts, renaming, 265
layouts, switching between, 265
media, 245, 249
media files, 245, 251
media services, 245, 255
media tasks, 245, 256
print previewing in RtfPad, 304
print setup in RtfPad, 305
printing in RtfPad, 303
product registry information, 245, 258
saving in RtfPad, 303
sending by email, 306

resetting
application filtering list defaults, 232
event logs, 244
media logs, 41
media statistics, 33
media task error status, 41

resource saver
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EMC, 228
restoring

changing extended drive serial number,
283

confirmation, 287
Data Manager, 267, 279
Data Manager configuration, 280
files and enabling direct read, 70, 78
files and logging duplicates, 70, 78
files from media, 70, 77, 287
files, scheduling, 70
meta-data export location, 285
meta-data exports, 284

RPC, 219
RPC connection, 290
RtfPad

error format, configuring, 307
error lookup, 239, 307
print previewing logs and reports, 304
printing logs and reports, 303
saving logs and reports, 303
sending logs and reports by email, 306
setting up printing, 305
taking an event viewer snapshot, 237
viewing event logs in, 239
viewing media logs in, 40
viewing prefetch request logs in, 158

rules
delete, 181
move, 134

S
saving logs and reports, 237, 303
scheduling

copy media creation, 107
copy media updates, 50
drive scans, 193, 205
fetches, 47
file migration, 48
file restore, 70
media activities, 46, 52, 193
media tasks, 49
meta-data exports, 193, 270, 271
prefetch requests, 48, 150

SCSI format, low-level, 58, 61
security

for remote administration, 290

sending
alerts of system errors or warnings, 232
logs and reports by email, 306

sequential
definition, 6
media fill method, 122, 126
UDF file system, 18, 23

serial numbers
copy media, 112
extended drive NTFS volume, 192
extended drive, changing, 281, 283
media, 28

service
account, 208, 210, 212, 215
account, system, 210, 212, 215
alerts tab, 232
CD-ROM drive saver, 224
CD-ROM timeslice last fetch, 224
CD-ROM timeslice maximum mount,

224
CD-ROM timeslice minimum mount, 224
configuring, 218
disabling, 207, 210, 212, 215
DVD drive saver, 224
DVD timeslice last fetch, 225
DVD timeslice maximum mount, 225
DVD timeslice minimum mount, 225
EMC resource saver, 228
general tab, 219
licensing information tab, 236
managing, 207
managing in Windows 2000, 214
managing in Windows NT, 211
managing through Data Manager, 208
optical drive saver, 225
optical timeslice last fetch, 225
optical timeslice maximum mount, 226
optical timeslice minimum mount, 225
options tab, 222
pausing, 208, 211, 214
settings tab, 219
settings, configuring, 210, 211, 212,

214, 215
starting, 208, 211, 214
startup settings, 207, 208, 210, 212,

215
startup settings, automatic, 210, 212,

215
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startup settings, disabled, 210, 212, 215
startup settings, manual, 210, 212, 215
stopping, 208, 211, 214
tape block size default value, 226
tape timeslice last fetch, 226
tape timeslice maximum mount, 226
tape timeslice minimum mount, 226
use hardware compression, 226
use special application filtering, 228
use write verify command, 227
warning users before pause or shutdown,

209
Service Manager, 208, 209
Shell Xtensions Wizard, 309

uninstalling, 318
space management, 163

extended drive, 9, 163, 164
extended drive, deleting files, 180
extended drive, purging files, 164
media, 30

special application filtering, 228
adding applications, 230
deleting applications, 232
modifying applications, 231
resetting list defaults, 232

spinning down media
CD-ROM, 224
DVD, 224
optical, 225

starting the Remote Administrator, 294
stationary drive, 6
stationary media, 6
statistics

backup, 203, 247
drive scan, 203
extended drive, 202, 247
fetched files, 203
files and data pending move, 142, 203
files and data pending purge, 179, 203
media, 31, 249
media file reads, 32
media file writes, 32
media mounts, 32
media, clearing, 33
move group, 132
move rule, 142
purge rule, 179
purged files, 203

reports, 245
storage media. See media
StorageTek’s ACSLS

deallocating media, 95, 96
deleting a media service, 102
removing drives, 102

supported
file systems, 18
media types, 14

system
backup and recovery, 267
error lookup, 239
errors and warnings, displaying as alerts,

232
errors and warnings, logs, 238
performance, impact of logs, 239, 240
service account, 210, 212, 215

system files, 139, 175, 187

T
tape, 14

8mm DAT, 14
9840, 14
AIT, 14
block size default value, 226
DLT, 14
Magstar, 14
supported file systems, 19
timeslice last fetch, 226
timeslice maximum mount, 226
timeslice minimum mount, 226

third-party backup
limitations, 268
media, 103, 275
mode for managed files, 196
saves migration info, 196

timeout minutes, fetch request, 198
timeslice

CD-ROM, last fetch, 224
CD-ROM, maximum mount, 224
CD-ROM, minimum mount, 224
DVD, last fetch, 225
DVD, maximum mount, 225
DVD, minimum mount, 225
optical, last fetch, 225
optical, maximum mount, 226
optical, minimum mount, 225
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tape, last fetch, 226
tape, maximum mount, 226
tape, minimum mount, 226

Tivoli Storage Manager (TSM), 6
transactions, flushing to media, 50
troubleshooting, 207

check disk, 103, 113
logs, 237
looking up errors, 239, 307
media, 39
prefetch requests, 158

truncating files, 164
TSM

backup software, 229
deallocating media, 95, 96
deleting a media service, 102
media, 17
removing media, 99

TSS file system, 18, 22

U
UDF file systems, 18
unformatted media, 25
uninstalling

ASM, 311, 312
ASM Data Manager, preparation, 311
Explorer Add-ons, 318
Remote Administrator, 315

unknown media, 25
use hardware compression, 226
use sequential fill method, 122, 126
use write verify command, 227

V
verifying writes to media, 227
version number, Data Manager, 219
virus scan software, controlling data access,
228

W
warning

displaying as alerts, 232
log, 10, 237, 238
log, clearing, 244

log, configuring, 240
log, configuring format, 240
log, configuring maximum size, 240
log, opening, 239
users before service paused/stopped,

209
when free space low, extended drive,

201
when free space low, move group, 128,

131
warranties, v
wasted space, compacting, 79, 131
watermark

data for cached moves, 129
files for cached moves, 128
purge start, 167, 199, 200
purge stop, 167, 199, 201

Windows
application log, 240
managing the service in 2000, 214
managing the service in NT, 211
native file systems, 18, 20
NT/2000 service, Data Manager, 207
registry report for Data Manager, 245,

258
security, 290

wizard
Add Media to Media Folders, 68
Auto-Detect, 295
Change Extended Drive Serial Number,

281, 283
Data Manager Setup, 311
Data Manager Uninstall, 312
Delete Rule, 182
Explorer Add-ons Uninstall, 318
Extended Drive Restore, 284
Label New Copy, 107
Move Group, 73
Prefetch, 147
Purge Rule, 170
Remote Administrator Setup, 291
Remote Administrator Uninstall, 315
Remove Media from Media Folders, 90
Repair Disk, 276, 278, 280
Report Generator, 10, 245, 246
Shell Xtensions, 309

WORM, 14, 18
preventing file delete, 199
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preventing file modification, 200
supported file systems, 19

WORM-Tape, 18
WORM-tape

block size default value, 226
write verify command, 227
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